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คาํนํา 
 

สดุยอดเคล็ดลับและลัดของ Excel เลอืกสรรความรูเ้กีѷยวกบัการใช ้Excel เทา่ทีѷจําเป็นตอ่การใช ้
งานมานําเสนอ ขอใหรู้จั้กเลอืกใชเ้ครืѷองมอื สตูร หรอืคําสัѷงทีѷจําเป็นของ Excel ใหไ้ดเ้พยีง 
15% แลว้หาทางนําไปใชส้รา้งงานใหไ้ดเ้ต็มทีѷในทันท ียอ่มดกีวา่การเสยีเงนิเสยีเวลาไปซืѸอ
หนังสอืเลม่โตแลว้ไลอ่า่นไปทลีะหนา้แตไ่มท่ราบวา่จะนําความรูไ้ปใชก้อ่นหลังอยา่งไร 

สดุยอดเคล็ดลับและลัดของ Excel มใิชเ่ป็นเพยีงหนังสอืเลม่หนึѷง แตย่ังเป็นหลักสตูรอบรม 
Excel ทีѷเคยจัดขึѸนทีѷสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีѷปุ่ น) มากวา่สบิปี จนกลายเป็นหลักสตูร
ยอดนยิมหลักสตูรหนึѷงซึѷงมผีูส้นใจตดิตอ่จองอบรมกนัลว่งหนา้กนัเป็นเดอืน โดยเฉพาะในชว่ง
เศรษฐกจิซบเซาก็ยังมผีูส้นใจเขา้อบรมกนัมใิชน่อ้ย จงึนับวา่เป็นหลักสตูรอบรมทีѷกอ่ประโยชน์
ชว่ยเหลอืการทําธรุกจิไดทั้ Ѹงในยามเฟืѷองฟแูละในยามยากจนขดัสนเงนิทอง 

ผูท้ีѷเหมาะสําหรับสดุยอดเคล็ดลับและลัดของ Excel ควรมพีืѸนฐานความรู ้Excel มาบา้ง อยา่ง
นอ้ยทีѷสดุขอใหคุ้น้เคยกบัการใชส้ตูรและคําสัѷงของ Excel มากอ่น ถา้ใหด้ทีีѷสดุควรเคยใช ้Excel 
ทําผดิพลาดมากอ่นมากเทา่ใดยิѷงด ีเพราะจะไดเ้รยีนรูส้ ิѷงใหม่ๆ และมองเปรยีบเทยีบออกวา่ วธิี
เกา่ของคณุกบัวธิทีีѷสดุยอดเคล็ดลับและลัดของ Excel นําเสนอนัѸน วธิไีหนดกีวา่กนั วธิใีดทีѷงา่ย 
ชว่ยลดความผดิพลาดในการใช ้Excel และทําใหค้ณุมคีวามสขุในการใช ้Excel มากกวา่กนั 

เนืѸอหาในหนังสอืเลม่นีѸใชไ้ดก้บั Excel 2010, 2013, 2016, 2019, 365 เป็นตน้มาและเผืѷอให ้
ใชก้บัเมนู 2003-2007 ไวด้ว้ย โดยเรยีงลําดับไวใ้หใ้กลเ้คยีงกบัลําดับในการอบรมใหม้ากทีѷสดุ 
ควรเปิดอา่นตั Ѹงแตห่นา้แรกไลไ่ปทลีะบท และขอใหพ้ยายามคดิพจิารณาตามไปดว้ยวา่ ทําไม
เครืѷองมอืนัѸนตอ้งใชก้อ่นเครืѷองมอืนีѸ นกึตั Ѹงคําถามตอ่ตัวเองเสมอวา่เพราะอะไรและเพืѷออะไรจงึ
ตอ้งใชเ้ครืѷองมอื สตูร หรอืคําสัѷงอยา่งนัѸนอยา่งนีѸ ลําดับเนืѸอหาของสดุยอดเคล็ดลับและลัดของ 
Excel มไิดย้กขึѸนมาเพยีงเพราะคดิวา่เป็นเรืѷองทีѷสําคัญหรอืน่าสนใจ หากยังมคีวามสมัพนัธก์นั
ระหวา่งเนืѸอหาแตล่ะลําดับกอ่นหลังอกีดว้ย 

นอกจากความรูท้ีѷไดร้ับจากหนังสอืนีѸ ขอใหด้บูทความและสอบถามปัญหาไดฟ้รจีากเว็บ 
www.ExcelExpertTraining.com  

สมเกยีรต ิฟุ้งเกยีรต ิ
7/1 รามคําแหง ซอย 35 
หัวหมาก บางกะปิ กทม 10240 
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วธิปีรบั Excel ใหพ้รอ้มตอ่การใชง้านอยา่งมอือาชพี 

1. ตอ้งการปรบัใหก้ดปุ่ ม Enter เพืѷอบนัทกึคา่แลว้อยูท่ ีѷเซลลเ์ดมิ สัѷง File > Options > 
Advanced > ตัดกาชอ่ง After pressing Enter, Move selection  
 

 
 
ทั ѸงนีѸใน Excel 2007 สัѷง Office > Excel Options แทน File > Options > 
 
(Excel 2003 : Tools > Options > Edit > ตัดกาชอ่ง Move selection after Enter) 

2. ตอ้งการปรบัใหก้ดปุ่ ม F2 เพืѷอ Edit แกไ้ขบน Formula Bar แทนในเซลล ์สัѷง File > 
Options > Advanced > ตัดกาชอ่ง Allow editing directly in cells  
(Excel 2003 : Tools > Options > Edit > ตัดกาชอ่ง Edit directly in cell) 
 
คําสัѷงนีѸยังมผีลทําใหเ้มืѷอดับเบลิคลกิทีѷเซลลส์ตูรแลว้ Excel จะยา้ยตําแหน่งไปยังตําแหน่ง
เซลลต์น้ทางทีѷอา้งองิในสตูรนัѸน และเมืѷอกดปุ่ ม F5 > Enter จะยา้ยกลับมาทีѷเซลลเ์ดมิทีѷ
เคยดับเบลิคลกิ 

3. ตอ้งการเปลีѷยนระบบการคาํนวณเป็น manual สัѷง Formulas > Calculation Opions 
> คลกิเลอืก Manual จากนัѸนตอ้งกดปุ่ ม F9 เพืѷอสัѷงคํานวณทกุแฟ้มหรอืกด Shift+F9 เพืѷอ
สัѷงคํานวณเฉพาะชทีทีѷเลอืกอยูเ่ทา่นัѸน 
(Excel 2003 : Tools > Options > Calculation > กาชอ่ง Manual) 
 
หมายเหต ุระบบการคํานวณจะเปลีѷยนตามระบบของแฟ้มแรกทีѷเปิดขึѸนกอ่นเสมอ 
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4. ตอ้งการเปิดใหใ้ช ้Macro และ Update Links ไดอ้ตัโนมตัทิกุแฟ้มในโฟลเดอรท์ ีѷ
กําหนดวา่ปลอดภยั สัѷง File > Options > Trust Center > กดปุ่ ม Trust Center 
Settings... (Excel 2003 : Tools > Macro > Security > Security Level > กาชอ่ง 
Medium) 

 
 
เลอืกเมนู Trusted Locations จากเมนูดา้นซา้ย จากนัѸนกดปุ่ ม Add new location... เพืѷอ
เลอืกชืѷอโฟลเดอร ์(Trusted Folder) ตามตอ้งการ  
 
นอกจากนีѸสําหรับ Excel 2010 เป็นตน้มายังมเีมนู Trusted Documents เพืѷอใชค้วบคมุการ
เปิดแฟ้มเพืѷอทําใหแ้ฟ้มใดทีѷเคยเปิดโดยให ้Macro ทํางานหรอื Update Links มากอ่นก็จะ
เปิดแบบนัѸนใหเ้องในคราวตอ่ไป 
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การกําหนดตาํแหนง่อา้งองิและขอบเขตพืҟนทีѷตาราง Excel 
 

บทความนีѸมจีดุประสงคใ์หผู้ท้ีѷเคยใช ้Excel มากอ่นและมพีืѸนฐานมาบา้งจนพอทราบวา่ตําแหน่ง
อา้งองิ (Cell Reference) ในตาราง Excel คอือะไรและนําไปใชก้นัอยา่งไร จะไดเ้ปิดหเูปิดตา
เรยีนรูเ้คล็ดลับทีѷคนทัѷวไปอาจมองขา้มหรอืไมน่กึฝันวา่จะเป็นไปได ้แลว้สามารถนําตําแหน่ง
อา้งองิไปใชก้บัสตูรและคําสัѷงไดอ้ยา่งพลกิแพลงมากยิѷงขึѸน โดยเฉพาะการเลอืกใสเ่ครืѷองหมาย 
$ ใหก้บัตําแหน่งอา้งองินัѸน ไมว่า่จะเป็น $ ในเซลลส์ตูร, $ ใน Conditional Format, $ ใน 
Data Validation, หรอื $ ในในเครืѷองมอือืѷนๆของ Excel ก็ตาม ผมถอืวา่ $ เป็นหัวใจของการใช ้
Excel ทเีดยีว 

ต ัҟงหลกักนักอ่นวา่จะใช ้Excel อยา่งคอมพวิเตอร ์

คณุลองนกึดซูวิา่มนุษยเ์ราไดร้ับประโยชนจ์ากการใชเ้ครืѷองคอมพวิเตอรต์า่งจากสมัยทีѷยังมแีต่
เครืѷองคดิเลขใหใ้ชก้นัอยา่งไรบา้ง หลายคนน่าจะตอบวา่ เครืѷองคอมพวิเตอรต์อ้งชว่ยใหคํ้าตอบ
ทีѷเร็วกวา่เครืѷองคดิเลขใชไ่หม แลว้ความเร็วทีѷวา่นีѸถกูวัดมาจากเวลาทีѷใชไ้ปของเครืѷอง
คอมพวิเตอรห์รอืเวลาของคณุกนัละ่ 

แน่นอนทีѷสดุวา่เครืѷองคอมพวิเตอรย์อ่มทํางานเร็วกวา่เครืѷองคดิเลข และเครืѷองคอมพวิเตอรร์ุน่
ใหมย่อ่มทํางานไดเ้ร็วกวา่เครืѷองคอมพวิเตอรร์ุน่เกา่ ยิѷงใช ้Excel ทีѷตดิตั Ѹงบนเครืѷองคอมพวิเตอร์
รุน่ลา่สดุ ก็ยิѷงไดคํ้าตอบผลลัพธจ์ากการคํานวณเร็วขึѸน ซึѷงถา้ใครหลงเขา้ใจวา่ตัวเองใช ้Excel 
แบบคอมพวิเตอรเ์ป็นอยูแ่ลว้เพยีงเพราะดจูากความเร็วของเครืѷองคอมพวิเตอรท์ีѷใชอ้ยู ่ก็เป็น
ความเขา้ใจทีѷถกูตอ้งเพยีงบางสว่น (และเป็นสว่นทีѷไมส่ําคัญเทา่ใดเสยีดว้ย) เพราะถา้คณุใช ้
Excel อยา่งคอมพวิเตอรเ์ป็น ตอ่ใหย้กเครืѷองคอมพวิเตอรร์ุน่โบราณทีѷทํางานชา้เป็นเตา่ ก็จะ
พบวา่คณุไมไ่ดเ้สยีเวลาตา่งกนัมากนัก 

ลักษณะของการใช ้Excel อยา่งคอมพวิเตอรม์ดีังนีѸ 

1. คณุจะตอ้งเสยีเวลาสรา้งและทดสอบนานหน่อย เนืѷองจากตอ้งหาทางคดิสรา้งงานให ้
เหมาะสมกบัแตล่ะสถานการณ์ ซึѷงคณุควรตั Ѹงหลักไวว้า่ แฟ้มงานทีѷสรา้งขึѸนมานัѸน จะตอ้ง
สามารถนํากลับมาใชซ้ํѸาแลว้ซํѸาอกีไดโ้ดยไมต่อ้งยอ้นกลับไปแกไ้ขใหมอ่กีแมแ้ตน่อ้ย 

2. หากจําเป็นตอ้งแกไ้ข ตอ้งสามารถแกไ้ขปรับปรงุแฟ้มไดง้า่ย ใชเ้วลาไมม่าก และไม่
สง่ผลกระทบตอ่การคํานวณเดมิทีѷถกูตอ้งอยูแ่ลว้ ทั ѸงนีѸไมว่า่จะกําหนดใหผู้ท้ีѷทําหนา้ทีѷ
แกไ้ขนัѸนคอืคณุซึѷงเป็นผูส้รา้งแฟ้มนัѸนเอง หรอืแมแ้ตจ่ะเป็นผูอ้ืѷนซึѷงไมเ่คยใชแ้ฟ้มนัѸนมา
กอ่นก็ตาม 

3. สามารถลดจํานวนคนและไมต่อ้งเพิѷมอตัรากําลังคนตามปรมิาณงานทีѷเพิѷมขึѸน 

4. ประหยัดเงนิลงทนุ เพราะไมต่อ้งจา่ยเพืѷอซืѸอเครืѷองหรอืโปรแกรมคอมพวิเตอรร์ุน่ใหม ่

5. คณุตอ้งมคีวามสขุและมเีวลาวา่งใหก้บัชวีติมากขึѸน 
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สตูรฉลาด (Smart Formula) 

Smart Formula แปลวา่ สตูรฉลาด ซึѷงสตูรฉลาดทีѷวา่นีѸจะฉลาดไดก้็ตอ่เมืѷอใชค้วามฉลาดของ
คณุในการสรา้งสตูรขึѸนมา เพืѷอใหม้ลัีกษณะการใชง้านไดต้ามนีѸ 

 
ในชทีหนึѷงๆหรอืตารางหนึѷงๆ ตอ้งมสีตูรตน้ฉบับเพยีงเซลลเ์ดยีว ซึѷงสามารถนําไปใช ้
ไดก้บัเซลลอ์ืѷนๆไดทั้ Ѹงตาราง แลว้เมืѷอใดทีѷจําเป็นตอ้งแกไ้ขสตูรใหม ่ก็จัดการแกไ้ข
สตูรนีѸเพยีงเซลลเ์ดยีวแลว้ Copy นําไป Paste เพืѷอใชไ้ดก้บัทกุเซลลใ์นตาราง 
 

 

ในโครงสรา้งของตัวสตูรฉลาดอาจใชว้ธิกีําหนดตําแหน่งอา้งองิแบบเซลลเ์ดยีวหรอืแบบกําหนด
ขอบเขตตารางก็ได ้โดยไมว่า่จะใชว้ธิใีดก็หลกีหนกีารกําหนดตําแน่งอา้งองิทีѷมเีครืѷองหมาย $ 
กํากบัตําแหน่ง 3 แบบตอ่ไปนีѸไปไมพ่น้ 

 ตาํแหนง่อา้งองิแบบ Absolute Reference มเีครืѷองหมาย $ วางไวด้า้นหนา้ของทัѸง
ตําแหน่ง Row และ Column เชน่ =$A$1 โดยใหใ้ชตํ้าแหน่งอา้งองิแบบนีѸกบักรณีทีѷ
ตอ้งการนําคา่คงทีѷไปใช ้

 ตาํแหนง่อา้งองิแบบ Relative Reference เป็นตําแหน่งอา้งองิซึѷงไมม่เีครืѷองหมาย 
$ เชน่ =A1 ซึѷงสตูรทีѷอา้งองิแบบนีѸจะตอ้งใชท้ีѷเซลลเ์ดมิเซลลเ์ดยีวไปตลอด ไมส่ามารถ 
Copy นําไป Paste เพืѷอทําใหไ้ดค้า่เดมิซํѸาทีѷเซลลอ์ืѷนไดอ้กี เพราะตําแหน่งอา้งองิจะ
เขยืѸอนตา่งจากตําแหน่งเดมิเสมอ ดังนัѸนจงึเป็นการอา้งองิแบบทีѷใชใ้นเซลลส์ตูรกนันอ้ย
ทีѷสดุ แตก่ลับถกูนํามาใชก้นัมากใน Conditional Formatting หรอื Data Validation 

 ตาํแหนง่อา้งองิแบบ Mixed Reference เป็นตําแหน่งอา้งองิทีѷนยิมใชก้นัมากทีѷสดุ 
โดยผูส้รา้งสตูรตอ้งเลอืกใสเ่ครืѷองหมาย $ ดา้นหนา้ตําแหน่ง Row หรอื Column เพยีง
อยา่งใดอยา่งหนึѷง เชน่ =A$1 เพืѷอคงตําแหน่ง Row 1 ไวต้ามเดมิตลอด หรอื =$A1 
เพืѷอคงตําแหน่ง Column A ไวต้ามเดมิตลอด ไมว่า่จะ Copy นําสตูรไป Paste ทีѷ
ตําแหน่งอืѷนก็ตาม 

วธิสีรา้งสตูรใหม้ตํีาแหน่งอา้งองิทีѷมเีครืѷองหมาย $ นําหนา้ตําแหน่งของ Row และหรอื Column 
นีѸ ใหใ้ชว้ธิ ีPointing แลว้กดปุ่ ม F4 ซํѸาไปเรืѷอยๆจนกวา่จะไดตํ้าแหน่ง $ ตามตอ้งการ 

1. ใหเ้ริѷมจากพมิพเ์ครืѷองหมายเทา่กบั = ลงไปในเซลลท์ีѷตอ้งการสรา้งสตูร (เพืѷอแสดงการ
ยดึครองเซลลนั์Ѹนไวก้อ่นวา่ เป็นเซลลท์ีѷจะรับสตูรลงไปเมืѷอเรากดปุ่ ม Enter) 

2. จากนัѸนใชว้ธิชีีѸลงไปในเซลลท์ีѷตอ้งการ (Pointing แปลวา่ ชีѸ) โดยใช ้Mouse คลกิเลอืก
เซลลท์ีѷตอ้งการ ไมว่า่จะอยูต่า่งชทีหรอืตา่งแฟ้มกนัก็ตาม เชน่ คลกิทีѷเซลล ์A1 จะได ้
สตูร =A1 
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3. จากนัѸนใหก้ดปุ่ ม F4 ไปเรืѷอยๆ จะพบวา่มเีครืѷองหมาย $ แทรกลงในสตูรใหเ้องตามลําดับ
ทีѷมกีารกดปุ่ ม F4 ดังนีѸ A1  $A$1  A$1  $A1  A1  แลว้จะมเีครืѷองหมาย $ 
วนซํѸาไปอกี 

4. เมืѷอไดตํ้าแหน่ง $ ควบคมุตําแหน่ง Row และหรอื Column ตามตอ้งการแลว้ใหก้ดปุ่ ม 
Enter เพืѷอรบัสตูรลงไปในเซลล ์แลว้จะพบวา่ Excel จะพากลบัมาทีѷเซลลซ์ึѷงพมิพ์
เครืѷองหมายเทา่กบันําหนา้สตูรเอาไวต้ั Ѹงแตแ่รกนัѷนเอง 

การใสเ่ครืѷองหมาย $ เพืѷอเป็นการควบคมุตําแหน่งอา้งองิไวไ้มใ่หเ้ขยืѸอนนีѸ นอกเหนอืจากการทํา
ใหค้ณุสามารถ Copy สตูรไปใชใ้นเซลลอ์ืѷนไดทั้นทแีลว้ ยังเป็นเรืѷองน่าสงัเกตวา่ชว่ยทําใหแ้ฟ้ม
มขีนาดเล็กลงกวา่แฟ้มทีѷมสีตูรซึѷงไมม่ ี$ กําหนดไวเ้ลย (ขอใหท้ดลองลบเครืѷองหมาย $ ทิѸง
จากสตูรในตารางขนาดใหญเ่พืѷอเปรยีบเทยีบดขูนาดแฟ้ม โดยใชคํ้าสัѷง Replace เครืѷองหมาย $ 
แตไ่มไ่ด ้Replace with ดว้ยเครืѷองหมายใด) 

นอกจากตําแหน่งอา้งองิทีѷตอ้งมเีครืѷองหมาย $ เป็นองคป์ระกอบสําคัญแลว้ ในโครงสรา้งของ
สตูร Smart Formula ยังอาจจําเป็นตอ้งพึѷงสตูร IF, And, Or หรอืสตูรอืѷนๆซึѷงทําหนา้ทีѷตัดสนิใจ 
เพืѷอชว่ยทําใหส้ตูรมเีงืѷอนไขในการคํานวณตา่งไปจากเดมิไดเ้องทันท ีเมืѷอมกีารนําสตูรเดยีวกนั
ไปใชซ้ํѸาทีѷตําแหน่งเซลลอ์ืѷน 

 

ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิเซลลเ์ดยีว 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

ข ัҟนตอนการสรา้ง 

1. เริѷมจากเลอืกเซลล ์C3 แลว้พมิพเ์ครืѷองหมายเทา่กบั = ลงไป 

2. จากนัѸนคลกิเซลล ์C2 จะไดส้ตูร =C2 

3. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรใหเ้ป็น =C$2 

4. พมิพเ์ครืѷองหมายคณู * 

5. จากนัѸนคลกิเลอืกเซลล ์B3 จะไดส้ตูร =C$2*B3 
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6. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรเป็น =C$2*$B3 

7. กดปุ่ ม Enter เพืѷอรับสตูรลงไปในเซลล ์C3 

8. Copy ไปทับตาราง C3:F5 

คาํอธบิาย 

 เซลล ์C3 เป็นเซลลท์ีѷมสีตูร Smart Formula ซึѷงโดยทัѷวไปจะเลอืกใหเ้ซลลห์ัวมมุ
ดา้นซา้ยบนของตารางเป็นเซลลท์ีѷมสีตูร Smart Formula 

 คณุอาจเลอืกสรา้งสตูรคณูโดยใชเ้ลข 2 นําหนา้แลว้นําไปคณูกบัเลข 10 เพืѷอทําใหไ้ด ้
สตูร =C$2*$B3 หรอืจะเลอืกใชเ้ลข 10 นําหนา้แลว้นําไปคณูกบัเลข 2 ซึѷงจะทําใหเ้กดิ
สตูร =$B3*C$2 ก็ไดแ้ละทําใหเ้กดิผลลัพธถ์กูตอ้งเทา่กนัทั Ѹงสองแบบ แตข่อแนะนําให ้
สรา้งพฤตกิรรมในการสรา้งสตูรของตนวา่ “ทกุสตูรทีѷสรา้งขึҟนจะนําตาํแหนง่อา้งองิ
ตามแนวนอนขึҟนกอ่นตาํแหนง่อา้งองิตามแนวต ัҟงเสมอ” ซึѷงหลักนีѸจะชว่ยใหค้ณุแกะ
สตูรของตัวเองไดง้า่ยขึѸน และหากสงัเกตสตูรอืѷนๆของ Excel เชน่ Index หรอื Offset 
จะใชตํ้าแหน่งอา้งองิจากแนวนอน Row ขึѸนกอ่นตําแหน่งอา้งองิจากแนวตั Ѹง Column 
เชน่กนั 

 C$2 ตอ้งมเีครืѷองหมาย $ วางไวห้นา้เลข 2 เนืѷองจากตารางสตูรคณูนีѸม ีRow 2 เป็น
ตําแหน่งอา้งองิทีѷตอ้งควบคมุไวไ้มใ่หเ้ปลีѷยน สว่นตัว C ไมต่อ้งมเีครืѷองหมาย $ นําหนา้ 
เพืѷอปลอ่ยให ้C เปลีѷยนตําแหน่งเป็น Column D E F หรอื Column อืѷนๆตามแตว่า่จะใช ้
สตูรนีѸหรอืไม ่

 $B3 ตอ้งมเีครืѷองหมาย $ วางไวห้นา้ Column B เนืѷองจากตารางสตูรคณูนีѸม ีColumn B 
เป็นตําแหน่งอา้งองิทีѷตอ้งควบคมุไวไ้มใ่หเ้ปลีѷยน สว่นเลข 3 ไมต่อ้งมเีครืѷองหมาย $ 
นําหนา้ เพืѷอปลอ่ยใหเ้ลข 3 เปลีѷยนตําแหน่งเป็น Row 4 5 6 หรอื Row อืѷนๆตามแตว่า่
จะใชส้ตูรนีѸหรอืไม ่

 หลักการใสเ่ครืѷองหมาย $ นีѸ ใหจํ้าไวว้า่ “ถา้ตาํแหนง่อา้งองิในสตูรมาจากคา่ตาม
แนวนอน ใหใ้ส ่$ ไวห้นา้ Row (เพราะ แนวนอน = Row) แตถ่า้ตาํแหนง่อา้งองิ
ในสตูรมาจากคา่ตามแนวต ัҟง ใหใ้ส ่$ ไวห้นา้ Column (เพราะ แนวต ัҟง = 
Column)” 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิตามขอบเขตพืҟนทีѷหวั
ตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

วธิกีารสรา้งคลา้ยกบัวธิแีรก แทนทีѷจะคลกิเลอืกเซลล ์C2 หรอืเซลล ์B3 วธินีีѸใหค้ลกิเลอืกเซลล ์
C2:F2 และ B3:B5 ซึѷงเป็นหัวตารางดา้นบนและดา้นซา้ยทัѸงหมด แลว้กดปุ่ ม F4 เพืѷอทําใหเ้กดิ
สตูร =$C$2:$F$2*$B$3:$B$5 

1. เริѷมจากเลอืกเซลล ์C3 แลว้พมิพเ์ครืѷองหมายเทา่กบั = ลงไป 

2. จากนัѸนคลกิเลอืกเซลลบ์นหัวตารางดา้นบนจากเซลลเ์ลข 2 - 5 จะไดส้ตูร =C2:F2 

3. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรใหเ้ป็น =$C$2:$F$2 

4. พมิพเ์ครืѷองหมายคณู * 

5. จากนัѸนคลกิเลอืกเซลลบ์นหัวตารางดา้นซา้ยจากเซลลเ์ลข 10 - 30 จะไดส้ตูร 
=$C$2:$F$2*B3:B5 

6. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรเป็น =$C$2:$F$2*$B$3:$B$5 

7. กดปุ่ ม Enter เพืѷอรับสตูรลงไปในเซลล ์C3 

8. Copy ไปทับตาราง C3:F5 

คาํอธบิาย 

 สตูรแบบทีѷอา้งองิกบัตําแหน่งทั Ѹงหมดบนหัวตารางหรอืขา้งตาราง แลว้ใสเ่ครืѷองหมาย $ 
ใหก้บัตําแหน่งทั Ѹง Row และ Column นีѸ ผมตั Ѹงชืѷอเรยีกวา่ สตูรแบบลอ้มร ัҟว โดยทีѷสตูร 
=$C$2:$F$2*$B$3:$B$5 จะทําหนา้ทีѷนําตําแหน่งอา้งองิบนรั Ѹวตามแนวตั Ѹงฉากทีѷตัดกนั
มาคณูกนัทลีะตัวใหเ้อง ทําใหไ้มต่อ้งคอยพะวงวา่จะตอ้งเลอืกใสเ่ครืѷองหมาย $ เพืѷอ
ควบคมุตําแหน่งอา้งองิตามแนวใดเป็นหลัก 

 ถา้เปรยีบเทยีบกบัสตูรคณูวธิแีรกซึѷงใชตํ้าแหน่งอา้งองิแบบเซลลเ์ดยีว จะพบวา่การใช ้
สตูรอา้งองิแบบเซลลเ์ดยีวมคีวามยดืหยุน่มากกวา่ เชน่เมืѷอหัวตารางมขีนาดใหญม่ากขึѸน 
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ก็สามารถ Copy สตูรไปใชต้อ่ไดทั้นท ีแตถ่า้สรา้งสตูรแบบลอ้มรั Ѹว จะตอ้งสรา้งสตูรใหม่
เพืѷอกําหนดตําแหน่งอา้งองิในสตูรใหม้ขีนาดขยายตาม (เวน้แตว่า่คณุทราบวธิขียาย
ขอบเขตตําแหน่งอา้งองิ ซึѷงจะนํามาอธบิายตอ่ไปในภายหลัง) 

 จดุออ่นของสตูรแบบลอ้มรั Ѹวก็คอื สตูรแบบนีѸใสเ่ครืѷองหมาย $ ควบคมุตําแหน่งแบบ 
Absolute จงึคํานวณหาคําตอบใหไ้ดเ้ฉพาะตารางจาก C3:F5 ซึѷงอยูภ่ายในขอบเขต
ของรั Ѹวเป็นแนวของตําแหน่งคงทีѷ หาก Copy สตูรไปใชน้อกรั Ѹวจะเกดิ Error ขึѸนตามรปู 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิแบบ Array ตาม
ขอบเขตพืҟนทีѷหวัตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

ข ัҟนตอนการสรา้ง 

1. แทนทีѷจะเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว คราวนีѸใหเ้ลอืกพืѸนทีѷตารางจากเซลล ์C3:F5 
ทั Ѹงหมดพรอ้มกนัไวก้อ่น 

2. จากนัѸนพมิพเ์ครืѷองหมายเทา่กบั = 

3. คลกิเลอืกเซลล ์C2:F2 บนหัวตาราง จะไดส้ตูร =C2:F2 

4. พมิพเ์ครืѷองหมายคณู * 

5. คลกิเลอืกเซลล ์B3:B5 จากขา้งตาราง จะไดส้ตูร =C2:F2*B3:B5 

6. จากนัѸนแทนทีѷจะกดปุ่ ม Enter ใหก้ดปุ่ ม Ctrl+Shift+Enter พรอ้มกนัทเีดยีว 3 ปุ่ ม จะ
ทําใหเ้กดิเครืѷองหมายวงเล็บปีกกาปิดหัวทา้ยสตูรใหเ้องกลายเป็น {=C2:F2*B3:B5} 

คาํอธบิาย 

 สาเหตทุีѷตอ้งเลอืกพืѸนทีѷตาราง C3:F5 ไวก้อ่นแทนการเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว 
เพืѷอทําใหผ้ลลัพธท์ีѷไดจ้ากสตูร Array คนืคา่กระจายคําตอบลงไปในตารางใหค้รบทกุ
ตําแหน่ง 

 ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร C2:F2 แลว้
กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีѸเปลีѷยนเป็น {2,3,4,5} จากนัѸนใหก้ดปุ่ ม Esc 
เพืѷอคนืสภาพสตูรตามเดมิ 

 ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร B3:B5 แลว้
กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีѸเปลีѷยนเป็น {10;20;30} จากนัѸนใหก้ดปุ่ ม Esc 
เพืѷอคนืสภาพสตูรตามเดมิ 
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 หากกดปุ่ ม F2 ตามดว้ย F9 จะพบวา่สตูร Array เดมิบน Formula Bar {=
C2:F2*B3:B5} จะเปลีѷยนเป็น ={20,30,40,50;40,60,80,100;60,90,120,150} แลว้
ขอใหส้งัเกตวา่มเีครืѷองหมาย Comma และ Semi-Colon ขั Ѹนอยูร่ะหวา่งตัวเลข (ซึѷง
เครืѷองหมาย Comma , นีѸแสดงถงึวา่คา่ถัดไปยังคงอยูใ่น Row เดมิ สว่นเครืѷองหมาย 
Semi-Colon ; แสดงวา่คา่ถัดไปตอ้งขึѸน Row ใหม)่ 

 ดังนัѸน ={20,30,40,50;40,60,80,100;60,90,120,150} จงึแสดงใหเ้ห็นวา่สตูร Array 
นีѸคนืคา่เป็นคําตอบซึѷงมขีนาดความกวา้ง 4 Column และมคีวามสงู 3 Row ตามขนาด
พืѸนทีѷตั Ѹงแต ่C3:F5 ทีѷตอ้งเลอืกไวก้อ่น เพืѷอใหก้ระจายคา่ลงไปใหค้รบนัѷนเอง 

 หากหัวตารางมขีนาดเปลีѷยนไป ตอ้งลบสตูร Array ทีѷสรา้งไวเ้ดมินีѸทิѸงไปกอ่นแลว้จงึ
สรา้งสตูร Array ใหมล่งไป ซึѷงในการลบสตูร Array ทิѸงนีѸ หากตอนทีѷสรา้งสตูรเกดิจาก
การสรา้งพรอ้มกนัทเีดยีวหลายเซลล ์จะเลอืกลบสตูรทิѸงบางเซลลไ์มไ่ด ้ตอ้งเลอืกเซลล ์
C3:F5 ทั Ѹงหมดแลว้จงึสัѷงลบสตูรทิѸงพรอ้มกนัทเีดยีวจงึจะลบได ้

 เนืѷองจากสตูร Array ในตัวอยา่งนีѸเกดิจากการสรา้งพรอ้มกนัทั Ѹงตารางดว้ยสตูรเดยีว จงึ
ทําให ้Excel คํานวณสตูรทั Ѹงตารางสตูรคณูเพยีงครั Ѹงเดยีว ถอืเป็นเคล็ดลับและลัดทีѷ
น่าสนใจเป็นอยา่งยิѷงเพราะถา้สรา้งไดจ้ะทําใหแ้ฟ้มคํานวณเร็วขึѸนอยา่งผดิหผูดิตาทเีดยีว 
(เร็วกวา่ตัวอยา่งสตูรคณูซึѷงสรา้งสตูรลงไปในเซลลเ์ดยีวแลว้ตอ้ง Copy ไป Paste 
เพืѷอใหคํ้านวณซํѸาอกีในเซลลอ์ืѷน) 

 หากตอ้งการคน้หาวา่สตูร Array ทีѷเห็นนัѸนสรา้งขึѸนพรอ้มกนัจากเซลลใ์ดถงึเซลลใ์ด ให ้
เริѷมจากคลกิเลอืกเซลลส์ตูร Array นัѸนๆกอ่นเพยีงเซลลเ์ดยีว แลว้กดปุ่ ม F5 > 
Special > กาชอ่ง Current array จะพบวา่ Excel เลอืกพืѸนทีѷตารางสว่นทีѷเกดิจาก
การสรา้งดว้ยสตูร Array พรอ้มกนันัѸนใหทั้นท ีจากนัѸนหากตอ้งการลบหรอืสรา้งสตูร 
Array ใหมล่งไปก็ใหก้ระทําตอ่พืѸนทีѷตารางทีѷเลอืกใหแ้ลว้นัѸนรว่มกนัเสมอ 
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วธิปีรบัขนาดขอบเขตพืҟนทีѷตาราง 

เพืѷอทําใหตํ้าแหน่งอา้งองิทีѷกําหนดไวใ้นสตูรปรับตําแหน่งตามอยา่งถกูตอ้งเสมอ เมืѷอใดทีѷ
ตอ้งการปรับขนาดขอบเขตพืѸนทีѷตาราง ใหใ้ชว้ธิ ีInsert หรอื Delete แนว Row หรอื Column 
เพืѷอแทรกเพิѷมหรอืลดพืѸนทีѷภายในทิѸง โดยกําหนดใหม้ผีลเฉพาะทัѸงแถวหรอืเฉพาะพืѸนทีѷใน
ตารางนัѸนก็ได ้ 

ตวัอยา่งการขยายขนาดตาราง 

สมมตวิา่ตอ้งการขยายขนาดตารางใหเ้พิѷมอกี 2 Row ใหเ้ริѷมจากเลอืกพืѸนทีѷตารางตั Ѹงแต ่Row 
สดุทา้ยออกไปตามจํานวน Row ทีѷตอ้งการ จากนัѸนคลกิขวาสัѷง Insert > Shift cells down 

 

ตวัอยา่งการลดขนาดตาราง 

สมมตวิา่ตอ้งการลดขนาดตารางใหม้จํีานวน Row ลดลง 2 Row ใหเ้ริѷมจากเลอืก Row ภายใน
พืѸนทีѷตารางตามจํานวน Row ทีѷตอ้งการ จากนัѸนคลกิขวาสัѷง Delete > Shift cells up 

 

หมายเหต ุ

1. หากในชทีมตีารางขอ้มลูเพยีงตารางเดยีว ใหใ้ชว้ธิเีลอืกทั Ѹงแนว Row หรอื Column 
โดยไมจํ่าเป็นตอ้งเลอืกเฉพาะภายในพืѸนทีѷตาราง จากนัѸนใหส้ัѷง Insert หรอื Delete ทั Ѹง
แนว Row หรอื Column ไดเ้ลย 

2. การลดขนาดตาราง สามารถเลอืกลบพืѸนทีѷรวมทั Ѹงแนว Row สดุทา้ยหรอื Column ขวา
สดุของขอบเขตตารางก็ได ้(แตไ่มแ่นะนําเพราะเป็นวธิตีา่งจากการขยายตาราง) 
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ขอ้ควรระวงัในการ Move เซลลข์อบเขตพืҟนทีѷตาราง 

1. หาก move เซลลข์อบตาราง (ไมว่า่จะเป็นดา้นขวาสดุหรอืดา้นลา่งสดุ) โดยใชคํ้าสัѷง 
Cut-Paste หรอืใช ้Mouse ลากเซลลอ์อกไปในแนวเดมิ จะทําใหตํ้าแหน่งเซลลท์ีѷอา้งไว ้
ในสตูรปรับตําแหน่งอา้งองิตาม แตถ่า้ move เซลลก์ลับมาทีѷเดมิ ตําแหน่งอา้งองิในสตูร
จะไมย่า้ยกลับมาทีѷเดมิ แตจ่ะมตํีาแหน่งเกนิไป 1 เซลล ์

2. หาก move เซลลข์อบตารางออกไปนอกแนวเดมิ จะไมทํ่าใหตํ้าแหน่งเซลลท์ีѷอา้งไวใ้น
สตูรยา้ยตาม  

ตวัอยา่ง 

สมมตวิา่จากตารางคํานวณสตูรคณูซึѷงอยูใ่นเซลล ์B2:F5 นัѸน เราไดส้รา้งสตูรหายอดรวมตัวเลข
บนหัวตารางดา้นบนไวท้ีѷเซลล ์D9 โดยใชส้ตูร =SUM(C2:F2) และหายอดรวมตัวเลขจากหัว
ตารางดา้นซา้ยไวท้ีѷเซลล ์D10 โดยใชส้ตูร =SUM(B3:B5) สว่นเซลล ์D11 หายอดรวมของผล
คณูไวโ้ดยใชส้ตูร =SUM(C3:F5) (โปรดสงัเกตเฉพาะตําแหน่งอา้งองิในสตูร โดยไมต่อ้งสนใจ
ตัวเลขผลลัพธ)์ 

 

เมืѷอยา้ยเซลล ์B5:F5 ซึѷงเป็นขอบตารางดา้นลา่งออกไปวางไวท้ีѷ Row 7 ในแนว Column เดมิ
สว่นขอบตารางดา้นขวาจากเซลล ์F2:F4 ใหย้า้ยไปวางไวท้ีѷเซลล ์H3:H5 นอกแนวเดมิ จะ
พบวา่การยา้ยขอบตารางดา้นลา่งตามแนวเดมิ ทําใหตํ้าแหน่งอา้งองิในสตูรทีѷอยูใ่นเซลล ์D10 
และ D11 เปลีѷยนตําแหน่งตามไดอ้ยา่งถกูตอ้ง สว่นการยา้ยขอบตารางดา้นขวาออกไปนอกแนว 
ไมไ่ดส้ง่ผลทําใหส้ตูรหายอดรวมตัวเลขจากหัวตารางดา้นบนในเซลล ์D9 เปลีѷยนไปแตอ่ยา่งใด 
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แตเ่มืѷอยา้ยเซลลก์ลับมาตําแหน่งเดมิ พบวา่ตําแหน่งอา้งองิในเซลล ์D10 และ D11 ไมย่อมยา้ย
กลับมาทีѷเดมิ แตจ่ะเกนิไป 1 เซลล ์(ตารางเดมิมขีอบเขตดา้นลา่งถงึ Row 5 แตตํ่าแหน่ง
อา้งองิเมืѷอยา้ยกลับจะมขีอบเขตถงึ Row 6) สว่นสตูรในเซลล ์D9 แสดงถกูตอ้งตามเดมิ 

 

 

ดังนัѸนแทนทีѷจะใชว้ธิ ีMove เซลลข์อบตารางไปทีѷอืѷนเพืѷอปรับขนาดตารางพืѸนทีѷเดมิทีѷกําหนดไว ้
ในสตูร ขอแนะนําใหใ้ชว้ธิ ีInsert หรอื Delete กบั Row หรอื Column ซึѷงจะชว่ยใหตํ้าแหน่ง
อา้งองิในสตูรปรับตามการขยายหรอืลดขนาดไดถ้กูตอ้งตามตอ้งการเสมอ 

 

เคล็ดการเลอืกพืҟนทีѷตาราง 

ตารางขอ้มลูขนาดเล็กทีѷใชก้นัอยูใ่นวันนีѸ จะเริѷมมขีนาดใหญโ่ตขึѸนไปเรืѷอยๆในวันถัดไป จากเดมิ
ทีѷใช ้Mouse คลกิเลอืกพืѸนทีѷตารางไดง้า่ยๆ พอตารางใหญข่ึѸนเพยีงเล็กนอ้ยจนขอบตารางยืѷน
พน้ขอบจอภาพ คณุจะพบวา่กวา่จะใช ้Mouse คลกิเลอืกพืѸนทีѷตารางไดค้รบทกุเซลลก์็ตอ้ง
เสยีเวลาลากไปลากมา หรอืถา้ใช ้Mouse ลากขา้มจอเร็วเกนิไปก็จะหลดุออกนอกตารางไปอยู่
ตําแหน่งไหนก็ไมรู่ ้ยิѷงคอมพวิเตอรข์องคณุเป็นเครืѷอง Notebook ทีѷไมม่ ีMouse ก็ยิѷงตอ้งงอนิѸว
เกร็งมอืปลํѸากบัพืѸนทีѷบนหนา้จอหลายพักทเีดยีวกวา่จะเลอืกพืѸนทีѷไดต้ามตอ้งการ 

ไมว่า่คณุจะใชเ้ครืѷองคอมพวิเตอรแ์บบใด จะม ีMouse หรอืไมก่็ตาม ขอใหพ้ยายามฝึกใชม้อื
ของคณุใหค้ลอ่ง หากมอืกําลังแตะแป้นพมิพอ์ยูเ่พราะเพิѷงพมิพข์อ้มลูเสร็จ ก็ขอใหฝึ้กใช ้
แป้นพมิพใ์นการเลอืกพืѸนทีѷตารางตอ่ไปเลย แตถ่า้มอืกําลังจับ Mouse อยูก่ข็อใหใ้ช ้Mouse 
ตอ่ไปไดทั้นท ีหรอืถา้มอืซา้ยกําลังแตะแป้นพมิพอ์ยูแ่ลว้มอืขวากําลังจับ Mouse อยู ่ก็ขอใหใ้ช ้
2 มอืรว่มกนัไดใ้นทันท ีไมใ่ชว่า่ตอ้งเสยีเวลายา้ยมอืจากแป้นพมิพไ์ปจับ Mouse เพราะใชเ้ป็น
แต ่Mouse 

สําหรับคนทีѷชอบฝึกสมาธ ิการใชค้อมพวิเตอรน์ีѷแหละจะชว่ยในการฝึกสตไิดเ้ป็นอยา่งด ีเพราะ
เราตอ้งคอยตามรูทั้ Ѹงกายและใจและใชก้ายใจประสานกนัใหด้ใีนการเลอืกใชแ้ป้นพมิพห์รอื 
Mouse เพืѷอนํามาใชง้านใหเ้หมาะสม สว่นคนทีѷคดิวา่ตัวเองมสีมาธมิสีตดิแีลว้ขอใหค้อยดมูอื
ของตัวเองใหด้วีา่พอใชทั้ Ѹง 2 มอืชว่ยพมิพอ์ะไรเสร็จลงไปแลว้ มอืขวาของคณุยา้ยไปแบบไมม่ี
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สตไิปควา้ Mouse อยูเ่รืѷอยเลยหรอืไม ่ถา้มอืของคณุดเูหมอืนวา่มชีวีติจติใจของมันเอง ชอบ
เลืѷอนไปจับ Mouse เองทกุครั Ѹงจนเหมอืนวา่มอืจะขาด Mouse ไปไมไ่ด ้แสดงวา่ยังขาดสต ิไม่
สามารถตามรูอ้าการของกายใจไดทั้น 

 

ปุ่ มบนแป้นพมิพท์ีѷใชใ้นการเลอืกพืҟนทีѷตาราง  

การใชแ้ป้นพมิพลั์ดมมีากมายหลายวธิหีลายปุ่ ม บางทตีอ้งกด 2 ปุ่ มหรอื 3 ปุ่ มพรอ้มกนั บางที
ตอ้งกดไลก่นัไปทลีะปุ่ ม ทําใหต้อ้งจดจํากนัวุน่วาย โดยหารูไ้มว่า่หากคณุเขา้ใจหนา้ทีѷของแตล่ะ
ปุ่ มดพีอแลว้เมืѷอนําไปใชร้ว่มกนัก็จะทํางานอยา่งทีѷมันถกูสรา้งมาใหทํ้านัѷนเอง กลา่วคอื 

 ปุ่ ม Ctrl ใหจํ้าวา่ปุ่ มนีѸทําหนา้ทีѷ ทําซํѸา หรอืจําวา่ Ctrl แปลวา่ ซํѸา 

 ปุ่ ม Shift แปลวา่ ตรงึ หมายถงึทําหนา้ทีѷยดึตําแหน่งปัจจบุันเอาไวไ้มใ่หเ้ลืѷอนตาม 

 ปุ่ ม End แปลวา่ สดุ หมายถงึทําหนา้ทีѷยา้ยตําแหน่งเซลลไ์ปจนสดุทาง 

 ปุ่ มลกูศรชีѸไปทางไหน ก็ยา้ยไปทางนัѸน 

 ปุ่ ม * หรอืเครืѷองหมายคณู แปลวา่ อะไรก็ได ้

 ปุ่ ม . หรอืเครืѷองหมายจดุทศนยิม แปลวา่ ถงึ 

จากนัѸนเรามาทดลองกบัตัวอยา่งตารางทีѷมตีัวเลข 1 – 50 บันทกึอยูใ่นเซลล ์B2:F11 โดยเริѷม
จากสมมตวิา่คณุกําลังเลอืกเซลลใ์ดก็ไดใ้นตารางตัวเลขนีѸ แลว้กดปุ่ มตามลําดับตอ่ไปนีѸ 

 

1. กดปุ่ ม Ctrl+* (เครืѷองหมายบวก หมายถงึใหก้ดปุ่ ม Ctrl พรอ้มกบัปุ่ ม *) จะทําหนา้ทีѷเลอืก
พืѸนทีѷตั Ѹงแตเ่ซลล ์B2:B11 เนืѷองจากปุ่ ม Ctrl แปลวา่ซํѸา และปุ่ ม * แปลวา่อะไรก็ได ้ดังนัѸน
เมืѷอกด 2 ปุ่ มนีѸพรอ้มกนั จงึทําหนา้ทีѷเลอืกเซลลอ์ะไรก็ไดท้ีѷตดิตอ่กนัซํѸาไปตลอด ซึѷงพืѸนทีѷ
แบบนีѸเรยีกวา่ Current Region (ทําไดอ้กีวธิหีนึѷงโดยการกดปุ่ ม F5 > Special > กาชอ่ง 
Current Region) ทั ѸงนีѸไมค่วรใช ้Ctrl+a เพราะถา้กดซํѸาหรอืกดแชจ่ะเลอืกพืѸนทีѷผดิทันท ี
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2. ตอ่จากขั ѸนแรกเมืѷอเลอืกพืѸนทีѷ Current Region ไดแ้ลว้ ใหส้งัเกตวา่เซลล ์B2 ทีѷมเีลข 1 จะ
เป็นเซลลซ์ึѷงมสีพีืѸนสวา่งทีѷสดุ แสดงตําแหน่งของ Active Cell (ซึѷงความหมายของ Active 
นีѸจะมเีพยีงหนึѷงเดยีวในกลุม่ของมัน เชน่ ในชทีหนึѷงซึѷงมหีลายเซลลก์็จะม ีActive Cell 
เพยีงเซลลเ์ดยีว หรอืในแฟ้มหนึѷงซึѷงมหีลายชที ก็มเีพยีงชทีเดยีวทีѷเป็น Active Sheet) 

3. กดปุ่ ม Ctrl+. แปลตามตัวปุ่ มวา่ ซํѸาถงึ หรอืทําหนา้ทีѷหาขอบเขตหัวมมุตารางวา่เริѷมจาก
ไหนถงึไหน ซึѷงเมืѷอกด 2 ปุ่ มนีѸซํѸาตอ่ไปเรืѷอยๆจะพบวา่ Excel จะยา้ยตําแหน่ง Active Cell 
จากเซลลเ์ลข 1  5  50  46  1 วนกลับทีѷเดมิซํѸาตอ่ไปเรืѷอยๆ 

 

4. ใหท้ดลองกดปุ่ ม Ctrl+. เพืѷอเลอืก Active Cell ใหก้ลับมาเป็นเซลลเ์ลข 1 ซึѷงอยูต่รงหัว
มมุซา้ยบนสดุของตาราง 

5. จากนัѸนกดปุ่ ม Shift คา้งไวเ้พืѷอตรงึเซลลเ์ลข 1 ไวไ้มใ่หข้ยับ แลว้กดปุ่ มลกูศรซา้ยขวาบน
ลา่งดจูะพบวา่ ขอบเซลลด์า้นขวาและดา้นลา่งเทา่นัѸนทีѷจะขยับตามทศิของการกดปุ่ มลกูศร 
ซึѷงเป็นวธิขียายหรอืลดขนาดพืѸนทีѷตารางทีѷตอ้งการเลอืกนัѷนเอง (จําไวว้า่ หากตอ้งการขยาย
หรอืลดขอบดา้นใด ใหย้า้ย Active Cell ไปไวฝั้ѷงตรงขา้มกอ่น จากนัѸนจงึกดปุ่ ม Shift+ปุ่ ม
ลกูศร ซึѷงจะขยับขอบตารางอกีฝัѷงหนึѷงของ Active Cell) 

จากนัѸนมาทดลองเลอืกเฉพาะแนวใดแนวหนึѷงของตารางกนับา้ง โดยใหเ้ริѷมจากคลกิเซลลเ์ลข 1 
ไวเ้ซลลเ์ดยีวกอ่น แลว้กดปุ่ ม Ctrl+Shift+ลกูศร จะเลอืกพืѸนทีѷจากเซลลเ์ดมิทีѷเลอืกไวไ้ปจน
สดุตารางตามทศิทางของลกูศร เชน่ เดมิอยูท่ีѷเซลลเ์ลข 1 ถา้กดปุ่ ม Ctrl+Shift+ลกูศรขวา จะ
เลอืกเซลลเ์ลข 1 – 5 (อาจใชก้ารกดปุ่ มอกีวธิหีนึѷง โดยเริѷมจากกดปุ่ ม Shift คา้งไวแ้ลว้กดปุ่ ม 
End ครั Ѹงหนึѷงแลว้กดปุ่ มลกูศรขวาตามอกีครั Ѹงก็ได ้ขอใหเ้ลอืกใชต้ามถนัด) 

 

วธิใีช ้Mouse เลอืกพืҟนทีѷตาราง 

โดยทัѷวไปเรามักทราบกนัแตว่า่ใหค้ลกิแลว้ลากเพืѷอเลอืกพืѸนทีѷตาราง ซึѷงกวา่จะเลอืกไดต้รง
ตําแหน่งครบทัѸงตารางก็ตอ้งลากแลว้ลากอกี ดังนัѸนหากมอืขวาของคณุอยูท่ีѷ Mouse อยูแ่ลว้ให ้
ใชม้อืซา้ยชว่ยโดยการกดปุ่ ม Shift เพืѷอตรงึเซลลท์ีѷเลอืกนัѸนไวก้อ่นจากนัѸนจงึใช ้Mouse ขยับ
จอแลว้คลกิเลอืกเซลลห์ัวมมุปลายทาง เชน่เดมิเลอืกเซลลเ์ลข 1 เอาไว ้ก็ใหก้ดปุ่ ม Shift แลว้
คลกิเซลลเ์ลข 50 ไดเ้ลยเพืѷอเลอืกตารางตั Ѹงแตเ่ลข 1 – 50 พรอ้มกนั 

สว่นการเลอืกพืѸนทีѷตารางตามแนวนอนหรอืแนวตั Ѹง ใหใ้ชว้ธิ ีDouble คลกิทีѷขอบเซลลร์ว่มกบั
การกดปุ่ ม Shift เชน่ถา้ตอ้งการเลอืกเซลลเ์ลข 1 – 5 ใหเ้ริѷมจากเลอืกเซลลเ์ลข 1 แลว้กดปุ่ ม 
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Shift คา้งไว ้จากนัѸนใหใ้ช ้Mouse ชีѸทีѷขอบเซลลด์า้นขวา (จะพบวา่ Cursor เปลีѷยนเป็น
เครืѷองหมายลกูศร ) แลว้ให ้Double คลกิทีѷดา้นขวาขอบเซลล ์เพืѷอบอก Excel วา่
ตอ้งการกระโดดไปตามทศิของขอบเซลลนั์ѷนเอง 

อกีวธิหีนึѷงแทนทีѷจะตอ้งเสยีเวลากดปุ่ ม Shift คา้งไวต้ลอด ใหเ้ริѷมจากคลกิเซลลเ์ลข 1 ไวก้อ่น 
จากนัѸนใหก้ดปุ่ ม F8 ซึѷงจะพบวา่ตรงขอบหนา้จอ Excel ดา้นขวาลา่งสดุจะมคํีาวา่ Ext (ยอ่จาก 
Extend แปลวา่ยดื) แสดงขึѸนมา แลว้จงึคลกิเลอืกเซลลป์ลายทาง จากนัѸนใหก้ดปุ่ ม F8 อกีครั Ѹง
หนึѷงเพืѷอลา้งคําวา่ Ext ออกไปกอ่นแลว้จงึทํางานตอ่ไปไดต้ามเดมิ 

 

การแบง่ขอบเขตพืҟนทีѷตาราง 

ในชทีของ Excel 2007 เป็นตน้มามพีืѸนทีѷตารางใหญก่วา่รุน่กอ่นอยา่งมาก จากเดมิมเีพยีง 
65,536 row และ 256 column ไดป้รับเพิѷมเป็น 1,048,576 row และ 16,384 column ซึѷงถา้
คณุพมิพค์า่ลงไปแลว้พยายาม paste ใหค้รบทกุเซลลใ์นชที จะพบวา่ Excel ตอ้งใชเ้วลานาน
แสนนานทเีดยีวกวา่จะไดข้อ้มลูเต็มทั Ѹงชที และเมืѷอสัѷง save จะไมม่ ีhard disk เครืѷองไหนทีѷ
สามารถเก็บแฟ้มขอ้มลูนัѸนได ้เพราะแฟ้มจะมขีนาดใหญเ่กนิกวา่จะรับได ้(ขออยา่พยายาม
ทดลองทําตามนีѸเด็ดขาด เพราะคณุจะรอไมไ่หวแลว้ตอ้งหันไปปิดเครืѷองคอมพวิเตอรไ์ปกอ่นทีѷ
จะ save เสร็จ) 

สาเหตทุีѷ Excel ขยายขนาดตารางใหใ้หญข่ึѸนจนดเูหมอืนใหญก่วา่ความจําเป็น มไิดมุ้ง่ใหค้ณุ
จําเป็นตอ้งใชใ้หค้รบทกุเซลล ์เพยีงแตจ่ะชว่ยใหส้ามารถรับขอ้มลูจากโปรแกรมอืѷนเขา้มาเก็บไว ้
ในชทีไดส้ะดวกขึѸน และเมืѷอคณุหันมาใช ้Excel 2007 แลว้ก็มไิดห้มายความวา่จากนีѸไปคณุไม่
จําเป็นตอ้งใชโ้ปรแกรมฐานขอ้มลูอืѷนอกีตอ่ไป เพราะในทีѷสดุแลว้เมืѷอขอ้มลูมปีรมิาณมากขึѸนและ
มคีวามสมัพนัธใ์นตัวฐานขอ้มลูซบัซอ้นตามขึѸนไปแลว้ โปรแกรมทีѷสรา้งขึѸนมาเพืѷอจัดการ
ฐานขอ้มลูโดยเฉพาะยอ่มเหมาะกวา่อยูด่ ี

อยา่วา่แตข่นาดของตารางทีѷมขีนาดใหญส่ามารถรับขอ้มลูไดม้ากขึѸนนีѸเลย ตอ่ใหใ้ช ้Excel 2003 
ทีѷมขีนาดตารางเล็กกวา่ หากผูใ้ช ้Excel ไมเ่ป็น พอนําขอ้มลูมาเก็บไวใ้นชทีอยา่งไมม่หีลักการ 
แลว้เมืѷอถงึเวลาจะตอ้งแยกขอ้มลูออกจากกนัเป็นสว่นๆก็จะทําไดย้าก จงึขอเสนอใหใ้ชห้ลกั 
ICO แบง่ขอบเขตพืѸนทีѷตาราง กลา่วคอื 

1. ใหแ้บง่แยกตารางขอ้มลูออกเป็น 3 ประเภท คอื ตาราง Input, ตาราง Calculate, และ 
ตาราง Output (หรอืใชต้ัวยอ่วา่ ICO) 

2. ตาราง Input คอื ตารางทีѷใชเ้ก็บขอ้มลูทีѷพมิพล์งไปหรอืเป็นขอ้มลูทีѷรับมาจากโปรแกรม
อืѷน หรอือกีนัยหนึѷงเป็นตารางฐานขอ้มลูนัѷนเอง ตาราง Input นีѸตอ้งออกแบบใหโ้ครงสรา้ง
ของตารางมลัีกษณะดังนีѸ 

2.1. หัวตารางดา้นบน ตอ้งเป็น row เดยีว ซึѷงอาจแตง่ขอ้ความในเซลลใ์หแ้สดงเป็นหลาย
บรรทัดได ้โดยกดปุ่ ม Alt+Enter เพืѷอขึѸนขอ้ความในบรรทัดใหมใ่นเซลลเ์ดมิ 
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2.2. ตอ้งบันทกึขอ้มลูใน column ใด column หนึѷงตดิตอ่กนัไปตลอด หา้มเวน้ชอ่งวา่ง ซึѷง
โดยทัѷวไป column ซา้ยสดุมักจะมขีอ้มลูตดิตอ่กนัไปอยูแ่ลว้เนืѷองจากเป็นขอ้มลูของ
เลขทีѷรายการ หรอืขอ้มลูรหัส หรอืขอ้มลูวันทีѷซ ึѷงเรยีงไปตามลําดับรายการทีѷเกดิขึѸน 

2.3. ตอ้งเวน้ขอบตารางไมว่า่จะเป็นขอบดา้นบนลา่งซา้ยขวาอยา่งนอ้ยขา้งละ 1 เซลล ์หา้ม
นําตาราง Input ไปตดิกบัเซลลข์อ้มลูอืѷนซึѷงไมใ่ชข่อ้มลูเรืѷองเดยีวกบัตารางขอ้มลูนัѸน 

3. ตาราง Calculate คอื ตารางทีѷใชส้รา้งสตูรคํานวณ ไมจํ่าเป็นตอ้งมโีครงสรา้งตามแบบ
ของตาราง Input แตใ่นตาราง Calculate นีѸคณุตอ้งหาทางสรา้งสตูรทีѷเซลลห์ัวมมุเป็นสตูร
ฉลาดทีѷสามารถปรับตําแหน่งอา้งองิไดเ้อง และในขณะทีѷสรา้งสตูรตอ้งใชปุ้่ ม F4 เพืѷอใส่
เครืѷองหมาย $ เพืѷอควบคมุตําแหน่งอา้งองิในสตูรไปยังเซลลท์ีѷบันทกึคา่ตัวแปรทีѷใชคํ้านวณ
ไว ้ซึѷงโดยทัѷวไปเซลลค์า่ตัวแปรจะวางไวต้ามแนวคูข่นานกบัแนวของตาราง Calculate เพืѷอ
ชว่ยใหเ้ครืѷองหมาย $ ทีѷใสไ่วใ้นสตูร ทําหนา้ทีѷควบคมุตําแหน่งของแนวของเซลลต์ัวแปรไว ้
เพืѷอนําคา่มาใชคํ้านวณนัѷนเอง 

4. ตาราง Output คอื ตารางแสดงผลลัพธท์ีѷตอ้งการ โดยตารางนีѸจะออกแบบใหม้หีนา้ตา
อยา่งไรก็ไดต้ามแตว่า่จะนําไปแสดงผลบนจอภาพหรอืในหนา้กระดาษทีѷสัѷงพมิพ ์

สาเหตทุีѷตอ้งใชห้ลัก ICO แยกขอ้มลูแตล่ะประเภทออกจากกนั เพืѷอชว่ยทําใหเ้ราสามารถใช ้
Excel รองรับกบัขอ้มลูทีѷมปีรมิาณมากขึѸนไปเรืѷอยๆไดต้ลอด ซึѷงในชว่งแรกทีѷยังมขีอ้มลูไมม่าก
นัก อาจใชช้ทีเดยีวเก็บขอ้มลูทั Ѹง I C และ O ไวด้ว้ยกนั จากนัѸนเมืѷอมปีรมิาณขอ้มลูมากขึѸนหรอื
ขอ้มลูมคีวามสลับซบัซอ้นมากขึѸนจงึคอ่ยยา้ยตารางแยกไปเก็บในชทีอืѷนหรอืแฟ้มอืѷนไดทั้นที
โดยไมก่ระทบกบัสตูรคํานวณทีѷสรา้งไว ้

ขอ้ผดิพลาดทีѷพบเห็นบอ่ยครั Ѹงเกดิจากการออกแบบตารางตามแบบรายงานทีѷตอ้งพมิพ ์เชน่ 
หากมรีายงานยาว 100 หนา้ ก็มักออกแบบตารางใน Excel ใหย้าวเหยยีดตอ่ๆกนัลงมาทัѸง 100 
หนา้แลว้จงึสัѷงพมิพอ์อกไปทลีะหนา้ ซึѷงวธินีีѸทําใหแ้ฟ้มมขีนาดใหญแ่ละยากตอ่การแกไ้ขเพราะ
จําเป็นตอ้งยอ้นกลับไปไลแ่กไ้ขในตารางแตล่ะหนา้ 

แตห่ากออกแบบตารางแบบ ICO เป็น ใหเ้ริѷมจากแยกตารางขอ้มลูทีѷเป็น Input ออกไป แลว้ใช ้
สตูรดงึคา่จากตาราง Input มาคํานวณในตาราง Calculate จากนัѸนจงึดงึผลลัพธท์ีѷคํานวณเสร็จ
แลว้ไปสรา้งตาราง Output ซึѷงจดุสําคัญอยูท่ีѷตาราง Output นีѷแหละ โดยเราตอ้งหาทางสรา้ง
ตาราง Output ไวเ้พยีงหนา้เดยีว จากนัѸนตอ้งสรา้งสตูรดงึขอ้มลูแตล่ะหนา้มาแสดงในตาราง 
Output หนา้เดยีวนีѸใหไ้ด ้ชว่ยใหแ้ฟ้มมขีนาดเล็กและแกไ้ขไดง้า่ยกวา่มาก 

สมมตวิา่หนา้กระดาษทีѷพมิพม์ ี30 บรรทัดตอ่หนา้ ดังนัѸนพอพมิพเ์ลขหนา้ทีѷ 1 ลงไป ตอ้งสรา้ง
สตูรดงึผลลัพธบ์รรทัดทีѷ 1 - 30 มาแสดงในหนา้นีѸ จากนัѸนพอเปลีѷยนเลขหนา้เป็นเลข 2 ก็จะได ้
บรรทัดทีѷ 31 – 60 มาแสดง พอเป็นหนา้ 3 ก็ไดบ้รรทัดทีѷ 61 - 90 มาแสดง ซึѷงสตูรทีѷดงึขอ้มลู
เชน่นีѸไดก้็คอืสตูร VLookup, Match, Index เป็นตน้ 
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การจดัเตรยีมพืҟนทีѷ ICO เพืѷอรบัขอ้มลูและป้องกนัการแกไ้ข 

แฟ้มทีѷสรา้งเสร็จพรอ้มใชง้าน ตอ้งมรีะบบแยกแยะตําแหน่งตารางทีѷเปิดใหร้ับคา่ใหมไ่ดพ้รอ้มทั Ѹง
หาทางป้องกนัตารางทีѷไมต่อ้งการใหใ้ครเขา้ไปแกไ้ข โดยตอ้งพจิารณาจากพืѸนทีѷตารางแตล่ะ
สว่น กลา่วคอื 

1. ตาราง Input เป็นพืѸนทีѷสว่นทีѷเปิดใหผู้ใ้ชง้านสามารถพมิพค์า่ใหมล่งไปได ้โดยมขีั Ѹนตอน
ในการจัดเตรยีมพืѸนทีѷดังนีѸ 

1.1. คลกิเลอืกพืѸนทีѷตารางสว่นทีѷเป็น Input (หากมหีลายพืѸนทีѷไมต่ดิตอ่กนั ใหก้ดปุ่ ม Ctrl 
คา้งไวก้อ่นแลว้คลกิเลอืกพืѸนทีѷแตล่ะสว่น แลว้อาจกําหนดส ีFont ใหแ้ตกตา่งจากสว่น
อืѷน ซึѷงผมเองชอบใชส้ชีมพเูพืѷอบอกผูใ้ชว้า่เป็นเซลล ์Input) 

1.2. คลกิขวา สัѷง Format Cells > Protection > แลว้ตดักาชอ่ง Locked ทิѸงไป 

 

1.3. สัѷง Review > Protect Sheet (Excel 2003 ใชคํ้าสัѷง Tools > Protection > 
Protect Sheet) 

1.4. หลังจากทีѷ Protect Sheet เสร็จ เมืѷอพมิพข์อ้มลูใหมล่งไปในเซลลท์ีѷเป็น Input แลว้ 
ใหก้ดปุ่ ม Tab ซึѷงจะพบวา่ Excel จะกระโดดไปเลอืกเซลล ์Input ตอ่ไปใหเ้อง 

2. ตาราง Calculate และตาราง Output เป็นพืѸนทีѷซ ึѷงมเีซลลส์ว่นใหญเ่ป็นสตูรซึѷงเมืѷอสรา้ง
เสร็จแลว้ ควรป้องกนัไมใ่หใ้ครเขา้ไปดสูตูร แกไ้ขสตูร หรอืลบสตูรทิѸงไดอ้กี โดยมขีั Ѹนตอน
ในการจัดเตรยีมพืѸนทีѷดังนีѸ (ถา้ชทีถกู Protect อยูต่อ้ง Unprotect Sheet กอ่น) 

2.1. คลกิเลอืกพืѸนทีѷตารางสว่นทีѷเป็นตาราง Calculate และตาราง Output 

2.2. คลกิขวา สัѷง Format Cells > Protection > แลว้กาชอ่ง Hidden เพืѷอซอ่นการ
แสดงสตูรทีѷจะเห็นบน Formula Bar และยังป้องกนัไมใ่ห ้Copy สตูรออกไปไดด้ว้ย 
โดยจะ Copy เฉพาะคา่ผลลัพธอ์อกไปไดเ้ทา่นัѸน (หา้มตดักาชอ่ง Locked ทิҟงอยา่ง
เด็ดขาด) และตอ้งทําขั Ѹนตอนตอ่ไปกอ่นดว้ยจงึจะเห็นผล 

 

2.3. สัѷง Review > Protect Sheet (Excel 2003 ใชคํ้าสัѷง Tools > Protection > 
Protect Sheet) 
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เมืѷอใดจะแยกชที เมืѷอใดจะแยกแฟ้ม 

สมมตวิา่คณุเก็บขอ้มลูไวจ้นเต็มชที ถา้เก็บขอ้มลูไวจ้นถงึ row สดุทา้ยในชทีแลว้ ชว่ยคดิกนั
หน่อยวา่ ขอ้มลูรายการถัดไปนัѸน จะนําไปเก็บไวท้ีѷไหน จะ Insert ชทีใหม ่หรอืจะเปิดแฟ้มใหม่
เพืѷอบันทกึรายการตอ่ไป 

ถา้คณุตอบวา่ ตอ้งขึѸนชทีใหมเ่พืѷอบันทกึรายการถัดไป 

ขอถามกลับวา่ แลว้ชทีใหมนั่Ѹนยังคงอยูใ่นแฟ้มเดมิใชไ่หม ถา้ทําแบบนีѸยอ่มทําใหแ้ฟ้มของคณุมี
ขนาดแฟ้มใหญข่ึѸนไปเรืѷอยๆ แลว้คณุเคยจําเป็นตอ้งใชข้อ้มลูทีѷอตุสา่หเ์ก็บไวนั้Ѹนทกุรายการ
พรอ้มกนับา้งไหม 

ผมเชืѷอวา่นอ้ยคนนักทีѷมโีอกาสใชข้อ้มลูพรอ้มกนัทกุรายการ ทั Ѹง 65,536 row ในชทีของ Excel 
2003 หรอืทกุ row ในชทีทีѷมจํีานวน row มากกวา่นัѸนใน Excel 2007 แสดงวา่ขอ้มลูทีѷเก็บไว ้
กลายเป็นภาระทีѷตอ้งแบกเอาไวเ้รืѷอยไป พอแฟ้มใหญข่ึѸนจะสง่ผลให ้Excel ทํางานชา้ลง แลว้
พอเครืѷองคอมพวิเตอรทํ์างานชา้ลงจนเป็นเตา่ คณุตอ้งวิѷงไปหาหัวหนา้เพืѷอของบซืѸอเครืѷอง
คอมพวิเตอรใ์หมห่รอืเปลา่ละ่ ถา้เป็นเชน่นีѸ ผมรับรองวา่คณุตอ้งหาซืѸอคอมพวิเตอรใ์หมอ่ยูบ่อ่ยๆ
ทเีดยีว ซึѷงถา้คณุใช ้Excel เป็น ขอใหย้ดึหลักในการแยกชทีหรอืแยกแฟ้มดังตอ่ไปนีѸแลว้รับรอง
วา่ คณุจะสามารถใชเ้ครืѷองคอมพวิเตอรข์องคณุตอ่ไปไดอ้กีนาน ไมว่า่ปรมิาณขอ้มลูจากมากขึѸน
เพยีงใด 

 
ขอ้มลูใดทีѷตอ้งคํานวณพรอ้มกนั ใหเ้ก็บไวใ้นแฟ้มเดยีวกนัโดยจะแยกชทีแตล่ะตาราง
หรอืไมก่็ได ้สว่นขอ้มลูใดทีѷไมต่อ้งคํานวณพรอ้มกนัหรอืเลอืกคํานวณได ้ใหแ้ยกเก็บ
ไวใ้นแฟ้มอืѷน แลว้สรา้งสตูร Link เพืѷอนําขอ้มลูมาใชเ้มืѷอตอ้งการ 
 

 

ยกตัวอยา่งเชน่ ในงบกําไรขาดทนุอาจแบง่ตารางคา่ใชจ้า่ยออกมาเป็นคา่ใชจ้า่ยคงทีѷกบั
คา่ใชจ้า่ยผันแปร ซึѷงหากคณุนําตารางคํานวณคา่ใชจ้า่ยคงทีѷมารวมไวใ้นแฟ้มเดยีวกบัตาราง
คา่ใชจ้า่ยผันแปร ยอ่มทําใหแ้ฟ้มนัѸนมขีนาดใหญแ่ละตอ้งเสยีเวลาคํานวณทีѷไมจํ่าเป็นทกุครั Ѹงทํา
ใหคํ้านวณชา้ลง แตถ่า้แยกตารางคํานวณคา่ใชจ้า่ยคงทีѷออกไปเป็นแฟ้มตา่งหาก เพืѷอทําให ้
แฟ้มนีѸคํานวณแยกจากสตูรอืѷน แลว้พอไดผ้ลลัพธเ์ป็นยอดคา่ใชจ้า่ยคงทีѷแลว้จงึ Link ผลลัพธท์ีѷ
ไดม้าแสดงในแฟ้มงบกําไรขาดทนุ โดยอาจรวมตารางคํานวณคา่ใชจ้า่ยผันแปรไวใ้นแฟ้มงบ
หรอืแยกเป็นแฟ้มตา่งหาก แลว้ดงึผลลัพธม์าแสดงในงบเชน่เดยีวกบัคา่ใชจ้า่ยคงทีѷก็ได ้

การแยกแฟ้มเพืѷอใหคํ้านวณแตล่ะเรืѷองแยกจากกนันีѸ จะทําใหแ้ฟ้มมขีนาดเล็กลงอยา่งมาก แต่
เราตอ้งเสยีเวลาเปิดแตล่ะแฟ้มเพืѷอไลคํ่านวณแตล่ะขั Ѹนใหเ้สร็จกอ่น ซึѷงถา้ใช ้Macro Recorder 
บันทกึการไลเ่ปิดปิดแฟ้มตามลําดับคํานวณ จะชว่ยทําใหข้ั ѸนตอนนีѸทํางานตอ่เนืѷองกนัไปโดย
อตัโนมัตแิละใชเ้วลาทัѸงหมดเร็วกวา่การรวมตารางทกุอยา่งไวใ้นแฟ้มเดยีวกนั 
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สําหรับผูท้ีѷไมคุ่น้เคยกบัการใชส้ตูร link ขา้มแฟ้มมากอ่น อาจสงสยัวา่ทําไมจงึตอ้งไลเ่ปิดแฟ้ม
ทีѷ link กนัทลีะคูด่ว้ย ทั Ѹงๆทีѷตอนทีѷเปิดแคแ่ฟ้มปลายทางขึѸนมาก็จะพบวา่ Excel จัดการ Update 
link ใหทั้นทอียูแ่ลว้ คําตอบก็คอืการเปิดแฟ้มปลายทางทีѷรับคา่จากแฟ้มอืѷนขึѸนมานัѸน ไมไ่ดทํ้า
ใหเ้กดิการคํานวณในแฟ้มตน้ทาง แตเ่ป็นการดงึผลจากการคํานวณทีѷเกดิขึѸนคราวกอ่นนัѸนมาใช ้
ในแฟ้มปลายทางเทา่นัѸน หากตอ้งการใหแ้ฟ้มใดคํานวณ เราตอ้งเปิดแฟ้มคูท่ีѷ link กนันัѸนขึѸนมา
กอ่นเสมอจงึจะกระตุน้ใหก้ารคํานวณเกดิขึѸนมาได ้

 

การกําหนดตาํแหนง่อา้งองิขา้มชทีหรอืขา้มแฟ้ม 

ผมเริѷมตน้ใชโ้ปรแกรม Excel ตั Ѹงแตย่คุทีѷในแฟ้มหนึѷงๆยังมชีทีใหใ้ชง้านไดเ้พยีงชทีเดยีวและยัง
ไมส่ามารถใชส้ตูรเชืѷอมขอ้มลูจากแฟ้มอืѷนมาใชง้านรว่มกนั ในยคุนัѸนตอ้งออกแบบตารางทั Ѹงหมด
ลงไปในชทีเดยีว ตอ่มา Excel ถกูพัฒนาใหส้ามารถสง่ขอ้มลูจากแฟ้มหนึѷงออกไปยังแฟ้มอืѷนได ้
แตก่็ยังไมส่ามารถทําหนา้ทีѷทั Ѹงรับทั Ѹงสง่ขอ้มลูกลับไปกลับมาระหวา่งแฟ้มเชน่ทีѷ Excel ในรุน่
ปัจจบุันทําได ้ซึѷงถา้ดใูหด้จีะพบวา่สิѷงทีѷ Excel สามารถสง่ขอ้มลูกลับไปกลับมาไดนั้Ѹนเป็นเพราะ
เราถกู Excel หลอกใหด้เูหมอืนวา่มหีลายชทีหรอืมหีลายแฟ้ม...แคนั่Ѹนเอง 

 
ขอใหจํ้าไวว้า่ ไมว่า่จะเป็นตา่งชทีหรอืตา่งแฟ้ม พอเปิดแฟ้มขึѸนมาใชง้านพรอ้มกนั มัน
ก็คอืชทีเดยีวกนันัѷนแหละ 
 

 

การทีѷเราเห็นวา่ในแฟ้มหนึѷงๆมหีลายชทีนัѸน เป็นภาพลวงตาทีѷชว่ยใหผู้ใ้ชง้านสามารถแยกเก็บ
ขอ้มลูตา่งเรืѷองไวใ้นชทีตา่งกนัไป สว่นขอ้มลูทีѷ link ขา้มแฟ้มไดนั้Ѹน ถา้คณุใช ้Excel รุน่แรกๆมา
กอ่นอยา่งผม พอสัѷง Unhide Sheet จะพบวา่ในแฟ้มปลายทางมชีทีหนึѷงถกูซอ่นไว ้โดยชทีนีѸใช ้
เก็บขอ้มลูจากชทีตน้ทางไวทั้ Ѹงหมด ดังนัѸนขอ้มลูทีѷไดม้าจากสตูร link ขา้มแฟ้ม ถา้วา่กนัให ้
ถกูตอ้ง ไมไ่ดเ้ป็นผลจากสตูรทีѷ link มาจากแฟ้มตน้ทางโดยตรง แตเ่ป็นขอ้มลูทีѷไดม้าจากชทีทีѷ
ซอ่นไวภ้ายในชทีปลายทางในแฟ้มเดยีวกนักบัแฟ้มทีѷมสีตูร link นัѷนเอง โดยเรยีกขอ้มลูทีѷเก็บ
ในชทีนีѸวา่ Cache Data ซึѷงสง่ผลใหแ้ฟ้มปลายทางมขีนาดแฟ้มใหญก่วา่ปกตติามไปดว้ย 
(ตอ่มา Microsoft ไดป้รับปรงุให ้Excel ซอ่นชทีนีѸไวโ้ดยไมส่ามารถคน้หาพบเชน่แตก่อ่น)  

ถา้คณุสามารถสรา้งสตูร link ขอ้มลูภายในชทีเดยีวกนั ก็ขอใหใ้ชว้ธิเีดยีวกนัในการ link ขอ้มลู
ขา้มชทีหรอืแมแ้ตข่า้มแฟ้ม ขอเพยีงอยา่กลัวภาพลวงตาทีѷทําใหเ้ห็นวา่เป็นตา่งชทีหรอืตา่งแฟ้ม
กนัเพราะความจรงิมันก็คอืชทีเดยีวกนันัѷนเอง ซึѷงกอ่นทีѷจะใชว้ธิสีรา้งสตูร link ทีѷนยิมใชก้นั
ตอ่ไปนีѸ ขอใหเ้ปิดแฟ้มทกุแฟ้มทีѷตอ้งการสรา้งสตูร link ขอ้มลูระหวา่งกนัขึѸนมากอ่นทัѸงแฟ้มตน้
ทางและแฟ้มปลายทางแลว้จะชว่ยใหส้รา้งสตูร link ไดง้า่ยมาก 
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1. วธิยีอ้นปลายกลบัมาหาตน้  

1.1. ใหเ้ริѷมจากพมิพเ์ครืѷองหมายเทา่กบั = ทีѷเซลลป์ลายทาง  

1.2. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขั ѸนตอนนีѸ) คลกิเลอืกชืѷอชทีตน้ทาง 
หรอืคลกิชืѷอแฟ้มตน้ทางทีѷเปิดไวก้อ่นแลว้จากคําสัѷง View > Switch Windows 
(Excel 2003 ใชคํ้าสัѷง Windows เพืѷอไปทีѷแฟ้มตน้ทาง) 

1.3. แลว้คลกิเลอืกเซลลต์น้ทาง  

1.4. จากนัѸนกดปุ่ ม Enter เพืѷอรับสตูร link ตําแหน่งเซลลต์น้ทางกลับไปบันทกึไวท้ีѷเซลล์
ปลายทาง (วธินีีѸโดยทัѷวไปจะทําไดท้ลีะเซลล ์เวน้แตจ่ะสรา้งสตูรแบบ Array จงึจะสรา้ง
พรอ้มกนัหลายเซลลทั์ Ѹงตาราง และขอใหส้งัเกตวา่ถา้เป็นสตูร link ขา้มแฟ้มจะได ้
ตําแหน่งอา้งองิแบบ Absolute เสมอ) 

2. วธิ ีCopy จากตน้ แลว้มา Paste Special แบบ Paste Link ทีѷปลาย  

2.1. ใหเ้ริѷมจากเลอืกพืѸนทีѷตารางตน้ทางทัѸงตารางพรอ้มกนั 

2.2. สัѷง Copy 

2.3. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขั ѸนตอนนีѸ) คลกิเลอืกชืѷอชที
ปลายทาง หรอืคลกิชืѷอแฟ้มปลายทางทีѷเปิดไวก้อ่นแลว้จากคําสัѷง View > Switch 
Windows (Excel 2003 ใชคํ้าสัѷง Windows เพืѷอไปทีѷแฟ้มปลายทาง) 

2.4. จากนัѸนใหเ้ลอืกเซลลห์ัวมมุตารางปลายทางเพยีงเซลลเ์ดยีวแลว้คลกิขวา สัѷง Paste 
Special > กดปุ่ ม Paste Link จะไดส้ตูร link พรอ้มกนัทเีดยีวทั Ѹงตาราง 

 

3. วธิ ีCut จากตน้ แลว้ไป Paste ทีѷปลาย โดยวธินีีѸวา่ไปแลว้ไมไ่ดเ้ป็นการสรา้งสตูร link 
แตใ่หเ้ริѷมจากสรา้งสตูร link ไวใ้นชทีเดยีวกนัตามวธิขีา้งตน้ใหเ้สร็จกอ่น จากนัѸนจงึสัѷง Cut 
ตารางสตูรจากชทีตน้ทางไป Paste ทีѷตําแหน่งปลายทางในชทีอืѷนหรอืแฟ้มอืѷน ซึѷง Excel 
จะปรับโครงสรา้งตําแหน่งอา้งองิในสตูรใหก้ลายเป็นตําแหน่งอา้งองิขา้มชทีหรอืขา้มแฟ้มให ้
เองทันท ี 
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วธิทีีѷ 3 นีѸเป็นเคล็ดลับสําคัญในการสรา้งสตูร link ขา้มแฟ้ม โดยเริѷมจากสรา้งสตูร link 
ทั Ѹงหมดในชทีเดยีวกนัใหเ้สร็จกอ่น จากนัѸนเมืѷอ Cut เซลลส์ตูรไปทีѷชทีอืѷนจะไดส้ตูร link 
ขา้มชที หรอืถา้ Cut เซลลส์ตูรไปทีѷแฟ้มอืѷนจะไดส้ตูร link ขา้มแฟ้ม ชว่ยใหไ้มต่อ้งเสยี
แรงเสยีเวลาสรา้งสตูร link ขา้มชทีหรอืขา้มแฟ้มตั Ѹงแตแ่รกแมแ้ตน่อ้ย เชน่  

 จากเดมิสรา้งสตูร link ในชทีเดยีวกนัเป็น =A1  

 พอ Cut ไปทีѷชทีอืѷน สตูรนีѸจะปรับตัวใหมเ่ป็น =Sheet1!A1 

 พอ Cut ตอ่ไปทีѷแฟ้มอืѷน สตูรนีѸจะปรบัตัวใหมเ่ป็น =[Source.xlsx]Sheet1!A1 
โดยคําวา่ Source ก็คอืชืѷอแฟ้มตน้ทาง และคําวา่ Sheet1 คอืชืѷอชทีตน้ทาง 

 ตอ่มาถา้ปิดแฟ้มตน้ทางทีѷชืѷอ Source ทิѸง สตูรนีѸจะปรับตัวใหมเ่ป็น 
='D:\Dummy\[Source.xlsx]Sheet1'!A1 
ซึѷงการทีѷมชีืѷอ Drive D และชืѷอโฟลเดอรว์า่ Dummy แสดงไวด้า้นหนา้สตูร แสดง
วา่แฟ้มตน้ทางทีѷชืѷอ Source นัѸน ในขณะนัѸนถกูจัดเก็บไวท้ีѷใดแตย่ังไมไ่ดถ้กูเปิด
ขึѸนมา 

 

ขอ้ควรระวงัในการรกัษาสตูร link ขา้มแฟ้มใหใ้ชง้านไดถ้กูตอ้งตลอดไป 

1. หากตอ้งการทําการแกไ้ขใดๆในแฟ้มทีѷ link กนั ตอ้งเปิดแฟ้มทีѷ link กนัทกุแฟ้มขึѸนมา
ทั Ѹงแฟ้มตน้ทางและแฟ้มปลายทางกอ่นทีѷจะเริѷมทําการแกไ้ขเสมอ เพืѷอทําใหก้ารแกไ้ขทีѷ
เกดิขึѸน เชน่ การยา้ยตําแหน่งเซลล ์การเปลีѷยนชืѷอชทีหรอืแมแ้ตช่ืѷอแฟ้ม สง่ผลให ้Excel ไล่
แกตํ้าแหน่งอา้งองิในสตูร link ขา้มแฟ้มใหเ้อง (Excel รุน่กอ่น 2013 สามารถจําวา่ตอ้งเปิด
แฟ้มใดบา้งพรอ้มกนัโดยใชก้ารเปิดแฟ้ม Workspace ชว่ย) 

2. หากตอ้งการ Save as เพืѷอเปลีѷยนชืѷอแฟ้มหรอืยา้ยโฟลเดอรท์ ีѷเก็บ ใหทํ้าการ Save 
แฟ้มตน้ทางกอ่นแลว้จงึ Save แฟ้มปลายทางตามทหีลัง โดยการ Save ทีѷวา่นีѸใหใ้ช ้
โปรแกรม Excel เปิดแฟ้มแลว้ Save จากโปรแกรม Excel เทา่นัѸน เพืѷอทําให ้Excel ปรบั
ตําแหน่งอา้งองิในสตูรตามตําแหน่งของโฟลเดอรแ์ละชืѷอแฟ้มทีѷเปลีѷยนไป (ตา่งจากการใช ้
Windows Explorer ในการยา้ยโฟลเดอรห์รอืเปลีѷยนชืѷอแฟ้ม ซึѷงจะไมช่ว่ยใหส้ตูรมกีาร
แกไ้ขตําแหน่งอา้งองิตามแมแ้ตน่อ้ย) 

3. หากตอ้งการแกไ้ขตาํแหนง่อา้งองิเนืѷองจาก Excel เตอืนวา่คน้หา link ไมพ่บ อาจ
เป็นเพราะคณุพลัѸงเผลอไมไ่ดป้ฏบิัตติามขอ้ควรระวัง 2 ขอ้ขา้งตน้ ก็ยังสามารถแกไ้ขให ้link 
ทํางานตามเดมิไดต้ามขั Ѹนตอนตอ่ไปนีѸ โดย Excel จะไลแ่กไ้ขชืѷอแฟ้มตน้ทางในเซลลส์ตูร 
link ทกุเซลลใ์หเ้องไมว่า่อยูใ่นชทีใด 

3.1. ใหเ้ปิดแฟ้มปลายทางขึѸนมากอ่นโดยไมต่อ้งเปิดแฟ้มตน้ทาง (แฟ้มปลายทางนีѸก็คอื
แฟ้มทีѷเปิดขึѸนมาแลว้พบวา่ Excel มคํีาเตอืนวา่หา link ไมพ่บ) 
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3.2. ตรวจสอบวา่ไมม่ชีทีใดถกูสัѷง Protect Sheet เอาไว ้(เพราะถา้ชทีใดถกู Protect จะไม่
สามารถแกไ้ขสตูร link ทีѷมอียูใ่นชทีนัѸนไดเ้ลย แมจ้ะสัѷงผา่น Excel ก็ตาม) 

3.3. จากนัѸนใหใ้ชคํ้าสัѷง Data > Edit Links (Excel 2003 ใชคํ้าสัѷง Edit > Links)  

3.4. คลกิเลอืกชืѷอแฟ้มตน้ทางทีѷแสดงในชอ่งรายชืѷอ Source  

3.5. กดปุ่ ม Change Source แลว้คลกิไลห่าแฟ้มตน้ทางทีѷเก็บไวใ้นโฟลเดอรท์ีѷตอ้งการ 

 

4. เคล็ดอืѷนๆซึѷงสามารถนํามาใชร้ว่มกบัคําสัѷง Edit Links จากรปูขา้งตน้ 

4.1. ปุ่ ม Update Values ทําหนา้ทีѷ update ขอ้มลูจากแฟ้มตน้ทางทีѷเลอืกชืѷอไวจ้ากชอ่ง 
Source ชว่ยทําใหส้ามารถเปิดแฟ้มขึѸนมาโดยไมต่อ้ง update ในตอนเปิดแฟ้มก็ได ้
(เพราะหากสัѷง update ตอนเปิดแฟ้ม จะทําให ้Excel เสยีเวลาอยา่งมากในการไล ่
update แฟ้มตน้ทางทีѷมทีกุแฟ้ม) แลว้ตอ่เมืѷอตอ้งการดงึขอ้มลูใหมจ่ากแฟ้มตน้ทาง
เมืѷอใด จงึคอ่ยคลกิปุ่ ม Update Values นีѸทลีะแฟ้มทีѷตอ้งการ 

4.2. ปุ่ ม Open Source ทําหนา้ทีѷเปิดแฟ้มตน้ทาง ตามชืѷอแฟ้มทีѷเลอืกไวจ้ากชอ่ง Source  

4.3. ปุ่ ม Break Link ทําหนา้ทีѷทําลายสตูรทั Ѹงหมดในเซลลท์กุเซลลท์ีѷมสีตูร link ขา้มแฟ้ม
ใหก้ลายเป็นคา่ value หรอืผลลัพธ ์ซึѷงไมแ่นะนําใหใ้ชว้ธินีีѸเพราะ Excel จะทําลายสตูร 
link ในแฟ้มนัѸนทั Ѹงหมดโดยเราไมม่ทีางทราบไดเ้ลยวา่เป็นเซลลใ์ดบา้งและยังไม่
สามารถ Undo ดังนัѸนหากตอ้งการทําลายสตูร link ในเซลลใ์ด ใหค้น้หาตําแหน่งเซลล์
ทีѷมสีตูร link โดยใชช้ืѷอแฟ้มทีѷแสดงในชอ่ง Source สําหรับคน้หาตําแหน่งเซลลนั์Ѹน 
เพืѷอ Copy แลว้ Paste Special แบบ Value ทับเฉพาะเซลลนั์Ѹนๆจะเหมาะกวา่ 

 วธิใีช ้Excel รุน่กอ่น 2013 ไลเ่ปิดแฟ้มท ัҟงหมดทีѷตอ้งการใหเ้อง 

1. ใหเ้ปิดแฟ้มทกุแฟ้มทีѷตอ้งการเปิดขึѸนมาพรอ้มกนัไวก้อ่น 

2. สัѷง View > Save Workspace (Excel 2003 สัѷง File > Save Workspace) แลว้ให ้
ตั Ѹงชืѷอแฟ้มใหมท่ีѷจะมนีามสกลุ .xlw และมขีนาดแฟ้มเล็กมาก 

3. จากนัѸนเมืѷอตอ้งการเปิดแฟ้มทัѸงหมด ใหเ้ปิดแฟ้ม .xlw นีѸแฟ้มเดยีว จะพบวา่ Excel ไลเ่ปิด
แฟ้มทัѸงหมดใหเ้องทันท ีโดยแฟ้ม .xlw นัѸนจะไมแ่สดงขึѸนบนจอตามแฟ้มอืѷนๆทีѷเปิดขึѸน 
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แนวทางการสรา้งงานเบืҟองตน้ 

ลองนกึดซูวิา่หากคณุมคีวามรูแ้ละสามารถใช ้Excel เพยีงแครู่จั้กการกําหนดตําแหน่งอา้งองิ
ดว้ยเครืѷองหมาย $ และการ link พืѸนทีѷตารางดว้ยสตูรขา้มชทีหรอืขา้มแฟ้มไดแ้ลว้ พอคณุไดร้ับ
มอบหมายงานจากหัวหนา้ จะตอ้งวางแผนสรา้งงานกนัทลีะขั Ѹนอยา่งไรบา้ง เพืѷอชว่ยใหพ้อสรา้ง
งานไปแลว้ก็ตอ้งไมต่อ้งเสยีเวลายอ้นกลับมาแกไ้ขกนัอกีใหวุ้น่วาย 

เมืѷอไดร้ับมอบงานใหใ้ช ้Excel มขีั Ѹนตอนทีѷควรคดิพจิารณาตามลําดับตอ่ไปนีѸ 

1. ขอใหค้ดิแบง่ขอ้มลูออกเป็นสว่นของตาราง Input, Calculate, และ Output 

2. ใหอ้อกแบบตาราง Output ซึѷงเป็นสว่นทีѷออกแบบไดง้า่ยทีѷสดุกอ่น เพราะสว่นใหญม่แีบบ
ตามหนา้ตารายงานทีѷเคยใชก้นัมากอ่นอยูแ่ลว้ 

3. จากนัѸนใหค้ดิยอ้นมาออกแบบตาราง Input โดยพจิารณาวา่ขอ้มลูใดบา้งซึѷงเป็นทีѷมาหรอืตน้
ทางของขอ้มลูทีѷใชคํ้านวณแลว้จะทําใหไ้ด ้Output ตามตอ้งการ และยดึหลักวา่ขอ้มลู 
Input ทีѷมอียูต่อ้งไมม่ขีอ้มลูใดทีѷบันทกึซํѸาไวโ้ดยไมจํ่าเป็นอยา่งเด็ดขาด เพืѷอลดความ
ซํѸาซอ้นและทําใหแ้ฟ้มขอ้มลูมขีนาดเล็กทีѷสดุ 

4. ใหแ้บง่ขอ้มลู Input ออกเป็น 2 สว่นเพืѷอแยกตารางออกจากกนั 

4.1. สว่นแรกเป็นขอ้มลูทีѷมลัีกษณะไมเ่ปลีѷยนแปลงตามระยะเวลา เชน่ ขอ้มลูของสนิคา้หรอื
ลกูคา้ในสว่นทีѷเป็นรหัสและชืѷอซึѷงกําหนดไวแ้น่นอนตายตัววา่รหัสนัѸนตอ้งเป็นชืѷอนัѸน 
หรอืขอ้มลูคา่คงทีѷตา่งๆซึѷงเป็นขอ้มลูสว่นกลางทีѷตอ้งนําไปใชร้ว่มกบัสว่นอืѷนอยูเ่สมอ 

4.2. อกีสว่นหนึѷงเป็นขอ้มลูทีѷมลัีกษณะเปลีѷยนแปลงอยูเ่สมอ โดยทัѷวไปมักเป็นขอ้มลูทีѷ
เกีѷยวขอ้งกบัการดําเนนิธรุกจิประจําวัน เชน่ การขาย การผลติ 

5. ในตาราง Calculate ใหแ้ยกเซลลคํ์านวณคา่ทีѷตอ้งถกูนําผลลัพธไ์ปใชเ้ป็นประจําออกไวเ้ป็น
ตารางเฉพาะ จะไดไ้มต่อ้งเสยีเวลาสรา้งสตูรคํานวณคา่เดมิซํѸาอกี โดยตารางคํานวณแตล่ะ
ตารางตอ้งหาทางออกแบบตารางใหใ้ชส้ตูร Smart Formula ทีѷกําหนดตําแหน่งควบคมุดว้ย
เครืѷองหมาย $ ใหถ้กูตอ้งเพืѷอทําใหต้ารางคํานวณหนึѷงๆมเีซลลส์ตูร Smart Formula เพยีง
เซลลเ์ดยีววางไวท้ีѷเซลลห์ัวมมุซา้ยสดุของตารางคํานวณ 

6. ถา้ยังมขีอ้มลูทั Ѹงหมดไมม่ากนัก ใหอ้อกแบบรวมทกุตารางไวใ้นชทีเดยีวกนักอ่น แตต่อ้งแยก
พืѸนทีѷของตาราง Input, ตาราง Calculate, และ ตาราง Output ออกจากกนั โดยอาจใช ้
แนว Column เป็นแนวในการแบง่ตารางแตล่ะสว่นออกจากกนั และใหจั้ดลําดับขอ้มลูและ
สตูรตามลําดับกอ่นหลังโดยพยายามสรา้งสตูร link ใหม้ทีศิทางการ link เซลลจ์ากบนมา
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ลา่งหรอืจากซา้ยไปขวา เพืѷอชว่ยใหไ้ลท่ีѷไปทีѷมาของขอ้มลูไดง้า่ย 

 

7. หากขอ้มลูมปีรมิาณมากขึѸนหรอืมหีลายตาราง ใหย้า้ยขอ้มลูแตล่ะตารางไปเก็บแยกชทีไวใ้ห ้
เป็นระเบยีบ และตอ้งวางตําแหน่งตารางใหท้กุชทีทีѷเก็บขอ้มลูเรืѷองเดยีวกนัใชตํ้าแหน่งเซลล์
เดยีวกนัตรงกนัทกุชที เชน่ สมมตวิา่คณุแยกรายงานรายเดอืนออกเป็นชทีละเดอืน โดยทีѷ
รายงานแตล่ะเดอืนมโีครงสรา้งตารางเหมอืนกนัทั Ѹงหมด หากชทีแรกวางตารางไวท้ีѷเซลล ์
B2:C6 ก็ใหใ้ชเ้ซลล ์B2:C6 ของทกุชทีเป็นตําแหน่งตารางรายงานตรงกนัดว้ย 

 

8. ประเด็นการวางตําแหน่งตารางใหต้รงกนัทกุชทีถอืเป็นเรืѷองสําคัญมาก แมบ้างชทีจะมขีอ้มลู
แคบ่างเซลลก์็ตาม ก็ขอใหว้างคา่เรืѷองเดยีวกนัไวใ้นเซลลเ์ดยีวกนัไปตลอดทกุชที เพราะเรา
สามารถใชส้ตูรหรอืคําสัѷงของ Excel ในการดงึคา่จากตําแหน่งเซลลเ์ดยีวกนัไดโ้ดยงา่ยแม ้
จะตา่งชทีกนัก็ตาม ทั ѸงนีѸอยา่พยายามลบ Row หรอื Column ทีѷไมม่ขีอ้มลูทิѸงหรอืเลืѷอน
เซลลท์ีѷมคีา่มาตดิกนัอยา่งเด็ดขาด 

9. ตราบใดทีѷแฟ้มนัѸนยังมขีนาดไมใ่หญนั่กและ Excel ไมเ่สยีเวลาคํานวณนานจนรอไมไ่หว 
ขอใหเ้ก็บตารางทั Ѹง Input Calculate และ Output ไวใ้นแฟ้มเดยีวกนัไปเรืѷอยๆแมจ้ะมหีลาย
ชทีก็ตาม หากไมจํ่าเป็นแลว้ อยา่พยายามแยกแฟ้มอยา่งเด็ดขาด 

10. ใหพ้จิารณายา้ยชทีออกมาเป็นแฟ้มใหมต่า่งหาก ตอ่เมืѷอแฟ้มเดมิมขีนาดใหญม่ากและตอ้ง
เสยีเวลาในการเปิดแฟ้มและเสยีเวลาในการคํานวณนานจนรอไมไ่หว เมืѷอตอ้งการยา้ยชทีทั Ѹง
ชทีเป็นแฟ้มใหมใ่หใ้ชว้ธิคีลกิขวาทีѷชืѷอชทีแลว้เลอืกคําสัѷง Move or Copy จากนัѸนคลกิใน
ชอ่ง To book เพืѷอเปลีѷยนเป็น (new book) (ทั ѸงนีѸหา้มกาชอ่ง Create a copy) แลว้กด OK 
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จะพบวา่ชทีนัѸนถกูยา้ยไปเปิดเป็นแฟ้มใหม ่แลว้ใหจั้ดเก็บแฟ้มนัѸนในชืѷอแฟ้มใหมท่ีѷตอ้งการ 

 

11. แทนทีѷจะ Move ชทีไปเป็นแฟ้มใหมซ่ึѷงมเีพยีงชทีเดยีว ใหพ้จิารณาวา่ชทีใดทีѷตอ้งคํานวณ
พรอ้มกนัหรอืคํานวณตอ่เนืѷองกนัไปทกุครั Ѹงทีѷเกดิการคํานวณ ก็ขอใหย้า้ยชทีเหลา่นัѸนไปเก็บ
ไวใ้นแฟ้มเดยีวกนั (สตูรทีѷตอ้งคํานวณตอ่เนืѷองกนัใหเ้ก็บไวใ้นแฟ้มเดยีวกนัเสมอ) 

12. หากแฟ้มใหมท่ีѷเกดิขึѸนจากการยา้ยชทีในขั Ѹนตอนขา้งตน้มสีตูร link กบัชทีอืѷน จะพบวา่ 
Excel ปรับตําแหน่งอา้งองิในสตูร link ตามชืѷอชทีและชืѷอแฟ้มใหมท่ีѷเกดิขึѸนใหเ้อง ขอให ้
สงัเกตวา่ ถา้อยูใ่นแฟ้มปลายทางจะพบวา่คําสัѷง Data > Edit Links (Excel 2003 ใหด้ทูีѷ
คําสัѷง Edit > Links) จะปรากฏขึѸนเพืѷอพรอ้มตอ่การใชง้านและยังมคีวามหมายอกีอยา่ง
หนึѷงวา่แฟ้มนัѸนเป็นแฟ้มปลายทาง 

13. หากตอ้งการเปิดแฟ้มทีѷ link กนัขึѸนมาใชง้าน ใหเ้ปิดแฟ้มปลายทางขึѸนมา โดยไมต่อ้งเปิด
แฟ้มตน้ทาง แตถ่า้ตอ้งการเปิดแฟ้มเพืѷอตอ้งการแกไ้ขใดๆ ใหเ้ปิดแฟ้มทกุแฟ้มทีѷ link กนั
ขึѸนมาพรอ้มกนัทั Ѹงหมด (น่าเสยีดายทีѷ Excel 2013 ยกเลกิการสรา้ง workspace) 

14. หากพบวา่แฟ้มทีѷตอ้งเปิดพรอ้มกนัเพืѷอทําใหคํ้านวณพรอ้มกนันัѸนมขีนาดแฟ้มรวมกนัแลว้
ใหญม่ากและเสยีเวลาเปิดแฟ้มตลอดจนเสยีเวลาคํานวณนานมาก ใหท้ยอยเปิดแฟ้มทีѷ link 
กนัทลีะคูต่ามลําดับการ link เพืѷอทําใหส้ตูรทีѷเกีѷยวขอ้งในแฟ้มทีѷ link กนันัѸนคํานวณแลว้สง่
คา่ไปเก็บไวใ้นแฟ้มปลายทางแตล่ะคู ่แลว้จงึไลเ่ปิดแฟ้มคูท่ีѷ link กนัในลําดับการคํานวณ
ขั Ѹนตอ่ไปเรืѷอยไป ซึѷงวธินีีѸจะชว่ยใหไ้มต่อ้งเปิดแฟ้มขนาดใหญม่ากและสามารถใชเ้ครืѷอง
คอมพวิเตอรร์ุน่เกา่ๆทํางานชา้และมหีน่วยความจําไมม่ากนักไดเ้ร็วโดยไมต่อ้งซืѸอเครืѷองใหม ่

 

เคล็ดการจดัการกบัระบบ link ขา้มแฟ้ม 

ใน Excel 2003 ระบบการ link ไมค่อ่ยยุง่ยากเทา่ใดนัก พอคณุเปิดแฟ้มปลายทางขึѸนมาแฟ้ม
เดยีว จะพบวา่ Excel เปิดหนา้จอขึѸนมาถามวา่ตอ้งการ Update Links ไหม 

 ถา้เลอืก Update จะพบวา่ไฟแสดงการทํางานของ Hard disk กระพรบิอยูพ่ักหนึѷง 
แสดงวา่ Excel กําลังแอบไปเปิดแฟ้มตน้ทางขึѸนมาเพืѷอดงึขอ้มลูในแฟ้มตน้ทางไปเก็บ
ไวท้ีѷ cache ในแฟ้มปลายทาง พอเก็บขอ้มลูเสร็จแลว้ Excel ก็จะปิดแฟ้มตน้ทางโดยทีѷ
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เราไมม่สีว่นรูเ้ห็นในการไปเปิดปิดแฟ้มตน้ทางแมแ้ตน่อ้ย จากนัѸนแฟ้มปลายทางก็จะมี
ขอ้มลูใหมต่ามขอ้มลูในแฟ้มตน้ทาง 

 ถา้เลอืก Don’t Update จะพบวา่แฟ้มปลายทางเปิดขึѸนมาใหใ้ชง้านไดทั้นท ีเพยีงแต่
วา่ขอ้มลูในแฟ้มปลายทางยังคงเป็นขอ้มลูเกา่ ไมไ่ดข้อ้มลูใหมต่ามแฟ้มตน้ทาง จากนัѸน
หากคณุตอ้งการ update หลังจากทีѷเปิดแฟ้มมาแลว้ ใหส้ัѷง Edit > Links > คลกิชืѷอ
แฟ้มตน้ทาง > กดปุ่ ม Update Values 

นอกจากนัѸนยังสามารถสัѷงให ้Excel  2003 เลกิถามวา่ตอ้งการ Update Links อยา่งถาวรเลยก็
ได ้โดยใชคํ้าสัѷง Tools > Options > Edit > ตดักาชอ่ง Ask to update automatic 
links ซึѷงจะสง่ผลให ้Excel 2003 เลกิถามการ update และจะจัดการ update ใหเ้องทันทเีมืѷอ
คณุเปิดแฟ้มปลายทางใดๆขึѸนมา  

ถา้พบวา่แฟ้มปลายทางเก็บ cache ซึѷงเป็นขอ้มลูจากแฟ้มตน้ทางไวจ้นแฟ้มปลายทางมขีนาด
ใหญม่าก ก็สามารถตัด cache ทิѸงไดโ้ดยเปิดแฟ้มปลายทางทีѷตอ้งการตัด cache ขึѸนมากอ่น
แลว้สัѷง Tools > Options > Calculation > ตดักาชอ่ง Save external links values 
ทิѸงไป ซึѷงจะพบวา่แฟ้มปลายทางมขีนาดแฟ้มลดลงอยา่งมาก แตเ่มืѷอตอ้งการใชง้านก็
จําเป็นตอ้งเปิดทกุแฟ้มทีѷ link กนัขึѸนมาพรอ้มกนัใหค้รบกอ่น หรอืถา้อยากเปิดแฟ้มปลายทาง
เพยีงแฟ้มเดยีว ตอ้งสัѷง Update Links เสมอเพืѷอทําใหเ้กดิ cache ชัѷวคราวขึѸนมาใชง้าน 

สว่นระบบการ link ใน Excel 2010 แมจ้ะมคํีาสัѷงและลักษณะบนจอทีѷตา่งจากเดมิไปบา้ง แตก่็
ทําหนา้ทีѷไมไ่ดแ้ตกตา่งจาก Excel 2003 เทา่ใดนักกลา่วคอื 

 เมืѷอเปิดแฟ้มปลายทางขึѸนมาแฟ้มเดยีวโดยไมต่อ้งเปิดแฟ้มตน้ทาง จะม ีSecurity 
Warning Tab เปิดขึѸนเหนอืขอบพืѸนทีѷตารางเพืѷอบอกวา่ Excel ไมไ่ด ้update link 
จนกวา่จะกดปุ่ ม Enable Content  
 

 
 
 



Page 34 of 147 

 

สดุยอดเคล็ดลับและลัดของ Excel 
© พ.ศ. 2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ

www.ExcelExpertTraining.com 

 หาก Security Warning Tab ถกูปิดหายไป คณุสามารถสัѷง update link ไดเ้องจาก
คําสัѷง Data > Edit Links แลว้คลกิชืѷอแฟ้มตน้ทางในชอ่ง Source แลว้กดปุ่ ม 
Update Values 

 

 ใน Edit Links ตามรปูขา้งตน้ หากตอ้งการปรับระบบการเตอืน update ของแฟ้ม
ปลายทางทีѷกําลังเปิดอยู ่ใหก้ดปุ่ ม Startup Prompt ดา้นลา่งสดุ จะสามารถกําหนดให ้
เมืѷอเปิดแฟ้มนัѸนมกีารเตอืน update link และ/หรอื ให ้update link ทันททีีѷเปิดแฟ้มดว้ย
ไดต้ามตอ้งการ (ไมค่วรเลอืกชอ่ง Don’t display the alert and don’t update 
automatic links เพราะในขณะเปิดแฟ้ม คณุจะไมม่ทีางทราบเลยวา่ขอ้มลูในแฟ้มทีѷเปิด
นัѸนเป็นขอ้มลูทีѷ update แลว้หรอืยัง) 
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 แทนทีѷจะปรับระบบการเตอืน update link ใหก้บัแตล่ะแฟ้ม คณุสามารถปรบัระบบของ 
Excel ใหเ้ลกิเตอืนการ update link ในขณะเปิดแฟ้มปลายทางทกุแฟ้ม เพืѷอใหม้กีาร 
update link เองทันททีีѷเปิดแฟ้ม โดยสัѷง File > Options > Advanced > 
General > ตดักาชอ่ง Ask to update automatic links ซึѷงคําสัѷงนีѸจะมผีล
ตอ่เนืѷองไปตลอดไมว่า่จะปิดเปิดตัวโปรแกรม Excel มาใชใ้หมก่็ตาม 

 

 หากแฟ้มปลายทางมขีนาดใหญม่าก คณุสามารถตัด cache ทีѷเก็บไวใ้นแฟ้มปลายทาง
ทิѸงไดเ้พืѷอลดขนาดแฟ้มลง โดยเปิดแฟ้มปลายทางนัѸนแลว้สัѷง File > Options > 
Advanced > When calculating this workbook > ตดักาชอ่ง Save 
external link values ตามภาพขา้งตน้ (และเมืѷอจะใชข้อ้มลูในแฟ้มปลายทางทีѷไมม่ ี
cache ก็ตอ้งเปิดแฟ้มแบบ update link เสมอ หรอืตอ้งใชว้ธิเีปิดแฟ้มทัѸงตน้ทางและ
ปลายทางขึѸนมาใชง้านพรอ้มกนั) 

 ใน Excel 2007 เป็นตน้มา มรีะบบ update link เมืѷอมกีารคํานวณ ซึѷงเป็นระบบใหมท่ีѷไม่
เคยมใีน Excel 2003 จากการสัѷง File > Options > Advanced > When 
calculating this workbook ตามภาพขา้งตน้ จากนัѸนใหเ้ลอืกกาในชอ่ง Update 
links to other documents ซึѷงปกตชิอ่งนีѸจะถกูเลอืกไวอ้ยูก่อ่นแลว้ 

 ใน Excel 2007 เป็นตน้มา มรีะบบ Trust Folder โดยคณุสามารถกําหนดให ้Excel 
ยอมรับขอ้มลูจากแฟ้มทกุแฟ้มทีѷเก็บไวใ้นโฟลเดอรท์ีѷคณุไวใ้จโดย Excel จะไมต่อ้ง
เสยีเวลาถาม update link หรอื enable macro เมืѷอคณุเปิดแฟ้ม เริѷมจากการสัѷง File > 
Options > Trust Center > กดปุ่ ม Trust Center Settings 
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จากนัѸนในหนา้จอถัดไปใหค้ลกิเลอืก Trusted Locations > กดปุ่ ม Add new 
location เพืѷอเลอืกโฟลเดอรท์ีѷไวใ้จได ้จากนัѸนเมืѷอเปิดแฟ้มทีѷเก็บไวใ้นโฟลเดอรท์ีѷ
กําหนด Excel ก็จะเปิดแฟ้มใหทั้นทโีดยไมม่กีารเตอืนใดๆทัѸงสิѸน 
 

 

 Excel 2010 มรีะบบ Trusted Documents ชว่ยจําวา่แฟ้มใดทีѷเคยเปิดแบบ Enable 
Macro หรอื Update Links มากอ่น เมืѷอเปิดแฟ้มนัѸนอกีจะเปิดระบบใหทํ้างานเองทันท ี
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การนําตาํแหนง่อา้งองิไปใชซํ้ҟา 

การนําตําแหน่งอา้งองิไปใชซ้ํѸาเป็นขั Ѹนตอนสําคัญทีѷจะทําใหค้ณุใช ้Excel ไดอ้ยา่งคอมพวิเตอร์
เพราะไมเ่พยีงชว่ยลดเวลาในการสรา้งงานทําใหไ้มต่อ้งสรา้งสตูรใหมท่กุครั Ѹงทีѷอยากไดแ้ลว้ 
หากทราบเคล็ดลับทีѷนํามาอธบิายนีѸยังชว่ยใหค้ณุเกดิความรูส้กึวา่ Excel เป็นโปรแกรมทีѷสามารถ
ใชง้านไดง้า่ยอกีดว้ย 

เพืѷอทําใหเ้ขา้ใจประเด็นของการนําตําแหน่งอา้งองิไปใชซ้ํѸาวา่คอือะไร ขอใหล้องทําตัวอยา่ง
งา่ยๆตอ่ไปนีѸดสูกัหน่อยวา่จะหาทางนําสตูรในเซลล ์D2 ทีѷนําตําแหน่งอา้งองิจากเซลล ์B2 และ 
C2 มาคณูกนัดว้ยสตูร =B2*C2 นีѸไปใชซ้ํѸาทีѷเซลลอ์ืѷนไดอ้ยา่งไรกนั 

 

โปรดสงัเกตวา่ในตัวสตูร =B2*C2 มไิดใ้สเ่ครืѷองหมาย $ เพืѷอควบคมุตําแหน่งใดไว ้ดังนัѸนหาก
ใชว้ธิ ีCopy เซลล ์D2 ไปใชท้ีѷเซลลอ์ืѷน จะทําใหตํ้าแหน่งอา้งองิในตัวสตูรเขยืѸอนจากตําแหน่ง
เดมิ เชน่ ถา้ Copy ไปใชท้ีѷเซลล ์D3 จะไดส้ตูร =B3*C3 ซึѷงไดคํ้าตอบผดิพลาดตา่งไปจากเดมิ 
ดังนัѸนหากตอ้งการนําสตูร =B2*C2 ไปใชซ้ํѸาทีѷเซลลอ์ืѷนไดทั้นทโีดยไมต่อ้งกงัวลเรืѷองการใส่
เครืѷองหมาย $ จะทําไดอ้ยา่งไร 

 

วธิที ีѷ 1 : Copy สตูรทีѷเปลีѷยนเป็น Text ไวก้อ่น 

ใหแ้กไ้ขสตูรจากเดมิ =B2*C2 ใหก้ลายเป็น Text โดยใสต่ัวอกัษรใดๆก็ไดล้งไปไวห้นา้
เครืѷองหมายเทา่กบั เชน่ c=B2*C2 จากนัѸนจงึ Copy เซลล ์D2 ไป Paste ทีѷเซลลอ์ืѷน แลว้
ยอ้นกลับมาแกไ้ขสตูรในเซลลทั์ Ѹงเซลลเ์ดมิและเซลลใ์หมใ่หก้ลับคนืเป็น =B2*C2 ตามเดมิ 

ในการแกไ้ขสตูรนีѸ หากมเีซลลส์ตูรเป็นจํานวนมาก ใหใ้ชคํ้าสัѷง Replace ชว่ยแกไ้ขในการ
เปลีѷยนเครืѷองหมายเทา่กบั = เป็น c= แลว้ Replace กลับมาสูส่ตูรทีѷมเีพยีงเครืѷองหมายเทา่กบั
นําหนา้ตามเดมิ (หา้มใสเ่ครืѷองหมายฝนทอง ‘ นําหนา้เครืѷองหมายเทา่กบั เนืѷองจากคําสัѷง 
Replace จะคน้หาเครืѷองหมายฝนทองไมพ่บ) 
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วธิที ีѷ 2 : Copy  Move  Copy เซลลส์ตูร 

 

1. ใหเ้ริѷมจาก Copy เซลล ์D2 ซึѷงมสีตูร =B2*C2 ไปเก็บไวท้ีѷเซลลใ์ดก็ได ้จากรปูสมมตวิา่
นําไปเก็บไวท้ีѷเซลล ์D6 โดยไมต่อ้งสนใจวา่จะทําใหส้ตูรมตํีาแหน่งอา้งองิตา่งไปจาก
เดมิกลายเป็น =B6*C6 ซึѷงไมใ่ชตํ่าแหน่งเซลลเ์ดมิ B2 และ C2 ก็ตาม 

2. จากนัѸนให ้Cut เซลล ์D2 ไปยังตําแหน่งเซลลใ์หมต่ามตอ้งการ เชน่ ยา้ยเซลลไ์ปไวท้ีѷ
เซลล ์F2 ทําใหไ้ดส้ตูร =B2*C2 ตามเดมิ (วธิ ีCut นีѸยังชว่ยใหส้ามารถนําสตูรไปใชซ้ํѸา
ในชทีอืѷนไดด้ว้ย) 

3. ขั Ѹนสดุทา้ยให ้Copy เซลล ์D6 กลับไปทีѷเซลล ์D2 จะทําใหไ้ดส้ตูร =B2*C2 กลับมา
ตามเดมิ 

เนืѷองจากมกีาร Cut เซลล ์D2 ไปทีѷตําแหน่งเซลลใ์หม ่จงึตอ้งทําความเขา้ใจดว้ยวา่ หากเดมิมี
สตูรในเซลลอ์ืѷนทีѷเคยกําหนดตําแหน่งอา้งองิกบัเซลล ์D2 เอาไว ้จะทําใหตํ้าแหน่งอา้งองิใน
สตูรถกูแกไ้ขตามการยา้ยไปยังตําแหน่งเซลลใ์หมด่ว้ยโดยอตัโนมัต ิ

วธิที ีѷ 3 : Copy สตูรในเซลลไ์ปใชซํ้ҟาทีѷเซลลอ์ ืѷน 

 

1. ใหเ้ริѷมจากใช ้Mouse คลกิลากทับสว่นของสตูรทีѷแสดงใน Formula Bar  

2. คลกิขวาสัѷง Copy 

3. กดปุ่ ม Esc 

4. จากนัѸนใหค้ลกิเลอืกเซลลท์ีѷตอ้งการแลว้สัѷง Paste 

นอกจาก 3 วธิขีา้งตน้นีѸแลว้ยังมวีธิอีืѷนอยูอ่กี เพยีงแตจ่ะตอ้งรูจั้กการตั Ѹงชืѷอและใชช้ืѷอ Range 
Name กอ่น ซึѷงจะนํามาอธบิายในลําดับตอ่ไป 
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หลกัการต ัҟงชืѷอและใชช้ืѷอใน Excel 

การตั Ѹงชืѷอและใชช้ืѷอเป็นหัวใจสําคัญของการนําตําแหน่งอา้งองิไปใชซ้ํѸา เนืѷองจากหากปราศจาก
การตั Ѹงชืѷอทีѷดขี ึѸนมาใชแ้ทนตําแหน่งอา้งองิของเซลลแ์ลว้ สตูรสั Ѹนๆทีѷดไูมม่พีษิภัยอะไร จะกลับ
กลายเป็นปัญหาอยา่งมาก ยิѷงใน Excel 2007 มพีืѸนทีѷตารางกวา่หมืѷน Column และลา้นกวา่ 
Row จะทําให ้สตูร =JAN2009 ซึѷงเป็นสตูรทีѷนําคา่มาจากเซลลใ์น Column JAN ตัดกบั Row 
2009 สามารถดผูาดๆและถกูตคีวามวา่เป็นคา่ของเดอืน Jan ปีค.ศ.2009 แทนก็เป็นได ้

หากสงัเกตขนาดของตัวอกัษรแตล่ะตัวในคําแตล่ะคําทีѷปรากฏในตาราง Excel จะพบวา่ ชืѷอใดๆ
ก็ตามทีѷเป็นชืѷอมาตรฐานของโปรแกรม Excel ซึѷงเราไมส่ามารถเขา้ไปแกไ้ข
เปลีѷยนแปลงใหเ้ป็นชืѷออืѷน ไดถ้กูจดัใหใ้ชต้วัอกัษรตวัใหญท่ ัҟงหมด (เวน้ชืѷอคาํส ัѷงบน 
Ribbon หรอืเมนู) เชน่ ชืѷอตําแหน่ง Column A B C D จนถงึ XFD (Excel 2003 ม ีColumn 
สดุทา้ยชืѷอ IV) และสตูรสําเร็จรปูของ Excel ทกุสตูร เชน่สตูร SUM, MAX, MIN, VLOOKUP 
ลว้นใชต้ัวอกัษรตัวใหญทั่Ѹงหมด ดังนัѸนแทนทีѷจะพรอ้มใจกนัตั Ѹงชืѷอแลว้ใชช้ืѷอทีѷเป็นตัวใหญ่
ทั Ѹงหมดตามแบบของชืѷอของ Excel เราควรกําหนดหลักการตั Ѹงชืѷอและใชช้ืѷอทีѷสืѷอความหมายได ้
ดขี ึѸนกวา่เดมิ ดังนีѸ 

1. หากแฟ้มใดจะถกูใชซ้ํѸา ขอใหต้ั Ѹงใจตั Ѹงชืѷอใหด้ ีเพืѷอทําใหไ้มว่า่ผูท้ีѷนําแฟ้มงานไปใชซ้ํѸานัѸนจะ
เป็นตัวคณุซึѷงเป็นผูส้รา้งแฟ้มนัѸนเองหรอืจะเป็นเพืѷอนทีѷเพิѷงเปิดใชแ้ฟ้มนัѸนเป็นครั Ѹงแรกก็ตาม 
จะไดส้ามารถเปิดแฟ้มดแูลว้สามารถไลท่ีѷไปทีѷมาของสตูรในเซลลไ์ดทั้นท ีแตถ่า้แฟ้มใดถกู
สรา้งขึѸนมาเพืѷอใชง้านงา่ยๆเพยีงครั Ѹงเดยีวแลว้ทิѸง ไมต่อ้งนํากลับมาใชอ้กี ก็ไมจํ่าเป็นตอ้งตั Ѹง
ชืѷอใหด้กี็ได ้

2. ชืѷอใดทีѷคณุตั ѸงขึѸนมาไมว่า่จะเป็นชืѷอชที ชืѷอแฟ้ม ชืѷอโฟลเดอร ์ชืѷอตําแหน่งเซลล ์(Range 
Name) ชืѷอสตูร (Formula Name) หรอืชืѷอทีѷตั Ѹงใหก้บัคา่คงทีѷ (Constant Name) ใหต้ั Ѹงชืѷอ
โดยใชต้ัวอกัษรตัวใหญผ่สมกบัตัวเล็กเสมอ 

3. เมืѷอใดทีѷตอ้งการสรา้งสตูรหรอือา้งถงึชืѷอใดๆก็ตาม ใหใ้ชต้ัวอกัษรตัวเล็กทั Ѹงหมดเทา่นัѸน 
เพราะเมืѷอพมิพล์งไปในเซลลแ์ลว้กดปุ่ ม Enter จะเกดิขอ้สงัเกตในตัวอกัษรของแตล่ะชืѷอ
ขึѸนมาทันทกีลา่วคอื 

3.1. ตัวอกัษรทีѷกลายเป็นตัวใหญทั่Ѹงหมด แสดงวา่เป็นชืѷอเฉพาะของ Excel 

3.2. ตัวอกัษรทีѷกลายเป็นตัวใหญผ่สมตัวเล็ก แสดงวา่เป็นชืѷอทีѷคณุตั Ѹงไว ้

3.3. ตัวอกัษรทีѷยังคงเป็นตัวเล็กทั Ѹงหมด แสดงวา่สะกดชืѷอผดิ ดังนัѸน Excel จงึไมย่อมรับชืѷอ
นัѸน ทําใหข้นาดตัวอกัษรไมเ่ปลีѷยนแปลงตาม 

4. ชืѷอทีѷตั ѸงขึѸนควรใชต้ัวอกัษรตั Ѹงแต ่4 ตัวขึѸนไปเพืѷอมใิหซ้ํѸากบัชืѷอของ Column แตถ่า้
จําเป็นตอ้งตั Ѹงชืѷอทีѷมตีัวอักษร 2-3 ตัวก็ทําได ้เพราะการตั Ѹงชืѷอทีѷใชต้ัวอกัษรตัวใหญผ่สมตัว
เล็กจะชว่ยในการแยกแยะใหเ้ห็นไดช้ดัอยูแ่ลว้วา่ Jan2009 มไิดม้คีวามหมายเดยีวกบั 
JAN2009 ทีѷเป็นเซลลใ์น Column JAN ตัดกบั Row 2009 (ถา้ตอ้งการตั Ѹงชืѷอทีѷเป็นตัวอักษร
ตัวเดยีว ขอใหห้ลกีเลีѷยงตัว C และ R เพราะซํѸากบัตัวยอ่ของ Row และ Column) 
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5. Excel จะไมย่อมรับชืѷอ Range Name ทีѷมกีารเวน้วรรค โดยหากสัѷงให ้Excel ใชข้อ้ความใน
เซลลต์ามขอบตารางมาเป็นชืѷอโดยอตัโนมัต ิจะถกูแกไ้ขเครืѷองหมายวรรคเป็นเครืѷองหมาย
ขดีลา่ง _ (Underscore) ใหเ้อง และ Excel จะไมย่อมรับชืѷอ Range Name ทีѷเป็นตัวเลข
ลว้นหรอืเป็นตัวเลขนําหนา้ตัวอกัษร 

6. แมจ้ะไมม่ขีอ้หา้มในการตั Ѹงชืѷอเป็นภาษาไทย แตก่็แนะนําใหต้ั Ѹงชืѷอเป็นภาษาองักฤษจะ
เหมาะสมกวา่ เพราะหากใช ้Excel version ภาษาองักฤษ เปิดแฟ้มทีѷมกีารใชช้ืѷอภาษาไทย 
จะอา่นชืѷอภาษาไทยไมอ่อก 

7. ในการตั Ѹงชืѷอชที หา้มตั Ѹงชืѷอวา่ History เนืѷองจากเป็นชืѷอทีѷ Excel สํารองไวใ้ชภ้ายใน 

8. ในการตั Ѹงชืѷอ Range Name หา้มตั Ѹงชืѷอวา่ Criteria หรอื Extract เพราะชืѷอ Criteria นีѸจะถกู
ลบทิѸงหรอืเปลีѷยนแปลงตําแหน่ง Extract จากเดมิไดเ้องทันททีีѷใชคํ้าสัѷง Advanced Filter 

9. หากตอ้งการไดร้ับความสะดวกจากคําสัѷง Data Form ใหต้ั Ѹงชืѷอตารางฐานขอ้มลูวา่ 
Database เพืѷอทําให ้Excel ดงึขอ้มลูมาใชใ้น Data Form ไดเ้องโดยทีѷคณุไมต่อ้งเลอืก
ตารางฐานขอ้มลูนัѸนไวก้อ่น 

10. โปรดเขา้ใจเพิѷมเตมิวา่ ในการเขยีนชืѷอสตูรและชืѷอตา่งๆทีѷใชใ้นการอบรมตลอดจนขอ้มลูบน
เว็บ www.ExcelExpertTraining.com นัѸน ใชว้ธิเีขยีนชืѷอโดยใชอ้กัษรตัวใหญผ่สมตัวเล็ก
เสมอ เพืѷอชว่ยในการอา่นใหส้ามารถแยกแตล่ะสว่นของคําไดง้า่ยขึѸน เชน่ VLookup, 
SumIF, SumProduct เป็นตน้ ซึѷงเมืѷอใดทีѷตอ้งการนําชืѷอไปใช ้ใหพ้มิพต์วัเล็กตลอดตาม
หลักการขา้งตน้ 

ใน Excel 2003 มรีะบบการตั Ѹงชืѷอ Range Name, Formula Name, และ Constant Name ทีѷไม่
ซบัซอ้นนัก เพยีงสัѷง Insert > Name > Define ก็สามารถ Add ตั Ѹงชืѷอหลายๆชืѷอไดโ้ดยใช ้
คําสัѷงนีѸเพยีงครั Ѹงเดยีว สว่นใน Excel 2007 ขึѸนไปมคํีาสัѷงในการตั Ѹงชืѷอใหเ้ลอืกได ้2 วธิ ีคอื 

1. หากตอ้งการตั Ѹงชืѷอเดยีว ใหส้ัѷง Formulas > Define Name 

2. หากตอ้งการตั Ѹงชืѷอหลายชืѷอและสามารถยอ้นกลับมาแกไ้ขหรอืตั Ѹงชืѷออืѷนใหมอ่กีไดใ้นทันท ี
ใหส้ัѷงผา่น Formulas > Name Manager  
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2.1. กดปุ่ ม New เพืѷอตั Ѹงชืѷอใหม ่หรอื 

2.2. กดปุ่ ม Edit เพืѷอแกไ้ขตําแหน่งอา้งองิในชืѷอ หรอื 

2.3. กดปุ่ ม Delete เพืѷอลบชืѷอทิѸง 

นอกจากนัѸน Excel 2007 เป็นตน้มา ไดป้รับปรงุระบบการตั Ѹงชืѷอใหส้นองตอบตอ่การใชง้านใน
ระดับ File Level หรอื Sheet Level ไดส้ะดวกกวา่แตก่อ่นมาก กลา่วคอื 

 

 การต ัҟงชืѷอเพืѷอใชใ้นระดบั File Level เป็นระบบมาตรฐานทีѷ Excel เลอืก Scope เป็น 
Workbook ไวใ้หต้ั Ѹงแตต่น้ เพืѷอทําใหช้ืѷอทีѷตั ѸงขึѸนในระดับนีѸสามารถนําไปใชร้ว่มกนัไดท้กุ
ชที 

 การต ัҟงชืѷอเพืѷอใชใ้นระดบั Sheet Level โดยคลกิเปลีѷยน Scope เป็นชืѷอชทีทีѷ
ตอ้งการ ทําใหช้ืѷอทีѷตั ѸงขึѸนในระดับชทีเป็นชืѷอทีѷใชใ้นชทีนัѸนและเป็นอสิระจากชทีอืѷน 
สง่ผลใหส้ามารถตั ѸงชืѷอซํѸากนัไดใ้นแฟ้มเดยีวกนั (น่าสงัเกตวา่เราสามารถกําหนด Scope 
ใหอ้ยูต่า่งชทีกบัชทีทีѷ Refers to ก็ยงัไดแ้ตไ่มค่วรทํา) 

 

การต ัҟงชืѷอ Constant Name 

Constant Name เป็นชืѷอทีѷตั Ѹงใหก้บัคา่คงทีѷ ซึѷงตามปกตใินการดําเนนิธรุกจิตอ้งเกีѷยวขอ้งกบั
คา่คงทีѷมากมาย นับตั Ѹงแต ่ชืѷอบรษัิท ทีѷอยู ่ชืѷอผูบ้รหิาร รหัสทีѷเป็นความลับ หมายเลขบัญช ี
ตัวเลขทางการเงนิตา่งๆ เชน่ อตัราดอกเบีѸย คา่เสืѷอมราคา ตัวเลขเงนิเดอืน ดังนัѸนแทนทีѷจะตอ้ง
บันทกึคา่เหลา่นีѸซํѸาลงไปในเซลลโ์ดยตรง นอกจากจะเสยีเวลาพมิพเ์องใหมท่กุครั Ѹงแลว้ ยังอาจ
พลัѸงเผลอบันทกึขอ้มลูตา่งไปจากเดมิ จงึขอแนะนําใหต้ั Ѹงชืѷอใหก้บัคา่คงทีѷทั Ѹงหมดทีѷม ีแทนทีѷ
จะตอ้งพมิพช์ืѷอยากๆยาวๆ ก็เพยีงพมิพช์ืѷอสั Ѹนๆทีѷจํางา่ยกวา่ และภายหลังหากมกีารเปลีѷยนแปลง
คา่ทีѷเคยคดิวา่คงทีѷ ก็ใหทํ้าการแกไ้ขคา่ทีѷกําหนดใหก้บัชืѷอทีѷเป็น Constant Name นีѸเพยีงครั Ѹง
เดยีว ก็จะสง่ผลใหท้กุเซลลท์ีѷนํา Constant Name ไปใชม้คีา่ใหมต่ามการแกไ้ขนัѸนไดทั้นท ี

สมมตวิา่ ตอ้งการตั Ѹงชืѷอ Constant Name วา่ “MyKey1” ใหม้คีา่เทา่กบัชืѷอ “Excel Expert 
Training” ใหเ้ริѷมจากพมิพช์ืѷอทีѷตอ้งการตั Ѹงลงไปในชอ่ง Name (โดยไมต่อ้งใสเ่ครืѷองหมาย
คําพดูปิดหัวทา้ยชืѷอ) จากนัѸนพมิพค์า่ทีѷตอ้งการลงไปในชอ่ง Refers to โดยตอ้งมเีครืѷองหมาย
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เทา่กบันําหนา้เสมอและถา้มคีา่เป็นตัวอกัษรก็ตอ้งใสข่อ้ความไวร้ะหวา่งเครืѷองหมายคําพดูดว้ย
ตามนีѸ 

Name: MyKey1 

Refers to: =”Excel Expert Training” 

แตถ่า้ตอ้งการตั Ѹงชืѷอ Constant Name ใหม้คีา่เป็นตัวเลข ก็ไมต่อ้งใสเ่ครืѷองหมายคําพดู แตต่อ้ง
ใสเ่ครืѷองหมายเทา่กบันําหนา้เชน่กนัตามนีѸ 

Name: MyKey2 

Refers to: =23187021 

จากนัѸนเมืѷอตอ้งการนําชืѷอ Constant Name นีѸไปใชใ้น
เซลล ์ใหพ้มิพ ์=mykey1 (สงัเกตวา่ถา้พมิพเ์องให ้
พมิพด์ว้ยตัวเล็กตลอด) หรอืกดปุ่ ม F3 เพืѷอเปิดรายชืѷอ
ทีѷตั Ѹงไวใ้นแฟ้มนัѸนขึѸนมาแสดงบนจอ แลว้ใหด้ับเบิѸลคลกิ
ทีѷชืѷอทีѷตอ้งการ (หรอืคลกิปุ่ ม OK) แลว้กดปุ่ ม Enter 
เพืѷอรับสตูร =MyKey1 ลงไปในเซลล ์จะไดคํ้าวา่ Excel 
Expert Training แสดงในเซลลนั์Ѹน 

 

หมายเหต ุชืѷอทีѷเป็น Range Name หรอื Formula Name มขีั Ѹนตอนการใชช้ืѷอเหมอืนกบั
Constant Name เชน่กนั 

 

การต ัҟงชืѷอ Range Name 

Range Name เป็นชืѷอทีѷตั Ѹงใหก้บัเซลลเ์ดยีวหรอืพืѸนทีѷตาราง (ทีѷมพีืѸนทีѷตดิกนัหรอืไมต่ดิกนัก็ได)้ 
ซึѷงมวีธิตีั Ѹงชืѷอไดห้ลายวธิ ีดังนีѸ 

1. วธิใีช ้Name Box เป็นชอ่งดา้นซา้ยมอืของ Formula Bar วธินีีѸเป็นวธิตีั Ѹงชืѷอทีѷงา่ยทีѷสดุ แต่
ใชก้บัการตั Ѹงชืѷอไดอ้ยา่งเดยีว ไมส่ามารถใช ้Name Box เพืѷอแกไ้ขหรอืลบชืѷอทิѸง 
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1.1. เริѷมจากคลกิเลอืกเซลลห์รอืตารางทีѷตอ้งการ (หากตอ้งการเลอืกเซลลท์ีѷไมต่ดิตอ่กนั ให ้
กดปุ่ ม Ctrl แลว้คลกิเลอืกพืѸนทีѷตารางทีѷตอ้งการไปเรืѷอยๆ) 

1.2. คลกิลกูศรดา้นขวาของชอ่ง Name Box แลว้พมิพช์ืѷอ Range Name ทีѷตอ้งการลงไป
ในชอ่ง Name Box ขอใหส้งัเกตวา่ พอพมิพต์ัวอกัษรทลีะตัวของชืѷอลงไป ชอ่ง Name 
Box จะเลืѷอนไปหาชืѷอเกา่ทีѷตั Ѹงไวก้อ่นแลว้เพืѷอคณุจะไดต้ั Ѹงชืѷอใหมท่ีѷไมซ่ํѸากบัชืѷอเดมิทีѷมี
อยูแ่ลว้ 

1.3. กดปุ่ ม Enter เพืѷอรับชืѷอลงไปในชอ่ง Name Box 

2. วธิใีชค้าํส ัѷง Formulas > Define Name หรอื Formulas > Name Manager 
(Excel 2003 ใชค้าํส ัѷง Insert > Name > Define) โดยกรอกชืѷอทีѷตอ้งการตั Ѹงลงไป
ในชอ่ง Name: แลว้คลกิลงไปในชอ่ง Refers to (โดยใหค้ลกิตอ่ทา้ยตําแหน่งเดมิทีѷแสดง
ไวใ้นชอ่ง Refers to: นีѸ) จากนัѸนใหเ้ลอืกพืѸนทีѷตารางทีѷตอ้งการแลว้กดปุ่ ม OK เพืѷอรับชืѷอ 

 

3. วธิใีชค้าํส ัѷง Formulas > Create from selection (Excel 2003 ใชค้าํส ัѷง Insert 
> Name > Create) วธินีีѸชว่ยนําขอ้ความทีѷอยูข่อบตารางมาตั Ѹงเป็นชืѷอใหก้บัพืѸนทีѷตาราง
ในฝัѷงตรงขา้มกบัขอ้ความนัѸน เริѷมจากคลกิเลอืกพืѸนทีѷตารางทีѷตอ้งการตั Ѹงชืѷอโดยใหเ้ลอืก
รวมทัѸงพืѸนทีѷหัวตารางไวด้ว้ย จากนัѸนใชคํ้าสัѷง Formulas > Create from Selection จะพบ
หนา้จอตอ่ไปนีѸเปิดขึѸนมา ใหด้วูา่ตรงตามตอ้งการแลว้กดปุ่ ม OK เพืѷอรับชืѷอ 

 
Excel เลอืกชอ่ง Left column ไวใ้ห ้เนืѷองจาก Column ซา้ยสดุของพืѸนทีѷตารางทีѷเลอืกนัѸน
มตีัวอกัษรบันทกึไว ้โดย Excel จะตั ѸงชืѷอพืѸนทีѷตาราง C2:E2 วา่ Income และตั ѸงชืѷอพืѸนทีѷ
ตาราง C3:E3 วา่ Cost ตามขอ้ความใน Column ซา้ยสดุใหทั้นท ีทั ѸงนีѸขอใหเ้ขา้ใจดว้ยวา่ 
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ชืѷอ Income และ Cost เป็นชืѷอทีѷ Excel ชว่ยตั Ѹงใหเ้พยีงครั Ѹงเดยีวตอนทีѷใชคํ้าสัѷง Create 
from selection นีѸเทา่นัѸน และจะยังคงใชช้ืѷอนีѸอยูโ่ดยไมเ่ปลีѷยนแปลงตามขอ้ความใน 
Column ซา้ยทีѷอาจมขีอ้ความตา่งไปจากเดมิแตอ่ยา่งใด 

หากตอ้งการขยายขอบเขตของ Range Name ใหใ้ชว้ธิกีาร Insert Row หรอื Insert Column 
หรอืใชว้ธิทีีѷ 2 หรอืวธิทีีѷ 3 ขา้งตน้เพืѷอเขา้ไปกําหนดขอบเขตพืѸนทีѷตารางใหมใ่หม้ขีนาดใหญข่ึѸน
ตามตอ้งการ 

Range Name ทีѷตั ѸงขึѸน สามารถนําไปใชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel ไดทั้นท ีเชน่ หาก
ตอ้งการหายอดรวมของตัวเลขใน Range Name ชืѷอ Income ใหเ้ริѷมสรา้งสตูรตามลําดับ
ตอ่ไปนีѸ 

1. พมิพ ์=sum( 

2. กดปุ่ ม F3 เพืѷอแสดงรายชืѷอทีѷตั Ѹงไวใ้นแฟ้ม (ในกรณีทีѷตอ้งการนําชืѷอมาจากแฟ้มอืѷน ใหย้า้ย
ไปอยูใ่นแฟ้มทีѷมชีืѷอ Range Name ทีѷตอ้งการนัѸนกอ่นแลว้จงึกดปุ่ ม F3) 

3. ดับเบิѸลคลกิทีѷชืѷอ Income จะไดส้ตูร =sum(Income 

4. กดปุ่ ม Enter จะไดส้ตูร =SUM(Income)  

แตถ่า้นํา Range Name ไปใชอ้า้งองิโดยตรงโดยไมไ่ดใ้ชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel 
จะพบวา่หากตั Ѹงชืѷอใหก้บัตารางทีѷมเีซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไป ชืѷอนัѸนจะนํามาใชไ้ดเ้ฉพาะในแนว
คูข่นานกบัแนวพืѸนทีѷตารางทีѷตั Ѹงชืѷอไวเ้ทา่นัѸน เชน่ หากตั Ѹงชืѷอตัวเลขหัวตารางในตําแหน่งจาก 
C2:F2 วา่ Top และตั Ѹงชืѷอตัวเลขขา้งตารางตําแหน่งจาก B3:B5 วา่ Left จะสง่ผลใหใ้ชส้ตูร 
=Top*Left คํานวณหาคําตอบไดเ้ฉพาะในขอบเขตตารางทีѷแนวคูข่นานของ Top ตัดกบั Left 
คอืพืѸนทีѷตารางตั Ѹงแต ่C3:F5 โดยสตูรนอกแนวคูข่นานจะไมคํ่านวณแตค่นืคา่เป็น Error 
#VALUE! 
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วธิตี ัҟงชืѷอตาํแหนง่อา้งองิแบบไรข้อบเขตจํากดั 

ขอยอ้นนําตัวอยา่งการคํานวณทีѷตั Ѹงชืѷอหัวตารางดา้นบนวา่ Top มาคณูกบัหัวตารางดา้นซา้ยทีѷตั Ѹง
ชืѷอวา่ Left โดยใชส้ตูร =Top*Left มาวเิคราะหอ์ยา่งละเอยีดวา่ ดว้ยเหตใุดสตูร =Top*Left 
จงึสามารถคํานวณหาคําตอบไดเ้ฉพาะพืѸนทีѷตารางในสว่นทีѷตัดกนัของแนวคูข่นานของ Top ตัด
กบั Left เทา่นัѸน สว่นพืѸนทีѷตารางนอกขอบเขตแนวทีѷตัดกนัจะใหคํ้าตอบเป็น Error 

 

เมืѷอใชคํ้าสัѷง Formulas > Name Manager ยอ้นไปตรวจสอบตําแหน่งอา้งองิทีѷ Excel 
กําหนดใหก้บัตําแหน่งอา้งองิทีѷมชีืѷอวา่ Top กบั Left จะพบวา่ เป็นตําแหน่งอา้งองิแบบ 
Absolute โดยมเีครืѷองหมาย $ ควบคมุตําแหน่งทั Ѹงแนว Row และ Column ตามรปูตอ่ไปนีѸ 

 

 ตําแหน่งอา้งองิชืѷอ Top มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$C$2:$F$2 

 ตําแหน่งอา้งองิชืѷอ Left มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B$3:$B$5 

ดว้ยสาเหตทุีѷตําแหน่งอา้งองิถกูควบคมุดว้ยเครืѷองหมาย $ ทั Ѹงแนว Row และ Column นีѷเองทีѷ
ทําใหเ้กดิการจํากดัขอบเขตใหใ้ชส้ตูรอา้งองิถงึชืѷอ Top กบั Left ไดเ้ฉพาะในแนวคูข่นาน 

ดังนัѸนหากคณุเขา้ใจถงึเหตแุละผลตามทีѷไปทีѷมาดังกลา่วขา้งตน้ จะสามารถเลอืกใชเ้ครืѷองหมาย 
$ ในการกําหนดขอบเขตแบบไมจํ่ากดัได ้โดยปรับตําแหน่งเครืѷองหมาย $ ตามหลักตอ่ไปนีѸ 

 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวนอน ใหใ้ช ้
ตําแหน่งอา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และใส่
เครืѷองหมาย $ ควบคมุตาํแหนง่เฉพาะ Row เชน่ C$2 

 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวต ัҟง ใหใ้ชตํ้าแหน่ง
อา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และใสเ่ครืѷองหมาย $ 
ควบคมุตาํแหนง่เฉพาะ Column เชน่ $B3 
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 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุแนว ใหใ้ชตํ้าแหน่งอา้งองิจาก
เซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และไมใ่สเ่ครืѷองหมาย $  

 หากตอ้งการใหตํ้าแหน่งอา้งองิใชไ้ดก้บัทกุชที ก็ไมต่อ้งระบชุืѷอชทีนําหนา้ตําแหน่ง
อา้งองิแตต่อ้งทิѸงเครืѷองหมาย ! ไวด้ว้ยเพืѷอหมายถงึทกุชที เชน่ !I5 

เนืѷองจากตําแหน่งอา้งองิแบบทีѷไมไ่ดใ้ส ่$ แบบ Absolute นีѸ จะยา้ยตําแหน่งไปตามแนวคูข่นาน
กบัตําแหน่งเซลลส์ตูรทีѷใช ้ดังนัѸนกอ่นทีѷจะใชคํ้าสัѷง Formulas > Name Manager เขา้ไป
กําหนดตําแหน่ง คณุจะตอ้งเลอืกเซลลใ์นแนวเดยีวกบัเซลลท์ีѷอา้งถงึในชอ่ง Refers to: ไว ้
ลว่งหนา้เสมอ ตามรปูตัวอยา่งตอ่ไปนีѸ 

 

1. หากตอ้งการตั Ѹงชืѷอ TopRow และ LeftColumn (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหม้ี
ตําแหน่งอา้งองิทีѷหมายถงึทกุเซลลใ์น Row 2 และทกุเซลลใ์น Column B ตามลําดับ 

1.1. ใหค้ลกิเลอืกเซลล ์C3 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 

1.2. ตั Ѹงชืѷอ TopRow ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!C$2 

1.3. ตั Ѹงชืѷอ LeftColumn ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B3 

2. หากตอ้งการตั Ѹงชืѷอ Sum3Above (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีѷหายอดรวม
ของเซลล ์3 เซลลท์ีѷอยูเ่หนอืขึѸนไปจากเซลลท์ีѷใชช้ืѷอนีѸอยูโ่ดยเวน้เซลลท์ีѷตดิกบัเซลลส์ตูร 

2.1. ใหค้ลกิเลอืกเซลล ์C13 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 

2.2. ตั Ѹงชืѷอ Sum3Above ใหม้ตํีาแหน่งอา้งองิ Refers to: =SUM(Sheet1!C9:C11) 

3. หากตอ้งการตั Ѹงชืѷอ Left2 (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีѷหาคา่จากเซลลท์ีѷอยู่
ดา้นซา้ยถัดไป 2 เซลลจ์ากเซลลท์ีѷใชช้ืѷอนีѸอยูแ่ละใหใ้ชก้บัทกุชทีไดด้ว้ย 

3.1. ใหค้ลกิเลอืกเซลล ์G10 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 

3.2. ตั Ѹงชืѷอ Left2 ใหม้ตํีาแหน่งอา้งองิ Refers to: =!E10 
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การต ัҟงชืѷอ Formula Name 

ในความเป็นจรงินัѸนทั Ѹง Constant Name หรอื Range Name ตา่งก็คอื Formula Name นัѷนเอง
เพราะในชอ่ง Refers to: ตอ้งใสเ่ครืѷองหมายเทา่กบัไวด้า้นหนา้คา่คงทีѷหรอืตําแหน่งอา้งองิไว ้
เสมอ จงึเทา่กบัวา่เป็นการตั Ѹงชืѷอใหก้บัสตูร เพยีงแตว่า่สตูรทีѷเป็น Constant Name กําหนดใหม้ี
คา่เป็นคา่คงทีѷ สว่น Range Name ไดก้ําหนดใหม้คีา่เทา่กบัคา่ทีѷเก็บไวใ้นตารางตามทีѷระบไุวใ้น
ชอ่ง Refers to: ซึѷงนอกจากจะอา้งถงึคา่คงทีѷหรอืตําแหน่งอา้งองิตามทีѷอธบิายผา่นไปแลว้ เรา
ยังสามารถใชช้อ่ง Refers to: ไดอ้กีหลายแบบ กลา่วคอื 

 ใชผ้สมกนัระหวา่งคา่คงทีѷและตําแหน่งอา้งองิ เชน่ =5*Top*Left โดยเลข 5 ถอืเป็น
คา่คงทีѷ สว่น Top กบั Left เป็นตําแหน่งอา้งองิ 

 ใชร้ว่มกบัสตูรสําเร็จรปูของ Excel เชน่ =SUM(Income) 

 ใชย้อ่สตูรยากๆยาวๆใหเ้ป็นชืѷอสั Ѹนๆเพยีงชืѷอเดยีว โดยทยอยนําชืѷอทีѷตั Ѹงไวม้าคํานวณใน
สตูรยาวๆทีѷคณุสรา้งขึѸน เชน่ แทนทีѷจะตั Ѹงชืѷอเดยีวใหก้บัสตูร 
=(5*Top*Left)+Sum(Income) ก็สามารถตั Ѹงชืѷอใหก้บัสตูรแตล่ะสว่นกอ่นแลว้จงึนําชืѷอ
มาใชต้อ่เป็น =MyVar1+MyVar2 โดยกําหนดใหต้ั Ѹงชืѷอ MyVar1 มคีา่ =5*Top*Left 
และตั Ѹงชืѷอ MyVar2 มคีา่ =SUM(Income) ไวก้อ่น 

 ใชก้ําหนดตําแหน่งอา้งองิแบบ Dynamic Range โดยใชส้ตูร Offset ชว่ยกําหนดขนาด
ตารางใหย้อ่หรอืขยายไดโ้ดยอตัโนมัตติามขนาดของขอ้มลู 

 

การเปลีѷยนตาํแหนง่อา้งองิในสตูรทีѷมอียูก่อ่นใหก้ลายเป็นชืѷอทีѷต ัҟงข ึҟนในภายหลงั 

 

สมมตวิา่สรา้งสตูร =C2-C3 เอาไวใ้นเซลล ์C4 เป็นตัวเลขกําไรขั Ѹนตน้ แลว้ Copy สตูรนีѸไปใช ้
ในเซลลต์ั Ѹงแต ่C4:E4 จากนัѸนตอ่มาไดต้ั Ѹงชืѷอ Income และ Cost เป็น Range Name ใหก้บั
พืѸนทีѷตารางตั Ѹงแต ่C2:E2 และ C3:E3 ตามลําดับ หากตอ้งการใหส้ตูรในเซลล ์C4:E4 เปลีѷยนไป
เป็นสตูร =Income-Cost ตามชืѷอทีѷตั ѸงขึѸนในภายหลัง ใหเ้ลอืกพืѸนทีѷ C4:E4 แลว้สัѷง Formulas 
> Define Name > Apply Names (Excel 2003 สัѷง Insert > Name > Apply) แลว้
เลอืกชืѷอ Income และ Cost (ซึѷง Excel มักจะเลอืกชืѷอทีѷเกีѷยวขอ้งกบัสตูรในพืѸนทีѷ C4:E4 ให ้
เอง) จากนัѸนกดปุ่ ม OK 
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เคล็ดลบัอืѷนๆทีѷควรทราบเกีѷยวกบัชืѷอทีѷบอกตาํแหนง่ 

1. ชอ่ง Name Box แสดงไดเ้ฉพาะชืѷอ Range Name ทีѷอยูใ่นแฟ้มนัѸนเทา่นัѸน  

2. การคน้หาตําแหน่งเซลลห์รอืตารางทีѷตั Ѹงชืѷอไว ้ใหใ้ช ้Name Box หรอืกดปุ่ ม F5 เพืѷอเลอืก
ชืѷอทีѷแสดงไวห้รอืพมิพช์ืѷอทีѷทราบลงไปเองก็ได ้

3. หากตอ้งการ Copy ชืѷอตําแหน่งอา้งองิไปใชท้ีѷแฟ้มอืѷนใหม้ชีืѷอแบบเดยีวกนั ใหเ้ลอืก Copy 
พืѸนทีѷตารางทั Ѹงหมดทีѷเกีѷยวขอ้งและสตูรไปดว้ยกนั (ซึѷงหมายถงึ พืѸนทีѷตารางทีѷระบไุวใ้น
ตําแหน่งอา้งองิ และเซลลส์ตูรทีѷอา้งถงึชืѷอตําแหน่งอา้งองิซึѷงอยูใ่นพืѸนทีѷทีѷเลอืกนัѸนดว้ย) 
จากนัѸนให ้Paste ลงไปในแฟ้มใหมต่ามตาํแหนง่เดมิของพืѸนทีѷตารางทีѷ Copy มา แลว้จงึ
สัѷงยา้ยไปทีѷอืѷนในภายหลังตามตอ้งการ 

4. เซลลเ์ดยีวมชีืѷอไดห้ลายชืѷอ แตช่อ่ง Name Box แสดงชืѷอแรกทีѷตั Ѹงตามลําดับตัวอกัษร เชน่ 
เซลล ์A1 ตั Ѹงชืѷอ Range Name ไวห้ลายชืѷอทั Ѹง Income, Sales, และ Revenue จะพบวา่
เมืѷอคลกิเขา้ไปทีѷเซลล ์A1 ในชอ่ง Name Box จะแสดงวา่มชีืѷอวา่ Income เพราะตัวอกัษร I 
มากอ่นตัวอกัษร R หรอื S แตถ่า้ไลด่รูายชืѷอใน Name Box จะพบชืѷออืѷนแสดงไวด้ว้ย 

5. ตัวชืѷอ Range Name กบัตําแหน่งอา้งองิในชอ่ง Refers to: ไมจํ่าเป็นตอ้งอยูใ่นแฟ้ม
เดยีวกนัก็ได ้โดยเราสามารถตั Ѹงชืѷอไวใ้นแฟ้มหนึѷง แตก่ําหนดใหตํ้าแหน่ง Refers to: ไปอยู่
ในแฟ้มอืѷนได ้โดยใช ้Mouse คลกิเลอืกตําแหน่งตารางในแฟ้มอืѷนก็จะไดตํ้าแหน่งทีѷตอ้งการ
มาใสใ่นชอ่ง Refers to: ใหเ้อง 

6. หาก Cut ตารางทีѷตั Ѹงชืѷอ Range Name เอาไวไ้ปวางไวใ้นแฟ้มอืѷน จะทําใหต้ัวชืѷอ Range 
Name ยังอยูใ่นแฟ้มเดมิ แตตํ่าแหน่งอา้งองิในชอ่ง Refers to: จะยา้ยตามไปทีѷแฟ้มอืѷน 
และยังสง่ผลใหช้อ่ง Name Box ไมแ่สดงชืѷอ Range Name นัѸนอกีตอ่ไป (โดยยังคงดชูืѷอ
ทกุประเภทไดจ้ากคําสัѷง Formulas > Name Manager) 

7. หากตอ้งการหาคา่ ณ ตําแหน่งเซลลท์ีѷตัดกนัของตารางทีѷตั Ѹงชืѷอไว ้(Intersection) ใหใ้ช ้
สตูรทีѷมเีครืѷองหมายวรรคคัѷนระหวา่งชืѷอ เชน่ =Top Left จะไดค้า่จากเซลลท์ีѷทีѷตําแหน่งตัด
กนัของ Top ตัดกบั Left 

8. หากตอ้งการสรา้งสตูรทีѷอา้งถงึตําแหน่งอา้งองิในตารางโดยตรง โดยไมต่อ้งการใหส้ตูรทีѷ
เกดิขึѸนใชช้ืѷอ Range Name ใหเ้ริѷมจากเลอืกเซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไปไวก้อ่นแลว้จงึพมิพ ์
= แลว้คลกิเลอืกเซลล ์จะไดส้ตูรทีѷมตํีาแหน่งอา้งองิโดยไมอ่า้งถงึชืѷอ Range Name 

9. Formula Name ทีѷใชตํ้าแหน่งอา้งองิทีѷไมใ่ช ่Absolute Reference ในบางกรณีจะไม่
คํานวณตามคา่ตัวแปรทีѷเปลีѷยนไป ซึѷงแกไ้ขไดโ้ดยปรับสตูรใหคํ้านวณรว่มกบัสตูร Now() 
หรอื Today() เชน่ Sum3Above ใช ้Refers to: =SUM(Sheet1!C9:C11)*Now()/Now() 

10. ชืѷอทีѷตั Ѹงไวจ้ะถกูเก็บไวใ้นแฟ้มทีѷใชตั้ Ѹงชืѷอเทา่นัѸน หากตอ้งการทําใหแ้ฟ้มใหมม่ชีืѷอทีѷตั Ѹงไว ้
แบบเดยีวกบัแฟ้มเดมิ ให ้Copy เซลลส์ตูรทีѷใชช้ืѷอในการอา้งองิถงึตําแหน่งเซลลไ์ปพรอ้ม
กบัเซลลท์ีѷถกูตั Ѹงชืѷอไวไ้ปดว้ยกนั และในการสัѷง Paste ในแฟ้มใหม ่ตอ้ง Paste ลงไปใน
ตําแหน่งเดมิดว้ย จงึจะทําใหแ้ฟ้มใหมเ่กดิชืѷอและมตํีาแหน่งอา้งองิถกูตอ้งตามแฟ้มเดมิ 
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การใชส้ตูรปรบัตาํแหนง่อา้งองิ 

คําอธบิายจากนีѸไปจะมปีระโยชนต์อ่เมืѷอคณุมพีืѸนฐานมากอ่นแลว้วา่ตําแหน่งอา้งองิมปีระโยชน์
อยา่งไรและจะนําตําแหน่งอา้งองิไปใชซ้ํѸาโดยการ Copy หรอืโดยการตั Ѹงชืѷอตําแหน่งอา้งองิได ้
อยา่งไร ซึѷงการนําตําแหน่งอา้งองิไปใชซ้ํѸาตามวธิทีีѷใชก้นัโดยทัѷวไป คณุตอ้งเสยีแรงเสยีเวลา 
Copy หรอืตอ้งสรา้งสตูรใหมท่กุครั Ѹง จงึเป็นเรืѷองน่าคดิวา่จะมวีธิใีดบา้งทีѷจะทําใหตํ้าแหน่ง
อา้งองิเดมิทีѷมอียูป่รับตําแหน่งไดเ้องโดยคณุไมต่อ้งเขา้ไปยุง่เกีѷยวแกไ้ขสตูรใหมอ่กีเลย 

 

วธิที ีѷ 1 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบเซลลเ์ดยีว 

ลองนกึดซูวิา่ ถา้เดมิคณุสรา้งสตูรเพืѷอดงึคา่จากเซลล ์A1 มาใชด้ว้ยสตูร =A1 จากนัѸนหาก
ตอ้งการทําใหส้ตูรในเซลลเ์ดมินัѷนแหละ ดงึคา่จากเซลล ์A2 มาแทน จะทําไดอ้ยา่งไรโดยไม่
ตอ้งยอ้นกลับไปแกไ้ขสตูรใหเ้ปลีѷยนเป็น =A2 แตอ่ยา่งใด 

 

แทนทีѷจะสรา้งสตูรตรงๆลงไปวา่ =A1 คราวนีѸใหย้อมเปลอืงเซลลห์น่อย เริѷมจากใชเ้ซลล ์C4 
และ C5 เป็นเซลลร์ับตัวอกัษร a และเลข 1 ลงไปตามลําดับ จากนัѸนนําตัวอักษรกบัตัวเลขมาตอ่
กนัในเซลล ์C6 โดยใชส้ตูร =C4&C5 จะไดคํ้าวา่ a1 ซึѷงเป็น Text ทีѷบอกตําแหน่งตามแบบ
มาตรฐานของตําแหน่งอา้งองิใน Excel (ถา้อยากลัดขั Ѹนตอน จะใชเ้ซลล ์C6 สําหรับพมิพ์
ตําแหน่งเซลล ์a1 ลงไปเลยก็ได ้โดยไมต่อ้งเสยีเซลล ์C4 และ C5 เพืѷอแยกตําแหน่งแตล่ะสว่น
ไวก้อ่น) 

จากนัѸนเซลล ์C7 ใชส้ตูร =Indirect(C6) จะไดค้า่เป็นตัวเลข 11 ซึѷงเป็นคา่จากเซลล ์A1 นัѷนเอง 
ทนีีѸหากตอ้งการคา่จากเซลลใ์ด ใหใ้ชตํ้าแหน่งอา้งองิตามคา่ในเซลล ์C6 ซึѷงอาจเกดิจากการ
พมิพแ์ยกสว่นของตัวอกัษรและตัวเลขทีѷบอกตําแหน่ง Column และตําแหน่ง Row ลงไปใน
เซลล ์C4 และ C5 หรอืจะใชว้ธิพีมิพตํ์าแหน่งเซลลท์ีѷตอ้งการลงไปเองโดยตรงในเซลล ์C6 เลย
ก็ได ้เชน่  

 ถา้พมิพคํ์าวา่ a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a2 

 ถา้พมิพคํ์าวา่ a3 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a3 

 ถา้พมิพคํ์าวา่ sheet3!a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จาก
เซลล ์a2 แตค่ราวนีѸมาจากชทีชืѷอ Sheet3 เป็นสตูรดงึคา่ขา้มชทีตามชืѷอชทีทีѷตอ้งการ 
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วธิที ีѷ 2 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชต้าํแหนง่ขอบเขตตาราง 

วธินีีѸมหีลักการคลา้ยกบัวธิแีรกทีѷใชตํ้าแหน่งอา้งองิจากเซลลเ์ดยีว เพยีงแตตํ่าแหน่งอา้งองิแบบ
ขอบเขตตารางตอ้งอยูใ่นโครงสรา้งของ ตาํแหนง่เซลลต์น้ทาง:ตาํแหนง่เซลลป์ลายทาง 
เชน่ A1:A3 จากนัѸนจงึนําตําแหน่งอา้งองิทีѷไดไ้ปใชก้บัสตูร Indirect 

 

สมมตวิา่คณุตอ้งการหาผลรวมของตัวเลขในเซลล ์A1:A3 ซึѷงปกตติอ้งใชส้ตูร =Sum(A1:A3) 
ซึѷงสตูรนีѸยังไงๆก็จะหาผลรวมจากเซลล ์A1:A3 ไปตลอด แตถ่า้ตอ้งการใหห้ายอดรวมจากเซลล์
ใดก็ไดถ้งึเซลลใ์ดก็ไดล้ะ่ จะสรา้งสตูรอยา่งไรครั Ѹงเดยีวแลว้ไมต่อ้งแกไ้ขสตูรอกีเลยในภายหลัง 

จากภาพขา้งตน้ ม ีText ทีѷบอกตําแหน่งเซลลต์น้ทาง a1 ในเซลล ์C6 ตรงกบัตัวอยา่ง Indirect 
แบบเซลลเ์ดยีว เพยีงแตค่ราวนีѸใหใ้ชเ้ซลล ์E4, E5, และ E6 สําหรับสรา้ง Text ทีѷบอกตําแหน่ง
ของเซลลป์ลายทาง a3 

จากนัѸนใชเ้ซลล ์D8 นําตําแหน่งเซลลต์น้ทางมาเชืѷอมตอ่กบัเครืѷองหมาย : แลว้เชืѷอมตอ่กบั
ตําแหน่งเซลลป์ลายทางดว้ยสตูร =C6&”:”&E6 จะไดค้า่ a1:a3 

หากตอ้งการหายอดรวมก็สามารถนํา Text ทีѷบอกตําแหน่งในเซลล ์D8 ไปใชร้ว่มกบัสตูร Sum 
และ Indirect เชน่ เซลล ์D9 ใชส้ตูร =Sum(Indirect(D8)) จะหายอดรวมตัวเลขจากตารางใน
ขอบเขตทีѷตอ้งการ 

นอกจากนีѸแทนทีѷจะนําคา่ในเซลล ์D8 ซึѷงมสีตูรเป็น =C6&”:”&E6 ไปใชต้อ่ในสตูร Sum เพืѷอ
หาผลรวม เรายังสามารถนําขอบเขตตําแหน่งอา้งองิทีѷไดน้ีѸไปใชใ้นสตูรอืѷนไดเ้ชน่เดยีวกนั 
เพยีงแตต่อ้งใชส้ตูร Indirect นําหนา้ตําแหน่งอา้งองิไวเ้สมอ เชน่ =Max(Indirect(D8)), 
=Min(Indirect(D8)), =Average(Indirect(D8)), =Index(Indirect(D8),2,1) เป็นตน้ 

ยิѷงกวา่นัѸนหากนําสตูร =$C$6&”:”&$E$6 หรอื =Indirect($C$6&”:”&$E$6) ไปตัѸงชืѷอเป็น 
Formula Name วา่ MyRange1 และ MyRange2 ตามลําดับ (หรอืชืѷออืѷนใดก็ได ้โดยตําแหน่ง
อา้งองิทีѷใชใ้น Formula Name ตอ้งกําหนดตําแหน่งแบบ Absolute จงึจะหาคา่ไดถ้กูตอ้ง) จะ
ชว่ยใหก้ารนําตําแหน่งอา้งองิไปใชต้อ่ไดส้ะดวกขึѸน เชน่ จากเดมิตอ้งใชส้ตูร 
=Sum(Indirect(D8)) ก็จะเทยีบเทา่กบัสตูร =Sum(Indirect(MyRange1)) หรอื 
=Sum(MyRange2) ซึѷงนอกเหนอืจากจะเป็นสตูรทีѷดดูกีวา่มากแลว้ยังไมข่ ึѸนกบัคา่ในเซลล ์D8 
ทีѷอาจถกูแกไ้ขอยา่งพลัѸงเผลอใหผ้ดิเพีѸยนไปในภายหลังไดอ้กีดว้ย 
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วธิที ีѷ 3 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชช้ืѷอ Range Name 

 

ตัวอยา่งนีѸตา่งจากตัวอยา่งทีѷผา่นมาเพยีงแคนํ่าชืѷอ Range Name มาใชแ้ทนตําแหน่งอา้งองิ
โดยตรง เชน่ หากตั ѸงชืѷอพืѸนทีѷตาราง D3:D6 วา่ Chonburi และตั ѸงชืѷอพืѸนทีѷตาราง C4:E4 วา่ 
Year2 (ใหใ้ชคํ้าสัѷง Formulas > Create from selection เพืѷอตั ѸงชืѷอพืѸนทีѷตามคําทีѷอยูบ่น
ของตารางรวดเดยีว) 

จากนัѸนใชเ้ซลล ์C9 และ C10 สําหรับพมิพช์ืѷอ Range Name ลงไป เชน่ พมิพคํ์าวา่ Chonburi 
และ Year2 ลงไปตามลําดับ 

 เซลล ์D9 หายอดรวมของ Chonburi ไดโ้ดยใชส้ตูร =Sum(Indirect(C9)) 

 เซลล ์D10 หายอดรวมของ Year2 ไดโ้ดยใชส้ตูร =Sum(Indirect(C10)) 

 เซลล ์E9 หาคา่ของ Chonburi ในปี Year2 ไดโ้ดยใชส้ตูรหาคา่แบบ Intersection 
=Indirect(C9) Indirect(C10) 

 

ขอ้ควรระวงัในการใชส้ตูร Indirect 

สตูรทกุสตูรของ Excel มทัี Ѹงขอ้ดแีละขอ้ดอ้ย สตูรบางสตูรทีѷพวกเราชอบใชเ้พราะเป็นสตูรทีѷ
เขยีนสั Ѹนๆ แตก่ลับทําให ้Excel ทํางานชา้ลงก็ม ี(เชน่ สตูร VLookup เป็นตน้) ซึѷงสตูร Indirect 
ก็มขีอ้ควรระวังอยูด่ว้ยกลา่วคอื สตูร Indirect สามารถ link ขอ้มลูขา้มแฟ้มได ้แตแ่ฟ้มตน้ทาง
ตอ้งเปิดขึѸนพรอ้มกบัแฟ้มปลายทางทีѷใชส้ตูรนีѸอยู ่และเป็นสตูรหนึѷงทีѷถอืเป็น Volatile Function 

Volatile Function เป็นชืѷอเรยีกประเภทของสตูร ทีѷจะทําการคํานวณใหมท่กุครั Ѹงตามการคํานวณ
ทีѷเกดิขึѸนในแฟ้ม ทั Ѹงๆทีѷเซลลส์ตูรนัѸนไมไ่ดม้ตํีาแหน่งอา้งองิทีѷสมัพันธก์บัเซลลอ์ืѷนมกีารคํานวณ
แมแ้ตน่อ้ย (ตามปกตสิตูรจะคํานวณใหมต่ามตอ่เมืѷอมเีซลลอ์ืѷนทีѷมตํีาแหน่งอา้งองิเกีѷยวขอ้งเกดิ
การคํานวณเทา่นัѸน) ดังนัѸนหากใชส้ตูรทีѷทําหนา้ทีѷแบบ Volatile นีѸมากไปจะทําใหแ้ฟ้มคํานวณ
ชา้ลง แตถ่า้มกีารใชส้ตูรเพยีงไมก่ีѷเซลลก์็ไมส่ง่ผลเทา่ใดนัก 

สตูรทีѷจัดเป็นประเภท Volatile Function ไดแ้ก ่สตูร Areas, Cell, Column, Columns, 
Indirect, Info, Now, Offset, Rand, Row, Rows, Today 
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วธิที ีѷ 4 : ใชส้ตูรเพืѷอยา้ยตาํแหนง่อา้งองิโดยอตัโนมตั ิ

แมส้ตูร  Indirect ชว่ยทําใหส้ามารถเปลีѷยนตําแหน่งอา้งองิไดก้็ตาม แตค่ณุยังคงตอ้งเป็นผู ้
กําหนดตําแหน่งใหมล่งไปเองทกุครั Ѹง ซึѷง Excel ยังมสีตูรอืѷนอกีมากมายทีѷทําหนา้ทีѷเปลีѷยนยา้ย
ตําแหน่งอา้งองิไดเ้ชน่ทีѷสตูร Indirect ทําได ้แถมยังมคีวามสามารถเหนอืกวา่เพราะสามารถ
เปลีѷยนยา้ยตําแหน่งอา้งองิตามเงืѷอนไขทีѷกําหนดหรอืจะกําหนดใหเ้ปลีѷยนยา้ยตําแหน่งโดย
อตัโนมัตไิดอ้กีดว้ย 

 สตูรทีѷสามารถเปลีѷยนยา้ยตําแหน่งอา้งองิตามเงืѷอนไขทีѷกําหนด เชน่ IF, Choose, 
Index, Offset 

 สตูรทีѷสามารถเปลีѷยนยา้ยตําแหน่งอา้งองิโดยอตัโนมัต ิเชน่ VLookup, Match ทีѷ
นํามาใชร้ว่มกบัสตูร Index หรอื Offset, Address ทีѷนํามาใชร้ว่มกบัสตูร Indirect 

รายละเอยีดการใชส้ตูรเหลา่นีѸ จะนํามาอธบิายตอ่ไปในภายหลังในบททีѷเกีѷยวขอ้งกบัแตล่ะสตูร
โดยเฉพาะ 

 

การกําหนดตาํแหนง่อา้งองิแบบวงกลม (Circular Reference) 

เมืѷอแรกเห็นชืѷอการกําหนดตําแหน่งอา้งองิแบบวงกลมน่าจะทําใหค้ดิไปวา่เป็นชืѷอเรยีกทีѷน่ารักด ี
แตเ่มืѷอใดทีѷเกดิการกําหนดตําแหน่งอา้งองิแบบวงกลมขึѸน เมืѷอนัѸนแฟ้มงานของคณุจะเขา้ขา่ย
เสีѷยงทเีดยีววา่จะใชแ้ฟ้มนัѸนตอ่ไปไดห้รอืไม ่เพราะตําแหน่งอา้งองิแบบวงกลมอาจเกดิขึѸนโดย
ไมต่ั Ѹงใจโดยไมรู่ต้ัว หรอืเกดิขึѸนอยา่งเจตนาใหม้ันเกดิขึѸนก็ได ้ซึѷงถา้ใครทีѷใช ้Excel เป็นประจํา
ทกุวัน น่าจะเคยเจอคําเตอืนตอ่ไปนีѸแสดงขึѸนบนหนา้จอมาแลว้บา้ง 

 

“การกําหนดตําแหน่งอา้งองิแบบวงกลมอาจจะทําให ้Excel คํานวณผดิพลาด” นีѷเป็นประเด็น
สําคัญของคําเตอืนทีѷแสดงขึѸนบนจอ  

ทีѷน่ากลัวทีѷสดุก็คอืคนบางคนทีѷใช ้Excel มานาน แตอ่าจไมเ่คยพบคําเตอืนตามหนา้จอขา้งบนนีѸ
เปิดขึѸนมาแสดงสกัครั Ѹงเดยีว ซึѷงเป็นไปไดน้อ้ยมากทีѷผูใ้ช ้Excel ไมเ่คยพลัѸงเผลอสรา้งสตูรผดิ
แบบ Circular มากอ่น แตอ่าจเป็นไปไดว้า่ตัวเองไดส้รา้งสตูรแบบ Circular Reference นีѸมา
กอ่นแลว้ เพยีงแตว่า่เขาเหลา่นัѸนสัѷงให ้Excel เลกิเตอืน โดยเฉพาะแฟ้มงานทีѷเป็นมรดกตกทอด
ใชต้อ่กนัมาหลายตอ่หลายรุน่ พอเปิดแฟ้มเขา้ไปแกไ้ขสตูรหรอืโยกยา้ยเซลลท์ีѷรุน่พีѷเขาสรา้งไว ้
โดยไมรู่จั้กทีѷไปทีѷมาของสตูรในเซลลเ์หลา่นัѸน ก็อาจทําใหเ้กดิ Circular Reference ไดทั้นท ี
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ตัวอยา่งการสรา้งสตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลมทีѷงา่ยทีѷสดุ เชน่ ในเซลล ์A1 สรา้งสตูร 
=A1 ลงไป หรอืในเซลล ์B3 สรา้งสตูร = B1+B2+B3 ลงไป หรอืสงัเกตงา่ยๆวา่สตูรในเซลล์
ใดมตํีาแหน่งอา้งองิทีѷระบถุงึเซลลนั์Ѹนเองอยูด่ว้ย ซึѷงนอกจากนีѸหากมสีตูรทีѷ link ตอ่ๆกนัไป
หลายๆเซลลแ์ลว้กลับสง่คา่กลับมาในเซลลใ์ดเซลลห์นึѷงในวงจรของเซลลท์ีѷ link กนั เชน่ 
เซลล ์A1 มสีตูร =A3 และเซลล ์A2 มสีตูร =A1 แลว้เซลล ์A3 มสีตูร =A2 ยอ่มทําใหเ้กดิ 
ตําแหน่งอา้งองิแบบวงกลมไดเ้ชน่กนั ซึѷงเรยีกอกีแบบหนึѷงวา่เกดิการคํานวณแบบวงกลม 
(Circular Calculation) 

ในการดําเนนิงานทางธรุกจิ มงีานหลายประเภทซึѷงอาจมเีงืѷอนไขทีѷจําเป็นตอ้งสรา้งสตูรทีѷมกีาร
กําหนดตําแหน่งอา้งองิแบบวงกลม อาทเิชน่ 

 ในเงืѷอนไขการคํานวณตน้ทนุสนิคา้ ซึѷงนําคา่ใชจ้า่ยทั Ѹงทางตรงและทางออ้มมา allocate 
เป็นตน้ทนุของสนิคา้ จากนัѸนหากสนิคา้นัѸนกลับไปใชเ้ป็นวัตถดุบิใหก้บัสนิคา้อืѷน แลว้
สดุทา้ยก็นําสนิคา้อืѷนนัѸนมาใชเ้ป็นองคป์ระกอบรว่มกบัสนิคา้เดมิอกี 

 หากบรษัิทรับจา่ยภาษีเงนิไดบ้คุคลธรรมดาแทนพนักงาน ซึѷงตามกฎเกณฑท์างภาษี
อากรกําหนดใหนํ้าภาษีทีѷจา่ยแทนนัѸนนํามาบวกเป็นเงนิไดเ้พิѷม แลว้เงนิไดร้วมทีѷเพิѷมขึѸนนีѸ
ก็ตอ้งนํากลับไปยอ้นคดิภาษีเงนิไดอ้กี 

 คา่ใชจ้า่ยบางรายการ อาจมขีอ้กําหนดทางภาษีวา่หา้มนํามาหักภาษีซํѸาอกี แตค่า่ใชจ้า่ย
นัѸนกลับมฐีานการคํานวณทีѷเกดิขึѸนจากกําไรสทุธ ิ

 ในกรณีของการกูเ้งนิ ถา้บรษัิทนําดอกเบีѸยจา่ยเงนิกูไ้ปเพิѷมยอดเงนิทีѷตอ้งกูเ้พิѷม ยอ่มทํา
ใหต้อ้งจา่ยดอกเบีѸยเพิѷมและทําใหต้อ้งกูเ้พิѷม 

 การของบประมาณคา่ใชจ้า่ยทีѷกําหนดวา่จะใหต้ามอตัรารอ้ยละของกําไร ซึѷงถา้กําไรเพิѷม
ก็จะทําใหไ้ดง้บประมาณคา่ใชจ้า่ยเพิѷม แตค่า่ใชจ้า่ยทีѷเพิѷมขึѸน ยอ่มสง่ผลใหก้ําไรลด 
และทําใหไ้ดง้บประมาณคา่ใชจ้า่ยลดลงตาม ซึѷงกลับทําใหก้ําไรเพิѷมขึѸน 

 งานคํานวณอืѷนๆ เชน่ การควบคมุให ้Excel เพิѷมคา่ตัวเลขครั Ѹงละเทา่ๆกนั โดยสรา้งสตูร 
=Number+A1 ลงไปในเซลล ์A1 หรอืการบันทกึประวัตติัวเลขสงูสดุ โดยสรา้งสตูร 
=Max(A1,NumberRange) ลงไปในเซลล ์A1 

หมายเหต ุแทนทีѷจะใชส้ตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลม ซึѷงทําใหแ้ฟ้มนัѸนมรีะบบการคํานวณ
แบบพเิศษทีѷตอ้งสัѷงให ้Excel ยอมรับกอ่นจงึจะคํานวณไดคํ้าตอบถกูตอ้ง เราสามารถใชคํ้าสัѷง
อืѷนทีѷทําหนา้ทีѷสัѷงให ้Excel คํานวณซํѸาได ้เชน่ Goal Seek หรอืใช ้Solver Add-in หรอืใชคํ้าสัѷง
จาก Visual Basic ควบคมุการคํานวณแทน 
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ข ัҟนตอนการสรา้งสตูรคาํนวณแบบ Circular Reference 

1. ใหเ้ลอืกสรา้งสตูรอืѷนๆทีѷคํานวณตามปกตทิกุสตูร (ทีѷไมต่อ้งใชก้ารคํานวณแบบ Circular 
Reference) ใหเ้สร็จกอ่น แลว้จงึสรา้งสตูรทีѷตอ้งคํานวณแบบ Circular Reference เป็นสตูร
สดุทา้ย เนืѷองจากหากตอ้งการให ้Excel คํานวณแบบ Circular เมืѷอใด คณุจะตอ้งสัѷงให ้
Excel เลกิเปิดคําเตอืน ซึѷงหากมกีารสรา้งสตูรผดิพลาดเผลอไปสรา้งสตูร Circular 
Reference ขึѸนโดยไมเ่จตนา ก็ยอ่มไมม่กีารเตอืนใหท้ราบ 

2. เมืѷอสรา้งสตูรคํานวณแบบ Circular Reference แลว้กดปุ่ ม Cancel เพืѷอปิดคําเตอืนบน
หนา้จอตามรปูขา้งตน้แลว้ จะพบคําวา่ Circular References: ตอ่ดว้ยตําแหน่งเซลลแ์สดง
ขึѸนตรงขอบดา้นลา่งซา้ยของจอ พรอ้มทัѸงในพืѸนทีѷตารางก็จะมเีสน้ลกูศรสนํีѸาเงนิชีѸตําแหน่ง
เซลลท์ีѷทําใหเ้กดิการอา้งองิแบบวงกลม ซึѷงหากตอ้งการให ้Excel แสดงชืѷอตําแหน่งเซลลท์ีѷ
เกีѷยวขอ้งกบัการอา้งองิแบบวงกลมดว้ย ใหส้ัѷง Formulas > Error Checking > 
Circular References แลว้จะพบตําแหน่งเซลลท์ีѷเกีѷยวขอ้งปรากฏตอ่ทา้ยคําสัѷงนีѸ 

 

3. เมืѷอตอ้งการให ้Excel ยอมรับการคํานวณแบบ Circular Reference ใหส้ัѷง File > 
Options > Formulas > กาชอ่ง Enable iterative calculation (Excel 2003 สัѷง 
Tools > Options > Calculation > กาชอ่ง Iteration) 

 

4. ชอ่ง Maximum Iterations และชอ่ง Maximum Change นัѸนไมจํ่าเป็นตอ้งเขา้ไปแกไ้ข
ตัวเลขใดๆ ซึѷง 2 ชอ่งนีѸทําหนา้ทีѷสัѷงให ้Excel คํานวณสงูสดุถงึ 100 ครั Ѹง หรอือาจไมถ่งึ 100 
ครั Ѹงก็ไดโ้ดยใหคํ้านวณจนกวา่จะพบวา่ คําตอบทีѷคํานวณไดใ้นแตล่ะรอบใหค้า่แตกตา่งกนั
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นอ้ยกวา่ .001 ก็จะหยดุคํานวณ ซึѷงการคํานวณเป็นรอบดังกลา่วนีѸจะเกดิขึѸนทันททีีѷมกีาร
สรา้งสตูรนัѸนเสร็จแลว้กดปุ่ ม Enter รบัสตูรลงไปหรอืเมืѷอมกีารกดปุ่ ม F9 เพืѷอสัѷงให ้Excel 
คํานวณ 

4.1. ใหเ้พิѷมตัวเลขจํานวนรอบสงูสดุในชอ่ง Maximum Iterations เมืѷอพบวา่ทกุครั Ѹงทีѷกดปุ่ ม 
F9 เพืѷอสัѷงคํานวณ จะไดต้ัวเลขคําตอบตา่งจากเดมิไปเสมอ ซึѷงหากเพิѷมตัวเลขในชอ่งนีѸ
แลว้กดปุ่ ม F9 พบวา่ตัวเลขผลจากการคํานวณไมเ่ปลีѷยนแปลงตอ่ไปอกี ยอ่มแสดงวา่
ไดคํ้าตอบสดุทา้ยแลว้ 

4.2. ใหป้รับตัวเลขคา่ความละเอยีดในชอ่ง Maximum Change ตอ่เมืѷอตอ้งการให ้Excel 
คํานวณละเอยีดขึѸน ซึѷงยอ่มทําใหต้อ้งใชจํ้านวนครั Ѹงในชอ่ง Maximum Iterations 
เพิѷมขึѸนตามไปดว้ย 

5. หลังจากสัѷงคําสัѷงตามขอ้ 3 แลว้ จะไมพ่บขอ้ความหรอืตําแหน่งเซลลท์ีѷแสดงบนหนา้จอตาม
ตําแหน่งตา่งๆทีѷเคยแสดงไวต้ามขอ้ 2 อกีตอ่ไป แตจ่ะพบคําวา่ Calculate แสดงคา้งอยูต่รง
ขอบจอดา้นลา่งซา้ยของโปรแกรม Excel แทน และขอใหส้งัเกตวา่ทกุครั Ѹงทีѷกดปุ่ ม F9 จะ
ทําใหคํ้าวา่ Calculate นีѸหายไปชัѷวขณะหนึѷงแลว้กลับมาแสดงใหม ่(โดย
ไมเ่กีѷยวขอ้งกบัการสัѷงใหคํ้านวณแบบ Manual ทีѷจะมคํีาวา่ Calculate 
แสดงขึѸนมาเชน่กนั แตเ่มืѷอกดปุ่ ม F9 เพืѷอสัѷงคํานวณแบบ Manual จะทํา
ใหคํ้าวา่ Calculate หายไปโดยไมก่ลับมาใหมอ่กี) 

6. ในกรณีทีѷตอ้งการตรวจสอบทีѷไปทีѷมาของสตูรทีѷมกีารใชตํ้าแหน่งอา้งองิแบบวงกลมวา่มี
เซลลใ์ดทีѷเกีѷยวขอ้งบา้ง ใหย้อ้นกลับไปตดักาชอ่ง Enable iterative calculation ทิҟง
ไป จากนัѸน Excel จะแสดงตําแหน่งเซลลท์ีѷเกีѷยวขอ้งไวท้ีѷคําสัѷง Formulas > Error 
Checking > Circular References ซึѷงเซลลเ์หลา่นัѸนอาจจะเป็นเซลลส์ตูรทีѷสรา้งไว ้
อยา่งตั Ѹงใจหรอืเผลอแกไ้ขสตูรใหต้า่งจากเดมิไปจนทําใหเ้กดิ Circular reference ขึѸนก็ได ้
จากนัѸนใหท้ยอยลบสตูรในเซลลด์ังกลา่วทิѸงไปทลีะเซลล ์จนกวา่จะพบวา่เมืѷอลบสตูรใน
เซลลใ์ดเสร็จแลว้ ทําใหไ้มเ่กดิคําเตอืน Circular ตอ่ไปอกี หลังจากนัѸนจงึไลส่รา้งสตูรใหม่
ขึѸนมาแทน ซึѷงหลายๆครั Ѹงจะพบวา่ตอ้งไลล่บสตูรในเซลลท์ิѸงแลว้ตอ้งสรา้งสตูรใหมนั่บรอ้ย
นับพันเซลลท์เีดยีว โดยเฉพาะตารางคํานวณทีѷตอ้งคํานวณรายการรายวันหรอืรายเดอืนตอ่
กนัไปเป็นตารางขนาดใหญ ่ดังนัѸนผูใ้ช ้Excel ทกุคนตอ้งรูต้ัวทันทเีมืѷอตัวเองเผลอสรา้งสตูร
ทีѷมตํีาแหน่งอา้งองิแบบวงกลมขึѸนมาเป็นครั Ѹงแรก หากปลอ่ยไวก้็จะตอ้งเสยีแรงเสยีเวลาไล่
ยอ้นมาแกไ้ขกนัใหมท่ลีะเซลล ์

7. เซลลท์ีѷทําใหเ้กดิ Circular นีѸ ควรใสส่ใีหต้า่งจากเซลลอ์ืѷน หรอืทําเครืѷองหมายพเิศษ หรอื
เขยีนอธบิายกํากบัไวด้ว้ยเพืѷอเตอืนผูใ้ชง้านใหแ้กไ้ขสตูรอยา่งระมัดระวัง 

8. ควรตั Ѹงชืѷอแฟ้มทีѷมสีตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลมใหม้ชีืѷอทีѷสะดดุตา จะไดไ้มเ่ผลอเปิด
แฟ้มทีѷตอ้งคํานวณแบบ Iterations นีѸข ึѸนมาใชง้านพรอ้มกบัแฟ้มอืѷน เพราะแฟ้มอืѷนๆจะรับ
คําสัѷง Iterations นีѸตามไปดว้ยโดยไมจํ่าเป็น 

9. หากปิดโปรแกรม Excel แลว้เปิด Excel ขึѸนมาใหม ่จะพบวา่ Excel ตัดกาชอ่ง Enable 
iterative calculation ทิѸงไปใหเ้สมอ 
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เคล็ดลบัอืѷนๆเกีѷยวกบัการใชต้ําแหนง่อา้งองิ 

1. ในกรณีตอ้งการหายอดรวมทกุชทีจากตําแหน่งเซลลเ์ดยีวกนั ใหส้รา้งสตูรหายอดรวมแบบ 
3 มติ ิซ ึѷงจะอยูใ่นโครงสรา้งสตูร =SUM(ชืѷอชทีแรก:ชืѷอชทีสดุทา้ย!ตําแหน่งเซลล)์ เชน่ 
=SUM(Sheet1:Sheet3!A1) ทําหนา้ทีѷหายอดรวมของเซลล ์A1 ทีѷอยูใ่นชที Sheet1 ถงึ 
Sheet3 ดังนัѸนหากตอ้งการใหร้วมขอ้มลูจากชทีใด ใหย้า้ยชทีนัѸนไปวางไวร้ะหวา่ง Sheet1 
ถงึ Sheet3 

1.1. ใหเ้ลอืกเซลลคํ์าตอบ พมิพ ์=sum( 

1.2. คลกิเซลลใ์นชทีแรกทีѷตอ้งการ 

1.3. กดปุ่ ม Shift คา้งไวแ้ลว้คลกิชทีสดุทา้ยทีѷตอ้งการ 

1.4. กดปุ่ ม Enter 

2. หากตอ้งการหายอดรวมจากทกุชทีเวน้ชทีทีѷสรา้งสตูรนีѸลงไป ใหพ้มิพส์ตูร =SUM('*'!
ตําแหน่งเซลล)์ เชน่ เมืѷอสรา้งสตูร =SUM('*'!A1) ลงไปในชที Sheet1 จะไดส้ตูร 
=SUM(Sheet2:Sheet3!A1) 

3. ในกรณีทีѷตอ้งการปรับโครงสรา้งของตารางในชทีหนึѷงๆใหเ้ป็นหลายแบบ โดยไมจํ่าเป็นตอ้ง
สรา้งชทีใหมส่ําหรับโครงสรา้งตารางแตล่ะแบบ แตใ่หป้รับโครงสรา้งในชทีเดมิชทีเดยีวนัѸน
แลว้สัѷงให ้Excel จดจําโครงสรา้งหนา้ตาตารางโดยสัѷง View > Custom Views > Add 
จากนัѸนใหต้ั Ѹงชืѷอหนา้ตาโครงสรา้งตารางนัѸนลงไป แลว้เมืѷอใดทีѷตอ้งการแสดงหนา้ตาตาราง
ชืѷอใดใหส้ัѷง View > Custom Views แลว้เลอืกชืѷอ View ทีѷเคยตั Ѹงชืѷอไว ้(วธินีีѸสามารถตั Ѹง
ชืѷอ View ขา้มชทีไดด้ว้ย ทําใหไ้มต่อ้งพึѷงชืѷอชที แถมยัง
ชว่ยปรับ Print settings และ Filter settings ตามแบบ
ทีѷกําหนดไวใ้นขณะทีѷตั Ѹงชืѷอใหทั้นท)ี 

4. ขอใหอ้อกแบบชทีทกุชทีทีѷเก็บขอ้มลูประเภทเดยีวกนัไว ้
ใหใ้ชตํ้าแหน่งเซลลเ์ดยีวกนัของทกุชที โดยไมต่อ้ง
คํานงึวา่บางชทีจะมขีอ้มลูครบหรอืไม ่จากนัѸนใหส้ัѷง Hide รายการทีѷไมม่ขีอ้มลูนัѸนออกไป 
และใหใ้ช ้Custom View ชว่ยบันทกึแบบโครงสรา้งตารางทั Ѹงกอ่นและหลังการ Hide ไวด้ว้ย 

5. พยายามหลกีเลีѷยงการใชเ้ซลลใ์ดๆใน Column A และ Row 1 ทัѸงนีѸเพืѷอทําใหภ้าพตารางทีѷ
แสดงบนจอดไูมอ่ดึอดั และยังสามารถปรับขนาดความสงูความกวา้งของ Column A และ 
Row 1 เพืѷอชว่ยปรับตําแหน่งตารางในหนา้กระดาษพมิพไ์ดด้กีวา่การกําหนด Margin แต่
เพยีงอยา่งเดยีว 

6. หา้ม Merge เซลลท์ีѷเกีѷยวขอ้งกบัการคํานวณ เพราะตําแหน่งอา้งองิในสตูรทีѷอา้งถงึเซลลท์ีѷ 
Merge กนัไวนั้Ѹนอาจใหตํ้าแหน่งอา้งองิทีѷคลาดเคลืѷอนจากความเป็นจรงิเมืѷอมกีาร Copy 
สตูรทีѷอา้งองิถงึตําแหน่งเซลลท์ีѷ Merge ไปใชท้ีѷเซลลอ์ืѷน ดังนัѸนหากตอ้งการปรับการแสดง
ขอ้มลูใหเ้ห็นวา่อยูก่ลางชว่งเซลลเ์ชน่เดยีวกบั Merge แตว่า่เซลลแ์ตล่ะเซลลย์ังคงเป็น
เซลลข์องมันเองโดยมไิดร้วมเป็นเซลลเ์ดยีวอยา่ง Merge แตอ่ยา่งใด ใหเ้ลอืกชว่งเซลลนั์Ѹน
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แลว้คลกิขวา สัѷง Format Cells > Alignment > Center Across Selection  

 

7. ในกรณีทีѷตอ้งการ Cut ตารางจากชทีหนึѷงไปยังชทีอืѷนหรอืแฟ้มอืѷน ใหเ้ริѷมจากเลอืกพืѸนทีѷ
ตารางทีѷตอ้งการจะ Cut ไปทัѸงหมด (โดยตอ้งตรวจสอบวา่เป็นพืѸนทีѷตารางทั Ѹงหมดทีѷมสีตูรทีѷ
เกีѷยวขอ้งกนั มฉิะนัѸนจะมเีซลลส์ตูรบางเซลลท์ีѷกลายเป็นสตูร link ขา้มแฟ้ม) จากนัѸนเมืѷอ
ตอ้งการ Paste สามารถเลอืก Paste ทีѷเซลลใ์ดในชทีใหมก่็ได ้โดย Excel จะปรับตําแหน่ง
อา้งองิตามตําแหน่งในชทีใหมใ่หเ้อง 

8. ในกรณีทีѷตอ้งการ Copy ตารางจากชทีหนึѷงไปยังชทีอืѷนหรอืแฟ้มอืѷน ใหเ้ริѷมจากเลอืกพืѸนทีѷ
ตารางทีѷตอ้งการจะ Copy จากนัѸนเมืѷอตอ้งการ Paste ใหเ้ลอืกเซลลใ์นชทีใหมท่ีѷเป็นเซลล์
เดยีวกบัเซลลแ์รกของตารางทีѷ Copy ไวก้อ่น แลว้จงึสัѷง Paste  

9. หากตอ้งการป้องกนัไมใ่หผู้อ้ืѷนนําแฟ้มไปแกไ้ขสตูร ไมจํ่าเป็นตอ้ง Protect Sheet ก็ได ้แต่
ใหส้ัѷงตัดเครืѷองหมาย $ ออกจากเซลลส์ตูรทกุเซลลโ์ดยใชคํ้าสัѷง Replace เพืѷอทําใหส้ตูร
ทั Ѹงหมดถกูแกไ้ขหรอืสรา้งใหมไ่ดย้ากมาก (น่าสงัเกตวา่พอตัดเครืѷองหมาย $ ทิѸงไป แฟ้มจะ
มขีนาดใหญข่ึѸน) 

10. หากตอ้งการป้องกนัการ Insert Row หรอื Insert Column ในพืѸนทีѷชว่งใด ใหส้รา้งสตูร 
Array ลงไปพรอ้มกนัเป็นรั ѸวขอบเขตนัѸน เชน่ เลอืกเซลล ์A1:A10 แลว้พมิพส์ตูร =0 หรอื 
=”” (=”” นีѸ จะกลายเป็นรั Ѹวไฟฟ้าทีѷมองไมเ่ห็นขอ้มลูในเซลลร์ั ѸวนัѸนดว้ย)แลว้กดปุ่ ม 
Ctrl+Shift+Enter ลงไป จะไดร้ั Ѹวป้องกนัการ Insert Row ในชว่ง Row 1 ถงึ Row 10 

11. หากตอ้งการใช ้Windows Explorer ในการ copy แฟ้ม Excel ทีѷ link กนัหลายๆแฟ้มไปเก็บ
ทีѷ drive อืѷนหรอืโฟลเดอรอ์ืѷน ให ้Copy ทั Ѹงโฟลเดอรท์ีѷเก็บแฟ้มทีѷ link กนันัѸนไปพรอ้มกนั
ทั Ѹงหมด เชน่ ใน ถา้เก็บแฟ้มทีѷ link กนัไวใ้นโฟลเดอรช์ืѷอ MyExcelFile ก็ให ้Copy ตัว
โฟลเดอร ์MyExcelFile ซึѷงมแีฟ้มทีѷ link กนัอยูภ่ายในนัѸนไปทัѸงชดุ โดยในโฟลเดอรช์ืѷอ 
MyExcelFile อาจมโีฟลเดอรย์อ่ยสรา้งไวด้ว้ยก็ได ้เมืѷอ Copy ไปไวท้ีѷ drive อืѷนแลว้ คณุจะ
เปลีѷยนชืѷอโฟลเดอร ์MyExcelFile เป็นชืѷออืѷนก็ได ้แตห่า้มเปลีѷยนชืѷอโฟลเดอรย์อ่ยเพราะสตูร 
link ในแฟ้ม Excel จะจําชืѷอโฟลเดอรย์อ่ยไวใ้นสตูร (แตไ่มจํ่าชืѷอโฟลเดอร ์MyExcelFile) 

12. แทนทีѷจะจัดเก็บแฟ้มไวใ้นชืѷอเดมิ ขอใหจั้ดเก็บแฟ้มในชืѷออืѷนทกุครั Ѹงทีѷมกีารแกไ้ขใดๆใน
แฟ้มนัѸน ทั ѸงนีѸเพืѷอทําใหม้แีฟ้มเกา่เก็บไวห้ลายๆรุน่ ดกีวา่การมแีฟ้มรุน่เดยีวแฟ้มเดยีว ซึѷง
เสีѷยงหากแฟ้มนัѸนอาจเสยีหายจนเปิดไมไ่ด ้
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แป้นพมิพล์ดัทีѷเกีѷยวขอ้งกบัตําแหนง่อา้งองิและขอบเขตพืҟนทีѷตาราง 
 

F2 ใชแ้กไ้ขขอ้มลูหรอืสตูรในเซลล ์

F3 ใชใ้สช่ืѷอตําแหน่งเซลลห์รอืชืѷอสตูรทีѷตั Ѹงไวใ้นแฟ้มนัѸนๆลงไปในสตูร  
หรอืสัѷง Paste List ตอ่ จะสรปุชืѷอทีѷตั Ѹงไวทั้ Ѹงหมดลงไปในตาราง 

F4 ใชใ้สเ่ครืѷองหมาย $ กํากบัตําแหน่งอา้งองิ  
หรอืสัѷงทวนคําสัѷงสดุทา้ยซํѸา 

F5 ใชห้าเซลล ์ตามตําแหน่งหรอืชืѷอตําแหน่งเซลลท์ีѷทราบ 
หรอืสัѷง Special ตอ่ จะคน้หาตําแหน่งเซลลไ์ดอ้กีหลายแบบ 

F8 ใชค้วบคมุตําแหน่งเซลลแ์รกไวไ้มใ่หข้ยับเพืѷอขยายตาราง (Extend) 

F9 ใชส้ัѷงคํานวณทกุชทีทกุแฟ้มทีѷเปิดขึѸน 

Shift + F9 ใชส้ัѷงคํานวณเฉพาะชทีทีѷเลอืกอยูช่ทีเดยีวเทา่นัѸน 

F2 ตามดว้ย F9 ใชแ้กะสตูรในเซลลเ์พืѷอดวูา่มคีา่ทีѷแทจ้รงิเป็นอยา่งไร แลว้กด Esc 

Ctrl + * หรอื Ctrl+a ใชเ้ลอืกพืѸนทีѷตารางซึѷงมขีอ้มลูตดิตอ่กนัไป (Current Region) 

Ctrl + . ใชย้า้ย Active Cell ไปตามเซลลห์ัวมมุของตารางทีѷเลอืกไว ้

Ctrl + Shift +  

Shift + End  

ใชเ้ลอืกพืѸนทีѷตารางจากเซลลท์ีѷเลอืกไวไ้ปจนสดุทางดา้นขวา  
หรอืตามทศิทางของลกูศรทีѷกด 

Ctrl + PgUp ใชเ้ลอืกชทีถัดไป 

Ctrl + PgDn ใชเ้ลอืกชทีกอ่นหนา้ 

Ctrl + Tab ใชเ้ลอืกแฟ้มถัดไปทีѷเปิดอยู ่

Ctrl + Shift + Tab ใชเ้ลอืกแฟ้มกอ่นหนา้ทีѷเปิดอยู ่

Ctrl + Shift + Enter ใชส้รา้งสตูร Array ซึѷงจะมเีครืѷองหมาย { } ปิดหัวทา้ยสตูร 
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วธิใีช ้Excel วเิคราะหท์างออกทีѷเป็นไปไดท้างธุรกจิ 
 

การประกอบธรุกจิยคุนีѸทําไดย้ากกวา่ยคุกอ่นมาก แมจ้ะสามารถระดมสมองรวมพลังผูม้คีวามรู ้
ความสามารถมาชว่ยคดิชว่ยทําไดก้็ตาม แตคู่แ่ขง่ทางการคา้ก็สามารถคดิแบบเดยีวกนัได ้
เชน่กนั นาย Bill Gates ผูก้อ่ตั Ѹงบรษัิท Microsoft ถงึกบักลา่ววา่ ในยคุกอ่นผูท้ีѷมขีอ้มลูคอืผูท้ีѷมี
อํานาจ แตเ่ดีѺยวนีѸเรามขีอ้มลูมากเสยีจนไมส่ามารถนําขอ้มลูมาใชป้ระโยชนไ์ดเ้ต็มทีѷ ผูท้ีѷสามารถ
ใชข้อ้มลูเหลา่นัѸนไดเ้ร็วทีѷสดุตา่งหากคอืผูท้ีѷจะมอํีานาจในปัจจบุัน ความเร็วทีѷวา่นีѸก็ตอ้งรวดเร็ว
แบบฉับพลันทันท ีใครก็ตามทีѷสามารถใชข้อ้มลูเพืѷอตัดสนิใจแลว้ฉวยโอกาสหาทางออกไดเ้ร็ว
กวา่ ผูนั้Ѹนจงึจะเป็นผูช้นะ 

โปรแกรม Microsoft Excel มเีครืѷองมอืหลายอยา่งทีѷเราสามารถนํามาชว่ยในการตัดสนิใจหา
ทางออกใหก้บัธรุกจิ ไดแ้ก ่Goal Seek, Data Table, Scenarios, Solver, และ Pivot Table  

 เครืѷองมอืทีѷใชว้เิคราะหห์าทางออกในอนาคต ไดแ้ก ่Goal Seek, Data Table, 
Scenarios, และ Solver เรยีกวา่เป็นเครืѷองมอืทีѷใชใ้นงาน Sensitivity Study (หรอื 
Sensitivity Analysis หรอืใน Excel 2007 เรยีกเครืѷองมอืนีѸวา่ What-If Analysis) ซึѷง
เป็นเนืѸอหาทีѷจะนํามาเลา่สูก่นัฟังในบทความนีѸ 

 เครืѷองมอืทีѷใชว้เิคราะหข์อ้มลูในอดตีมาดผูลในปัจจบุัน ไดแ้ก ่Pivot Table 

 

เร ิѷมจากแยกตวัแปรคอืประตสููท่างออก 
หากในเซลลห์นึѷงมสีตูรทีѷสรา้งไวเ้ป็น =2*3 ชว่ยกนัพจิารณาดวูา่การสรา้งสตูรแบบนีѸไมด่ี
อยา่งไร  

สตูรทีѷพมิพค์า่คงทีѷเป็นตัวเลข 2 ตัวเลข 3 แลว้นํามาคณูกนัแบบนีѸมชีืѷอเรยีกวา่ Hard Code แปล
ตามตัวหนังสอืก็มคีวามหมายวา่เป็นรหัสทีѷยากตอ่การแกไ้ข เพราะถา้วันหนึѷงคณุตอ้งการแกไ้ข
สตูรจากเดมิ =2*3 เป็น =5*3 วันนัѸนคณุก็ตอ้งเปิดแฟ้มขึѸนมาแลว้คน้หาใหพ้บกอ่นวา่เซลลท์ีѷมี
สตูร =2*3 ทีѷตอ้งการแกไ้ขนัѸนอยูท่ีѷเซลลใ์ดชทีใด แลว้ก็ตอ้งคลกิเขา้ไปแกส้ตูรใหมเ่ป็น =5*3 

ถา้ในแฟ้มนัѸนมเีซลลส์ตูรคํานวณอยูนั่บพันนับหมืѷนเซลล ์กวา่จะคน้หาจนพบเซลลท์ีѷตอ้งการ ก็
ตอ้งเสยีเวลาไมใ่ชน่อ้ย ยิѷงมหีลายเซลลซ์ึѷงมสีตูร =2*3 เหมอืนกนั ยิѷงเกดิความเสีѷยงหากเผลอ
ไปแกไ้ขผดิเซลล ์และความผดิพลาดเล็กนอ้ยแบบนีѸแหละทีѷจะปิดประตสููท่างออกของคณุ 

คอมพวิเตอรจ์ะเป็นคอมพวิเตอรไ์ดอ้ยา่งสมบรูณ์และคณุสามารถนํา Goal Seek, Data Table, 
Scenarios, และ Solver มาใชไ้ดต้อ้งเริѷมจากการแยกตัวแปรออกนอกสตูรไวก้อ่น ดังนัѸนแทนทีѷ
จะสรา้งสตูร =2*3 ลงไป ใหเ้ลอืกเซลลร์ับตัวเลข 2 และอกีเซลลห์นึѷงรับตัวเลข 3 จากนัѸนจงึนํา
เซลลทั์ Ѹงสองมาคณูกนัไดผ้ลลัพธเ์ป็นเลข 6 
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 เซลล ์B2 เป็นเซลลร์ับตัวแปร มคีา่เป็นเลข 2 

 เซลล ์C2 เป็นเซลลร์ับตัวแปร มคีา่เป็นเลข 3 

 เซลล ์D2 เป็นเซลลส์ตูรคํานวณหาผลลัพธ ์มสีตูร =B2*C2 

 

หลกัการแยกตวัแปร 

1. ตัวแปร คอื คา่ทีѷมนุษยส์ามารถกําหนดใหม้คีา่เปลีѷยนแปลงตา่งไปจากเดมิ ตัวแปรอาจ
เป็นไดทั้ Ѹงคา่ทีѷเป็นตัวเลข ตัวอกัษร หรอืแมแ้ตส่ตูร 

2. เซลลร์ับตัวแปรอาจใชเ้ซลลเ์ดยีวหรอืหลายเซลล ์ขึѸนกบัประเภทของตัวแปรนัѸนๆวา่มกีาร
เปลีѷยนแปลงไปตามระยะเวลาหรอืเงืѷอนไขอืѷนใดหรอืไม ่ถา้เป็นคา่คงทีѷซ ึѷงใชค้า่เดยีวไป
ตลอด ก็สามารถใชเ้ซลลร์ับคา่เพยีงคา่เดยีวเซลลเ์ดยีวในแฟ้มหนึѷง แตถ่า้เป็นคา่ทีѷมี
ความผันผวนเปลีѷยนแปลงไปตามระยะเวลาก็จําเป็นตอ้งใชห้ลายเซลล ์เชน่ ตัวแปร
ประเภทราคาสนิคา้ ควรกําหนดใหแ้ตล่ะชว่งเวลามรีาคาสนิคา้แตกตา่งกนัไปเพืѷอใหเ้กดิ
ความยดืหยุน่ในการคํานวณ ก็จําเป็นตอ้งใชห้ลายเซลลเ์พืѷอรับตัวแปรประเภทราคา
สนิคา้ทีѷมยีอดตา่งกนัไปในแตล่ะชว่งเวลา 

3. ควรคดิเผืѷอไวต้ั Ѹงแตต่น้เสมอวา่ คา่คงทีѷทกุคา่เป็นตัวแปรทีѷคา่อาจเปลีѷยนแปลง เพราะ
คา่คงทีѷใดๆทีѷคดิวา่คงทีѷในวันนีѸ อาจเป็นไปไดว้า่ไมใ่ชค่า่ทีѷจะคงทีѷไปตลอด ดังนัѸนหาก
ไมม่ัѷนใจวา่จะคงทีѷไปตลอดหรอืไม ่ควรออกแบบตารางตั Ѹงแตแ่รกเผืѷอไวใ้หส้ามารถ
เปลีѷยนแปลงตัวแปรตามระยะเวลาไดด้ว้ย เชน่ อตัราภาษีธรุกจิเฉพาะ ซึѷงอาจถกู
ปรับเปลีѷยนใหต้า่งไปจากเดมิในอนาคต 

4. ลกูเลน่ทางธรุกจิเป็นตัวแปรไดเ้หมอืนกนั อยา่คดิวา่วธิดํีาเนนิการทางธรุกจิตอ้งเป็นแบบ
ปัจจบุันไปตลอด คณุตอ้งเผืѷอเซลลร์ับตัวแปรทีѷอาจเกดิขึѸนหรอืไมเ่กดิขึѸนไวก้อ่นตั Ѹงแต่
แรก ดกีวา่ทีѷจะยอ้นกลับไปแกไ้ขตารางแทรกตัวแปรเพิѷมในภายหลัง ขอใหอ้อกแบบ
โครงสรา้งตารางเผืѷอไวก้อ่นดกีวา่ขาด 

5. ในกรณีทีѷตัวแปรมเีงืѷอนไขซบัซอ้น ควรแยกตัวแปรประเภทนัѸนไปเก็บเป็นตารางเฉพาะ
หรอืเป็นชทีเฉพาะหรอืแมแ้ตเ่ป็นแฟ้มเฉพาะสําหรับตัวแปรนัѸนๆ โดยใหอ้อกแบบตาราง
ตามแบบโครงสรา้งฐานขอ้มลูทีѷดดีว้ย 

6. ควรใสส่สีรรคใ์หเ้ห็นเซลลร์ับตัวแปรแยกชดัเจนแตกตา่งจากเซลลส์ตูรคํานวณและ
กําหนดให ้Excel เปิดรับคา่ใหมไ่ด ้โดยคลกิขวาลงไปในเซลลต์ัวแปรนัѸน สัѷง Format 
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Cells > Protection แลว้ตัดกาชอ่ง Locked ทิѸงไป จากนัѸนสัѷง Review > Protect 
Sheet (Excel 2003 สัѷง Tools > Protection > Protect Sheet) แลว้จะพบวา่เมืѷอกด
ปุ่ ม Tab จะยา้ยตําแหน่งเซลลไ์ปตามเซลลท์ีѷเป็นตัวแปรใหเ้อง 

 

วธิใีช ้Goal Seek 
เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 30 คณุก็ตอ้งตอบวา่เลข 10 เพราะคณุ
คดิสตูรคณูในใจออกมาไดทั้นทเีลยใชไ่หมวา่ 10*3 = 30 แตถ่า้เปลีѷยนโจทยใ์หมว่า่ เลขอะไร
เอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 77.77 คราวนีѸสมองของคณุก็จะคดิในใจอยา่ง
รวดเร็ววา่ “ไมไ่หว คดิไมไ่หว” ถา้ตอ้งเสยีเวลากดเครืѷองคดิเลขหรอืสรา้งสตูรเอาเลข 77.77 ตั Ѹง
แลว้หารดว้ย 3 เพืѷอหาเลขอะไรเอย่ตัวนัѸนก็ได ้ยอ่มแสดงวา่คณุใช ้Goal Seek ไมเ่ป็น 

Goal Seek เป็นเครืѷองมอืทีѷชว่ยคดิยอ้นโดยคณุไมต่อ้งเสยีเวลาสรา้งสตูรใหมเ่พืѷอคดิยอ้นเอง
แมแ้ตน่อ้ย เพยีงแตว่า่ Goal Seek จะทํางานไดต้อ่เมืѷอมเีซลลร์ับตัวแปรทีѷสามารถถกู Excel ทํา
หนา้ทีѷเปลีѷยนแปลงเป็นเลขใหมต่ามตอ้งการ แตห่ากเป็นเซลลส์ตูรจะไมส่ามารถใช ้Goal Seek 
เขา้ไปแกไ้ขสตูรใดๆในเซลลใ์หเ้ป็นคา่ใหมไ่ด ้

จากโจทยเ์ดมิ เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 77.77 

1. สรา้งตัวอยา่ง 2*3 ได ้6 ตามตัวอยา่งทีѷผา่นมา 

2. สัѷง Data > What-If Analysis > Goal Seek (Excel 2003 สัѷง Tools > Goal Seek) 

 

3. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีѷเซลล ์D2 โดยเซลลน์ีѸตอ้งเป็นเซลลส์ตูร
คํานวณ สว่นชอ่ง To value: ใหพ้มิพเ์ลข 77.77 ลงไป แลว้ใหค้ลกิในชอ่ง By 
changing cell: แลว้คลกิตอ่ไปทีѷเซลล ์B2 โดยเซลล ์B2 นีѸตอ้งเป็นเซลลร์ับตัวแปรทีѷ
กําลังตอ้งการหา ถอืเป็นตัวเลขคําตอบใหมท่ีѷตอ้งการ 
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4. กดปุ่ ม OK จะพบวา่ Excel เปลีѷยนตัวเลข 2 ในเซลล ์B2 เป็นตัวเลข 25.92333 ซึѷงทํา
ใหเ้กดิผลลัพธท์ีѷเซลล ์C2 เป็นเลข 77.77 ตามตอ้งการ แลว้ใหก้ดปุ่ ม OK เพืѷอยอมรับ
คําตอบทีѷ Goal Seek หาให ้

 

5. หากตอ้งการหาตัวเลขคําตอบทีѷตา่งจากเดมิ ตอ้งสัѷง Data > What-If Analysis > Goal 
Seek ซํѸาเองใหม ่

คราวนีѸมาลองใช ้Goal Seek กบัปัญหาทีѷยากขึѸน โดยใหห้าวา่ตัวเลขคา่โฆษณาในเซลล ์G18 
ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขั Ѹนตน้ 

 

จากภาพตารางขา้งบนนีѸ เซลล ์G16 และเซลล ์H17 เป็นเซลลร์ับตัวแปร ซึѷงมคีา่เป็นตัวเลข
ยอดขาย 1,000 บาทและตัวเลขเปอรเ์ซน็ตต์น้ทนุขายเทา่กบั 20% ตามลําดับ สว่นเซลลส์ตูร
คํานวณมใีนเซลล ์G17 มสีตูร =H17*G16 เพืѷอหายอดตน้ทนุขายเทา่กบั 200 บาท (คดิเป็น 
20% ของยอดขาย) สว่นเซลล ์G19 เป็นเซลลส์ตูรคํานวณหากําไรขั Ѹนตน้มสีตูร =G16-G17-
G18 มาจากยอดขายหักตน้ทนุขายและหักคา่โฆษณา เซลลท์ีѷเวน้วา่งไวค้อืเซลล ์G18 ใหใ้ชห้า
คา่โฆษณา ซึѷงตอนเริѷมตน้นีѸเวน้วา่งไว ้จงึทําใหเ้ซลล ์H18 ซึѷงมสีตูรคํานวณหาสดัสว่นรอ้ยละ
ของคา่โฆษณาตอ่กําไรขั Ѹนตน้ =G18/G19 ซึѷงขณะนีѸคนืคา่เทา่กบั 0 

ตัวอยา่งนีѸไมส่ามารถใชว้ธิคีดิงา่ยๆวา่ ในเมืѷอตอ้งการคา่โฆษณาเป็น 15% ของกําไรขั Ѹนตน้ ก็ให ้
สรา้งสตูร =.15*G19 ลงในในเซลล ์G18 ก็สิѸนเรืѷอง เพราะหากสรา้งสตูร =.15*G19 ลงไปใน
เซลล ์G18 จะพบวา่เกดิการอา้งองิแบบวงกลม (ตอ้งหันไปใชก้ารคํานวณแบบ Iteration เขา้มา
ชว่ย ซึѷงเป็นอกีวธิหีนึѷงในการแกปั้ญหานีѸ) เพราะหากคา่โฆษณาเพิѷม จะทําใหก้ําไรลด แลว้พอ
กําไรลด ยอ่มสง่ผลใหค้า่โฆษณาลดตาม พอคา่โฆษณาลดลง กําไรก็ตอ้งเพิѷม กลายเป็นการ
คํานวณแบบวงกลมทีѷไมส่ามารถหาคําตอบสดุทา้ยไดโ้ดยวธิธีรรมดาทัѷวไป 

คณุสามารถแกปั้ญหานีѸโดยใช ้Goal Seek โดยเริѷมตน้จากสัѷง สัѷง Data > What-If Analysis > 
Goal Seek 
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1. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีѷเซลล ์H18 โดยเซลลน์ีѸเป็นเซลลส์ตูร
คํานวณหาวา่คา่โฆษณาเป็นรอ้ยละเทา่ใดของกําไรขั Ѹนตน้ =G18/G19 

2. ชอ่ง To value: ใหพ้มิพเ์ลข .15 ซึѷงเป็นตัวเลขคําตอบทีѷตอ้งการ 

3. คลกิในชอ่ง By changing cell: แลว้คลกิตอ่ไปทีѷเซลล ์G18 เพืѷอใหห้าตัวเลขคา่
โฆษณา 

4. กดปุ่ ม OK > OK จะไดต้วัเลขคําตอบคา่โฆษณาเทา่กบั 104.50377964375 ทีѷ Goal 
Seek คดิให ้

 

Goal Seek เป็นเครืѷองมอืพสิดารทีѷเหมาะในการวางแผนงบประมาณ ชว่ยตั Ѹงราคาขายสนิคา้เพืѷอ
ทําใหไ้ดก้ําไรตามตอ้งการ หรอืชว่ยในการคํานวณยอ้นกลับในงานทีѷคนเราคดิเองไมไ่หวได ้
อยา่งไมน่่าเชืѷอ ซึѷงในงานวางแผนตัดสนิใจนัѸน แทบเป็นไปไมไ่ดเ้ลยทีѷเราจะมคีวามเชืѷอมัѷน 
100% ตอ่คําตอบทีѷมอียูเ่สมอไป ดังนัѸนแทนทีѷจะเสีѷยงกบัการใชต้ัวเลขเพยีงตัวเดยีว ขอแนะนํา
ใหใ้ช ้Goal Seek คดิยอ้นหาชว่งคา่ทีѷเป็นไปไดว้า่อยูใ่นชว่งตัวเลขระหวา่งคา่ใด เพืѷอทําให ้
สามารถวางแผนไดอ้ยา่งยดืหยุน่มากขึѸน เชน่ เดมิเคยถามวา่ ตัวเลขคา่โฆษณาในเซลล ์G18 
ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขั Ѹนตน้ ก็ใหใ้ช ้Goal Seek คน้หาคําตอบทีѷยดืหยุน่
กวา่เดมิวา่ ตัวเลขคา่โฆษณาในเซลล ์G18 ตอ้งเป็นคา่ระหวา่งเลขใด จงึจะคดิเป็น 15% - 
20% ของกําไรขั Ѹนตน้ 
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ขอ้จํากดัของ Goal Seek และวธิแีกไ้ข 

ขอ้จํากดัทีѷสําคัญของ Goal Seek เกดิจากทกุครั Ѹงทีѷตอ้งการคดิยอ้นครั Ѹงใหม ่คณุตอ้งเป็นผูส้ัѷงให ้
Goal Seek ทํางานซํѸาดว้ยตนเอง และ Goal Seek จะยอมใหเ้ปลีѷยนแปลงตัวเลขตัวแปรไดเ้พยีง
เซลลเ์ดยีว นอกจากนีѸสว่นทีѷไมย่ดืหยุน่ทีѷสดุก็คอื คณุตอ้งกรอกตัวเลขทีѷตอ้งการลงไปในชอ่ง 
To value เองเสมอ โดยไมส่ามารถ link คา่ตัวเลขเป้าหมายทีѷตอ้งการจากเซลลเ์ขา้ไปใชใ้น 
Goal Seek จงึเป็นเครืѷองมอืทีѷไมเ่หมาะสําหรับผูท้ีѷไมเ่คยใช ้Goal Seek มากอ่น 

เราสามารถแกไ้ขจดุออ่นของ Goal Seek ใหส้ามารถรับคา่จากเซลลไ์ดโ้ดยตรง และหาทาง
ปรับปรงุให ้Goal Seek ทํางานหาคําตอบใหเ้องทันทอียา่งอตัโนมัต ิโดยเริѷมจากใช ้Macro 
Recorder บันทกึการสัѷง Data > What-If Analysis > Goal Seek แลว้ใชง้านตามตัวอยา่งการ
คํานวณหาคา่โฆษณาในตัวอยา่งทีѷผา่นมา จะไดร้หัส VBA ตามนีѸ 

Sub SetGoal() 

    Range("H18").GoalSeek Goal:=0.15, ChangingCell:=Range("G18") 

End Sub 

จากนัѸนใหแ้กไ้ขตําแหน่งอา้งองิและคา่คงทีѷในตัวรหัสใหอ้า้งถงึชืѷอ Range Name ทีѷตั Ѹงไวใ้น
ตารางกลายเป็นรหัสใหมด่ังนีѸ 

Sub SetGoal() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 

โดยกําหนดใหต้ั Ѹงชืѷอ Range Name ชืѷอวา่ MyTarget ใหก้บัเซลล ์H18 และชืѷอ ChangeCell 
ใหก้บัเซลล ์G18 และเมืѷอใดทีѷตอ้งการตัวเลขตัวใหม ่ใหก้รอกตัวเลขลงไปในเซลลท์ีѷตั Ѹงชืѷอวา่ 
TargetValue  

หากตอ้งการความสะดวกมากขึѸน ควรสัѷงให ้Goal Seek ทํางานเองโดยใช ้Event ก็จะได ้
ผลลัพธทั์นทโีดยไมต่อ้งเสยีเวลามาเปิด Goal Seek ขึѸนเพืѷอกรอกคา่เองอกีตอ่ไป เชน่ หากใช ้
Calculation Event ก็จะไดผ้ลลัพธต์ามการคํานวณใดๆทีѷเกดิขึѸนในชทีนัѸน 

Private Sub Worksheet_Calculate() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 
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วธิใีช ้Data Table 
ถา้ถามวา่ตอนเริѷมตน้ใชส้ตูรคํานวณใน Excel แรกเริѷมนัѸนคณุตอ้งรูจั้กใชอ้ะไรใหเ้ป็น ก็ตอบวา่
ตอ้งรูจั้กการกําหนดตําแหน่งอา้งองิโดยการใชเ้ครืѷองหมาย $ ควบคมุแนวของคา่ทีѷใชใ้นการ
คํานวณ แลว้ถา้ถามตอ่ไปวา่ ตอนสรา้งแฟ้มงานเสร็จแลว้ละ่ตอ้งใชอ้ะไรใหเ้ป็น คําตอบก็คอื
ตอ้งใช ้Data Table สรปุคําตอบทีѷเป็นไปไดเ้พืѷอใชต้ัดสนิใจ 

Data Table เป็นคําสัѷงทีѷมมีานานแลว้แตม่ักถกูละเลยไมส่นใจใชก้นันัก คงเป็นเพราะคําสัѷงนีѸถกู
ออกแบบมาใหอ้ยูก่นัเมนู Data จงึทําใหน้กึไปวา่เป็นคําสัѷงทีѷไมเ่กีѷยวขอ้งกบัการคํานวณ อกี
ทั Ѹงตัวอยา่งและคําอธบิายใน Help ก็มไิดใ้หร้ายละเอยีดชดัเจนนัก ผูท้ีѷจะเขา้ใจ Data Table ได ้
ก็ตอ้งลองใชคํ้าสัѷงนีѸดแูลว้จงึจะซึѸงถงึประโยชนข์องมัน 

Data Table อาศัยการออกแบบตารางแบบพเิศษทีѷจะชว่ยให ้Excel นําคา่ทีѷวางไวบ้นหัวตาราง
หรอืขา้งตารางดา้นใดดา้นหนึѷงหรอืทั Ѹงสองดา้น สง่ตอ่ไปแทนทีѷคา่หรอืสตูรทีѷบันทกึไวใ้นเซลล ์
เมืѷอคา่ในเซลลเ์หลา่นัѸนเปลีѷยนไปตามคําสัѷง Data Table ก็จะทําใหเ้ซลลส์ตูรทีѷเกีѷยวขอ้ง
คํานวณหาคําตอบใหม ่เพยีงแตก่ารเปลีѷยนแปลงคา่ในเซลลแ์ละคําตอบใหมท่ีѷเกดิขึѸนนัѸน เราจะ
ไมเ่ห็นมกีารเปลีѷยนแปลงใดๆเกดิขึѸนในตาราง แตจ่ะพบวา่ Excel นําคําตอบมาสรปุไวใ้นตาราง 
Data Table ใหเ้อง 

สําหรับผูท้ีѷคุน้เคยกบัการเขยีนโปรแกรมสําเร็จรปู การทํางานของ Data Table เปรยีบเทยีบได ้
กบัการใชร้หัสโปรแกรมสัѷงให ้Excel ทํางานซํѸาหลายครั Ѹงเป็น loop โดย Excel จะสง่คา่ไปทีѷ
เซลลท์ีѷเรากําหนดใหใ้นแตล่ะ loop ทั ѸงนีѸ Data Table จะทํางานเป็น loop ใหอ้ตัโนมัตโิดยเรา
ไมต่อ้งเสยีเวลาเขยีนโปรแกรมแมแ้ตน่อ้ย 

Data Table ม ี3 แบบตามจํานวนตัวแปรทีѷเกีѷยวขอ้ง ไดแ้ก ่

 Data Table แบบ 1 ตัวแปร  

 Data Table แบบ 2 ตัวแปร 

 Data Table แบบไมจํ่ากดัตัวแปร โดยใชร้ว่มกบัสตูร Index (กลายเป็นวธิทีีѷฉลาดกวา่
การใช ้Scenarios) 

โครงสรา้งตาราง Data Table แบง่เป็น 4 สว่น ตามรปู 
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Data Table แบบ 1 ตวัแปร 

จากตัวอยา่งการหาคา่โฆษณา หากกําหนดใหค้า่โฆษณาเป็นตัวเลขในชว่ง 100 ถงึ 400 บาท 
ใหห้าวา่จะสง่ผลตอ่กําไรขั Ѹนตน้อยา่งไร 

ทางออกในการแกปั้ญหานีѸ หากคณุไมรู่จั้ก Data Table มากอ่น ก็คงตอ้งสรา้งตารางคํานวณซํѸา
กนัหลายๆตารางเพืѷอทดลองใสต่ัวเลขคา่โฆษณาลงไปเพืѷอหาผลลัพธท์ีѷตอ้งการ 

แทนทีѷจะเสยีแรงเสยีเวลาสรา้งตารางคํานวณซํѸา ใหอ้อกแบบโครงสรา้งตาราง Data Table 
ขึѸนมากอ่น โดยในปัญหานีѸสงัเกตวา่ตอ้งการเปลีѷยนคา่โฆษณาเพยีงคา่เดยีว ดังนัѸนจงึเขา้ขา่ย 
Data Table แบบ 1 ตัวแปร ซึѷงมโีครงสรา้งแยกแยะออกไปอกี 2 แบบยอ่ยตามแตว่า่คณุ
ตอ้งการดตูัวแปรตามแนวใด ไดแ้ก ่

 Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นขา้งตามแนวตั Ѹง สว่นหัวตารางดา้นบน
เป็นสตูรคําตอบทีѷ link มา และเมืѷอสัѷง Data Table ใหเ้ลอืกใชช้อ่ง Column Input Cell 

 Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นบนตามแนวนอน สว่นหัวตารางดา้นขา้ง
เป็นสตูรคําตอบทีѷ link มา และเมืѷอสัѷง Data Table ใหเ้ลอืกใชช้อ่ง Row Input Cell 

ตัวอยา่งการใช ้Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นขา้งตามแนวตั Ѹง 

 

1. นําตัวเลขคา่โฆษณามาพมิพล์งในเซลล ์E23:E27 โดยจะกําหนดใหเ้ป็นตัวเลขใด
กอ่นหลังก็ได ้ไมจํ่าเป็นตอ้งเรยีงลําดับมากนอ้ย 

2. เซลล ์F22 และ G22 สรา้งสตูร link ผลลัพธข์องสตูรคํานวณมาจากเซลล ์G19 และ 
H18 ตามลําดับ 

3. ใหเ้ลอืกพืѸนทีѷ E22:G27 แลว้สัѷง Data > What-If Analysis > Data Table (Excel 
2003 สัѷง Data > Table) 

4. คลกิลงในชอ่ง Column input cell แลว้คลกิตอ่ไปทีѷเซลล ์G18 (เพืѷอกําหนดให ้Data 
Table ยงิตัวเลขคา่โฆษณาทีѷวางไวต้ามแนวตั Ѹงไปทีѷเซลล ์G18) แลว้กดปุ่ ม OK 

5. จะพบคําตอบปรากฏในตาราง F23:G27 และเมืѷอคลกิดจูะพบสตูร {=TABLE(,G18)} 
ซึѷงสตูรนีѸเราไมส่ามารถสรา้งเอง ตอ้งใชคํ้าสัѷง Data Table เทา่นัѸนจงึจะเกดิสตูรนีѸข ึѸน 
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และเมืѷอดใูนสตูรจะพบ (,G18) แสดงถงึการไมใ่ช ้Row Input แตใ่ช ้Column Input มี
เซลล ์G18 เป็นเซลลร์ับคา่ 

หากใชต้าราง Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นบนตามแนวนอน ตอ้งออกแบบ
ตารางตามรปูตอ่ไปนีѸ 

 
ขอ้สงัเกต 

1. Data Table แบบ 1 ตัวแปร สามารถหาคําตอบมาแสดงในตารางไดห้ลายเรืѷอง ตามแต่
วา่จะ link สตูรคําตอบเรืѷองใดมาแสดงในหัวตารางอกีขา้งหนึѷง จงึใหผ้ลลัพธไ์ดม้ากกวา่ 
Data Table แบบ 2 ตัวแปร ซึѷงแมจ้ะใชต้ัวแปรได ้2 ตัว แตจ่ะแสดงคําตอบในตารางได ้
เพยีงเรืѷองเดยีวเพราะมเีซลลห์ัวมมุเพยีงเซลลเ์ดยีว  

2. ถา้ตอ้งการใชต้ัวแปรมากกวา่ 2 ตัว หรอืตอ้งการคําตอบหลายเรืѷอง สามารถใชส้ตูร If, 
Choose หรอื Index ชว่ยทําให ้Data Table ทํางานไดไ้มจํ่ากดั 

3. สตูรทีѷ Excel สรา้งใหเ้มืѷอสรา้ง Data table เป็นสตูรทีѷถกูสรา้งขึѸนแบบ Array พรอ้มกนั
ทกุเซลล ์โดยมโีครงสรา้งสตูรดังนีѸ 
 
=Table(Row Input Cell, Column Input Cell) 
 
Data Table แบบ 1 ตัวแปร จะเกดิสตูร =Table(Row Input Cell,) เมืѷอเป็นตารางทีѷใช ้
Row Input และจะเกดิสตูร =Table(, Column Input Cell) เมืѷอเป็นตารางทีѷใช ้
Column Input สว่น Data Table แบบ 2 ตัวแปรจะเกดิสตูรทีѷใชโ้ครงสรา้งแบบเต็ม 
=Table(Row Input Cell, Column Input Cell) 

4. การอา่นผลลัพธจ์ากตาราง Data Table ตอ้งอธบิายใหช้ดัเจนวา่ ในขณะทีѷคา่โฆษณา
เปลีѷยนแปลงไปนัѸน ตัวเลขตัวแปรอืѷน ไดแ้ก ่ยอดขาย และ %ตน้ทนุขาย ถอืวา่คงทีѷ 

5. คา่โฆษณาในเซลล ์G18 จะเวน้วา่งไวห้รอืจะใสต่ัวเลขใดๆแมจ้ะสรา้งสตูรคํานวณไวก้อ่น
หรอืหลังการสัѷง Data Table ก็ได ้เพราะไมม่ผีลตอ่การคํานวณใน Data Table 

6. ตาราง Data Table ไมส่ามารถถกู Copy ออกไปใชท้ีѷอืѷน เพราะเมืѷอ Paste จะพบวา่สตูร 
Table ในตารางถกูเปลีѷยนเป็นตัวเลขคา่คําตอบแทนทกุเซลล ์
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7. เราไมส่ามารถ Insert แทรกเซลลส์ตูร Table และหากตอ้งการลบสตูร Table ทิѸง ตอ้ง
เลอืกพืѸนทีѷตารางทั Ѹงหมดทีѷมสีตูร Table แลว้จงึจะสามารถลบสตูรทิѸงพรอ้มกนัทกุเซลล ์

 

Data Table แบบ 2 ตวัแปร 

ในตัวอยา่งเดมิ หากตอ้งการวเิคราะหว์า่ถา้เราเปลีѷยนแปลงตน้ทนุขายและคา่โฆษณาจะมผีล
อยา่งไรบา้งตอ่ยอดกําไรขั Ѹนตน้ 

 

1. พมิพต์ัวแปรตน้ทนุขายไวใ้นเซลล ์F22:H22 ซึѷงถอืเป็น Row Input 

2. พมิพต์ัวแปรตน้คา่โฆษณาไวใ้นเซลล ์E23:E27 ซึѷงถอืเป็น Column Input 

3. ในเซลลห์ัวมมุตาราง E22 สรา้งสตูร =G19 เพืѷอ link สตูรคํานวณหากําไรขั Ѹนตน้มาใช ้

4. จากนัѸนใหเ้ลอืกพืѸนทีѷตั Ѹงแต ่E22:H27 แลว้สัѷง Data > What-If Analysis > Data 
Table (Excel 2003 สัѷง Data > Table) 

5. คลกิลงไปในชอ่ง Row Input Cell แลว้คลกิตอ่ไปยังเซลล ์G17 ซึѷงเป็นเซลลต์น้ทนุ
ขาย 

6. คลกิลงไปในชอ่ง Column Input Cell แลว้คลกิตอ่ไปยังเซลล ์G18 ซึѷงเป็นเซลลค์า่
โฆษณา แลว้กดปุ่ ม OK จะพบคําตอบของกําไรขั Ѹนตน้ แสดงในตาราง F23:H27 

 

เมืѷอนํา Data Table มาเปรยีบเทยีบกบั Goal Seek มขีอ้สงัเกตดังนีѸ 

1. Data Table สามารถสง่คา่ตัวแปรใหมค่รั Ѹงละหลายตัวไปแทนทีѷเซลลท์ีѷมสีตูรสรา้งไว ้ซึѷง 
Excel จะคํานวณใหต้ามคา่ตัวแปรใหมนั่Ѹน โดยถอืวา่ไมไ่ดใ้ชส้ตูรทีѷสรา้งไวก้อ่นแลว้ในเซลล์
นัѸนมาใชคํ้านวณรว่มดว้ยแตอ่ยา่งใด สว่น Goal Seek สามารถสง่ตัวแปรใหมไ่ปไดค้รั Ѹงละ 1 
ตัวและไมส่ามารถสง่ตัวแปรไปแทนเซลลท์ีѷเป็นสตูร 
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2. Data Table เหมาะกบัการใชว้างแผนระยะยาว โดยกําหนดคา่ตัวแปรบนหัวตารางให ้
ครอบคลมุชว่งคา่ทีѷเป็นไปไดเ้พืѷอดผูลลัพธท์ีѷเกดิขึѸนในชว่งคา่นัѸนๆซึѷงอาจไมไ่ดคํ้าตอบตรง
กบัคา่เป้าหมายทีѷตอ้งการ สว่น Goal Seek เหมาะสําหรับการวเิคราะหห์าตัวเลขเฉพาะกจิ 
ซึѷงจะคดิยอ้นกลับจนไดต้ัวเลขตามตอ้งการ 

3. เราสามารถสัѷง Formulas > Calculation Options > Automatic Except for Data Tables 
(Excel 2003 สัѷง Tools > Options > Calculation > Automatic except tables) เพืѷอ
กําหนดใหใ้ชก้ารกดปุ่ ม F9 เพืѷอสัѷงให ้Data Table คํานวณเฉพาะเมืѷอตอ้งการเทา่นัѸน สว่น 
Goal Seek แมว้า่จะพบวา่ใชก้บัการคํานวณแบบ Automatic หรอื Manual ก็ได ้แตเ่ราควร
ใช ้Goal Seek รว่มกบัการคํานวณแบบ Automatic ไวก้อ่น เพืѷอชว่ยทําใหม้ัѷนใจวา่เซลล์
สตูรทีѷเกีѷยวขอ้งถกูคํานวณตามกนัไปครบทัѸงหมดดว้ย 

4. เนืѷองจากเราเป็นผูก้ําหนดคา่ตัวแปรใหใ้ชก้บั Data Table ดังนัѸน Excel จะถกูสัѷงใหคํ้านวณ
ตามคา่ตัวแปรเหลา่นัѸนจนครบทกุตัว สว่น Goal Seek จะคํานวณยอ้นกลับใหเ้องแตอ่าจได ้
คําตอบเฉพาะในชว่งคา่ทีѷ Excel คน้หาใหเ้ทา่นัѸน  

5. หาก Data Table ไมส่ามารถหาคําตอบทีѷตอ้งการ ก็สามารถใช ้Goal Seek ทํางานตอ่บน
ตาราง Data Table โดยใหใ้ช ้Goal Seek คดิยอ้นหาคา่ตัวแปรบนหัวตาราง Data Table 
จนกวา่จะคํานวณไดคํ้าตอบมาปรากฏขึѸนในพืѸนทีѷสว่นของคําตอบในตาราง Data table 

 

Data Table แบบไมจ่ํากดัตวัแปร 

วธิดีัดแปลง Data Table ใหทํ้างานไดไ้มจํ่ากดัตัวแปร เป็นเคล็ดลับทีѷผมคน้พบตั Ѹงแตส่มัย
ทํางานวเิคราะหโ์ครงการลงทนุใหก้บับรษัิทซพี ีตอนนัѸนยังไมย่อมเปิดเผยเคล็ดลับนีѸกบัใคร
เพราะถอืวา่เป็นวธิทีีѷทําใหส้ามารถใช ้Excel วเิคราะหว์างแผนไดไ้มจํ่ากดั และยังไมเ่คยพบวา่มี
ฝรัѷงชาตอิืѷนคนใดทราบวธิทีีѷผมใช ้แตพ่อผมเปลีѷยนอาชพีมาเป็นวทิยากรก็ตั Ѹงใจวา่จะเปิดเผยให ้
เรยีนรูอ้ยา่งไมต่อ้งปิดบังกนัแตอ่ยา่งใด 

สมัยทีѷทํางานอยูบ่รษัิทซพี ีผมคยุใหห้ัวหนา้ทีѷเป็นคนจนีเชืѸอสายฝรัѷงฟังวา่ ผมสามารถใช ้
โปรแกรม Lotus 1-2-3 วเิคราะหโ์ครงการไดอ้ยา่งไมจํ่ากดัตัวแปร ชว่งแรกเขายังสงสยัวา่ทีѷผม
วา่ไมจํ่ากดัตัวแปรนัѸนเป็นอยา่งไร หัวหนา้คนนีѸขอใหผ้มสาธติวธิกีารใหเ้ขาด ูพอเขาเห็นวธิทีีѷผม
ใชว้า่สามารถชว่ยใหว้เิคราะหโ์ครงการไดย้ดืหยุน่เพยีงใด เขาก็สัѷงงานผมเพิѷมขึѸนถงึ 6 เทา่ตัว
ทเีดยีว (แมง้านจะหนักขึѸนแตผ่มมคีวามภมูใิจเป็นอยา่งมากเพราะหัวหนา้ใหเ้กยีรตลิงมานัѷงทีѷ
โตะ๊กบัผมเพืѷอใหผ้มสาธติใหด้ ูซึѷงหัวหนา้คนนีѸมตํีาแหน่งใหญเ่ป็นอนัดับสองของซพีทีเีดยีว 
และในชัѷวชวีติของผมก็มหีัวหนา้คนนีѸเพยีงคนเดยีวทีѷยอมมานัѷงขา้งๆเพืѷอดผูมทําคอมพวิเตอร)์ 

หลักการทีѷชว่ยทําให ้Data Table คํานวณไดไ้มจํ่ากดัตัวแปร เกดิจากการนําสตูร Index ดงึตัว
แปรแตล่ะชดุไปแทนทีѷตัวแปรทีѷใชต้ามปกต ิ(โดยตัวแปรแตล่ะชดุมจํีานวนตัวแปรนับรอ้ยนับพัน
ตัวไดไ้มจํ่ากดั) แทนทีѷจะใช ้Data table สง่คา่ตัวแปรทีѷใชคํ้านวณไปยัง Row Input Cell หรอื 
Column Input Cell โดยตรง ใหเ้ปลีѷยนไปใชเ้ลขทีѷ Row หรอืเลขทีѷ Column ของตาราง
ฐานขอ้มลูเป็นตัวแปรแทน 
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พอ Data Table เริѷมสง่ตวัเลข Row Input Cell หรอื Column Input Cell ก็จะทําใหส้ตูร Index 
ดงึตัวแปรทีѷเกีѷยวขอ้งสง่ตอ่ไปยังตารางคํานวณและเกดิผลลัพธส์ง่กลับมาแสดงในตาราง Data 
Table (ซึѷงการทํางานแบบนีѸยังทําใหเ้ครืѷองมอืทีѷเรยีกวา่ Scenarios กลายเป็นเครืѷองมอืทีѷ
ลา้สมัย เราไมค่วรเสยีเวลาหรอืใสใ่จทีѷจะนํา Scenarios มาใชอ้กีตอ่ไป) 

 

 

1. วงจรการคํานวณในภาพขา้งตน้นีѸเริѷมจากสรา้งตารางฐานขอ้มลูชืѷอ MyData จากเซลล ์
N13:P16 เพืѷอบันทกึตัวแปรยอดขายและตน้ทนุของแตล่ะ Case ทีѷเป็นไปได ้เชน่ Case1 
กําหนดใหย้อดขายเทา่กบั 100 และมตีน้ทนุแตล่ะตัวเทา่กบั 10, 20, 30 และบันทกึ 
Case2, Case3 ใน column ถัดไป 

2. เซลล ์J12 ถอืเป็นหัวใจของการคํานวณ โดยกําหนดใหพ้มิพเ์ลข 1, 2, หรอื 3 ลงไปเพืѷอ
แสดงถงึเลขทีѷ Case ทีѷตอ้งการนํามาคํานวณ เชน่ ตามภาพนีѸเซลล ์J12 มคีา่เป็นเลข 1 ซึѷง
แสดงวา่กําลังดงึตัวแปรของ Case1 มาใชคํ้านวณ (หรอืหมายถงึ Column ทีѷ 1 จากตาราง
ชืѷอ MyData) 

3. เซลล ์J13:J16 ใชส้รา้งสตูร =INDEX(MyData,0,J12) แบบ Array ลงไปพรอ้มกนัเพืѷอดงึ
ขอ้มลูจากตารางชืѷอ MyData ตามเลข Column ทีѷเลอืกจากเซลล ์J12 

4. เซลล ์H13:H16 ใชส้รา้งสตูรรับคา่แตล่ะเซลลต์อ่มาจากขอ้ 3 เพืѷอนํามาคํานวณเป็นงบ
การเงนิเพืѷอหายอด Margin, Tax, และ Profit 

5. ตาราง Data Table คอืพืѸนทีѷตาราง M20:P27 เป็น Data Table แบบ 1 ตัวแปร 

5.1. กําหนดใหว้างตัวแปรเป็นเลขทีѷ Case ไวบ้นหัวตารางดา้นบนในชว่ง N20:P20 

5.2. หัวตารางดา้นขา้ง M21:M27 ใชส้รา้งสตูร link ผลลัพธจ์ากงบการเงนิทั Ѹงงบจากชว่ง
เซลล ์H13:H19 มาแสดงเซลลต์อ่เซลลต์ามลําดับรายการของงบการเงนิ 

5.3. ในการสัѷง Data Table ใหเ้ลอืกพืѸนทีѷตาราง M20:P27 แลว้ใช ้Row Input Cell เป็น
เซลล ์J12 
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6. วงจรของการคํานวณของ Data Table เริѷมจาก Data Table ยงิตัวเลขทีѷ Case ไปทีѷเซลล ์
J12 จากนัѸนสตูร Index ในชว่ง J13:J16 จะดงึคา่จากตาราง MyData สง่คา่ตอ่ไปยังงบ
การเงนิในชว่ง H13:H16 แลว้ Data Table จะดงึผลลัพธก์ลับมาแสดงแตล่ะ Case ตามแนว
ของเลขตัวแปรซึѷงเป็นเลขทีѷแตล่ะ Case ทีѷอยูใ่นหัวตารางดา้นบน ถอืเป็นการทํางานครบ
วงจรของ Data Table ทีѷมกีารสง่คา่ไปแลว้รับผลลัพธก์ลับมา (หากเขา้ใจประเด็นนีѸ จะ
สามารถใช ้Data Table สง่คา่ตัวแปรขา้มชทีหรอืขา้มแฟ้มไดด้ว้ย) 

 

วธิใีช ้Solver 
ตอนทีѷเห็นชืѷอคําวา่ Solver เป็นครั Ѹงแรก ไมเ่ขา้ใจวา่มันคอือะไร แตพ่อลองใช ้Solver ไปสกัพัก
จงึเขา้ใจวา่ทีѷแท ้Solver ก็คอืเครืѷองมอืทีѷชว่ยในการคํานวณประเภท Linear Programming 
นัѷนเอง แตพ่อเอย่ถงึคําวา่ Linear Programming ก็อาจทําใหห้ลายคนทีѷไมเ่คยเรยีนเรืѷองนีѸใน
สมัยมหาวทิยาลัยงงมากขึѸนก็ได ้จงึขออธบิายแบบภาษาชาวบา้นกนัดกีวา่ 

ขอใหน้กึถงึ Solver ตอ่เมืѷอปัญหาหนึѷงสามารถมคํีาตอบไดห้ลายคําตอบ เชน่ ถา้คณุมเีงนิอยู่
หนึѷงแสนบาท จะขอแลกธนบัตรใบละ 1,000 บาท 500 บาท 100 บาท 50 บาท หรอื 20 บาท
ไดอ้ยา่งละกีѷฉบับ หรอืถา้ตอ้งการสว่นผสมทีѷเป็นนํѸารวม 100 ซซี ีจะนําของเหลว 3 อยา่งมา
ผสมกนัในอัตราสว่นอยา่งละเทา่ใดเพืѷอใหร้วมกนัแลว้เป็นนํѸา 100 ซซี ีซึѷงจะเห็นวา่ ในสอง
ปัญหานีѸ เราสามารถแลกธนบัตรไดห้ลายแบบ และมอีตัราสว่นของเหลวไดห้ลายแบบ 

การคดิแกปั้ญหาการคํานวณใน Excel มหีลักอยูว่า่ ถา้ปัญหาหนึѷงๆมคํีาตอบเพยีงคําตอบเดยีว 
ขอรับรองวา่ Excel มสีตูรทีѷสามารถนํามาใชคํ้านวณหาคําตอบทีѷตอ้งการนัѸนไดแ้น่ๆ ซึѷงถงึจะไม่
สามารถใชส้ตูรสําเร็จรปูทีѷ Excel เตรยีมไวใ้หใ้ชไ้ดโ้ดยตรง เราก็สามารถนําสตูรมาซอ้นตอ่กนั
หรอืใชห้ลายสตูรมาคํานวณรว่มกนัเพืѷอแกปั้ญหานัѸน ขออยา่ใจรอ้นรบีตอบวา่ไมม่สีตูรใน Excel 
ทีѷทําได ้ขอใหใ้จเย็นๆคอ่ยๆคดิ เพราะบางปัญหากวา่จะคดิสตูรออกมาไดต้อ้งคดิกนัเป็นสบิปีก็
เป็นได ้ 

แตถ่า้ปัญหาหนึѷงๆอาจจะมหีลายคําตอบ ก็จําเป็นตอ้งใชส้ตูรคํานวณของ Excel นํามาใชร้ว่มกบั
คําสัѷง Solver โดยตอ้งหาทางสรา้งสตูรคํานวณทีѷเกีѷยวขอ้งไวต้ารางใหเ้รยีบรอ้ยกอ่น จากนัѸนจงึ
ใช ้Solver นําผลลัพธจ์ากสตูรทีѷคํานวณไดไ้ปใชต้อ่ ทั ѸงนีѸในตัวคําสัѷง Solver เองจะไมส่ามารถ
รับสตูรคํานวณ ดังนัѸนจงึเป็นหนา้ทีѷของเราทีѷตอ้งสรา้งสตูรไวใ้นเซลลต์า่งๆเพืѷอ Solver จะทํา
หนา้ทีѷคน้หาตัวเลขคําตอบทีѷเป็นไปได ้แลว้นําผลลัพธท์ีѷคํานวณไดไ้ปเปรยีบเทยีบระหวา่งเซลล์
สตูรคํานวณทีѷเกีѷยวขอ้งวา่ไดคํ้าตอบตามขอบเขตเงืѷอนไขทีѷกําหนดทัѸงหมดแลว้หรอืไม ่ 

Solver กบั Goal Seek มลัีกษณะการทํางานคลา้ยกนัและตา่งกนั ดังนีѸ 

 เครืѷองมอืทั Ѹงคูทํ่าหนา้ทีѷทดลองคา่แทนลงไปในเซลลร์ับตัวแปร (Changing Cells) ซึѷง
หา้มเป็นเซลลส์ตูร โดย Solver สามารถใชต้ัวแปรไดม้ากถงึ 200 ตัว (หรอืมากกวา่นัѸน
หากใช ้Solver แบบพเิศษของ www.Solver.com) สว่น Goal Seek ใชต้ัวแปรไดเ้พยีง
ตัวเดยีว 
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 เซลลผ์ลลัพธเ์ป้าหมาย (Target Cell) ของ Solver สามารถเลอืกใหเ้ป็นคา่ Maximize, 
Minimize, หรอื Optimize ใหไ้ดค้า่ใดคา่หนึѷง ในขณะทีѷ Goal Seek หาคา่แบบ 
Optimize เทา่นัѸน 

 Solver รับเงืѷอนไข (Constraints) ไดโ้ดยตรง เพืѷอใชค้วบคมุใหคํ้าตอบทีѷไดนั้Ѹนตอ้ง
บรรลเุงืѷอนไขทีѷกําหนดดว้ย สว่น Goal Seek ใช ้Constraint ของ Calculation Options 

 การสัѷง Solver ตอ้งเรยีกใชผ้า่น Add-ins ซึѷง Microsoft จัดเตรยีมไวใ้หใ้ชโ้ดยไมต่อ้ง
หาซืѸอเพิѷมแตอ่ยา่งใด สว่น Goal Seek เป็นคําสัѷงมาตรฐานทีѷเรยีกใชไ้ดทั้นท ี

เนืѷองจาก Solver มขีั Ѹนตอนการใชง้านทีѷคอ่นขา้งซบัซอ้น ดังนัѸนจงึขอยกตัวอยา่งทีѷไมย่ากนัก
เพืѷอสรา้งความคุน้เคยกบัพืѸนฐานการใชง้าน หากตอ้งการศกึษาการใชง้านโดยละเอยีดขอใหดู้
ไดจ้าก www.Solver.com 

 

ในตัวอยา่งนีѸกําหนดใหม้ตีัวเลข 3 ตัวอยูใ่นเซลล ์B2:B4 มคีา่เทา่กบั 15, 25, 35 ตามลําดับ ให ้
ตอบคําถามวา่มเีซลลใ์ดบา้งทีѷสามารถนํามารวมกนัแลว้ไดคํ้าตอบเป็นเลข 40 

ถา้คดิในใจก็ตอบวา่ตอ้งใชต้ัวเลขในเซลล ์B2+B3 = 15+25 ทําใหไ้ดผ้ลลัพธเ์ทา่กบั 40 แต่
เราตอ้งการใช ้Solver ในการบอกตําแหน่ง B2 และ B3 จงึตอ้งหาทางสรา้งสตูรทีѷเกีѷยวขอ้งลง
ไปในตารางใหเ้สร็จกอ่นดังนีѸ 

 เซลล ์C2:C4 เวน้ไวเ้พืѷอให ้Solver หาตัวเลขเฉพาะเลข 1 หรอื 0 ใสล่งไป เพืѷอใชเ้ป็น
การชีѸตําแหน่งทีѷจะนํามาใช ้เชน่ ถา้ C2:C4 ไดต้ัวเลข 1, 1, 0 ตามลําดับ ก็แสดงวา่ใช ้
เซลล ์C2 และ C3 สว่นเซลล ์C4 ไมต่อ้งนํามาใช ้

 เซลล ์D2:D4 ตอ้งสรา้งสตูรนําตัวเลขใน B2:B4 มาคณูกบัตัวเลข 1 หรอื 0 ทีѷ Solver 
จะหาใหจ้ากเซลล ์C2:C4 เป็นผลลัพธท์ีѷคณูกนัทลีะเซลล ์

 เซลล ์D5 สรา้งสตูร =SUM(D2:D4) เพืѷอหายอดรวมทัѸงหมดของผลคณู ซึѷงเราตอ้งการ
คําตอบในเซลลน์ีѸเทา่กบั 40 

หลังจากทีѷออกแบบตารางและสรา้งสตูรคํานวณขา้งตน้เรยีบรอ้ยแลว้ ใหเ้ริѷมใช ้Solver ตาม
ขั Ѹนตอนตอ่ไปนีѸ 
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1. สัѷง File > Options > Add-ins เลอืก Manage : Excel Add-ins แลว้กดปุ่ ม Go (Excel 
2003 สัѷง Tools > Options > Add-ins) 

 

2. กาชอ่ง Solver Add-in แลว้กดปุ่ ม OK 

 

3. สัѷง Data > Solver (Excel 2003 สัѷง Tools > Solver) 
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4. ในชอ่ง Set Objective: ใหค้ลกิเลอืกเซลล ์D5 ซึѷงเป็นสตูรหายอดรวมของผลคณู แลว้
คลกิเลอืกชอ่ง Value of: พมิพเ์ลขคําตอบ 40 ลงไป 

5. ในชอ่ง By Changing Variable Cells: ใหค้ลกิเลอืกเซลล ์C2:C4 ซึѷงเป็นเซลลร์ับตัว
แปรทีѷตอ้งการหาคา่ใหม ่

6. เพิѷม Constraints โดยกดปุ่ ม Add แลว้กําหนดเซลล ์C2:C4 = binary  

 

7. กดปุ่ ม Solve จะเห็นตัวเลข 1 หรอื 0 แสดงในเซลล ์C2:C4 แลว้ทําใหไ้ดต้ัวเลขยอด
รวมของผลคณูในเซลล ์D5 = 40 ตามตอ้งการแลว้กดปุ่ ม OK เพืѷอยอมรับ 

 

ขอ้ควรระวงัในการใช ้Solver 

1. หากตอ้งการสัѷงให ้Solver พมิพร์ายงาน ใหค้ลกิเลอืกชืѷอรายงานในชอ่ง Reports (เป็น
ชอ่งดา้นขวาของ Solver Results ตามภาพขา้งบนนีѸ) แตม่ขีอ้แมว้า่ตอ้งไมส่ัѷง Protect 
Workbook ไวก้อ่น 

2. เงืѷอนไขในสว่นของ Constraints เป็นสิѷงสําคัญทีѷทําให ้Solver สามารถหาคา่ทีѷตอ้งการ 
หากกําหนด Constraints ไวไ้มค่รบถว้นก็จะสง่ผลใหไ้มส่ามารถหาคําตอบทีѷตอ้งการ
หรอือาจเกดิคําตอบทีѷไมน่่าจะเป็นไปได ้เชน่ ในปัญหาการผลติถา้ลมืกําหนด 
Constraints ใหเ้ป็นจํานวนเต็ม ก็จะไดคํ้าตอบจํานวนผลติทีѷมเีศษทศนยิม หรอืถา้ไมไ่ด ้
กําหนดใหเ้ป็นคา่ทีѷมากกวา่หรอืเทา่กบั 0 ก็จะไดคํ้าตอบทีѷเป็นเลขตดิลบ 
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เครืѷองมอือืѷนในการวเิคราะหท์างออกทีѷเป็นไปได ้
Goal Seek, Data Table, และ Solver จัดเป็นเครืѷองมอืทีѷใชว้เิคราะหห์าทางออกในอนาคต 
เนืѷองจากผลลัพธท์ีѷได ้ตอ้งผา่นสตูรทีѷเราสรา้งเพืѷอคํานวณตามคา่ตัวแปรทีѷสมมตขิึѸน ทั ѸงนีѸ Excel 
ยังมเีครืѷองมอืทางสถติอิกีหลายอยา่งทีѷเราสามารถนํามาชว่ยวัดระดับความเชืѷอมัѷน เพยีงแค่
เรยีกใช ้Analysis ToolPak Add-in ทีѷตดิตั Ѹงมาพรอ้มกบัโปรแกรม Excel ก็จะไดคํ้าสัѷงดา้นสถติิ
อกีมากมายหลายอยา่งมาใชง้านในดา้น Data Analysis เชน่ Anova, Correlation, 
Covariance, F-Test, Regression, t-test, และ z-test เป็นตน้ โดยบรษัิท Microsoft ได ้
พัฒนาเครืѷองมอืทางสถติเิหลา่นีѸใหม้ขีั Ѹนตอนการใชง้านงา่ยๆ เครืѷองมอืหลายอยา่งสามารถ
ทํางานอยา่งอตัโนมัต ิชว่ยทําใหค้นทีѷคดิวา่วชิาสถติเิป็นฝันรา้ยสามารถนอนหลับฝันด ีเพราะ
สถติใิน Excel ไมไ่ดย้ากอยา่งทีѷเคยคดิ 

สว่น Pivot Table จัดเป็นเครืѷองมอืทีѷใชว้เิคราะหข์อ้มลูในอดตีมาดผูลในปัจจบุัน เพราะขอ้มลู
สว่นใหญท่ีѷเหมาะสําหรับนํามาใชก้บั Pivot Table เป็นผลมาจากการดําเนนิการทางธรุกจิ โดย
จะนํารายละเอยีดการใช ้Pivot Table มาอธบิายในภายหลัง 
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เร ืѷองทีѷไมค่อ่ยรูก้นัเกีѷยวกบัสตูร 
 

โปรแกรม Microsoft Excel รุน่ใหม ่มไิดม้เีสน่หอ์ยูท่ีѷรปูรา่งหนา้ตาบนหนา้จอทีѷประกอบไปดว้ย
แถบรบิบอนแบบใหม(่ทีѷยังไมค่อ่ยคุน้เคย) และมพีืѸนทีѷตารางซึѷงมขีนาดใหญม่ากขึѸนกวา่เดมิ
หลายเทา่เพยีงเทา่นัѸน แตส่าเหตทุีѷทําให ้Excel มเีสน่ห ์กลายเป็นโปรแกรมยอดนยิมมานาน
แสนนาน ก็เพราะมอีงคป์ระกอบสําคัญ นัѷนคอื Excel ตั Ѹงแตรุ่น่แรกๆไดจั้ดเตรยีมสตูรสําเร็จรปูไว ้
มากมายใหนํ้ามาใชก้นั หากสตูรทีѷมอียูย่ังไมส่ามารถใชคํ้านวณหาคําตอบทีѷตอ้งการได ้เราก็
สามารถนําสตูรทีѷมอียูนั่ Ѹนมาใชร้ว่มกนั ซอ้นกนั หรอืผกูสตูรเขา้ดว้ยกนั จนกลา่วไดว้า่เราสามารถ
ใช ้Excel คํานวณหาคําตอบไดก้บัโจทยก์ารคํานวณทกุเรืѷอง ปัญหาใดทีѷคดิวา่ไมส่ามารถใช ้
Excel หาคําตอบ นัѷนเป็นเพราะคนเราตา่งหากทีѷยังคดิไมอ่อก ไมใ่ชว่า่ใช ้Excel หาคําตอบ
ไมไ่ด ้บางปัญหาอาจตอ้งใชเ้วลาคดินับสบิปีกวา่จะทราบวา่ตอ้งเอาสตูรนัѸนมาซอ้นกบัสตูรนีѸแลว้
ก็จะไดคํ้าตอบทีѷตอ้งการออกมานัѷนเอง 

เคล็ดลับทีѷชว่ยใหส้ามารถใชส้ตูรจนชํѷาชอง มใิชว่า่ตอ้งรูจั้กสตูรทกุสตูรทีѷ Excel มอียูห่รอก 
เพราะสตูรทีѷใชง้านกนัประจํานัѸนมไีมม่ากนัก แครู่จั้กการใชส้ตูร Sum, If, And, Or, Choose, 
VLookup, Match, Index, CountIF, SumIF, Offset, Indirect, และ Array Formula ใหเ้ป็น 
และสามารถนําสตูรแคน่ีѸแหละมาใชร้ว่มกนัใหเ้ป็นก็เพยีงพอแลว้ แตก่วา่จะใชส้ตูรใหเ้ป็นยังมี
หลายเรืѷองทีѷตอ้งทําความเขา้ใจกนั หากคดิเพยีงวา่ขอใชส้ตูรเหลา่นีѸเป็นก็พอแลว้ คณุก็จะถงึ
ทางตันในไมช่า้ โดยบทความนีѸจะขอนําเรืѷองทีѷไมค่อ่ยรูก้นัเกีѷยวกบัสตูรมาอธบิาย หลายเรืѷอง
เป็นเรืѷองสําคัญทีѷคดิกนัวา่ไมส่ําคัญ บางเรืѷองก็งา่ยแตค่ดิไมถ่งึวา่เรืѷองงา่ยนัѷนแหละยังมอีะไร
หลายอยา่งซอ่นอยูอ่กี 

 

ทาํอยา่งไรใหเ้กง่สตูร Excel   

1. ไมจํ่าเป็นตอ้งซืѸอหนังสอืเกีѷยวกบัสตูร เพยีงแคเ่ปิดโปรแกรม Excel แลว้กดปุ่ ม F1 ก็จะ
เปิด Excel Help ขึѸนมาคน้หาสตูรทีѷ Excel มอียูไ่ดแ้ลว้ ถา้คณุตอ้งการซืѸอหนังสอื
เกีѷยวกบัสตูร ขอใหห้าซืѸอหนังสอืทีѷอธบิายเรืѷองสตูรไดล้ะเอยีดกวา่ทีѷมใีน Help (ซึѷงหา
ไดย้ากมาก เพราะคนแตง่หนังสอืมักเขยีนอธบิายตา่งจาก Help ไมม่าก) 

2. ถา้ซืѸอหนังสอื Excel มาแลว้ ขอใหเ้ปิดอา่นตั Ѹงแตห่นา้แรกจนถงึหนา้สดุทา้ยโดยไมต่อ้ง
เปิดคอมพวิเตอร ์เพราะถา้มัวเปิดอา่นไปทําตัวอยา่งไปบนหนา้จอพรอ้มกนั กวา่จะอา่น
หมดเลม่ก็จะใชเ้วลาเกนิปีครึѷง (ซึѷง Excel จะมรีุน่ใหมใ่หพ้วกเราไดใ้ชง้านกนัประมาณ
ทกุปีครึѷง แลว้คณุจะตอ้งซืѸอหนังสอื Excel รุน่ใหมม่าตั Ѹงตน้อา่นกนัตั Ѹงแตห่นา้แรกกนัใหม่
อกี สดุทา้ยกไ็มส่ามารถรูจั้ก Excel ครบทัѸงหมดสกัท)ี 

3. ถา้ยังไมไ่ดซ้ืѸอหนังสอื ขอใหไ้ปทีѷ www.xlfdic.com ซึѷงจะมแีฟ้มตัวอยา่งการใชส้ตูร 
Excel กวา่ 150 สตูรให ้download มาศกึษากนัไดฟ้ร ี
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4. ขอใหพ้ยายามรอบรูก้อ่นรูล้กึ คณุควรรอบรูไ้วก้อ่นวา่ Excel มสีตูรอะไรบา้ง จากนัѸนเมืѷอ
ถงึเวลาทํางานจงึคอ่ยใชเ้วลารูล้กึเรยีนรูส้ตูรแตล่ะสตูรใหค้ลอ่งในภายหลัง 

5. ตั Ѹงหลักไวเ้ลยวา่ Excel มสีตูรทีѷคณุสามารถนํามาใชก้บังานทกุอยา่งของคณุไดอ้ยูแ่ลว้ 
ถา้ไมม่สีตูรสาํเร็จรปูทีѷคํานวณลัดหาคําตอบไดโ้ดยตรง ใหห้าทางนําสตูรหลายสตูรมาใช ้
งานรว่มกนั 

6. เริѷมแรกทีѷทดลองใชส้ตูร ควรใชก้บัโจทยง์า่ยๆทีѷทราบคําตอบทีѷถกูตอ้งอยูแ่ลว้ จะได ้
เขา้ใจหลักการคํานวณทีѷ Excel ใชว้า่มขีั Ѹนตอนการคดิคํานวณอยา่งไร และเมืѷอได ้
คําตอบตรงกบัทีѷทราบ จะชว่ยทําใหค้ณุเกดิความมัѷนใจ และเกดิความกลา้ทีѷจะนําสตูรไป
ใชใ้นปัญหาอืѷนตอ่ไป ลองคดิดวูา่ =2*3 กบั =123*4.56 สตูรใดทีѷงา่ยกวา่กนั 

7. ถา้สตูรคํานวณไดคํ้าตอบอืѷนตา่งจากทีѷตอ้งการ อยา่คดิวา่ตัวเองสรา้งสตูรผดิ แตค่วร
พยายามคดิคน้หาใหไ้ดว้า่คําตอบทีѷไดนั้Ѹนหมายถงึการคํานวณของอะไร หลายๆครั Ѹง
ทเีดยีวทีѷคณุจะไดส้ตูรลัดและลับแปลกๆทีѷคนอืѷนไมรู่จั้กกนั 

8. อยา่รรีอทีѷจะสรา้งสตูรใหเ้ห็นผลลัพธก์บัตาวา่ถกูหรอืผดิ ถา้คณุเอาแตก่ลัวๆกลา้ๆไมย่อม
สรา้งสตูรสกัทกี็จะไมม่วีันเกง่สตูรไดห้รอก ขอใหส้รา้งสตูรบอ่ยๆ สตูรทีѷผดิหรอืถกู
เหลา่นัѸนจะเป็นบทเรยีนสอนคณุใหเ้กง่กวา่คนอืѷนทีѷไมเ่คยยอมทําผดิ 

9. ถา้ปัญหาการคํานวณซบัซอ้นยากมาก ควรแยกเซลลใ์หใ้ชเ้ซลลห์ลายๆเซลลแ์ยก
คํานวณสตูรแตล่ะขั Ѹน จากนัѸนจงึคอ่ยหาวธินํีาสตูรมาตอ่กนัเป็นสตูรยาวๆสตูรเดยีวใน
เซลลเ์ดยีว 

10. พยายามหาทางแกปั้ญหาสรา้งสตูรดว้ยตัวเองใหไ้ด ้ถา้ทําไดเ้องแลว้คณุจะเกดิความ
ภาคภมูใิจ เกดิความกลา้และอยากลอง ทําใหเ้กง่ขึѸนไปไดเ้อง อยา่ลอกสตูรคนอืѷนมาใช ้
ถา้พยายามอยา่งไรแลว้คดิสตูรไมอ่อก ขอใหค้น้หาคําตอบจาก Google กอ่นทีѷจะเอย่
ปากถามใคร 

หวังวา่คําแนะนํา 10 ขอ้นีѸจะเป็นแนวทางชว่ยใหค้ณุกลายเป็นคนเกง่สตูร Excel และขอฝากคน
ทีѷชอบใชส้ตูรรุน่ใหมท่ีѷเพิѷงเกดิขึѸนใน Excel 2007 ขึѸนไปวา่ อยา่เพิѷงรบีรอ้นนําสตูรใหม่ๆ เหลา่นัѸน
มาใช ้เพราะตราบใดทีѷเพืѷอนของคณุยังคงใช ้Excel รุน่เกา่กวา่อยู ่เขาจะไมส่ามารถนําแฟ้มของ
คณุทีѷสรา้งไวโ้ดยใชส้ตูรรุน่ใหมม่าคํานวณไดเ้ลย คณุนัѷนแหละทีѷจะตอ้งรับภาระยอ้นกลับไป
แกไ้ขสตูรรุน่ใหมใ่หเ้ป็นรุน่เกา่เพืѷอเปิดแฟ้มใน Excel รุน่เกา่ทีѷคนอืѷนเขายังไมเ่ลกิใชก้นั 
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Formula vs Function 

ทั ѸงสองคํานีѸถา้แปลเป็นไทยก็แปลวา่ “สตูร” เหมอืนกนั โดยคําวา่ Formula เป็นคําทีѷมี
ความหมายกวา้งกวา่ Function กลา่วคอื  

 Formula หมายถงึ สตูรทกุอยา่งทีѷมเีครืѷองหมายเทา่กบั = นําหนา้ เชน่ =A1 หรอื 
=1+2 หรอื =Now() 

 Function หมายถงึ สตูรสําเร็จรปูทีѷตดิมากบัโปรแกรม Excel เชน่ สตูร Sum, Max, 
Min, If, VLookup หรอื Now เป็นตน้ 

ดังนัѸนเพืѷอทําความเขา้ใจใหต้รงกนั ในบทความนีѸจะใชคํ้าวา่ สตูร ซึѷงหมายถงึทั Ѹง Formula และ 
Function หรอือกีนัยหนึѷง สตูรก็คอือะไรก็ตามทีѷมเีครืѷองหมาย = นําหนา้ สว่นตัวผมเองจะเขยีน
อธบิายเรืѷองสตูรในกระดาษโดยใชต้ัวใหญป่นตัวเล็ก เชน่ Sum หรอื VLookup เพืѷอชว่ยใหอ้า่น
แตล่ะคําของสตูรไดง้า่ย แตเ่มืѷอถงึคราวนําไปใชใ้น Excel โปรดพมิพส์ตูรดว้ยตัวเล็กทั Ѹงหมด
เสมอ 

 

Text vs Number 

คา่ทีѷพมิพบ์ันทกึลงไปในเซลลห์รอืผลจากการคํานวณมอียูเ่พยีง 3 อยา่งคอื คา่ทีѷถอืเป็นText 
คา่ทีѷถอืเป็น Number และคา่ทีѷ error ไมส่ามารถนําไปใชคํ้านวณตอ่ได ้

 Text คอื คา่ทีѷพมิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิซา้ยของเซลล์
ทันท ี(โดยไมต่อ้งกาํหนด Format) เชน่ พมิพคํ์าวา่ abc หรอื กขค หรอืแมแ้ตต่ัวเลขทีѷ
พมิพต์อ่ทา้ยเครืѷองหมายฝนทอง เชน่ ‘123 หรอืผา่นการกําหนด Format Number ให ้
ถอืเป็นแบบ Text ซึѷงโดยทัѷวไปหากเซลลด์า้นขวายังวา่งอยู ่จะพบวา่ถา้เซลลม์ ีText ทีѷ
ยาวกวา่ความกวา้งของเซลล ์จะยอมให ้Text นัѸนแสดงตอ่ไปในเซลลด์า้นขวา 

 Number คอื คา่ทีѷพมิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิขวาของเซลล์
ทันท ี(โดยไมต่อ้งกําหนด Format) เชน่ พมิพต์ัวเลข 123 หรอืพมิพว์ันทีѷ 14/2/2009 
ซึѷงโดยทัѷวไปถา้เซลลม์คีวามกวา้งไมพ่อทีѷจะแสดงตัวเลขทัѸงหมด Excel จะแสดงดว้ย
เครืѷองหมาย ####### ซํѸาจนเต็มเซลล ์(แกไ้ดโ้ดยคลกิขวาลงไปในเซลลแ์ลว้สัѷง 
Format Cells > Alignment > กาชอ่ง Shrink to fit เพืѷอสัѷงให ้Excel ยอ่ขนาด
ของ Font ใหม้ขีนาดพอดทีีѷจะแสดงไดเ้ต็มความกวา้งของเซลล)์ 

 Error เป็นผลทีѷเกดิจากการคํานวณทีѷไมส่ามารถนําไปคํานวณตอ่ได ้เชน่  

o #N/A เมืѷอสตูรหาขอ้มลูทีѷตอ้งการไมพ่บ (Not Available) 

o #NAME? เมืѷอสตูรหาชืѷอทีѷตอ้งการไมพ่บ เชน่ =answer โดยทีѷในแฟ้มนัѸน
ไมไ่ดต้ั Ѹงชืѷอ Range Name วา่ answer ไวก้อ่น 

o #NULL! เมืѷอสตูรหาตําแหน่งทีѷตัดกนัไมไ่ด ้เชน่ =A:A B:B 
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o #NUM! เมืѷอสตูรใชต้ัวเลขทีѷเป็นไปไมไ่ดใ้นการคํานวณ เชน่ =Sqrt(-1) 

o #REF! เมืѷอตําแหน่งเซลลท์ีѷเคยอา้งไวใ้นสตูรถกู delete ทิѸงไป 

o #VALUE! เมืѷอสตูรไมส่ามารถคํานวณได ้เชน่ นําตัวเลขคณูตัวอกัษร =123*a 

 

 
หลักการใช ้Excel ทีѷด ีคอื คา่ใดๆทีѷเกีѷยวขอ้งกบัตัวเลข ก็ขอใหเ้ป็นตัวเลขทีѷชดิขวา
ของเซลลเ์สมอ ไมค่วรใชต้ัวเลขทีѷชดิซา้ยของเซลล ์

 

ขนาดแฟ้ม vs ประเภทขอ้มลู 

ขนาดของแฟ้มขึѸนกบัประเภทของขอ้มลู โดยเรยีงลําดับขนาดแฟ้มจากเล็กไปใหญไ่ดต้ามนีѸ 

1. แฟ้มทีѷเก็บขอ้มลูเป็น Number เชน่ 1, 111, 123 

2. แฟ้มทีѷเก็บขอ้มลูเป็น Text เชน่ a, aaa, abc 

3. แฟ้มทีѷเก็บขอ้มลูเป็นสตูรทีѷคนืคา่เป็น Number เชน่ =1, =111, =123 

4. แฟ้มทีѷเก็บขอ้มลูเป็นสตูรทีѷคนืคา่เป็น Text เชน่ =”a”, =”aaa”, =”abc” 

ทีѷแปลกก็คอื ขนาดของแฟ้ม ไมข่ึѸนกบัความยาวของคา่ในเซลล ์เชน่ ถา้เซลลม์คีา่ทีѷบันทกึไว ้
เป็น 1 หรอืเพิѷมความยาวตัวเลขเป็น 111 หรอื 123 ก็จะมขีนาดแฟ้มเทา่กนักบั 1 ตัวเดยีว หรอื
ถา้สรา้งเป็นสตูร =1 หรอืเพิѷมความยาวตัวเลขเป็น =111 หรอื =123 จะมขีนาดแฟ้มเทา่กนักบั 
=1 

ดังนัѸนถา้ตอ้งการลดขนาดแฟ้มใหเ้ล็กทีѷสดุ แทนทีѷจะพมิพเ์ลข 1 แลว้สรา้งสตูรบวกเลขตอ่กนัไป
ทลีะเซลลใ์หก้ลายเป็นลําดับตัวเลข 1, 2, 3, 4, 5 ก็ควรพมิพเ์ลขลงไปในเซลลโ์ดยตรงแทน
การสรา้งสตูร และสตูรใดๆทีѷคํานวณเสร็จเรยีบรอ้ยไปแลว้และไมม่กีารเปลีѷยนแปลงคําตอบตา่ง
จากเดมิอกีแลว้ เราก็ควร Copy แลว้ Paste Special ใหก้ลายเป็น Value จะทําใหแ้ฟ้มเล็กลง
ไปมากทเีดยีว 

สว่นเซลลส์ตูรทีѷเกดิ Error ขึѸนก็ควรใชส้ตูร IF ปรบั Error ใหเ้ปลีѷยนเป็นคา่อืѷนแทน ดังนีѸ 

 ในกรณีทีѷ A1 คนืคา่เป็น Number ใหใ้ช ้=IF( IsError(A1), 0, A1)  

 ในกรณีทีѷ A1 คนืคา่เป็น Text ใหใ้ช ้=IF( IsError(A1), “คําเตอืนใดๆก็ได”้, A1)  

ซึѷงตัวผมเอง นยิมใชส้ตูร =IF( IsError(A1), 0, A1) ทั Ѹงในกรณีทีѷเดมิคนืคา่เป็น Number หรอื 
Text ก็ตาม เพราะสามารถใช ้Format ปรับการแสดงเลข 0 ใหแ้สดงเป็นคา่อืѷนหรอืแมแ้ตทํ่าให ้
ดเูหมอืนกลายเป็นเซลลว์า่งไดต้อ่ไป 
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ตาํแหนง่เซลลท์ีѷเลอืกสําหรบัสรา้งสตูร 

เห็นหัวขอ้นีѸแลว้คงสงสยักนัวา่ตําแหน่งเซลลท์ีѷเลอืกสรา้งสตูรลงไปนัѸนเป็นประเด็นทีѷตอ้งใสใ่จ
กนัดว้ยหรอื ถา้คดิกนังา่ยๆวา่ “ในเมืѷอฉันตอ้งการจะสรา้งสตูรลงไปตรงนีѸก็ตอ้งตามใจฉัน ฉันจะ
สรา้งสตูรลงไปตรงนีѸเสยีอยา่ง ใครจะทําไม” ก็แสดงวา่คณุมองขา้มอะไรทีѷเป็นเรืѷองสําคัญอยา่ง
หนึѷงไปแลว้ 

ตําแหน่งเซลลท์ีѷคณุสรา้งสตูรหาคําตอบลงไป สามารถชีѸเป็นชีѸตายใหก้บังานของคณุทเีดยีว 
เพราะถา้อยูม่าวันหนึѷง เมืѷอยา้ยเซลลส์ตูรไปทีѷตําแหน่งอืѷน สตูรทีѷเคยคํานวณหาคําตอบไดต้ลอด
มา อาจคนืคา่เป็นคําตอบทีѷผดิหรอืแสดงผลลัพธแ์ตกตา่งไปจากเดมิก็ได ้

วธิทีดสอบสตูรทีѷคณุหรอืใครสรา้งขึѸนวา่เป็นสตูรทีѷใชไ้ดห้รอืไม ่ใหท้ดลองยา้ยเซลลส์ตูรไปทีѷอืѷน 
ยา้ยไปเรืѷอยๆหลายๆตําแหน่ง พรอ้มกนันัѸนทดลองยา้ยตารางขอ้มลูทีѷใชอ้า้งองิไปทีѷอืѷนดว้ย ลอง 
Insert Row หรอื Column แทรกตารางขอ้มลูเขา้ไปอกี ถา้สตูรนัѸนยังคงหาคําตอบได ้
เหมอืนเดมิ แสดงวา่สตูรนัѸนใชง้านได ้

ทราบไหมวา่ถา้ตารางขอ้มลูทีѷเก็บคา่อยูใ่นตารางชว่ง B2:D5 คณุควรสรา้งสตูรคํานวณซึѷง
เกีѷยวขอ้งกบัการใชข้อ้มลูในตารางนีѸไวท้ีѷเซลลใ์ด ซึѷงจะรับประกนัวา่สตูรทีѷสรา้งขึѸนจะสามารถ
นําไปใชง้านตอ่ไดท้กุทีѷ 

คําตอบก็คอื หา้มสรา้งสตูรในแนวเดยีวกบัตารางขอ้มลู นัѷนคอื อยา่สรา้งสตูรในชว่ง Column B 
ถงึ D และชว่ง Row 2 ถงึ 5 

สาเหตทุีѷหา้ม เพราะการสรา้งสตูรใดๆทีѷมตํีาแหน่งอา้งองิไปยังคา่ในแนวเดยีวกบัตารางขอ้มลู 
อาจคนืคา่เป็นคําตอบเป็นคา่ในตารางตามแนวเดยีวกนัก็ได ้

หากสรา้งสตูรในเซลลซ์ึѷงไมไ่ดอ้ยูใ่นแนวเดยีวกบัชว่ง Column B ถงึ D และชว่ง Row 2 ถงึ 5 
แลว้คณุหาทางปรับสตูรนัѸนใหคํ้านวณหาคําตอบทีѷตอ้งการ ยอ่มรับประกนัไดว้า่ สตูรนัѸนเป็นสตูร
ทีѷใชง้านไดจ้รงิและจะยังคงคนืคา่เป็นคําตอบเดมิไปตลอด ไมว่า่จะยา้ยเซลลส์ตูรไปทีѷตําแหน่ง
อืѷนก็ตาม 

พอพบวา่สตูรทํางานไดจ้รงิแลว้ จากนัѸนจะยา้ยเซลลส์ตูรไปวางไวใ้นแนวคูข่นานกบัตารางขอ้มลู
ทีѷใชใ้นการคํานวณก็ไมว่า่กนั 

 

สตูรก็มจีงัหวะหายใจดว้ยนะ   

ผูท้ีѷใช ้Excel เป็นประจําตอ้งรูจั้กสตูรตอ่ไปนีѸเป็นอยา่งด ี=IF(C2=0, 0, B2/C2) 

สตูรขา้งตน้นีѸคอืสตูรทีѷใชส้ําหรับปรับสตูรทีѷนําตัวเลขมาหารกนัไมใ่หแ้สดงคําเตอืน Error วา่ 
#DIV/0! ขึѸนมา  
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เมืѷอเซลล ์C2 ซึѷงเป็นเลขตัวหารมคีา่เป็น 0 ใหค้นืคา่ 0 เป็นตัวเลขคําตอบแทน แตถ่า้เซลล ์C2 
ไมไ่ดเ้ป็นเลข 0 ก็ยอ่มนํา C2 มาหาร B2 ไดต้ามปกต ิผูท้ีѷสรา้งสตูรหารกนัจะหลกีเลีѷยงสตูร
ดังกลา่วนีѸไมไ่ด ้

ขอถามวา่ เวลาทีѷคณุสรา้งสตูร คณุมพีฤตกิรรมในการสรา้งสตูรกนัอยา่งไร คณุจะพมิพล์งไปใน
เซลลว์า่ =if(c2=0,0,b2/c2) รวดเดยีวใหค้รบทัѸงหมดแลว้จงึกดปุ่ ม Enter หรอืไม ่หรอืจะคอ่ยๆ
พมิพ ์=if แลว้หยดุหายใจพักหนึѷงแลว้จงึพมิพ ์c2=0 ตอ่ แลว้ก็หยดุพักหายใจอกีเฮอืกหนึѷงจงึ
คอ่ยๆพมิพส์ว่นทีѷเหลอืตอ่ 

ขอ้ผดิพลาดทีѷพบบอ่ยในการสรา้งสตูรของคนทีѷเพิѷงเรยีนรูก้ารใช ้Excel ก็คอื มักหลงลมื
เครืѷองหมายวงเล็บ พมิพเ์ครืѷองหมาย Comma ขาดไป บางครัѸงพมิพส์ลับทีѷ บางครั Ѹงพมิพข์าด 
บางครั Ѹงพมิพเ์กนิ ทําใหเ้มืѷอกดปุ่ ม Enter ลงไปแลว้ Excel ตอ้งเตอืนขึѸนมาบนจอใหค้ณุทราบวา่
สตูรทีѷสรา้งนัѸนผดิ 

ผูส้รา้งสตูรตอ้งมสีมาธพิอตัว สมาธทิีѷวา่นีѸเกดิจากการรูจั้กวา่เมืѷอใดจะหยดุเมืѷอใดจะสรา้งตอ่ ถา้รู ้
หลักจังหวะหายใจจะชว่ยใหค้ณุสรา้งสตูรไดง้า่ยขึѸน ไมว่า่สตูรสั Ѹนๆหรอืสตูรยากๆยาวๆก็ใชห้ลัก
จังหวะหายใจนีѸกนัทั ѸงนัѸน 

จังหวะหายใจทีѷวา่นีѸ ไมใ่ชจั่งหวะหายใจของ Excel หรอกนะ Excel มันไมไ่ดม้กีารหายใจ
เหมอืนกบัมนุษย ์แตเ่ป็นจังหวะหายใจของคณุนัѷนแหละ ตอ้งรูว้า่เมืѷอใดทีѷควรจะหยดุแลว้หายใจ
สกัเฮอืกหนึѷงแลว้จงึสรา้งสตูรตอ่ ซึѷงเรืѷองการหายใจนีѸไมต่อ้งลอกจังหวะการหายใจใหเ้หมอืนกบั
ผมก็ได ้ตัวใครตัวมัน ขอใหเ้ลอืกจังหวะหายใจทีѷตัวเองคดิวา่ถนัดก็แลว้กนั 

ขอยกสตูรทั Ѹงหมดมาดกูนัอกีครั Ѹง  

=IF(C2=0, 0, B2/C2)  

มาดกูนัวา่ถา้เป็นวธิขีองผม จะสรา้งสตูรนีѸโดยหยดุพักเพืѷอหายใจกนัตรงไหนบา้ง เอา้หายใจเขา้
แลว้นะ จากนัѸนเริѷมสรา้งสตูรโดยใชว้ธิตีามลําดับตอ่ไปนีѸ 

1. พมิพเ์ครืѷองหมายเทา่กบั 

2. พมิพคํ์าวา่ if( 

3. หยดุเพืѷอหายใจ จากนัѸนสรา้งสตูรตอ่ดว้ยขั Ѹนตอ่ไป 

4. หยบิเมาสค์ลกิเซลล ์C2 

5. แลว้พมิพ ์=0, ตอ่ 

6. หยดุเพืѷอหายใจ 

7. ในใจอา่นสตูรทีѷไดต้ามนีѸ =if(C2=0, วา่ถา้เซลลต์ัวหารมคีา่เทา่กบั 0 ละ่กอ้ 

8. พมิพ ์0, ตอ่ 
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9. หยดุเพืѷอหายใจ 

10. ในใจอา่นสตูรทีѷพมิพ ์0, วา่ ใหคํ้าตอบทีѷไดเ้ป็น 0 แทนนะ จากนัѸน 

11. หยบิเมาสค์ลกิเซลล ์B2 

12. พมิพเ์ครืѷองหมายหาร / 

13. แลว้หยบิเมาสค์ลกิเซลล ์C2 

14. หยดุเพืѷอหายใจ 

15. ในใจอา่นสตูร B2/C2 ทีѷไดม้าวา่ แตถ่า้ตัวหารไมใ่ชเ่ลข 0 ใหคํ้าตอบทีѷไดเ้ป็นสตูรหาร
กนัตามปกต ิ

16. จากนัѸนจงึกดปุ่ ม Enter รับสตูรลงไปในเซลล ์โดยไมต่อ้งพมิพเ์ครืѷองหมายวงเล็บปิด 
เพราะถา้มวีงเล็บเปิดตัวเดยีว Excel จะพมิพเ์ครืѷองหมายวงเล็บปิดใหเ้อง 

จับหลักไดไ้หมเอย่ ขอใหส้งัเกตวา่ใหห้ยดุเพืѷอหายใจไดห้ลังจากพมิพจ์บตรงเครืѷองหมายนัѸนๆ
ไง ถา้ใชเ้ครืѷองหมายจดุจดุแทนชว่งหยดุเพืѷอหายใจ จะไดส้ตูรตามแบบนีѸ  

=if(.........C2=0,.........0,......... B2/C2 

ฝึกหยดุเพืѷอพักหายใจใหไ้ดจั้งหวะ วธินีีѸจะชว่ยลดขอ้ผดิพลาดหลงลมืการใสเ่ครืѷองหมายวงเล็บ
หรอืเครืѷองหมาย Comma ในการสรา้งสตูรไปไดเ้ยอะทเีดยีว 

 

ธรรมชาตขิองสตูร   

ถา้เขา้ใจธรรมชาตติอ่ไปนีѸของสตูร จะทําใหเ้ราใชส้ตูร Excel ไดง้า่ยโดยไมต่อ้งทอ่งจําและลด
ขอ้ผดิพลาดเมืѷอนําสตูรมาใช ้

1. ชืѷอสตูรเป็นตัวอกัษรภาษาองักฤษตัวใหญ ่เชน่ IF, MAX, MIN ดังนัѸนเวลาพมิพส์ตูรใหพ้มิพ์
ตัวเล็ก พอกดปุ่ ม Enter แลว้จะพบวา่ ถา้เราสะกดชืѷอสตูรถกูตอ้ง Excel จะเปลีѷยนตัวอกัษร
จากตัวเล็กไปเป็นตัวใหญทั่Ѹงหมดใหทั้นท ี

2. เราสามารถพมิพส์ตูรโดยถา้ในสตูรมเีครืѷองหมายวงเล็บเปิดเพยีงวงเล็บเดยีว พอกดปุ่ ม 
Enter จะพบวา่ Excel พมิพเ์ครืѷองหมายวงเล็บปิดใหเ้อง แตถ่า้มวีงเล็บเปิดหลายตัว เราตอ้ง
ใสเ่ครืѷองหมายปิดวงเล็บใหค้รบทกุคู ่เพราะถา้กดปุ่ ม Enter ลงไป Excel จะพยายามคดิใส่
เครืѷองหมายวงเล็บปิดใหค้รบแตอ่าจใสว่งเล็บปิดผดิคูใ่หก้็ได ้

3. วงเล็บในสตูรตอ้งใสใ่หค้รบคูแ่ละถกูตําแหน่ง มวีงเล็บเกนิดกีวา่ขาดวงเล็บ 

4. ถา้ไมใ่สว่งเล็บ Excel จะไลคํ่านวณตามลําดับดังนีѸ ยกกําลังกอ่นแลว้ตามดว้ยคณูหรอืหาร
แลว้ตามดว้ยบวกหรอืลบ (คณูหาร หรอืบวกลบ มศีักดิѻศรเีทา่กนั จะไลคํ่านวณจากซา้ยไป
ขวาแลว้แตว่า่เครืѷองหมายใดมกีอ่น) ดตูัวอยา่งทา้ยขอ้ 7 
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5. โครงสรา้งสตูร Excel ถกูสรา้งขึѸนมาเลยีนแบบลําดับความคดิของมนุษย ์ดังนัѸนถา้เราเขา้ใจ
ตัวเองวา่เรามองเราคดิทลีะขั Ѹนอยา่งไร เราก็จะสรา้งสตูรไดง้า่ยโดยไมต่อ้งทอ่ง เชน่ เวลา
เราคดิเรืѷองเงืѷอนไขวา่ ถา้ทําด ีตอ้งไดด้ ีแตถ่า้ไมทํ่าด ีตอ้งไดเ้รืѷองอืѷนๆ ตัวสตูร IF ของ 
Excel ก็จะมลํีาดับในโครงสรา้งสตูรตามแบบทีѷเราคดิออกมาเป็น =IF(ทําดใีชไ่หม, ไดด้,ี 
ไดอ้ืѷนๆ) ขอใหอ้า่นรายละเอยีดประเด็นนีѸจากบทความเรืѷอง เมืѷอสตูร Excel มชีวีติจติใจ หรอื
จากลงิค ์www.excelexperttraining.com/blogs/archives/z300-ExcelCore000706.php 

6. ในโครงสรา้งสตูร ถา้มกีารอา้งองิกบัตําแหน่งเซลลต์ามแนวนอนและแนวตั Ѹง จะตอ้งใส่
ตําแหน่งอา้งองิตามแนวนอนไวก้อ่นแนวตั Ѹงเสมอ ดไูดจ้ากสตูร Index หรอืสตูร Offset 
(ดังนัѸนเราควรสรา้งสตูรคํานวณบวกลบคณูหารอืѷนๆใหใ้ชตํ้าแหน่งอา้งองิตามแนวนอนกอ่น
แนวตั Ѹงดว้ยเชน่กนั เพืѷอเป็นแบบแผนชว่ยใหเ้ขา้ใจทีѷไปทีѷมาและแกะสตูรไดง้า่ย) 

7. ถา้ในโครงสรา้งสตูรประเภทฐานขอ้มลู มตีัวแปร (Option) ทีѷอาจใสห่รอืไมใ่สก่็ได ้เชน่สตูร 
VLookup หรอืสตูร Match ขอใหย้ดึหลักวา่ 

7.1. ถา้ไมใ่ส ่Option หรอืละไว ้หรอืใสต่ัวเลข 1 นัѸน สตูรนีѸจะใชก้บัตารางขอ้มลู ทีѷเรยีงคา่
จากนอ้ยไปมาก (จําไวว้า่เรยีงตามธรรมชาตติอ้งเรยีงจากนอ้ยไปมากเสมอ) 

7.2. ถา้ใส ่Option เป็น False หรอืใสต่ัวเลข 0 สตูรนีѸจะใชก้บัตารางขอ้มลูทีѷไมเ่รยีงลําดับ 
(จําไวว้า่ 0 แปลวา่ไม ่หมายถงึไมต่อ้งเรยีงลําดับ) 

7.3. ถา้ใส ่Option เป็นตัวเลข -1 นัѸน สตูรนีѸจะใชก้บัตารางขอ้มลู ทีѷเรยีงคา่จากมากไปนอ้ย 
(จําไวว้า่เรยีงผดิธรรมชาตติอ้งเรยีงจากมากไปนอ้ย) 

ตวัอยา่งลําดบัการคาํนวณตามเครืѷองหมายบวกลบคณูหาร 

ถา้สรา้งสตูร =1+2-3*4/5^6 ลงไปในเซลล ์Excel จะคํานวณตามหลักการดังนีѸ 

1. คํานวณเครืѷองหมายยกกําลัง ^ กอ่น นัѷนคอืจะคํานวณ 5^6 

2. ตามดว้ยการคํานวณคณูหรอืหาร แลว้แตว่า่เครืѷองหมายใดมากอ่นจากซา้ยไปขวา นัѷนคอื
จะคํานวณ 3*4 แลว้จงึนําผลคณูทีѷไดไ้ปหารดว้ยคําตอบทีѷไดจ้าก 5^6 

3. ตามดว้ยการคํานวณบวกหรอืลบ แลว้แตว่า่เครืѷองหมายใดมากอ่นจากซา้ยไปขวา นัѷนคอื
จะคํานวณ 1+2 แลว้จงึนําผลบวกทีѷไดไ้ปลบกบัผลลัพธท์ีѷไดจ้าก 3*4/5^6 

 

จะสรา้งสตูรใหวุ้น่กนัไปไดแ้คไ่หน   

สตูรสําเร็จรปูของ Excel 2003 ทีѷเราใชก้นัจนชนิ (จนไมอ่ยากเปลีѷยนมาใช ้Excel 2007 หรอื 
Excel รุน่ทีѷใหมก่วา่) มขีอ้กําหนดในตัวสตูรวา่ ในวงเล็บของสตูรสําเร็จรปูหนึѷงๆนัѸน สามารถซอ้น
สตูรเขา้ไปไดอ้กี 7 สตูร และในวงเล็บของบางสตูรจะถกูแบง่ Argument หรอืตัวแปรทีѷคัѷนดว้ย
เครืѷองหมาย comma แบง่ไดส้งูสดุ 30 Arguments (หรอือกีนัยหนึѷงใส ่Comma ไดส้งูสดุ 29 
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ตัวเพืѷอแบง่สว่นในวงเล็บออกเป็น 30 สว่น) และสตูรทีѷยาวทีѷสดุทีѷสามารถพมิพล์งไปในเซลล์
หนึѷงๆไดนั้Ѹน ยาวไดส้งูสดุ 1,024 ตัวอกัษร 

ขอ้กําหนดเหลา่นีѸนับวา่เพยีงพอกบัการคํานวณทัѷวไป นานๆทจีงึมโีจทยท์ีѷตอ้งใชจ้นเกนิกวา่
ขดีจํากดั ซึѷงแกไ้ขไดง้า่ยๆโดยแยกการคํานวณเป็นสว่นๆ แลว้แบง่แตล่ะเซลลใ์หแ้ยกคํานวณ
แตล่ะสว่นของสตูร จากนัѸนจงึนําผลการคํานวณทีѷไดม้าคํานวณรว่มกนัตอ่เป็นขั Ѹนๆ หรอืไมก่็ตอ้ง
ฉลาดเลอืกใชส้ตูรอืѷนทีѷคํานวณไดคํ้าตอบแบบเดยีวกนัแทน  

สําหรับสตูรสาํเร็จรปูใน Excel รุน่ 2007 เป็นตน้มา ปรับขอ้กําหนดดังกลา่วเป็นดังนีѸ 

1. ในวงเล็บของสตูรสําเร็จรปู สามารถซอ้นสตูรเขา้ไปไดอ้กี 64 สตูร (Nested levels of 
functions) 

2. ในวงเล็บของสตูรสําเร็จรปู สามารถแบง่ออกเป็น 255 arguments (Arguments in 
Functions) 

3. ในเซลลห์นึѷงๆรับสตูรไดย้าวทีѷสดุ 8,192 characters (Length of formula contents) 

ขอ้กําหนดเหลา่นีѸเปิดกวา้งใหเ้ราสรา้งสตูรไดส้บายขึѸน ซึѷงขอแนะนําวา่อยา่ใชค้วามสบายจนเกนิ
ตัว เพราะตัวคณุนัѷนแหละทีѷจะถกูลงโทษหากสรา้งสตูรแบบสบายเกนิไป เพราะหากตอ้ง
ยอ้นกลับมาแกะสตูรเพืѷอแกไ้ขอกีในภายหลัง มันไมใ่ชง่านทีѷงา่ยเลยทีѷจะแกะสตูรซอ้นกนัหลาย
สบิชั Ѹน 

พงึระลกึไวเ้สมอวา่ สตูรทีѷคณุสรา้งตั Ѹงแตแ่รกนัѸน ตอ้งเป็นสตูรทีѷใชง้านไดต้ลอดไปโดยไมต่อ้ง
ยอ้นกลับมาแกไ้ขสตูรอกี แตถ่า้จําเป็นตอ้งแกไ้ขสตูร ก็ตอ้งแกไ้ขไดง้า่ย ไมว่า่คณุหรอืเพืѷอน
ของคณุก็ตอ้งแกะสตูรไดง้า่ย 

ดังนัѸนการทีѷ Microsoft ปรับขอ้จํากดัของสตูรใหย้ดืหยุน่มากขึѸนนีѸ ถา้สตูรใดทีѷคณุคดิวา่มเีงืѷอนไข
ของการคํานวณไมย่ากนัก"ตอ่การจําของคณุ"และงา่ยทีѷจะยอ้นกลับมาแกไ้ข ก็เชญิซอ้นสตูรเขา้
ไปหลายๆชั Ѹนไดต้ามใจ แตถ่า้มทีางเลอืกอืѷนทีѷดกีวา่ เชน่ มสีตูรอืѷน หรอืตอ้งปรับโครงสรา้ง
ตารางเสยีใหมเ่พืѷอใหเ้ขา้กบัสตูรนัѸน ก็ขอแนะนําใหต้ัดสนิใจเลอืกใหด้ ี

 

สตูรทีѷหาคา่ได ้ก็ใชบ้อกตาํแหนง่ได ้  

เชืѷอไหมวา่เรืѷองทีѷจะอธบิายนีѸแทบทกุคนทีѷใช ้Excel ทราบกนัดอียูแ่ลว้ ใชก้นัอยูท่กุวัน แตน่กึไม่
ถงึวา่สตูรทีѷหาคา่ได ้จะใชบ้อกตําแหน่งทีѷแปลกแตกตา่งจากทีѷเขา้ใจกนัอยา่งไร 

พอสรา้งสตูรลงไปในเซลลใ์ดๆก็ตามวา่ =A1 สตูรนีѸก็จะดงึคา่จากเซลล ์A1 มาแสดงใหเ้ห็น 
และพรอ้มกนันัѸนเราก็จะทราบดว้ยวา่ คา่ทีѷไดน้ีѸมาจากเซลล ์A1 เพราะดจูากตัวสตูรทีѷใชตํ้าแหน่ง
อา้งองิ =A1 นัѷนเอง 
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ทีѷพเิศษไปกวา่นีѸ หากคณุตัดกาในชอ่ง Allow edit directly in cells ทิѸงไป (ใน Excel Options 
> Advanced หรอืใน Excel 2003 ใชเ้มนู Tools > Options > Edit) จะพบวา่เมืѷอดับเบลิคลกิ
ทีѷเซลลส์ตูร =A1 จะยา้ยตําแหน่ง cursor ไปทีѷเซลลต์น้ทาง A1 ใหทั้นท ี

สิѷงทีѷอธบิายขา้งตน้นีѸเคยอธบิายมาหลายตอ่หลายครั Ѹงในการอบรมและในเว็บ 
ExcelExpertTraining.com ซึѷงพฤตกิรรมแบบนีѸแหละทีѷนําไปสูเ่รืѷองแปลกทีѷคาดไมถ่งึ จากเดมิ
ทีѷเขยีนวา่ "สตูรทีѷหาคา่ได ้ก็ใชบ้อกตําแหน่งได"้ ขอเขยีนใหมใ่หล้ะเอยีดชดัเจนกวา่เดมิวา่ 

 
สตูรใดๆทีѷสามารถหาคา่ทีѷเก็บไวจ้ากตารางไดโ้ดยตรง สตูรนัѸนยอ่มเป็นสตูรทีѷบอก
ตําแหน่งได ้โดยอยา่สรา้งสตูรนัѸนลงไปในเซลล ์แตต่อ้งนําสตูรนัѸนไปซอ้นในสตูรอืѷนก็
จะกลายเป็นสตูรทีѷบอกตําแหน่ง  

 

ยกตัวอยา่งเชน่ สตูร =INDEX(A1:B10,5,2) เป็นสตูรหาคา่จากตารางขอ้มลูชว่ง A1:B10 ใน
ตําแหน่ง Row 5 ตัดกบั Column 2 จะไดค้า่จากเซลล ์B5 

ถา้อยากจะตามไปดวูา่เซลล ์B5 อยูท่ีѷไหนโดยไมต่อ้งนัѷงแกะสตูรวา่ Row 5 ตัดกบั Column 2 
คอืเซลลใ์ด ใหห้ยบิเมาสค์ลกิลากทับสตูร =INDEX(A1:B10,5,2) ทีѷแสดงบน Formula Bar 
จากนัѸนกดปุ่ ม F5 แลว้กดปุ่ ม Enter จะพบวา่สตูร =INDEX(A1:B10,5,2) เปลีѷยนไปเป็น =B5 
ใหทั้นท ีพอเห็นดังนีѸแลว้ใหก้ดปุ่ ม Esc เพืѷอทําใหส้ตูรคนืสูส่ภาพเดมิ 

ยิѷงกวา่นัѸน ถา้ Copy สตูร =INDEX($A$1:$B$10,5,2) ไวก้อ่นแลว้กดปุ่ ม F5 แลว้กดปุ่ ม Ctrl+v 
เพืѷอ Paste สตูรนีѸลงไปในชอ่ง Reference แลว้กดปุ่ ม Enter จะพบวา่ Excel พาคณุยา้ย
ตําแหน่งไปทีѷเซลล ์B5 ใหเ้ลย (สงัเกตวา่วธินีีѸตอ้งกําหนดตําแหน่งอา้งองิเป็น Absolute คอื 
$A$1:$B$10 กอ่นดว้ย) 

ยิѷงกวา่นีѸของยิѷงกวา่นัѸนอกี ถา้นําสตูร INDEX(A1:B10,5,2) ไปซอ้นในสตูรอืѷน เชน่ สตูร Offset 
จะทําใหส้ตูร INDEX(A1:B10,5,2) ทําหนา้ทีѷชีѸตําแหน่งตอ่ใหก้บั Offset 

ขอใหส้รา้งสตูร =OFFSET(INDEX(A1:B10,5,2),2,3) แลว้ลองใชว้ธิขีา้งตน้คน้หาวา่หมายถงึ
เซลลใ์ด จะพบวา่เป็นเซลล ์E7 ใชไ่หม เพราะเซลล ์E7 เป็นเซลลท์ีѷอยูถ่ัดลงมาจากเซลล ์B5 
จํานวน 2 row และถัดไปดา้นขวาจํานวน 3 column เทยีบเทา่กบัการใชส้ตูร 
=OFFSET(B5,2,3) นัѷนเอง 

แตถ่า้สรา้งสตูร =INDEX(A1:B10,5,2) ไวใ้นเซลล ์D12 แลว้ใชส้ตูร Offset อา้งถงึ D12 ใน
แบบ =OFFSET(D12,2,3) จะพบวา่ D12 ไมไ่ดช้ว่ยบอกตําแหน่งตอ่ใหก้บัสตูร Offset เพราะ
สตูร Index ในเซลล ์D12 ทําหนา้ทีѷหาคา่จากเซลล ์B5 มาแสดงเสร็จก็จบหนา้ทีѷไปแลว้ 

สตูรทีѷสามารถหาคา่ทีѷเก็บไวจ้ากตารางไดโ้ดยตรง ซึѷงทํางานไดแ้บบทีѷอธบิายนีѸ ไดแ้ก ่If, 
Choose, Index, Offset, Indirect (แตไ่มร่วมสตูร VLookup เพราะมันไมไ่ดห้าคา่ไดโ้ดยตรง) 
ซึѷงไมจํ่าเป็นตอ้งคนืคา่เพยีงคา่เดยีวเป็นตําแหน่งเซลลเ์ดยีว โดยสามารถคนืคา่เป็นตารางเพืѷอ
ใชบ้อกตําแหน่งตารางทั Ѹงตารางก็ยังได ้
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ดตูัวอยา่งประกอบบทความนีѸไดจ้าก 
"www.excelexperttraining.com/forums/content.php?r=191-สตูร-ตําแหน่งอา้งองิ" 

 

จํานวนเซลลส์ตูรเดยีว   

ผูส้รา้งสตูร Excel ทัѷวไป คุน้เคยกบัการสรา้งสตูรหนึѷงทีѷคนืคา่เพยีงหนึѷงคา่ หรอือกีนัยหนึѷง
เรยีกวา่ สตูรเดยีวคนืคา่เดยีว ซึѷงสรา้งลงไปในเซลลเ์ดยีว แตน่อ้ยคนนักทีѷจะทราบวา่ สตูร Excel 
สตูรหนึѷงๆสามารถคนืคา่เป็นคําตอบไดห้ลายคา่ก็เป็นไปไดเ้หมอืนกนั สตูรพวกหลังนีѸเรยีกวา่ 
สตูร Array 

การทีѷเราเลอืกเซลลเ์ดยีว แลว้พมิพส์ตูรลงไปในเซลลเ์ดยีวนัѸน มสีาเหตเุนืѷองจากสตูรนัѸนคนืคา่
ไดคํ้าตอบเพยีงคา่เดยีว 

ถา้สตูรหนึѷงๆคนืคา่เป็นคําตอบไดห้ลายคา่ หากสรา้งสตูรนัѸนลงไปในเซลลเ์ดยีว ยอ่มไมถ่กูตอ้ง 
แมจ้ะเห็นคําตอบแสดงขึѸนมาก็ตาม เพราะคําตอบทีѷแสดงขึѸนมาใหเ้ห็นนัѸนเป็นเพยีงคําตอบแรก
คําตอบเดยีว เราหมดโอกาสทราบคําตอบคา่อืѷนๆ 

พออา่นถงึตรงนีѸ คนทีѷไมรู่จั้กกบัสตูร Array คงเริѷมสงสยัวา่ สตูรแบบไหนกนัทีѷมคํีาตอบไดห้ลาย
คา่ในสตูรเดยีว มาทดลองโดยเริѷมจากพมิพค์า่ใดๆก็ไดล้งไปในเซลล ์A1:A3 สมมตวิา่พมิพ ์11, 
22, 33 ตามลําดับ  

 

แลว้สรา้งสตูร =A1:A3 ลงไปในเซลล ์B1 จะเห็นคําตอบเป็นเลข 11 คา่เดยีวใชไ่หม 

จากนัѸนใหแ้กะดคูา่ทีѷแทจ้รงิในสตูร โดยกดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่สตูร =A1:A3 
เปลีѷยนเป็น ={11;22;33} 

ขอใหส้งัเกตวา่เครืѷองหมายวงเล็บ { ทีѷเกดิขึѸนนัѸนอยูห่ลังจากเครืѷองหมายเทา่กบั ซึѷงแสดงคา่
แบบ Array และระหวา่งตัวเลขจะมเีครืѷองหมาย semi-colon ; คัѷน ซึѷงแสดงวา่คา่ถัดไปอยูใ่น 
Row ถัดไป (หรอืขึѸน Row ใหม)่ 

พอเห็นคา่แลว้วา่สตูรนีѸม ี3 คา่และแตล่ะคา่อยูต่ามแนวตั Ѹง ก็ใหก้ดปุ่ ม Esc เพืѷอยอ้นกลับไปเป็น
สตูร =A1:A3 ตามเดมิ 
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คราวนีѸถงึขั Ѹนตอนสําคัญ หากตอ้งการกระจายคา่แตล่ะคา่ในสตูร Array ลงไปในเซลล ์ใหเ้ริѷม
จากเลอืกเซลล ์3 เซลลต์ามแนวตั Ѹง (เพราะเราทราบจากการแกะสตูรมากอ่นแลว้วา่มคีา่ 3 คา่
ตามแนวตั Ѹง) โดยจะเลอืกทีѷตําแหน่งใดก็ไดใ้นชที จากนัѸนสรา้งสตูร =A1:A3 ลงไปแลว้กดปุ่ ม 
Ctrl+Shift+Enter พรอ้มกนั จะพบวา่ Excel กระจายคา่ในสตูรลงไปในเซลลแ์ตล่ะเซลลใ์หเ้ห็น
จนครบ และตัวสตูรเปลีѷยนเป็น {=A1:A3} โดยสงัเกตวา่คราวนีѸเครืѷองหมาย { ตัวแรกวางไว ้
กอ่นเครืѷองหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีѷเกดิจากการกดปุ่ ม Ctrl+Shift+Enter 
(ไมใ่ชว่งเล็บปีกกาทีѷใชก้ํากบัลําดับของคา่ทีѷตอ้งอยูห่ลังเครืѷองหมายเทา่กบั) 

ประโยชนข์องการเลอืกจํานวนเซลลใ์หค้รบเหมาะกบัจํานวนและแนวของคา่ทีѷตอ้งการนีѸ จะชว่ย
ใหเ้ราเห็นคา่ทกุคา่กระจายตัวลงไปในเซลลแ์ตล่ะเซลล ์ทําใหป้ระหยัดเวลาไมต่อ้งคอยกดปุ่ ม 
F2 ตามดว้ย F9 เพืѷอแกะสตูรเป็นครั Ѹงๆไป อกีทั Ѹงสตูรทีѷสรา้งขึѸนพรอ้มกนัทเีดยีวหลายเซลล ์จะ
ทําให ้Excel เสยีเวลาในการคํานวณเพยีงครั Ѹงเดยีว 

 

วธิแีก ้error #VALUE! ดว้ย Lotus 1-2-3   

เมืѷอนําเซลลท์ีѷมคีา่เป็นตัวเลขมาบวกดว้ยเซลลท์ีѷมคีา่เป็นตัวอกัษรโดยการสรา้งสตูรบวกทีѷนํา
เซลลม์าบวกกนั เชน่ =A1+A2 จะพบวา่ไดคํ้าตอบเป็น #VALUE! นัѸน เราสามารถสัѷงให ้Excel 
คํานวณหาคําตอบเป็นยอดรวมเฉพาะตัวเลขไดโ้ดยใชส้ัѷงให ้Excel คํานวณแบบ Lotus 1-2-3 

ใน Excel 2010 เริѷมจากสัѷง File > Options > Advanced > แลว้เลืѷอนจอไปดา้นลา่งสดุจะพบ 
Lotus compatibility Settings for: ชืѷอชทีทีѷตอ้งการใหคํ้านวณแบบ Lotus 1-2-3 โดยใหก้า
ชอ่ง Transition formula evaluation (Excel 2007 ใหค้ลกิปุ่ ม Office แทน File หรอื Excel 
2003 สัѷง Tools > Options > Transition > กาชอ่ง Transition formula evaluation) 
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คําสัѷง Transition formula evaluation นีѸเกดิขึѸนในสมัยทีѷคนทัѸงโลกยังนยิมใช ้Lotus 1-2-3 กนั 
ดังนัѸนเพืѷอชว่ยทําใหค้นเปลีѷยนใจมาใช ้Excel ไดง้า่ยขึѸน ทางไมโครซอฟทจ์งึสรา้งคําสัѷงนีѸข ึѸน
เพืѷอใหพ้วกเราสามารถนําแฟ้มทีѷสรา้งจาก Lotus 1-2-3 มาเปิดใชใ้น Excel ตอ่ไดทั้นทโีดย 
Excel จะเปลีѷยนระบบการคํานวณในชทีทีѷเลอืกไวใ้หคํ้านวณตามแบบทีѷ Lotus 1-2-3 ใชนั้ѷนคอื
ใน Lotus 1-2-3 ถอืวา่ตัวอกัษรมคีา่เทา่กบั 0 (สว่น Excel ถอืวา่ตัวอกัษรมคีา่มากกวา่เลขทัѸง
ปวง) 

นอกจากนัѸนหากกาชอ่ง Transition formula entry จะชว่ยทําใหส้ตูรทีѷสรา้งจาก Lotus 1-2-3 
release 2.2 ถกูเปลีѷยนเป็นสตูรของ Excel ใหทั้นทเีมืѷอเปิดแฟ้มทีѷใชส้ตูรนัѸนดว้ย Excel 

สว่นชอ่ง Transition navigation keys จะเปลีѷยนพฤตกิรรมของปุ่ มลกูศร ปุ่ ม Tab หรอืปุ่ มใดๆทีѷ
ทําหนา้ทีѷเคลืѷอนยา้ยตําแหน่งเซลลท์ีѷเลอืก ใหทํ้าตามทีѷ Lotus 1-2-3 ใช ้ซึѷงชว่งแรกกวา่ผมจะ
หันมาใช ้Excel อยา่งเต็มตัว ตอ้งอาศัยกาชอ่งนีѸอยูน่านเพราะมอืยังไมคุ่น้กบัปุ่ มทีѷเคยเลืѷอนไป
เลืѷอนมาตามแบบทีѷตัวเองเคยชนิ 

ตวัอกัษรมไิดม้คีา่เทา่กบั 0 

กอ่นจะจบบทความนีѸ ทราบไหมวา่ ตัวอกัษร a หรอืตัวอกัษรใดๆก็ตามทีѷบันทกึลงไปในเซลล ์
มไิดถ้อืวา่มคีา่เทา่กบั 0 หรอกนะ ถา้ไมเ่ชืѷอ สมมตวิา่เซลล ์A1 มคีา่เป็น a ขอใหล้องสรา้งสตูร 
=A1=0 ดกูไ็ดจ้ะพบวา่ไดคํ้าตอบเป็น FALSE สว่นสตูร =A1>999999999 จะไดคํ้าตอบเป็น 
TRUE 

Excel ถอืวา่ตัวอกัษรใดๆมคีา่มากกวา่เลขทัѸงปวง อกีนัยหนึѷงมคีา่เป็น Infinity หากสรา้งสตูร 
=Sum(A1,123) แลว้ไดคํ้าตอบเทา่กบั 123 เป็นเพราะ Excel จะละเลยไมนํ่าตัวอกัษรมา
คํานวณในสตูร Sum นีѷแหละเป็นเรืѷองทีѷหลายๆคนชอบเขา้ใจผดิกนัวา่ ตัวอกัษรมคีา่เป็น 0 

ถา้สรา้งสตูร =A1+123 จะไดคํ้าตอบเป็น #VALUE! เพราะ Excel จะไมย่อมรับการนําตัวอกัษร
มาบวกกบัตัวเลข แตเ่ราสามารถเปลีѷยนพฤตกิรรมของ Excel ใหค้ดิแบบ Lotus 1-2-3 ไดต้าม
คําอธบิายขา้งตน้ 

ถา้ถามวา่ระหวา่งสตูรบวกกบัสตูร Sum เราจะเลอืกใชก้ารบวกเลขวธิใีดกบังานสําคัญ 

คําตอบก็คอื ตอ้งเลอืกใชส้ตูรบวก เพราะหากมกีารบันทกึตัวเลขผดิ กลายเป็นบันทกึตัวอกัษร
ลงไปแทน จะพบวา่ Excel ไมย่อมคํานวณให ้โดยไดคํ้าตอบเป็น #VALUE! ซึѷงเทา่กบัชว่ย
เตอืนเราใหท้ราบวา่เกดิขอ้ผดิพลาดขึѸนมาในระหวา่งการบันทกึขอ้มลูนัѷนเอง 
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หลากหลายแนวทางการใชส้ตูร IF 

 

ในบรรดาสตูรสําเร็จรปูของ Excel นัѸน สตูรทีѷใชม้ากทีѷสดุและมปีระโยชนม์ากทีѷสดุรองจากสตูร 
SUM เห็นจะหนไีมพ่น้สตูร IF ซึѷงแปลวา่ "ถา้" นีѸแหละ โดยเฉพาะคนทีѷมตํีาแหน่งขึѸนชืѷอวา่เป็น
หัวหนา้ ถา้ใชส้ตูร IF ไมเ่ป็น ก็ไมส่มควรเป็นหัวหนา้หรอกนะ เปลีѷยนตําแหน่งใหไ้ดช้ืѷอตรงขา้ม
กบัคําวา่หัวกบัหนา้ ใหก้ลายเป็นตําแหน่งเทา้หลังแทนจะเหมาะสมกวา่ 

ถา้นําเงืѷอนไขขา้งตน้เกีѷยวกบัหัวหนา้มาเขยีนดว้ยสตูร IF จะไดส้ตูรตามนีѸ 

=IF ( หวัหนา้ใชส้ตูร IF เป็นหรอืไม ่, ถา้ใชเ้ป็น ใหเ้ป็นหวัหนา้ตอ่ไป , ถา้ใชไ้ม่
เป็น ใหเ้ป็นเทา้หลงัแทน ) 

หรอืถา้คดิเขยีนสตูร IF ตามหลักกฎแหง่กรรมของการทําดตีอ้งไดด้ ีทําชัѷวไดช้ัѷว จะไดส้ตูรตาม
นีѸ 

=IF ( คณุทําดใีชไ่หม , ถา้ทําด ีตอ้งไดด้ ี, ถา้ไมท่ําด ีตอ้งไดร้บัผลอืѷนๆ ) 

สงัเกตวา่ในสตูร IF ของการตรวจสอบวา่ทําดหีรอืไมนั่Ѹน ถา้ไมไ่ดทํ้าด ีไมใ่ชว่า่จะไดช้ัѷว เพราะ
เงืѷอนไขทีѷใชเ้ป็นเพยีงตรวจสอบวา่ทําดอียา่งเดยีวเทา่นัѸน คนทีѷไมไ่ดทํ้าด ีไมใ่ชว่า่ตอ้งทําชัѷวก็
ได ้อาจอยูเ่ฉยๆไมไ่ดทํ้าดไีมไ่ดทํ้าชัѷว ดังนัѸนกรณีทีѷไมไ่ดทํ้าด ีจงึตอ้งไดร้ับผลอยา่งอืѷนซึѷงไมใ่ช่
ผลจากการทําด ี

ถา้คณุเขา้ใจวธิคีดิเงืѷอนไขในใจของตัวคณุเอง ก็จะพบวา่บรษัิทไมโครซอฟทไ์ดส้รา้ง Excel 
ขึѸนมาโดยใชส้ตูร IF ทีѷมโีครงสรา้งของสตูรตามหลักการเดยีวกนักบัทีѷคณุคดิไดนั้ѷนเอง 

 

โครงสรา้งสตูร IF 

=IF(การตรวจสอบเงืѷอนไข, ผลลพัธก์รณีทีѷตรวจสอบเงืѷอนไขวา่ใช,่ ผลลพัธ์
กรณีทีѷตรวจสอบเงืѷอนไขวา่ไมใ่ช)่ 

ในสว่นของการตรวจสอบเงืѷอนไข ใหใ้สส่มการทีѷตอ้งการลงไป โดยใชเ้ครืѷองหมาย =, >, <, 
>=, <=, หรอืไมเ่ทา่กบั <> หรอืในสว่นของการตรวจสอบเงืѷอนไขนีѸ อาจใชส้ตูรอืѷนซึѷงคนืคา่
เป็น TRUE หรอื FALSE อยา่งใดอยา่งหนึѷง เชน่ AND, OR, TRUE, FALSE, ISNUMBER เป็น
ตน้ 
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ตวัอยา่งการใช ้IF แบบงา่ยๆ 

 

=IF(SaleChoice="n", 1000, 2000) 

สตูรนีѸจะคนืคา่เป็นตัวเลข 1000 ตอ่เมืѷอเซลลท์ีѷตั Ѹงชืѷอวา่ SaleChoice มคีา่เป็นตัวอกัษร n 
เทา่นัѸน แตถ่า้ SaleChoice มคีา่อืѷน จะคนืคา่เป็นตัวเลข 2000 แทน 

เนืѷองจากตัวอกัษร n เป็นตัวอกัษรทีѷ Excel ไมรู่จั้ก จงึจําเป็นตอ้งใส ่"n" ไวร้ะหวา่งเครืѷองหมาย
คําพดู สว่นคําวา่ IF และ SaleChoice นัѸนแมว้า่เป็นตัวอกัษรแตไ่มต่อ้งใสร่ะหวา่งเครืѷองหมาย
คําพดูเพราะเป็นตัวอกัษรทีѷ Excel รูจั้กแลว้วา่คําวา่ IF คอืสตูรชืѷอ IF และคําวา่ SaleChoice เป็น 
Range Name ทีѷตั Ѹงชืѷอไว ้สว่นตัวเลข 1000 และ 2000 เป็นตัวเลขทีѷ Excel รับทราบอยูแ่ลว้วา่
เป็นตัวเลขจงึไมต่อ้งใสร่ะหวา่งเครืѷองหมายคําพดูแตอ่ยา่งใด 

 

=IF(MyMargin>0, MyMargin*0.3, 0) 

สตูรนีѸใชก้บัการคํานวณหายอดภาษี ถา้ MyMargin หรอืเซลลก์ําไรขั Ѹนตน้มคีา่มากกวา่ 0 ยอ่ม
แสดงวา่มกีําไรเกดิขึѸน จงึนํายอดกําไรขั Ѹนตน้ไปคณูดว้ยอตัราภาษี 30% แตถ่า้ไมม่กีําไรก็ไม่
ตอ้งจา่ยภาษี  

 

แนวทางการใชส้ตูร IF 

1.ใชเ้ปลีѷยนเสน้ทางการรับคา่ 

2.ใชใ้นการตัดสนิใจ 

3.ใชใ้นการเปลีѷยนคา่หรอืแสดงคา่ 

4.ใชเ้ปลีѷยนเสน้ทางการสง่คา่ 
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การใชส้ตูร IF ในการเปลีѷยนเสน้ทางการรบัคา่   

 

การสรา้งสตูรลงิคเ์พืѷอเชืѷอมโยงคา่โดยทัѷวไปเป็นการเชืѷอมโยงกนัแบบ 1 ตอ่ 1 เชน่ เมืѷอตอ้งการ
ทําใหเ้ซลล ์A2 มคีา่เทา่กบัเซลล ์A1 ก็จะสรา้งสตูร =A1 ลงไปในเซลล ์A2 ทําใหเ้ซลล ์A2 
แสดงคา่เปลีѷยนแปลงตามคา่ในเซลล ์A1 ซึѷงการลงิคแ์บบนีѸเซลล ์A1 เรยีกวา่เป็นเซลลต์น้ทาง 
และเซลล ์A2 เรยีกวา่เป็นเซลลป์ลายทาง 

แตถ่า้เซลลต์น้ทางมมีากกวา่ 1 เซลล ์เชน่กําหนดใหเ้ซลล ์C2 และ C3 สามารถเป็นเซลลต์น้
ทางไดทั้ Ѹงคู ่โดยกําหนดใหเ้ซลล ์E3 เป็นเซลลป์ลายทางเพยีงเซลลเ์ดยีว โดยเลอืกทีѷจะรับคา่
จากเซลล ์C2 หรอื C3 ก็ไดแ้ลว้แตเ่งืѷอนไขทีѷเรากําหนดวา่จะใหเ้ลอืกรับคา่มาจากเซลลใ์ด 

 

จากภาพกําหนดใหเ้ซลล ์E2 เป็นเซลลส์ําหรับใสค่า่เงืѷอนไขลงไปวา่จะเป็นตัวอกัษร A หรอื B 
(หรอืคา่อืѷนใดก็ได)้ สว่นเซลล ์E3 ซึѷงเป็นเซลลป์ลายทาง ใหส้รา้งสตูรตอ่ไปนีѸ 

=IF( E2="A", C2, C3) 

ดังนัѸนเมืѷอเซลล ์E2 มคีา่เป็น A จงึทําใหเ้ซลล ์E3 รับคา่ 100 มาจากเซลล ์C2 แตถ่า้เซลล ์E2 
ไมไ่ดม้คีา่เป็น A ก็จะทําใหเ้ซลล ์E3 เปลีѷยนเสน้ทางการรับคา่ 200 มาจากเซลล ์C3 แทน 

แตถ่า้กําหนดใหม้จํีานวนเซลลต์น้ทางมากมายหลายเซลล ์เชน่ ตามรปูตอ่ไปนีѸใชเ้ซลลต์น้ทาง
ถงึ 14 เซลล ์

 

สตูรลงิคเ์พืѷอเลอืกรับคา่ในเซลล ์F9 จะกลายเป็นสตูรซบัซอ้นมากขึѸน 
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=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(
E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="
K",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

ซึѷงเซลล ์E9 มคีา่เป็น K จงึทําใหส้ตูร IF ในเซลล ์F9 เลอืกรับคา่มาจากเซลล ์I8 

แตถ่า้โครงสรา้งตารางไมไ่ดจั้ดใหเ้ป็นระเบยีบ แมส้ตูร IF จะยงัคงทํางานไดต้ามเดมิก็ตาม แต่
จะพบวา่การแกะสตูรเพืѷอตรวจสอบความถกูตอ้งทําไดย้ากขึѸนมาก 

 

 

สตูรในเซลล ์F9 

=IF(E9="A",C2,IF(E9="B",I3,IF(E9="C",J11,IF(E9="D",F2,IF(E9="E",I9,IF(E9
="F",J16,IF(E9="G",H14,IF(E9="H",E14,IF(E9="I",G17,IF(E9="J",H7,IF(E9=
"K",C8,IF(E9="L",D6,IF(E9="M",D12,C17))))))))))))) 

แตช่ว่ยตรวจสอบวา่ แมว้า่ E9 มคีา่เทา่กบั K ทําใหเ้ซลล ์F9 รับคา่ 1100 มาจากเซลล ์C8 ได ้
ถกูตอ้งตามตอ้งการก็ตาม แตค่า่ 1100 ทีѷไดร้ับมานัѸน ไมใ่ชต่ัวเลขของคา่ K แตเ่ป็นของคา่ X 
มใิชห่รอื 

ตั Ѹงแต ่Excel 2007 เป็นตน้มา ในวงเล็บของแตล่ะสตูร เราสามารถซอ้นสตูรเขา้ไปไดถ้งึ 64 สตูร 
(Excel 2003 และรุน่กอ่นนัѸนจะซอ้นไดเ้พยีง 7 สตูร) ซึѷงจากตัวอยา่งขา้งตน้น่าจะทําใหเ้ราได ้
เรยีนรูว้า่ ถงึแมว้า่เราสามารถใชส้ตูร IF ซอ้น IF เพืѷอหาคา่ทีѷกระจายกนัอยูต่า่งทีѷตา่งชทีตา่ง
แฟ้มไดก้็ตาม แตก่ารกระจายกนัของคา่นีѷเอง หากกระจายอยา่งขาดระเบยีบ ยอ่มเพิѷมความเสีѷยง
ทีѷจะหาคําตอบผดิพลาดไดโ้ดยไมรู่ต้ัว และเมืѷอจะตรวจสอบแกไ้ขก็จะทําใหทํ้าไดย้าก 

ดังนัѸนโปรดจําไวว้า่ ขอใหเ้ลอืกใชส้ตูร IF กบัปัญหางา่ยๆ แตเ่มืѷอปัญหาซบัซอ้นมากขึѸน 
เราควรปรับเปลีѷยนโครงสรา้งตารางหรอืเลอืกใชส้ตูรอืѷนซึѷงทํางานไดเ้ชน่เดยีวกนักบัสตูร 
IF จะเหมาะสมกวา่ 
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การใชส้ตูร IF ในการตดัสนิใจ   

 

โครงสรา้งสตูร IF แบบงา่ยๆ =IF(เงืѷอนไข,ผลกรณีใช,่ผลกรณีไมใ่ช)่ มพีืѸนฐานของตัวสตูรทํา
หนา้ทีѷตัดสนิใจตามเงืѷอนไขทีѷเรากําหนดลงไปในสตูรอยูแ่ลว้ ไมว่า่จะใชส้ตูร IF ในการเปลีѷยน
เสน้ทางการรับคา่หรอืใชใ้นการปรับเปลีѷยนคา่ก็ตาม ยอ่มถอืวา่เป็นการใชส้ตูร IF ในการ
ตัดสนิใจนัѷนเอง เพยีงแตห่ัวขอ้นีѸจะแยกแยะประเภทของการตัดสนิใจใหเ้ห็นชดัขึѸน  

การใชส้ตูร IF ในการตัดสนิใจม ี2 แบบ ขึѸนกบัวา่เงืѷอนไขถัดไปกําหนดวา่ตอ้งผา่นเงืѷอนไขกอ่น
หนา้อยา่งไร 

1. การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ช ่

2. การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใช ่

 

การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ช ่ 

เป็นเงืѷอนไขทีѷพบเห็นกนัทัѷวไป เชน่ สตูร IF ในตัวอยา่งทีѷใชส้ําหรับเปลีѷยนเสน้ทางในการรับคา่
นัѷนเอง เมืѷอเงืѷอนไขการรับคา่แรกผา่นไปแลว้ ไดคํ้าตอบแรกตามเงืѷอนไขแรกเมืѷอตัดสนิวา่ใชไ่ป
แลว้ก็จะไดคํ้าตอบกรณีทีѷใชเ่รยีบรอ้ย แตห่ากเงืѷอนไขแรกไมผ่า่น ก็จะตอ้งพจิารณาเงืѷอนไขใน
ลําดับถัดไป ซึѷงแสดงเป็นโครงสรา้งสตูร IF จากแบบงา่ยๆกลายเป็นแบบซอ้นกนัดังนีѸ  

สําหรับการตดัสนิใจในเงืѷอนไขแรก 

=IF(เงืѷอนไขทีѷ 1, ผลกรณีใชข่องเงืѷอนไขทีѷ 1, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1) 

ถา้เงืѷอนไขทีѷ 1 ยังไมผ่า่น ใหแ้ตกผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1 ตอ่เป็น IF สตูรทีѷสองเพืѷอคดิ
ตามเงืѷอนไขทีѷ 2 

=IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่องเงืѷอนไขทีѷ 2, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 2) 

เมืѷอนําสตูรทั Ѹงสองเงืѷอนไขมาซอ้นเป็นสตูรในเซลลเ์ดยีว จะไดส้ตูรตามนีѸ 

=IF(เงืѷอนไขทีѷ 1, ผลกรณีใชข่องเงืѷอนไขทีѷ 1, IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่อง
เงืѷอนไขทีѷ 2, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 2) ) 
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ตวัอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ชใ่นการตดัเกรด 

 

กําหนดใหเ้ซลล ์B3:C5 เป็นตารางคะแนน-เกรด  

 ถา้สอบไดต้ั Ѹงแต ่90 คะแนนขึѸนไปใหไ้ดเ้กรด A 

 ถา้สอบไดต้ั Ѹงแต ่70 คะแนนขึѸนไปใหไ้ดเ้กรด B 

 ถา้สอบไดต้ั Ѹงแต ่0 คะแนนขึѸนไปใหไ้ดเ้กรด C 

สมมตวิา่เซลล ์E3 มคีา่เป็น 75 เป็นคะแนนทีѷสอบได ้เซลล ์F3 หาคําตอบเป็นเกรด B โดยใช ้
สตูร IF ซอ้นกนัดังนีѸ 

=IF( E3>=B3, C3, IF(E3>=B4,C4,C5) ) 

ซึѷงแปลสตูรออกมาตามเงืѷอนไขทีѷกําหนดไดเ้ป็น 

=IF( คะแนนทีѷสอบได ้>=90, "A", IF(คะแนนทีѷสอบได ้>=70,"B","C") ) 

ขอ้สงัเกต 

1. การเขยีนสตูร IF ซอ้น IF มหีลักการสาํคัญ คอื ตอ้งจดัลําดบัของเงืѷอนไขทีѷเปิด
โอกาสให ้IF ทกุตวัในสตูรมโีอกาสไดท้ํางาน ดังนัѸนจงึตอ้งใชเ้งืѷอนไข คะแนนทีѷ
สอบได ้>=90 ขึѸนกอ่นเป็นเงืѷอนไขแรก หากเงืѷอนไขนีѸไมผ่า่นจงึปลอ่ยใหเ้งืѷอนไขถัดไป
ทํางาน (แตถ่า้สรา้งผดิโดยใชเ้งืѷอนไข >=70 ขึѸนกอ่น จะปิดโอกาสของเงืѷอนไขเกรด A 
เพราะ >=70 ยอ่มหมายถงึ >=90 อยูแ่ลว้) 

2. แมต้อ้งการเกรด A, B, C แตเ่ราใช ้IF ซอ้นกนัเพยีง 2 IF เทา่นัѸน เพราะถา้ไมใ่ชทั่ Ѹงสอง
เงืѷอนไข ก็ตอ้งเป็นเกรด C นัѷนเอง 
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การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใช ่ 

 

เป็นเงืѷอนไขทีѷกําหนดซอ้นเขา้ไปเพืѷอตัดสนิใจในทกุเงืѷอนไขพรอ้มกนัไป เกดิเป็นโครงสรา้งสตูร
ตามนีѸ 

=IF(เงืѷอนไขทีѷ 1, IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่องเงืѷอนไขทีѷ 1 และ 2, ผลกรณี
ไมใ่ชข่องเงืѷอนไขทีѷ 2), ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1) 

หากผลกรณีทีѷใชข่องทกุเงืѷอนไขเป็นคา่เดยีวกนั สว่นผลกรณีทีѷไมใ่ชข่องเงืѷอนไขทีѷ 1 และผล
กรณีทีѷไมใ่ชข่องเงืѷอนไขทีѷ 2 เป็นคา่เดยีวกนั แทนทีѷจะใชส้ตูร IF ซอ้นกนัหลายสตูร ใหใ้ชส้ตูร 
And หรอืถา้เป็น IF หลายสตูรบวกกนัใหใ้ช ้Or มาชว่ยในสตูร IF เพยีงสตูรเดยีวไดด้ังนีѸ 

=IF( And( เง ืѷอนไขทีѷ 1,เง ืѷอนไขทีѷ 2), ผลกรณใีช,่ ผลกรณีไมใ่ช)่ 

=IF( OR( เง ืѷอนไขทีѷ 1,เง ืѷอนไขทีѷ 2), ผลกรณีใช,่ ผลกรณีไมใ่ช)่ 

หมายเหต ุ

1. สตูร And จะคนืคา่เป็นจรงิตอ่เมืѷอทกุเงืѷอนไขเป็นจรงิพรอ้มกนั หากเงืѷอนไขใดเงืѷอนไข
หนึѷงเป็นเท็จ จะคนืคา่เป็นเท็จ (จําวา่ False เป็นลักษณะเดน่) 

2. สตูร OR จะคนืคา่เป็นเท็จตอ่เมืѷอทกุเงืѷอนไขเป็นเท็จพรอ้มกนั หากเงืѷอนไขใดเงืѷอนไข
หนึѷงเป็นจรงิ จะคนืคา่เป็นจรงิ (จําวา่ True เป็นลักษณะเดน่) 

ตวัอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใชใ่นการป้องกนัสตูรลบั  

 

สมมตวิา่เราตอ้งการบวกเลข 1 กบัเลข 2 ในเซลล ์B2 และ C2 เขา้ดว้ยกนั แตก่อ่นจะยอมให ้
สตูร B2+C2 ทํางานไดต้ามปกต ิตอ้งผา่นการกรอกรหัสลงไปในเซลล ์B4 และ B5 เป็นเลข 
123 และ 999 ตามลําดับใหถ้กูตอ้งเรยีบรอ้ยกอ่น 

ถา้สรา้งสตูร IF ซอ้น IF จะไดส้ตูรตามเซลล ์D2 

=IF( B4=123, IF(B5=999, B2+C2, 0), 0) 

หรอืใชส้ตูร And มาใชง้านรว่มดว้ย กลายเป็นสตูร IF เพยีงสตูรเดยีวดังนีѸ 

=IF( AND(B4=123,B5=999), B2+C2, 0) 
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ตวัอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใชใ่นการรบัเงนิในชว่งวนัทีѷ
กําหนด 

 

หากตอ้งการรับเงนิ 100 บาท ระหวา่งวันทีѷ 2-5 กําหนดใหใ้ช ้Range Name ในตารางตอ่ไปนีѸ 

 B3:B8 ชืѷอ From 

 C3:C8 ชืѷอ To 

 D3:D8 ชืѷอ Amount 

 E2:K2 ชืѷอ Date 

เซลล ์E3 เป็นสตูรรับเงนิในชว่งวันทีѷตอ้งการตามนีѸ 

=IF( Date>=From, IF(Date<=To,Amount,0), 0) 

หรอื 

=IF( AND(Date>=From,Date<=To), Amount, 0) 

ขอ้สงัเกต 

ตัวอยา่งนีѸใชส้ตูร And มาชว่ยเพราะตอ้งการใหค้นืคา่เป็น True เฉพาะในชว่งวันทีѷ 2-5 เทา่นัѸน 
(ดเูซลล ์E8:K8) 
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การใชส้ตูร IF ในการเปลีѷยนคา่หรอืแสดงคา่   

 

ในกรณีทีѷผลลัพธจ์ากการคํานวณหรอืคา่ทีѷไดจ้ากการลงิคต์อ่มาจากเซลลอ์ืѷน อาจไมใ่ชค่า่ทีѷ
ตอ้งการแสดงใหผู้ใ้ชเ้ห็นเสมอไป เราสามารถนําสตูร IF มาชว่ยเปลีѷยนคา่เดมินัѸนใหก้ลายเป็น
คา่ใหมห่รอืเปลีѷยนจากตัวเลขหรอืคําเตอืน Error ใหก้ลายเป็นตัวอกัษรทีѷสืѷอความหมายได ้
ชดัเจนกวา่แทน 

 

โปรดดตูัวอยา่งจาก Row 2 ขา้งตน้ ในการนําเลขมาหารกนันัѸน หากเป็นตัวเลขทีѷนํามาหารกนั
ได ้ก็ยอ่มคนืคา่ทีѷตอ้งการออกมาไดทั้นท ีเชน่ เมืѷอนําเลข 100 จากเซลล ์B2 มาหารดว้ยเลข 5 
จากเซลล ์C2 โดยสรา้งสตูร = B2/C2 ลงไปในเซลล ์D2 จะไดคํ้าตอบเป็นตัวเลข 20 

ใน Row 5 ถา้เปลีѷยนเลข 5 ทีѷเป็นตัวหาร ใหเ้ป็นเลข 0 แทน จะพบวา่สตูร =B5/C5 ไมส่ามารถ
คํานวณได ้โดยแสดง Error #DIV/0! ออกมาแทน (#DIV/0! ยอ่มาจากคําวา่ Error from 
Divided by Zero หรอื Error เนืѷองจากการถกูหารดว้ยเลข 0) 

เราสามารถเปลีѷยนการแสดง Error ใหเ้ป็นเลข 0 แทน โดยใชส้ตูรตามตัวอยา่งใน Row 8 ดังนีѸ 

=IF(C8=0, 0, B8/C8) 

หรอือา่นสตูรเป็นคําแปลวา่ ถา้เซลลต์ัวหารมคีา่เทา่กบั 0 ใหผ้ลลัพธแ์สดงเลข 0 แทนการแสดง 
Error แตถ่า้ตัวหารไมใ่ชเ่ลข 0 ก็ใหคํ้านวณหารกนัตอ่ไปตามปกต ิ

ถา้ตัวหารไมใ่ชเ่ลข 0 แตก่ลับกลายเป็นตัวอกัษร o จะพบวา่สตูร IF ขา้งตน้นีѸคอืคา่ออกมาเป็น 
#VALUE! แทน เพราะ Excel ไมย่อมรับการนําตัวอกัษรไปหารตัวเลข 

ใน Row 11 กรณีทีѷตัวหารเป็นตัวอกัษร o (หรอืตัวอกัษรอืѷนใด) เราสามารถป้องกนัการเกดิ 
Error จากการหารโดยใชส้ตูร IsError มาชว่ยตรวจสอบการคํานวณวา่จะเกดิ Error หรอืไม ่

=IF( ISERROR(B11/C11), 0, B11/C11) 

หรอืตั Ѹงแต ่Excel 2007 เป็นตน้มาม ีIfError เป็นสตูรใหมท่ีѷสั Ѹนลง 

=IFERROR(B11/C11,0) 
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หมายเหต ุ

1. กอ่นทีѷจะใชส้ตูร IsError ควรหาทางตรวจสอบสตูรคํานวณทีѷสรา้งกอ่นวา่สามารถ
คํานวณไดคํ้าตอบทีѷตอ้งการหรอืไม ่เพราะหากใชส้ตูร IsError เขา้มาชว่ยรว่มกบัสตูร IF 
แลว้ เราจะไมเ่ห็น Error เกดิขึѸนอกีเลย 

2. ควรเลอืกนําเฉพาะบางสว่นของการคํานวณจากสตูรทีѷจะนํามาตรวจสอบดว้ยสตูร 
IsError โดยไมจํ่าเป็นตอ้งนําสตูรยาวๆทั Ѹงหมดมาใสล่งไปในวงเล็บของสตูร IsError 

3. ในกรณีทีѷเกดิ Error ขึѸน ในกรณีทีѷผลลัพธเ์ดมิเป็น Text ควรเปลีѷยน Error เป็นคําเตอืน 
หรอืกรณีผลลัพธเ์ดมิเป็นเลข ควรเปลีѷยน Error เป็นเลข 0 แทน จากนัѸนใหใ้ช ้Format 
0;-0; ซอ่นเลข 0 ใหด้เูหมอืนเป็นชอ่งวา่ง 

4. ในการเปลีѷยนการแสดง Error ใหแ้สดงเป็นชอ่งวา่ง พยายามหลกีเลีѷยงการใช ้Null Text 
หรอื "" (แทนการใชเ้ลข 0) เพราะ "" มสีภาพเป็น Text ซึѷงหากนําคา่นีѸไปบวกลบคณู
หารตอ่จะเกดิ Error ตอ่ไปอกี กลายเป็นภาระใหเ้ราตอ้งสรา้งสตูร =IF(Cell="", "", 
Cell) ตอ่ไปอกี ซึѷงทําใหแ้ฟ้มคํานวณชา้ลงและมขีนาดใหญข่ึѸนโดยไมจํ่าเป็น 

5. ในกรณีทีѷตอ้งการแสดง #N/A ใหใ้ชส้ตูร NA() 

6. นอกเหนอืจากการใชส้ตูร IF ชว่ยในการเปลีѷยน Error ใหเ้ป็นคา่อืѷนแลว้ ในหนา้กระดาษ
ทีѷถกูพมิพ ์สามารถใชคํ้าสัѷง Page Setup > Sheet > Print > Cells error as เพืѷอ
เปลีѷยนเซลลท์ีѷมคีา่เป็น Error ใหแ้สดงเป็นชอ่งวา่ง, --, #N/A แทนไดอ้กีดว้ย 

 

สตูรกลุม่ Is ทีѷใชช้ว่ยในการตรวจสอบ  

 IsNA ตรวจสอบ Error #N/A "Not Available" ซึѷงเกดิจากสตูรกลุม่ Lookup ในกรณีทีѷ
หาคา่ทีѷตอ้งการไมพ่บ 

 IsError ตรวจสอบ Error ทกุประเภท 

 IsErr ตรวจสอบ Error เกอืบทกุประเภท เวน้ NA 

 IsBlank ตรวจสอบเซลลว์า่ง 

 IsText ตรวจสอบเซลลม์คีา่เป็น Text หรอืคา่ทีѷจะชดิซา้ยใหเ้องเมืѷอพมิพล์งไป เชน่ 
'123 ถอืวา่เป็น Text 

 IsNumber ตรวจสอบเซลลม์คีา่เป็น Number หรอืคา่ทีѷจะชดิขวาใหเ้องเมืѷอพมิพล์งไป 
เชน่ 10/4/2010 จะชดิขวาเพราะถอืวา่เป็น Number 
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การใชส้ตูร IF ในการเปลีѷยนเสน้ทางการสง่คา่   

 

ตามปกตสิตูรทีѷสรา้งลงไปในเซลลจ์ะทําหนา้ทีѷคํานวณหรอืรับคา่ทีѷลงิคม์าจากเซลลต์น้ทาง สว่น
การสง่คา่จากเซลลต์น้ทางไปยังเซลลป์ลายทางโดยไมต่อ้งสรา้งสตูรลงไปในเซลลนั์Ѹนไม่
สามารถทําไดโ้ดยวธิปีกตทัิѷวไป แตต่อ้งเขยีนรหัส VBA เขา้มาชว่ย 

 

ตัวอยา่ง กําหนดใหส้ง่คา่จากเซลล ์Source ไปยังเซลล ์Target1 หรอื Target2 ตามเงืѷอนไข
ตอ่ไปนีѸ 

 หาก Source มคีา่นอ้ยกวา่ 0 เชน่มคีา่เป็นเลข -111 ใหส้ง่คา่ -111 ไปยังเซลล ์
Target1 

 หาก Source มคีา่มากกวา่หรอืเทา่กบั 0 เชน่มคีา่เป็นเลข 222 ใหส้ง่คา่ 222 ไปยัง
เซลล ์Target2 

เริѷมตน้จากใหต้ั Ѹงชืѷอ Source, Target1, Target2 ใหก้บัเซลล ์C2, C5 ,C6 ตามลําดับและตั Ѹงชืѷอ 
Target เป็น Formula Name มคีา่เป็นสตูร 

=IF( Source<0, Target1, Target2) 

จากนัѸนใหส้รา้งชดุคําสัѷงนีѸลงไปใน Visual Basic Editor 

Sub SendData() 

MyVar = [Source] 

[Target] = MyVar 

End Sub 
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1. ชดุคําสัѷงนีѸจะรับคา่ทีѷเก็บไวใ้นเซลลท์ีѷตั Ѹงชืѷอไวว้า่ Source ไปเก็บไวท้ีѷตัวแปรทีѷมชีืѷอวา่ 
MyVar 

2. จากนัѸนคา่ทีѷเก็บไวใ้น MyVar จะถกูสง่ตอ่ไปยัง Formula Name ทีѷตั Ѹงชืѷอไวว้า่ Target 

3. เนืѷองจาก Target เป็นสตูร =IF( Source<0, Target1, Target2) จงึทําหนา้ทีѷ
ตรวจสอบคา่ทีѷรับมาจาก Source กอ่นแลว้จงึเลอืกสง่คา่ไปยังเซลลท์ีѷตั Ѹงชืѷอวา่ Target1 
หรอื Target2 ตามเงืѷอนไขทีѷกําหนดไวข้า้งตน้ตอ่ไป 
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หลบรอ้นหนสีตูร IF ไปหาทางออกอืѷน 
 

สตูร IF เป็นสตูรทีѷมคีวามยดืหยุน่อยา่งมาก เราสามารถใชทั้ Ѹงตัวเลข ตัวอกัษร สตูรอืѷน หรอื
ตําแหน่งอา้งองิเพืѷอใชใ้นการกําหนดเงืѷอนไข และสามารถใชเ้งืѷอนไขเปรยีบเทยีบคา่ไดทั้ Ѹง
เทา่กบั มากกวา่ นอ้ยกวา่ หรอืไมเ่ทา่กบั ซึѷงใน Excel ตั Ѹงแตรุ่น่ 2007 เป็นตน้มาไดป้รับปรงุให ้
สามารถนําสตูรมาซอ้นเขา้ไปไดถ้งึ 64 สตูร ทําใหใ้ชส้ตูร IF ไดก้วา้งขวางกวา่ Excel 2003 
หรอืรุน่เกา่กอ่นนัѸนทีѷซอ้นสตูรไดอ้กีเพยีง 7 สตูรเทา่นัѸน 

ไมว่า่จะใชส้ตูร IF ใหเ้ต็มทีѷตามความสามารถของ Excel รุน่เกา่หรอืรุน่ใหม ่ถา้เขยีนสตูร IF 
ซอ้นกนัจนกลายเป็นสตูรยาวเหยยีดตามสตูรในเซลล ์D9 ตอ่ไปนีѸ คณุคดิวา่อยากจะใชส้ตูร IF 
ตอ่ไปอกีหรอื 

 

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU
M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,0))))))) 

+IF(SUM(F9:L9)>C9,0,IF(SUM(F9:M9)>C9,8,IF(SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>
C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9,12,IF(SUM(F9:R9)>C9,13,0))))))) 

+IF(SUM(F9:R9)>C9,0,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:U9)
>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,0)))))
)) 

+IF(SUM(F9:X9)>C9,0,IF(SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9
)>C9,22,IF(SUM(F9:AB9)>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,0)
)))))) 

+IF(SUM(F9:AD9)>C9,0,IF(SUM(F9:AE9)>C9,26,IF(SUM(F9:AF9)>C9,27,IF(SUM(F9:
AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI9)>C9,30,IF(SUM(F9:AJ9)>C9,31
,0))))))) 
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สตูรขา้งตน้เป็นสตูรคํานวณหาวันทีѷใดในแตล่ะเดอืนซึѷงสนิคา้ทีѷเก็บไวใ้น Stock จะเริѷมไม่
เพยีงพอตอ่การเบกิใช ้โดยตอ้งนําสตูร IF มาซอ้นกนัเพืѷอตรวจสอบยอดเบกิใชส้ะสมตั Ѹงแตว่ัน
แรกไปจนถงึสิѸนเดอืน เริѷมจากยอดเบกิวันแรกในเซลล ์F9 กลายเป็นยอดเบกิสะสม 2 วันจาก
เซลล ์F9:G9 หรอืยอดเบกิสะสม 3 วันจากเซลล ์F9:H9 เรืѷอยไปจนถงึ F9:AJ9 ซึѷงเป็นยอดเบกิ
ใชส้ะสมถงึ 31 ครั Ѹงตามจํานวนวันในแตล่ะเดอืนมาเทยีบกบัปรมิาณ Stock ในเซลล ์C9  

ถา้ใช ้Excel 2003 หรอืรุน่กอ่นนัѸน ตอ้งแยกสตูรทีѷซอ้นกนัชดุละ 7 วัน โดยกําหนดเงืѷอนไขในแต่
ละชดุวา่ หากไมเ่ป็นจรงิใหค้นืคา่เทา่กบั 0 โปรดสงัเกตวา่ในวงเล็บของ IF ทีѷซอ้นกนัแตล่ะชดุ
นัѸนจะลงทา้ยดว้ย ,0))))))) แลว้จงึนําสตูร IF ทีѷซอ้นกนัมาบวกเขา้ดว้ยกนั 

โจทยเ์ดยีวกนันีѸ หากใช ้Excel 2007 เป็นตน้มา เราสามารถซอ้น IF ลงไปในวงเล็บของสตูร IF 
รว่มกนัไดส้งูสดุถงึ 64 สตูรไดเ้ลย ทําใหส้ตูรสั Ѹนลงบา้งเหลอืสตูรตามนีѸ 

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU
M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,IF(SUM(F9:M9)>C9,8,IF(
SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9
,12,IF(SUM(F9:R9)>C9,13,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:
U9)>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,IF(
SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9)>C9,22,IF(SUM(F9:AB9)
>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,IF(SUM(F9:AE9)>C9,26,IF(
SUM(F9:AF9)>C9,27,IF(SUM(F9:AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI
9)>C9,30,IF(SUM(F9:AJ9)>C9,31,0))))))))))))))))))))))))))))))) 

แมส้ตูร IF สามารถคํานวณหาคําตอบไดต้ามตอ้งการ แตจ่ากโครงสรา้งยาวเหยยีดนอกจากจะ
ทําใหแ้ฟ้มมขีนาดใหญข่ึѸนแลว้ ยังเพิѷมความเสีѷยงในการตดิตามแกไ้ขหรอืตรวจสอบอกีดว้ย 
ดังนัѸนแทนทีѷจะใชส้ตูร IF เราสามารถใชส้ตูรตอ่ไปนีѸแทน 

=(F9<=C9)+(SUM(F9:G9)<=C9)+(SUM(F9:H9)<=C9)+(SUM(F9:I9)<=C9)+(SUM(F
9:J9)<=C9)+(SUM(F9:K9)<=C9)+(SUM(F9:L9)<=C9)+(SUM(F9:M9)<=C9)+(SUM(F
9:N9)<=C9)+(SUM(F9:O9)<=C9)+(SUM(F9:P9)<=C9)+(SUM(F9:Q9)<=C9)+(SUM(
F9:R9)<=C9)+(SUM(F9:S9)<=C9)+(SUM(F9:T9)<=C9)+(SUM(F9:U9)<=C9)+(SUM
(F9:V9)<=C9)+(SUM(F9:W9)<=C9)+(SUM(F9:X9)<=C9)+(SUM(F9:Y9)<=C9)+(SU
M(F9:Z9)<=C9)+(SUM(F9:AA9)<=C9)+(SUM(F9:AB9)<=C9)+(SUM(F9:AC9)<=C9)
+(SUM(F9:AD9)<=C9)+(SUM(F9:AE9)<=C9)+(SUM(F9:AF9)<=C9)+(SUM(F9:AG9)
<=C9)+(SUM(F9:AH9)<=C9)+(SUM(F9:AI9)<=C9)+(SUM(F9:AJ9)<=C9)+1 

ถา้ยังยาวเกนิไปอกี ก็ตอ้งหันมาใชส้ตูร Array กนัตามนีѸ 

{=SUM((SUBTOTAL(9,INDIRECT(ADDRESS(ROW(F9),COLUMN(F9))&":"&ADDRESS(
ROW(F9),ROW(INDIRECT(COLUMN(F9)&":"&COLUMN(AJ9))))))<=C9)*1)+1} 
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หนสีตูร IF ไปใชส้ตูร Choose หรอื Index   

 

Choose เป็นสตูรซึѷงทําหนา้ทีѷเลอืกคา่ทีѷใสไ่วใ้นวงเล็บของตัวสตูร Choose เองตามเลขลําดับทีѷ
เรากําหนด โดยใชเ้ลขลําดับตั Ѹงแตเ่ลข 1 - 254 (Excel 2003 ตอ้งใชเ้ลข 1 - 29) ตาม
โครงสรา้งสตูร ดังนีѸ 

 

=CHOOSE(เลขลําดบั, คา่ทีѷ1, คา่ทีѷ2, .... คา่ทีѷ 254) 

 

สตูร Choose กบัสตูร IF มคีวามเหมอืนกนัตรงทีѷ 2 สตูรนีѸเหมาะกบัการหาคา่คําตอบจากคา่ทีѷ
กระจายตัวโดยไมจํ่าเป็นตอ้งอยูใ่นตารางทีѷเป็นพืѸนทีѷตอ่เนืѷองกนัไป เพยีงแตส่ตูร Choose ตอ้ง
ใชต้ัวเลขลําดับเป็นเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 - 254 เป็นเงืѷอนไขในการเลอืกคําตอบ สว่นสตูร 
IF สามารถรบัเงืѷอนไขเปรยีบเทยีบไดทั้ Ѹงตัวเลขและตัวอกัษรและไมจํ่ากดัวา่ตอ้งใชเ้งืѷอนไขกรณี
เทา่กนัเพยีงอยา่งเดยีวเชน่ทีѷสตูร Choose กําหนดไว ้

สมมตวิา่สตูร IF ทีѷใชอ้ยูเ่ป็นสตูรตามนีѸ  

=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(
E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="K
",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

สตูรขา้งตน้ใชค้า่ในเซลล ์E9 เป็นเงืѷอนไขในการเปรยีบเทยีบกบัตัวอกัษร A - M เชน่ ถา้เซลล ์
E9 มคีา่เป็นตัวอกัษร A จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวอกัษร B จะคนื
คา่เป็นคา่จากเซลล ์C5 เป็นตน้ 

เนืѷองจากเงืѷอนไขทีѷใชใ้นสตูร IF ใชเ้ทยีบกบัตัวอกัษร จงึไมม่ทีางทีѷจะนําสตูร Choose มาใช ้
แทน แตห่ากเราสามารถเปลีѷยนเงืѷอนไขจากตัวอกัษรทีѷใชเ้ดมิ หันมาใชเ้ปรยีบเทยีบกบัตัวเลข
แทน กลายเป็นสตูรตามนีѸ 

=IF(E9=1,C2,IF(E9=2,C5,IF(E9=3,C8,IF(E9=4,C11,IF(E9=5,C14,IF(E9=6,C1
7,IF(E9=7,F2,IF(E9=8,F17,IF(E9=9,I2,IF(E9=10,I5,IF(E9=11,I8,IF(E9=12,I
11,IF(E9=13,I14,I17))))))))))))) 

สตูร IF ทีѷแกไ้ขใหมน่ีѸ ใชค้า่ในเซลล ์E9 เป็นเงืѷอนไขในการเปรยีบเทยีบกบัตัวเลข 1 - 13 เชน่ 
ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์C5 เป็นตน้ 

เนืѷองจากสตูร IF ใชเ้งืѷอนไขเทยีบกบัตัวเลข และเป็นตัวเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 - 13 ซึѷงไม่
เกนิ 254 และเป็นเงืѷอนไขทีѷใชก้ารตรวจสอบวา่เทา่กบัหรอืไมเ่ทา่นัѸน (ไมไ่ดต้รวจสอบวา่
มากกวา่นอ้ยกวา่) จงึสามารถใชส้ตูร Choose ทีѷสั Ѹนกวา่แทนไดด้ว้ยตามนีѸ 



Page 104 of 147 

 

สดุยอดเคล็ดลับและลัดของ Excel 
© พ.ศ. 2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ

www.ExcelExpertTraining.com 

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8,I11,I14,I17) 

 

ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์C5 แตถ่า้ E9 มคีา่เป็นตัวเลข 14 จะคนืคา่เป็นคา่จากเซลล ์I17 

สตูร Choose สามารถใชเ้ลอืกคา่ทีѷกระจาย ซึѷงการกระจายตัวนีѷเองทีѷจะกลายเป็นหนามยอกอก
หากมกีารกระจายตัวกนัมากเกนิไปเชน่สตูรตอ่ไปนีѸ 

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8, 

I11,I14,I17,D3,D6,D9,D12,D15,D18,G3,G18,J3,J6,J9, 

J12,J15,J18,E4,E7,E10,E13,E16,E19,H4,H19,K4,K7, 

K10,K13,K16,K19) 

เพยีงเห็นสตูรแวบเดยีวก็รูส้กึเหนืѷอยแลว้ใชไ่หม แมว้า่สตูร Choose จะสามารถใชเ้ลอืกคา่ทีѷ
กระจายตัวกนัอยูไ่ดส้งูสดุถงึ 254 คา่ก็ตาม หากเราเผลอจัดลําดับคา่คําตอบสลับทีѷกนัเพยีงคา่
เดยีว จะสง่ผลทําใหส้ตูร Choose คนืคา่คําตอบผดิพลาดทันท ี

ถา้คา่ทีѷตอ้งการเลอืกนัѸนถกูนํามาจัดลําดับใหมไ่วใ้นตารางใหเ้ป็นพืѸนทีѷซ ึѷงตอ่เนืѷองกนัไป เรา
สามารถนําสตูร Index มาใชแ้ทน Choose เพราะสตูร Index มโีครงสรา้งสตูรตามนีѸ 

 

=INDEX(พืҟนทีѷตารางทีѷเป็น Single Row, เลขลําดบั) 

หรอื 

=INDEX(พืҟนทีѷตารางทีѷเป็น Single Column, เลขลําดบั) 

 

Single Row หรอื Single Column หมายถงึพืѸนทีѷตารางทีѷมคีวามสงูหรอืความกวา้งเป็น
เซลลเ์ดยีวตามแนวนอนหรอืแนวตั Ѹง 

 

ดังนัѸนแทนทีѷจะใชส้ตูร IF หรอืสตูร Choose ตามตัวอยา่งทีѷกลา่วไปแลว้นัѸน หากเราสามารถจัด
โครงสรา้งตารางใหมใ่หอ้ยูใ่นแนวนอนหรอืแนวตั Ѹง และใชต้ัวเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 เป็นตน้
ไปเป็นตัวชีѸตําแหน่ง ก็ควรหันมาใชส้ตูร Index แทนดกีวา่ กลายเป็นสตูรตามนีѸ 

=INDEX(A1:A10000, E9) 

ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์A1 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์A2 แตถ่า้ E9 มคีา่เป็นตัวเลข 10000 จะคนืคา่เป็นคา่จากเซลล ์
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A10000 ซึѷงการนําคา่ทีѷตอ้งการมาจัดไวใ้นพืѸนทีѷเซลล ์A1:A10000 ทําใหง้า่ยในการคน้หา
ตําแหน่งเซลลเ์พืѷอบันทกึหรอืเปลีѷยนแปลงคา่ใหมใ่นอนาคต 

การเลอืกใชส้ตูรไดอ้ยา่งเหมาะสม สตูรนัѸนตอ้งสามารถรองรับกบัเงืѷอนไขทีѷอาจเปลีѷยนแปลงได ้
ในอนาคตโดยเราไมต่อ้งยอ้นกลับมาแกไ้ขสตูรเกา่ทีѷเคยสรา้งไวอ้กีเลย ดังนัѸนจะเลอืกใชส้ตูร IF 
หรอื Choose หรอื Index ก็ตอ้งคดิพจิารณาใหเ้หมาะสมดว้ยวา่โครงสรา้งตารางและคา่ทีѷใชเ้ป็น
เงืѷอนไขนัѸนเป็นอยา่งไร  

แทนทีѷจะปลอ่ยใหบ้ันทกึคา่อยา่งตามใจหรอืไมไ่ดใ้สใ่จวา่จะใชตํ้าแหน่งเซลลท์ีѷใดในการบันทกึ
คา่ หากรูจั้กออกแบบตารางใหเ้หมาะสมจะชว่ยใหเ้ราสามารถเลอืกใชส้ตูรไดย้ดืหยุน่มากขึѸน 

 

หนสีตูร IF ไปใชส้ตูร VLookup   

 

VLookup ยอ่มาจากคําวา่ Vertical Lookup ทําหนา้ทีѷตรงตามคําแปลทีѷหมายถงึการมองตาม
แนวตั Ѹง โดยเริѷมจากใชค้า่ทีѷตอ้งการคน้หา นําไปเปรยีบเทยีบกบัคา่ทีѷเก็บไวใ้นตารางจาก 
Column ซา้ยสดุวา่ คา่ทีѷใชค้น้หานัѸนอยูใ่นแนวของคา่ใดใน Column ซา้ยสดุนัѸน แลว้คนืคา่เป็น
คําตอบจาก Column ตามเลขทีѷเราตอ้งการ โดย VLookup มโีครงสรา้งสตูร 2 แบบ 

 

โครงสรา้งสตูรแบบ Approaching Match  

เหมาะกบัตารางขอ้มลูทีѷ Column ซา้ยสดุเป็นตัวเลขตอ่เนืѷองทีѷเรยีงคา่จากนอ้ยไปมาก 
โครงสรา้งนีѸทํางานตามเงืѷอนไขแบบนอ้ยกวา่หรอืเทา่กบั 

=VLOOKUP(คา่ทีѷใชห้า, ตารางทีѷเก็บคา่, เลขทีѷ Column ของคาํตอบ) 

 

โครงสรา้งสตูรแบบ Exact Match  

เหมาะกบัตารางขอ้มลูทีѷ Column ซา้ยสดุเป็นรหัส ซึѷงไมจํ่าเป็นตอ้งเรยีงคา่ โครงสรา้งนีѸทํางาน
แบบเงืѷอนไขเทา่กบั 

=VLOOKUP(คา่ทีѷใชห้า, ตารางทีѷเก็บคา่, เลขทีѷ Column ของคาํตอบ,  
   FALSE หรอื 0) 
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ในกรณีทีѷใชส้ตูร IF หาคําตอบเป็นเกรด A B หรอื C โดยใชส้ตูร =IF( E3>=B3, C3, 
IF(E3>=B4,C4,C5) ) 

 

หากตอ้งการเปลีѷยนมาใชส้ตูร VLookup ตอ้งเรยีงคะแนนในตารางจากนอ้ยไปมาก ตามรปู
ตอ่ไปนีѸแทน 

 

เซลล ์F3 สรา้งสตูร =VLOOKUP(E3,B3:C5,2) ซึѷงเป็นสตูร VLookup แบบ Approaching 
Match เนืѷองจากคา่ทีѷใชห้าเป็นตัวเลข และตัวเลขนีѸสามารถเป็นตัวเลขทีѷตอ่เนืѷองกนัไป และคนื
คา่ไดคํ้าตอบเป็นเกรด B โดยมลํีาดับการทํางานของสตูร ดังนีѸ 

1. VLookup นําคะแนนทีѷสอบได ้75 คะแนน ไปตรวจสอบกบัตารางขอ้มลู B3:C5 

2. ใน Column ซา้ยสดุทีѷเรยีงเลขจากนอ้ยไปมากนัѸน พบวา่เลขคะแนน 70 เป็นเลขทีѷมาก
ทีѷสดุทีѷยังนอ้ยกวา่หรอืเทา่กบัเลข 75 ซึѷงเป็นคะแนนทีѷสอบได ้แสดงวา่คําตอบทีѷตอ้งการ 
อยูใ่นแนวเดยีวกบัเลขคะแนน 70 แน่นอน 

3. เลข 2 ทีѷใสล่งไปในวงเล็บของสตูร VLookup เป็นตัวเลขแทน Column ทีѷสองในพืѸนทีѷ
ตาราง B3:C5 ซึѷงเป็น Column เรืѷองเกรดทีѷเป็นคําตอบ จงึคนืคา่ออกมาเป็นเกรด B 

หากเลอืกใชส้ตูรแบบ Exact Match =VLOOKUP(E3,B3:C5,2,0) ซึѷงเพิѷมเลข 0 ตอ่ทา้ยลงไป
ในวงเล็บ จะไดคํ้าตอบเป็น #N/A เนืѷองจาก Column ซา้ยสดุทีѷเป็นตัวเลขคะแนน ไมม่เีลข 75 
แสดงไว ้จงึคนืคา่คําตอบออกมาวา่ Not Available แสดงวา่หาคา่ทีѷตอ้งการไมพ่บ 

แมก้ารใชส้ตูร VLookup จะชว่ยใหไ้ดส้ตูรทีѷสั Ѹนลงก็ตาม แตจ่ะทําให ้Excel คํานวณชา้กวา่ใน
กรณีทีѷใชส้ตูร IF หากตารางทีѷใชเ้ก็บขอ้มลูมขีนาดใหญข่ึѸน ก็จะสง่ผลใหส้ตูร VLookup คํานวณ
ชา้ลง เราจงึตอ้งพงึระวังไวเ้สมอวา่ทกุอยา่งมทัี Ѹงขอ้ดขีอ้เสยี ไดอ้ยา่งก็จําเป็นตอ้งเสยีอยา่ง
เชน่กนั 
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หนสีตูร IF ไปใชส้ตูร Max Min หรอืแคใ่ชว้งเล็บชว่ย   

 

ในบรรดาเงืѷอนไขทีѷใชก้นัมากทีѷสดุในชวีติประจําวันเห็นจะหนีไมพ่น้เงืѷอนไขเกีѷยวกบัการตัดสนิใจ
ในเรืѷองหา้มเกนิกวา่หรอืหา้มตํѷากวา่ ยกตัวอยา่งทีѷใกลต้ัว เชน่ เกณฑก์ารคํานวณภาษีเงนิได ้
บคุคลธรรมดา มหีลักคํานวณภาษีจากเงนิไดว้า่ เงนิไดช้ว่งทีѷไมเ่กนิกวา่ยอดนัѸนยอดนีѸใหใ้ชอ้ตัรา
ภาษีเทา่นัѸนเทา่นีѸ หรอืภาษีเงนิไดข้องบรษัิทตอ้งคํานวณจากยอดกําไร แตถ่า้ขาดทนุก็ไม่
จําเป็นตอ้งจา่ยภาษี เทยีบไดก้บัเงืѷอนไขทีѷหา้มคดิภาษีถา้มตีัวเลขตํѷากวา่ 0 นัѷนเอง 

ถา้มตีัวเลขใดๆทีѷอาจเป็นไปไดทั้ Ѹงคา่บวกลบและศนูย ์แลว้กําหนดใหใ้ชส้ตูร IF ปรับคา่นีѸใหเ้ป็น
คา่ใหมท่ีѷหา้มตํѷากวา่ 0 แตถ่า้ตัวเลขนัѸนมคีา่มากกวา่ 0 อยูแ่ลว้ ก็ขอใหค้งคา่เดมิ จะตอ้งสรา้ง
สตูรตามนีѸ 

=IF(เซลลต์วัเลข<0, 0, เซลลต์ัวเลข) 

หรอื 

=IF(เซลลต์วัเลข>=0, เซลลต์ัวเลข, 0) 

แทนทีѷจะใชส้ตูร IF ในเงืѷอนไขทีѷเกีѷยวขอ้งกบัขอ้กําหนดหา้มตํѷากวา่หรอืหา้มเกนิกวา่ เรา
สามารถนําสตูร Max หรอื Min มาใชแ้ทนโดยใชห้ลักชว่ยจํา ดังนีѸ 

 สตูร Max หรอื Min นีѸทํางานตรงขา้มกบัความเขา้ใจ 

 ปกตสิตูร Max ทําหนา้ทีѷหาคา่สงูสดุ แตใ่หใ้ชก้บัเงืѷอนไขหา้มตํѷากวา่ โดยใชส้ตูร 
 
=MAX(ตวัเลขตามเกณฑต์ํѷาสดุทีѷเป็นไปได,้ ตวัเลขทีѷตอ้งการเทยีบ) 

 ปกตสิตูร Min ทําหนา้ทีѷหาคา่ตํѷาสดุ แตใ่หใ้ชก้บัเงืѷอนไขหา้มเกนิกวา่ โดยใชส้ตูร 
 
=MIN(ตวัเลขตามเกณฑส์งูสดุทีѷเป็นไปได,้ ตวัเลขทีѷตอ้งการเทยีบ) 

ตามตัวอยา่งขา้งตน้ทีѷใชส้ตูร IF ปรับตัวเลขไมใ่หตํ้ѷากวา่ 0 นัѸน สามารถเปลีѷยนมาใชส้ตูร Max 
ตอ่ไปนีѸแทน 

=MAX(0, เซลลต์วัเลข) 

สว่นในกรณีทีѷตอ้งการสรา้งสตูรควบคมุตัวเลขไมใ่หเ้กนิเลข 100 สามารถใชส้ตูร IF หรอื Min 
ไดต้ามนีѸ 

=IF(เซลลต์วัเลข>100, 100, เซลลต์วัเลข) 

หรอื 

=IF(เซลลต์วัเลข<=100, เซลลต์วัเลข, 100) 
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หรอื 

=MIN(100, เซลลต์วัเลข) 

นอกจากนีѸเรายังสามารถใชว้งเล็บชว่ยในการตัดสนิใจโดยไมจํ่าเป็นตอ้งพึѷงพาสตูรใดๆ เชน่ 
กรณีทีѷตอ้งการเปลีѷยนตัวเลขใหไ้มตํ่ѷากวา่ 0 ตามตัวอยา่งขา้งตน้ ใหใ้ชส้ตูรทีѷใชว้งเล็บชว่ย
ตอ่ไปนีѸไดเ้ลย 

 

=(เซลลต์วัเลข<=0)*0 + (เซลลต์วัเลข>0)*เซลลต์วัเลข 

 

การใชว้งเล็บชว่ยในการตดัสนิใจ มหีลักการดังนีѸ 

1. สามารถใชไ้ดเ้ฉพาะเมืѷอผลลัพธท์ีѷตอ้งการเป็นตัวเลขเทา่นัѸน เนืѷองจากตอ้งนําตัวเลขมา
คํานวณตอ่กนัไปเรืѷอยๆ 

2. หากมหีลายวงเล็บ ตอ้งมเีงืѷอนไขเดยีวในวงเล็บหนึѷงเทา่นัѸนทีѷเป็นจรงิ และเงืѷอนไขใน
วงเล็บอืѷนตอ้งเป็นเท็จทั Ѹงหมด 

3. เงืѷอนไขทีѷใชต้รวจสอบนัѸน ถา้คนืคา่เป็นเท็จ ถอืวา่มคีา่เทา่กบัเลข 0 แตถ่า้คนืคา่เป็นจรงิ 
ถอืวา่มคีา่เทา่กบัเลข 1 

4. ใหนํ้าเงืѷอนไขมาบวกกนัในกรณีทีѷกําหนดใหเ้งืѷอนไขเดยีวเทา่นัѸนเป็นจรงิ หรอืนําเงืѷอนไข
มาคณูกนัในกรณทีีѷตอ้งการตรวจสอบวา่ทกุเงืѷอนไขเป็นจรงิพรอ้มกนั 

จากตัวอยา่งขา้งตน้ในกรณีทีѷหา้มตํѷากวา่ 0 เชน่ เซลลต์ัวเลขมคีา่เทา่กบั -5 เมืѷอนํามาแทนคา่ลง
ไปในสตูร =(เซลลต์ัวเลข<=0)*0 + (เซลลต์ัวเลข>0)*เซลลต์ัวเลข แลว้ Excel จะคดิทลีะขั Ѹน
ตามนีѸ 

1. แทนคา่ตัวเลขลงไปในสตูรเป็น =(-5<=0)*0 + (-5>0)*-5 

2. วงเล็บของ (-5<=0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 

3. วงเล็บของ (-5>0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 

4. จะไดส้ตูร =1*0 + 0*-5 

5. จะไดส้ตูร =0 + 0 

6. ซึѷงปรับคา่ -5 ออกมาเป็น 0 

แตถ่า้เซลลต์ัวเลขมคีา่เทา่กบั 5 เมืѷอนํามาแทนคา่ลงไปในสตูร =(เซลลต์ัวเลข<=0)*0 + 
(เซลลต์ัวเลข>0)*เซลลต์ัวเลข แลว้ Excel จะคดิทลีะขั ѸนตามนีѸ 

1. แทนคา่ตัวเลขลงไปในสตูรเป็น =(5<=0)*0 + (5>0)*5 
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2. วงเล็บของ (5<=0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 

3. วงเล็บของ (5>0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 

4. จะไดส้ตูร =0*0 + 1*5 

5. จะไดส้ตูร =0 + 5 

6. ซึѷงปรับคา่ 5 ออกมาเป็น 5 เทา่กบัคา่บวกตามคา่เดมินัѷนเอง 

แมก้ารใชว้งเล็บชว่ยในการตัดสนิใจจะเกดิสตูรทีѷมคีวามยาวซึѷงดเูหมอืนไมจํ่าเป็นก็ตาม แต่
โครงสรา้งสตูรภายในวงเล็บทกุวงเล็บมคีวามคลา้ยคลงึกนั จงึสามารถตรวจสอบแกไ้ขไดง้า่ย 
และยังเป็นพืѸนฐานของการคํานวณแบบ Array อกีดว้ย 

 

หนสีตูร IF ไปใชค้ําส ัѷงบนเมน ู  

 

สมัยทีѷผมใช ้Excel รุน่แรกๆ Excel ไมไ่ดม้คํีาสัѷงบนเมนูใหเ้ลอืกใชไ้ดม้ากมายอยา่งเชน่ทกุวันนีѸ 
แตก่็ไดพ้ึѷงสตูร IF นีѷแหละชว่ยในการตรวจสอบคา่ตา่งๆ อยา่งเชน่ถา้ตอ้งการตรวจสอบคา่ทีѷ
พมิพล์งไปวา่เป็นตัวเลขอยา่งเดยีวเทา่นัѸน ก็ตอ้งใชส้ตูร IF มาผสมกบัสตูร IsNumber เพืѷอ
ตรวจสอบคา่ทีѷพมิพว์า่ ถา้ไมใ่ชต่ัวเลข ใหแ้สดงคําเตอืนออกมาวา่ Input is Wrong ตามสตูร
ตอ่ไปนีѸ 

=IF(ISNUMBER(Cell), "OK", "Input is Wrong") 

การใชส้ตูรดังกลา่วจําเป็นตอ้งสรา้งสตูรลงไปในอกีเซลลห์นึѷงเพืѷอเป็นเซลลท์ีѷแสดงคําเตอืน
ออกมาใหเ้ห็น นอกจากสตูร IF ก็มแีตร่ปูแบบจากคําสัѷง Format เป็นอกีเครืѷองมอืหนึѷงทีѷกําหนด
ลงไปในเซลล ์เชน่ ถา้หากตอ้งการเตอืนวา่ Input is Wrong ในเซลลท์ีѷควบคมุวา่ตอ้งเป็น
ตัวเลขเทา่นัѸน ก็สามารถกําหนด Format ตามนีѸ 

0;-0;0;"Input is Wrong" 

แม ้Format จะแสดงคําวา่ Input is Wrong ใหเ้ห็นในเซลลท์ีѷบันทกึคา่ลงไปก็ตาม แตก่็ถอืวา่
ไดเ้กดิคา่ทีѷผดิพลาดขึѸนมาแลว้ ตา่งจาก Excel รุน่ใหมท่ีѷมคํีาสัѷงบนเมนู Data Validation กบั 
Conditional Formatting ใหเ้ลอืกใช ้ซึѷงสามารถแสดงคําเตอืนหรอืเปลีѷยนสใีหเ้ห็นชดัในเซลล์
นัѸนๆเลย
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วธิใีช ้Data Validation 

สมมตวิา่ตอ้งการพมิพช์ืѷอเดอืนลงไปในเซลล ์ซึѷงทีѷผา่นมาเคยพมิพผ์ดิซํѸาแลว้ซํѸาอกี จงึตอ้งการ
สัѷงให ้Excel แสดงคําเตอืนขึѸนมาเมืѷอพมิพช์ืѷอเดอืนผดิ  

 

1. ตั Ѹงชืѷอ Range Name ใหก้บัเซลลท์ีѷเก็บชืѷอเดอืนในเซลล ์B2:B7 ใหม้ชีืѷอวา่ Choice 

2. เลอืกเซลล ์D2 ทีѷเป็นเซลลซ์ึѷงตอ้งการพมิพช์ืѷอเดอืนทีѷตอ้งการแลว้สัѷง Data > Data 
Validation (Excel 2003 สัѷง Data > Validation) 

3. ในชอ่ง Allow คลกิเลอืก List (ในชอ่ง Allow นีѸเองทีѷเราสามารถเลอืกประเภทของ
ขอ้มลูทีѷยอมรับไดอ้กีหลายอยา่งตามแตจ่ะกําหนด หรอืเลอืก Allow แบบ Custom เพืѷอ
ใชส้ตูรตรวจสอบการบันทกึคา่) 

4. ใหค้ลกิลงไปในชอ่ง Source แลว้กดปุ่ ม F3 เพืѷอเปิดรายชืѷอ Range Name ทีѷมอียูข่ ึѸนมา 

5. ใหเ้ลืѷอนหาชืѷอ Choice เพืѷอเลอืกแลว้กดปุ่ ม OK 2 ครั Ѹง 

6. จะพบวา่เซลล ์D2 มปีุ่ มลกูศรแสดงขึѸนมาทางขอบดา้นขวา และเมืѷอคลกิปุ่ มลกูศรนีѸก็จะมี
รายชืѷอเดอืนแสดงใหค้ลกิเลอืกก็ได ้หรอืหากทดลองพมิพช์ืѷอเดอืนลงไปในเซลล ์D2 
เอง ถา้เราพมิพช์ืѷอเดอืนผดิ พอกดปุ่ ม Enter เพืѷอรับชืѷอเดอืนลงไป จะมคํีาเตอืนแสดง
ขึѸนมาใหเ้ห็นวา่ The value you entered is not valid. 
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วธิใีช ้Conditional Formatting 

สมมตวิา่พอคลกิเลอืกชืѷอเดอืน May ในเซลล ์D2 แลว้ ตอ้งการเปลีѷยนสเีซลลใ์นตารางทีѷตั Ѹงชืѷอ
วา่ Choice ในเซลลท์ีѷมคํีาวา่ May ตรงตามทีѷเลอืก ใหทํ้าดังนีѸ  

 

1. เลอืกพืѸนทีѷตารางทีѷตั Ѹงชืѷอวา่ Choice 

2. สัѷง Home > Conditional Formatting > New Rules > Use a formula to 
determine which cells to format (Excel 2003 สัѷง Format > Conditional 
Formatting) 

3. สรา้งสตูร =B2=$D$2 ลงไปในชอ่ง Edit the Rule Description 

4. กดปุ่ ม Format แลว้กําหนดรปูแบบทีѷแตกตา่งไปจากเดมิตามตอ้งการ 

5. Data Validation กบั Conditional Formatting ถอืเป็นเครืѷองมอืซึѷงควรนํามาใชพ้รอ้ม
กนัเสมอ โดย Validation จะทําหนา้ทีѷเสมอืนยามเฝ้าประตตูรวจสอบแขกทีѷจะยอมให ้
ผา่นประตเูขา้มา แตถ่า้มแีขกเดนิผา่นประตเูขา้มาแลว้ก็ตอ้งใช ้Conditional 
Formatting เปลีѷยนสแีสดงตัวแขกผูนั้ѸนขึѸนมา  
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กรณีตอ้งการควบคมุตาํแหนง่ของเซลลท์ีѷจะเปิดใหพ้มิพค์า่  

จากรปูตอ่ไปนีѸ หากตอ้งการควบคมุใหเ้ปิดบันทกึคา่ไดต้ามตําแหน่งตัวชีѸบนหัวตารางทีѷเป็น Y 
และตามตําแหน่งขา้งตารางทีѷเป็น B และใหเ้ปลีѷยนสบีอกตําแหน่งอกีดว้ย จะพบวา่เซลล ์D4 
เปลีѷยนสแีละเป็นเซลลเ์ดยีวเทา่นัѸนทีѷจะเปิดใหพ้มิพค์า่ใหมล่งไปได ้

 

1. คลกิเลอืกพืѸนทีѷเซลล ์C3:E4 ซึѷงเป็นพืѸนทีѷในตาราง 

2. จากนัѸนใชคํ้าสัѷง Conditional Formatting ในทํานองเดยีวกบัตัวอยา่งขา้งตน้ ตา่งกนั
เพยีงใชส้ตูร =C$2&$B3=$C$6&$C$7 

3. ตามดว้ยคําสัѷง Data Validation โดยใช ้Allow แบบ Custom โดยกําหนดใหใ้ชส้ตูร 
=C$2&$B3=$C$6&$C$7 ซึѷงเป็นสตูรเดยีวกนักนัทีѷใชก้บั Conditional 
Formatting นัѷนเอง 
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สตูร Array : สตูรซึѷงคนสว่นใหญใ่ชไ้มเ่ป็น 
 

เรืѷองสตูร Array เป็นเรืѷองทีѷผมเคยเขยีนมาแลว้หลายครั Ѹง เคยอธบิายมาแลว้หลายรอบ ทกุครั Ѹงทีѷ
จัดอบรมก็พดูเรืѷองสตูร Array อยูเ่สมอ คนทีѷฟังเรืѷองสตูร Array แลว้เขา้ใจก็จะเขา้ใจในทันท ี
แลว้ก็ตอ้งมานัѷงเบืѷอนัѷงทนฟังผมอธบิายเรืѷองสตูร Array นีѸซํѸาแลว้ซํѸาอกี เพราะคนสว่นใหญเ่ขา
ฟังกีѷทกีีѷทกี็ไมเ่ขา้ใจเรืѷองสตูร Array นีѸสกัท ีไมใ่ชว่า่ฟังแบบเขา้หซูา้ยแลว้ทะลหุขูวาหรอก แต่
แยย่ิѷงกวา่นัѸนอกี พออธบิายเรืѷองสตูร Array ทไีร ปรากฏวา่เสยีงพดูอธบิายของผมมันเดนิทางไป
ไมถ่งึหคูนฟังเสยีดว้ยซํѸา เพราะคนฟังพอฟังแลว้ไมรู่เ้รืѷองกจ็ะมอีาการหนังตาหนักขึѸนเรืѷอยๆแลว้
หลับหหูลับตาไมไ่ดฟั้งทกุครั Ѹงไป 

"ถา้คณุใชส้ตูร Array เป็น จะแกปั้ญหาอะไรไดบ้า้ง" ผมคดิวา่ตอ้งเริѷมอธบิายใหพ้วกเราเห็น
คณุประโยชนข์องสตูร Array กนักอ่น ถา้เห็นประโยชนข์องสตูร Array วา่จะชว่ยแกปั้ญหาของ
ตัวเองไดม้ากมายขนาดไหน จะไดเ้กดิความอยากใชแ้ลว้จะไดม้คีวามตั Ѹงหนา้ตั Ѹงตาตั Ѹงใจมา
เรยีนรูส้ตูร Array 

 

ประโยชนข์องสตูร Array  

สตูร Array จะชว่ยทําใหค้ณุสามารถทําสิѷงทีѷไมน่กึไมฝั่นวา่ Excel จะทําไดม้ากอ่น ไดแ้ก ่

1. ทําใหแ้ฟ้มมขีนาดเล็กลง เนืѷองจากแทนทีѷจะตอ้งสรา้งตารางหลายๆตารางเพืѷอแยก
คํานวณทลีะขั Ѹน เราสามารถสรา้งสตูร Array ลงไปในเซลลเ์พยีงเซลลเ์ดยีวก็ไดคํ้าตอบ
ทีѷตอ้งการแลว้ 

2. ทําใหเ้กบ็ขอ้มลูไวใ้นตารางเดยีวชทีเดยีว โดยไมต่อ้งแยกตารางฐานขอ้มลูออกเป็น
หลายตารางหรอืหลายชทีเพยีงเพืѷอตอ้งการหายอดรวมแยกประเภทตามขอ้มลูทีѷจัดแยก
ไว ้

3. ทําให ้Excel ทํางานแบบคอมพวิเตอรไ์ดอ้ยา่งแทจ้รงิ พอกรอกคา่ลงไปก็จะไดคํ้าตอบทีѷ
ตอ้งการทันท ีไมต่อ้งเสยีแรงและเสยีเวลาคลกิเลอืกใชคํ้าสัѷงบนเมนู เชน่ ไมต่อ้งสัѷง 
Sort ตารางก็จัดเรยีงใหเ้องแลว้ หรอืไมต่อ้งสัѷง AutoFilter ก็สามารถหายอดรวมแยก
ประเภทไดแ้ลว้ 

4. ทําใหส้ตูรสําเร็จรปูของ Excel มคีวามสามารถเหนอืชั ѸนขึѸนกวา่เดมิ สามารถใชส้ตูรใน
เซลลเ์ดยีวลัดหาคําตอบ 

ในการอบรมครั Ѹงหนึѷงมผีูเ้ขา้อบรมคนหนึѷงมทีา่ทไีมส่นใจเรยีนรูส้ตูร Array โดยอา้งวา่ ทําไมตอ้ง
ใชส้ตูร Array ดว้ยในเมืѷอ Excel ก็มสีตูรและคําสัѷงบนเมนูอยูแ่ลว้ ถา้อยากไดอ้ะไรก็แคค่ลกิ
คําสัѷงบนเมนู ก็จะไดคํ้าตอบทีѷตอ้งการแลว้มใิชห่รอื 
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ผมจงึเรยีนถามกลับวา่ แลว้มอืทีѷใชค้ลกิคําสัѷงบนเมนูทีѷวา่นัѸนน่ะเป็นมอืของใคร ถา้คณุสง่แฟ้มไป
ใหห้ัวหนา้ทีѷใช ้Excel ไมเ่ป็น หัวหนา้จะรูว้ธิเีลอืกคลกิเมนูนัѸนเมนูนีѸดว้ยหรอื เห็นทหีัวหนา้ตอ้ง
พึѷงพามอืของคณุไปชัѷวชวีติหรอืไม ่แตถ่า้คณุสรา้งสตูร Array เป็น แฟ้มนัѸนๆจะทํางานตอ่เอง
อยา่งอตัโนมัตโิดยไมต่อ้งหว่งวา่ใครจะเป็นผูใ้ชแ้ฟ้มของคณุ 

อยา่งเรืѷองการใช ้Pivot Table เหมอืนกนัทีѷหัวหนา้มักชอบใชเ้ป็นชวีติจติใจแลว้ผลักดันให ้
ลกูนอ้งใช ้Pivot Table ตามกนัไปทัѸงบรษัิท โดยหารูไ้มว่า่ถา้ใช ้Array เป็นก็แทบไมจํ่าเป็นตอ้ง
ใช ้Pivot Table เสยีดว้ยซํѸา  

 

ขอ้เสยีของสตูร Array 

1. ทําใหแ้ฟ้มคํานวณชา้ลง แตเ่นืѷองจากการใชส้ตูร Array จะชว่ยทําใหแ้ฟ้มมขีนาดเล็กลง
ซึѷงโดยทัѷวไปยอ่มสง่ผลใหแ้ฟ้มเล็กคํานวณเร็วกวา่แฟ้มใหญ ่ถา้คณุออกแบบโครงสรา้ง
ตารางใหเ้หมาะกบัสตูร Array ดว้ย ปัญหาเรืѷองนีѸก็จะชดเชยกนัไป 

2. ทําใหแ้กไ้ขสตูรยากขึѸน เพราะคนทัѷวไปมักไมเ่ขา้ใจเรืѷองสตูร Array เป็นพืѸนอยูแ่ลว้และ
ไมท่ราบวา่ขั Ѹนตอนการสรา้งสตูร Array ตอ้งกดปุ่ ม Ctrl+Shift+Enter พรอ้มกนัแทนทีѷ
จะกดปุ่ ม Enter (ซึѷงใน Excel 365 สามารถกดปุ่ ม Enter แทนไดเ้ลย) 

3. คนทีѷตดินสิยัชอบสรา้งสตูร Array มักหลงลมืมองขา้มสตูรสําเร็จรปูอืѷนทีѷมอียูแ่ลว้ใน
โปรแกรม Excel ซึѷงสตูรสําเร็จรปูจะใชเ้วลาคํานวณเร็วกวา่สตูร Array 

 

เบืҟองตน้ของ Array 

ขนาดผมใชส้ตูร Array มานานนับสบิปี สรา้งสตูร Array เพืѷอใชก้บังานมาสารพัดชนดิ ตอบ
คําถามเรืѷอง Array ใน Excel Expert Forum ซํѸาแลว้ซํѸาอกีนับเป็นพันๆครั Ѹง แตก่็ยังมสีตูร Array 
อกีเยอะทีѷผมเห็นแลว้ตอ้งถอนหายใจ ไมส่ามารถแกะทีѷไปทีѷมาของลําดับการคํานวณทีѷใชใ้น
สตูร Array เหลา่นัѸน เพราะเป็นสตูรทีѷคนอืѷนสรา้งขึѸน ถา้คนทีѷสรา้งสตูร เขาไมไ่ดเ้ขยีนอธบิาย
แนวคดิประกอบสตูรไวด้ว้ย ยอ่มทําใหผู้อ้ืѷนคดิถามในใจวา่ “เขาสรา้งสตูรยากๆยาวๆแบบนีѸข ึѸนมา
ไดอ้ยา่งไรกนั” แลว้ถา้เราไดแ้ตล่อกเอาสตูรของคนอืѷนมาใช ้ก็ไดแ้ตใ่ช ้ไมส่ามารถดัดแปลง
แกไ้ขสตูรทีѷลอกมาเพืѷอปรับใหเ้ขา้กบัเงืѷอนไขในงาน วันหนึѷงเราก็จะหนา้แตก เมืѷอถกูจับไดว้า่
ไมไ่ดเ้กง่จรงิ “ออ้ ลอกสตูรเขามานีѷเอง” ดังนัѸนถา้จะคดิใชส้ตูร Array ตอ้งหาทางสรา้งสตูรเอง
ใหเ้ป็น แมส้ตูร Array ทีѷสรา้งขึѸนเองเป็นสตูรยาวกวา่สตูรของคนอืѷนก็ตาม 

สตูร Array สตูรแรกๆทีѷทําใหผ้มเกดิความประทับใจแลว้เกดิแรงบันดาลใจใหอ้ยากเรยีนรูเ้รืѷอง
สตูร Array มากขึѸน เป็นสตูรทีѷใชคํ้านวณหาจํานวน Unique Items หรอืนับจํานวนชืѷอรายการทีѷ
ไมซ่ํѸากนั 

{=SUM(1/CountIF(DataRange,DataRange))} 
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สมมตวิา่ใน DataRange บันทกึชืѷอลกูคา้ไวต้ามนีѸ aa, bb, aa, cc, bb สตูรนีѸจะหาคําตอบเป็น
เลข 3 ซึѷงหมายถงึการนับชืѷอลกูคา้วา่มอียู ่3 คน คอื aa, bb, และ cc แตก่วา่จะหาทางสรา้งสตูร
ใหทํ้างานไดก้็ตอ้งทราบกอ่นวา่เครืѷองหมายวงเล็บปีกกา { } ทีѷเห็นอยูด่า้นหนา้สดุและดา้น
ทา้ยสดุของสตูรนัѸน ไมใ่ชเ่ครืѷองหมายวงเล็บปีกกาทีѷพมิพเ์อง แตเ่กดิจากการกดปุ่ ม 
Ctrl+Shift+Enter พรอ้มกนัและหา้มมชีอ่งวา่งใน DataRange ดว้ย 

ตอนทีѷผมเห็นสตูรนีѸก็คดิไมอ่อกวา่มันใชห้ลักการใดในการคํานวณ แตพ่ออา่นคําอธบิายทีѷมากบั
สตูรจงึเขา้ใจ สตูรนีҟเป็นการหายอดรวมของคา่เฉลีѷยตอ่ตวัของแตล่ะรายการใน 
DataRange กลา่วคอื ถา้นับจํานวนชืѷอแตล่ะชืѷอใน DataRange aa, bb, aa, cc, bb จะพบ
จํานวนของการซํѸากนัดังนีѸ 

 ม ีaa ซํѸากนัอยู ่2 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวของ aa แตล่ะตัวคอื 1/2 

 ม ีbb ซํѸากนัอยู ่2 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวของ bb แตล่ะตัวคอื 1/2 

 ม ีcc อยู ่1 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวคอื 1 

เมืѷอรวมคา่เฉลีѷยตอ่ตัวเขา้ดว้ยกนั จาก DataRange aa, bb, aa, cc, bb 
=1/2+1/2+1/2+1+1/2 จะไดคํ้าตอบเป็นจํานวนของ Unique Items เทา่กบั 3 

จวบจนปัจจบุันนีѸยังตามหาคนทีѷคดิสรา้งสตูรยอดเยีѷยมนีѸข ึѸนมาเป็นครั Ѹงแรกไมพ่บวา่เป็นใคร ยังดี
ทีѷมคํีาอธบิายประกอบสตูรนีѸไวด้ว้ย 

 

อยากเกง่สตูร Array ตอ้งสรา้งไปแกะไป 

จากคําอธบิายทีѷเขยีนไวเ้กีѷยวกบัทีѷไปทีѷมาของสตูรคํานวณหาจํานวน Unique Items วา่ เป็นการ
หายอดรวมของคา่เฉลีѷยตอ่ตัวของแตล่ะรายการใน DataRange ยอ่มทําใหค้นสว่นใหญท่ีѷเพิѷง
รูจั้กสตูร Array เป็นครั Ѹงแรกคงยังไมเ่ขา้ใจลําดับในการคํานวณทีѷใชใ้นสตูรนีѸชดัเจนนัก ถา้
อยากจะเขา้ใจอยา่งถอ่งแทว้า่สตูร Array ทํางานไดอ้ยา่งไร ตอ้งเรยีนรูจ้ากการปฏบิัตเิทา่นัѸน 
โดยใชว้ธิทีดลองสรา้งสตูรไปแกะไปซึѷงมอียู ่2 วธิ ี

1. สรา้งสตูร Array ลงไปในเซลลเ์ดยีวแลว้แกะคา่ในแตล่ะสว่นของสตูร โดยการกดปุ่ ม F9 
เพืѷอดใูนชอ่ง Formula Bar หรอื 

2. สรา้งสตูร Array ลงไปในตารางพรอ้มกนัทเีดยีวหลายๆเซลลห์รอืใชต้ารางแยกคํานวณ
ทลีะขั Ѹน เพืѷอดผูลลัพธก์ระจายออกมาใหเ้ห็นในตาราง 

โดยทัѷวไปจะใชว้ธิแีรกสําหรับแกะสตูรทีѷไมซ่บัซอ้นหรอืไมย่าวนัก พอแกะสตูรโดยการกดปุ่ ม F9 
แลว้ตอ้งอยา่ลมืกดปุ่ ม Esc เพืѷอยอ้นหลังกลับคนืสูส่ภาพเดมิกอ่นแกะ (ถา้แกะสตูรแลว้เผลอกด 
Enter ลงไปจะทําลายสตูรใหก้ลายเป็นคา่คงทีѷแทน) 

วธิทีีѷสอง เหมาะสําหรับคนทีѷเพิѷงเรยีนรูเ้รืѷอง Array หรอืใชแ้กะสตูรยากๆยาวๆ หรอืใชท้ดลอง
สรา้งสตูร Array ขึѸนใหมต่ั Ѹงแตแ่รก เพราะวธินีีѸจะเห็นผลลัพธแ์ตล่ะขั Ѹนของการคํานวณแสดง
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กระจายใหเ้ห็นในเซลลแ์ตล่ะเซลลใ์นตาราง จากนัѸนพอซอ้นสตูรตอ่ๆกนัไปจนไดคํ้าตอบทีѷ
ตอ้งการแลว้จงึนําสตูรแตล่ะขั Ѹนมาซอ้นตอ่กนัเป็นสตูรเดยีวเพืѷอนําไปใชง้านตอ่ไป 

 

วธิแีกะสตูร Array วธิที ีѷ 1 

 

DataRange คอื ตารางชว่ง B3:B7 

เซลล ์D3 มสีตูร Array {=SUM(1/COUNTIF(DataRange,DataRange))} โดย
เครืѷองหมายวงเล็บปีกกาเกดิจากการกดปุ่ ม Ctrl+Shift+Enter พรอ้มกนั (ไมไ่ดพ้มิพ ์{} เอง) 

1. เริѷมจากคลกิลงไปในชอ่ง Formula Bar คลกิลากทับสว่นของสตูร 
COUNTIF(DataRange,DataRange) 

2. กดปุ่ ม F9 จะพบวา่สตูร CountIF นับจํานวนซํѸาของคา่แตล่ะตัว ทําใหส้ตูรทั Ѹงหมด
เปลีѷยนเป็นสตูร =SUM(1/{2;2;2;1;2}) 

3. ตัวเลข  {2;2;2;1;2} หมายถงึ จํานวนซํѸาของแตล่ะคา่ กลา่วคอื aa ม ี2 คา่, bb ม ี2 คา่
, aa ม ี2 คา่, cc ม ี1 คา่, และ bb ม ี2 คา่ 

4. คลกิลากทับสว่นของสตูร 1/{2;2;2;1;2} 

5. กดปุ่ ม F9 จะพบวา่สตูร 1/{2;2;2;1;2} หาคา่เฉลีѷยจากจํานวนซํѸาของคา่แตล่ะตัว ทําให ้
สตูรทั Ѹงหมดเปลีѷยนเป็นสตูร =SUM({0.5;0.5;0.5;1;0.5}) 

6. ตัวเลข {0.5;0.5;0.5;1;0.5} เกดิจากสว่นของหารหาคา่เฉลีѷยโดย 1/2 ทําใหเ้กดิเลข 
0.5 และ 1/1 ทําใหเ้กดิเลข 1 

7. คลกิลากทับสตูร SUM({0.5;0.5;0.5;1;0.5}) แลว้กดปุ่ ม F9 จะไดคํ้าตอบเป็นสตูร =3 

8. กดปุ่ ม Esc เพืѷอทําใหส้ตูรแปลงกลับไปเป็นสตูรแรกเริѷมตามเดมิ 

หมายเหต ุการคลกิแลว้ลากทับสว่นของสตูรทีѷแสดงในชอ่ง Formula Bar นีѸ ตอ้งคลกิแลว้ลาก
ทับสว่นของสตูรทีѷครบและพรอ้มจะคํานวณได ้เชน่ COUNTIF(DataRange,DataRange) แต่
ถา้ลากทับขาดหรอืเกนิ เชน่ ลากทับ /COUNTIF(DataRange,DataRange) ซึѷงมเีครืѷองหมาย
หารเกนิเขา้มาดว้ย จะทําใหเ้มืѷอกดปุ่ ม F9 จะพบวา่ไมส่ามารถแกะสตูรสว่นนัѸนได ้
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วธิแีกะสตูร Array วธิที ีѷ 2 

วธินีีѸใชต้ารางเป็นตัวชว่ยหาผลลัพธข์องการคํานวณทลีะขั Ѹนแสดงใหเ้ห็นไดทั้นทวีา่ หลังจาก
คํานวณขั Ѹนแรกเสร็จแลว้ สง่ผลไปคํานวณตอ่ในการคํานวณขั Ѹนถัดไปอยา่งไรและเกดิผลลัพธ์
อยา่งไร ซึѷงพอคํานวณตอ่กนัไปจนเกดิผลลัพธไ์ดถ้กูตอ้งตามทีѷตอ้งการแลว้ จงึนําสตูรแตล่ะขั Ѹน
มาซอ้นกนัเป็นสตูร Array เพยีงสตูรเดยีว 

 

ใหเ้ริѷมจากแยกสตูร =SUM(1/COUNTIF(DataRange,DataRange)) ออกเป็นสว่นๆตามลําดับ
การคํานวณ โดยไลจ่ากสตูรทีѷอยูภ่ายในวงเล็บในสดุออกมา 

1. Step1 เซลล ์D3 สรา้งสตูร =COUNTIF(DataRange,B3) แลว้ copy ลงมาตลอดแนว
จนถงึ เซลล ์D7 

2. ตัวเลขทีѷไดจ้ากเซลล ์D3:D7 เป็นตัวเลขการนับวา่ขอ้มลูแตล่ะตัวมบีันทกึไวซ้ํѸากนักีѷครั Ѹง
ภายใน DataRange 

3. Step2 เซลล ์E3 สรา้งสตูร =1/D3 แลว้ copy ลงมาตลอดแนวจนถงึ เซลล ์E7 

4. ตัวเลขทีѷไดจ้ากเซลล ์E3:E7 เป็นตัวเลขคา่เฉลีѷยตอ่ตัวจากการนับวา่ขอ้มลูแตล่ะตัวมี
บันทกึไวซ้ํѸากนักีѷครั Ѹงภายใน DataRange 

5. Step3 เซลล ์F3 สรา้งสตูร =SUM(E3:E7) เพืѷอหายอดรวมของคา่เฉลีѷย ไดคํ้าตอบเป็น
จํานวนของ Unique Items 

หมายเหต ุใน Step1 และ Step2 แทนทีѷจะสรา้งสตูรลงไปในเซลล ์D3 และ E3 เพยีงเซลล์
เดยีว ใหท้ดลองสรา้งสตูรคํานวณแบบ Array ลงไปในตารางหลายเซลลพ์รอ้มกนัแทนก็ได ้

 Step1 ใหเ้ลอืกเซลล ์D3:D7 แลว้พมิพส์ตูร =COUNTIF(DataRange,DataRange) 
แลว้กดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งสตูรนีѸลงไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบ
เป็นการนับคา่ซํѸาเชน่เดยีวกนั เนืѷองจากสตูร CountIF จะใชแ้ตล่ะคา่ใน DataRange 
ตรวจสอบจํานวนการบันทกึซํѸาจากพืѸนทีѷ DataRange ทั Ѹงหมดเชน่เดยีวกบัสตูรทีѷนับแต่
ละตัว 

 Step2 ใหเ้ลอืกเซลล ์E3:E7 แลว้พมิพส์ตูร =1/D3:D7 แลว้กดปุ่ ม Ctrl+Shift+Enter 
เพืѷอสรา้งสตูรนีѸลงไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบเป็นคา่เฉลีѷยเชน่เดยีวกนั 
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Array คอือะไร 

บทความนีѸยกความหมายของ Array มาไวต้อนหลัง เพืѷอใหเ้ห็นตัวอยา่งการใชส้ตูร Array ไว ้
กอ่นบา้ง ทําใหไ้ดเ้ห็นวา่ เรานําสตูร Array ไปใชง้านกนัอยา่งไร แลว้มันคํานวณหาอะไร พอได ้
ผา่นการลองทํากบัมอืมาแลว้ คงพอเดากนัไดบ้า้งวา่ Array คอือะไร 

Array คอื คา่ตั Ѹงแตส่องคา่ขึѸนไป แทนทีѷจะใชเ้ซลลเ์ดยีวรับคา่เดยีวตามวธิปีกตทัิѷวไป เรา
สามารถใชเ้ซลลเ์ดยีวรับคา่หลายคา่ลงไปก็ได ้แทนทีѷจะใชพ้ืѸนทีѷตารางของจรงินับรอ้ยนับพัน
เซลลเ์พืѷอกรอกคา่หรอืสรา้งสตูรใหคํ้านวณตอ่ๆกนัไปทลีะขั Ѹน ดว้ยการใช ้Array จะชว่ยใหเ้รา
สามารถใชเ้ซลลเ์พยีงเซลลเ์ดยีวแทนพืѸนทีѷตารางขนาดใหญ ่กลายเป็นเซลลท์ีѷทําหนา้ทีѷแทน
ตารางของจรงิซึѷงเรยีกวา่เป็นตารางในอดุมคตกิ็ได ้

คา่ตั Ѹงแตส่องคา่ขึѸนไปจะเรยีงตามแนวนอน หรอืแนวตั Ѹง หรอืเรยีงตอ่กนัไปเป็นพืѸนทีѷตารางทีѷมี
ความสงูความกวา้งหลาย row หลาย column ก็ได ้โดย Excel กําหนดใหใ้ชเ้ครืѷองหมายในการ
แบง่ลําดับของคา่ ดังนีѸ 

 ถา้เป็น Array ในแนวนอน ใหใ้ชเ้ครืѷองหมาย comma , คัѷนระหวา่งคา่แตล่ะคา่ เชน่ 
11,22,33 

 ถา้เป็น Array ในแนวตั Ѹง ใหใ้ชเ้ครืѷองหมาย semi-colon ; คัѷนระหวา่งคา่แตล่ะคา่ เชน่ 
11;22;33 

 ถา้เป็น Array ทีѷมขีนาดความสงู 2 row และมคีวามกวา้ง 3 column จะแสดงคา่ทีѷมี
เครืѷองหมาย comma และ semi-colon ผสมกนั เชน่ 1,2,3;11,22,33 โดย Array จะไล่
ลําดับจากแนวนอน 1,2,3 กอ่นแลว้จงึใช ้; ขึѸนแนวนอนถัดไปเป็น 11,22,33 

การนําคา่แบบ Array ไปใชใ้นเซลล ์ตา่งจากการใชว้ธิพีมิพ ์1,2,3 ลงไปในเซลลต์ามปกต ิโดย
ตอ้งใช ้Array แบบสตูรทีѷมเีครืѷองหมายเทา่กบันําหนา้สดุเทา่นัѸน ดังนีѸ 

1. การใชแ้บบสตูร Array Constant เชน่ พมิพ ์={1,2,3} ลงไปในเซลลใ์ดๆ จะพบวา่
ในเซลลแ์สดงคา่แรกคอืเลข 1 เพยีงคา่เดยีว ซึѷงถา้ตอ้งการแสดงใหค้รบทกุคา่ ตอ้ง
เลอืกเซลล ์3 เซลลต์ดิกนัตามแนวนอนแลว้พมิพ ์={1,2,3} แลว้กดปุ่ ม 
Ctrl+Shift+Enter เพืѷอบนัทกึ จะพบวา่สตูร ={1,2,3} ซึѷงมวีงเล็บปีกกาอยูด่า้นหลัง
เครืѷองหมายเทา่กบั จะมวีงเล็บปีกกาเพิѷมดา้นหนา้เครืѷองหมายเทา่กบัอกีชั Ѹนหนึѷงเป็น {=
{1,2,3}} 

2. การใชแ้บบสตูร Array ซึѷงรบัคา่มาจากการอา้งองิกบัพืҟนทีѷในตาราง เชน่ รับคา่ 
Array มาจากเซลลต์ามแนวนอน {=A1:C1} หรอืรับคา่ Array มาจากเซลลต์ามแนวตั Ѹง 
{=A1:A3} หรอืรับคา่ Array มาจากตารางขนาดความสงู 2 row และมคีวามกวา้ง 3 
column {=A1:C2} ทั ѸงนีѸโปรดสงัเกตวา่วธินีีѸจะมเีครืѷองหมายวงเล็บปีกกาแสดงไวห้นา้
เครืѷองหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีѷเกดิจากการกดปุ่ ม Ctrl+Shift+Enter 

3. การใชแ้บบสตูร Array ซึѷงรบัคา่มาจากสตูรทีѷคนืคา่แบบ Array เชน่ 
{=Offset(A1,0,0,2,3)} ซึѷงเทยีบเทา่กบัการอา้งองิมาจากเซลล ์A1:C2 เป็นตน้ 
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การนําคา่แบบ Array ทั Ѹง 3 แบบไปใช ้ขอใหเ้ลอืกพืѸนทีѷตารางใหม้ขีนาดพอดบิพอดกีบัจํานวน
ของคา่ทีѷมอียูใ่น Array หรอืใหม้ขีนาดตารางเทา่กบัจํานวนผลลัพธท์ีѷตอ้งการไวก้อ่นทีѷจะสรา้ง
สตูรลงไป กลา่วคอื ถา้ในสตูร Array คนืคา่สดุทา้ยเพยีงคา่เดยีวก็ใหส้รา้งสตูรลงไปในเซลล์
เพยีงเซลลเ์ดยีว แตถ่า้สตูร Array คนืคา่ผลลัพธท์ีѷมจํีานวนคา่มากกวา่คา่เดยีว ก็ตอ้งเลอืกพืѸนทีѷ
ตารางใหม้ขีนาดความสงูและความกวา้งเทา่กนักบัจํานวนและลําดับคา่ทีѷมอียู ่จากนัѸนใหก้ดปุ่ ม 
Ctrl+Shift+Enter ในการรับสตูร Array ลงไป จะพบวา่ Excel กระจายคา่ทีѷมอียูล่งไปในพืѸนทีѷ
ตารางทีѷเตรยีมไวใ้หเ้ห็นไดค้รบทกุคา่ 

 

ตวัอยา่งการสรา้งตารางสตูรคณูแบบ Array 

 

เมืѷอตั Ѹงชืѷอ Range Name ใหก้บัตัวเลขบนหัวตารางและขา้งตารางวา่ Top และ Left เสร็จแลว้ 
ใหท้ดลองเลอืกพืѸนทีѷเซลล ์C3:H7 ซึѷงเกนิกวา่แนวขอบเขตตารางตัวเลขทีѷม ีแลว้สรา้งสตูร 
=Top*Left แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=Top*Left} 

สงัเกตวา่เฉพาะพืѸนทีѷตาราง C3:F5 ซึѷงอยูภ่ายในขอบเขตของ Top กบั Left เทา่นัѸนสามารถ
คํานวณหาผลคณูเป็นตารางสตูรคณูทีѷตอ้งการ สว่นพืѸนทีѷนอกเหนอืจาก C3:F5 ทีѷมสีตูร Array 
จะคนืคา่เป็น Error #N/A 

จากนัѸนใหค้ลกิเซลลใ์ดก็ไดท้ีѷมสีตูร {=Top*Left} แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะแสดง
ผลลัพธเ์ป็น Array Constant {20,30,40,50;40,60,80,100;60,90,120,150} โดยผลลัพธน์ีѸมี
เครืѷองหมาย ; คัѷนอยู ่2 ตัว แสดงวา่ม ี3 row เพราะมกีารขึѸน row ใหม ่2 ครั Ѹง และในชว่งทีѷคัѷน
ดว้ย ; นัѸน มเีครืѷองหมาย , คัѷนอยูช่ว่งละ 3 ตัว แสดงวา่ในแตล่ะ row มคีา่อยู ่4 column หรอือกี
นัยหนึѷงแสดงวา่ พืѸนทีѷตารางทีѷเหมาะจะสรา้งสตูร {=Top*Left} ลงไปนัѸน ตอ้งมคีวามสงู 3 row 
และกวา้ง 4 column ดังนัѸนหากเลอืกพืѸนทีѷเกนิกวา่ทีѷจําเป็นก็จะไดคํ้าตอบเป็น Error #N/A 

แตถ่า้ตอ้งการหายอดรวมของผลคณูของ =Top*Left ในเซลล ์C9 ใหส้รา้งสตูร 
=SUM(Top*Left) แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=SUM(Top*Left)} ซึѷง
สาเหตทุีѷคราวนีѸสรา้งสตูรลงไปในเซลล ์C9 เพยีงเซลลเ์ดยีว เพราะคําตอบของการหายอดรวมมี
เพยีงคา่เดยีวเทา่นัѸน 
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เร ืѷองอืѷนๆเกีѷยวกบั Array ทีѷควรทราบ 

1. ใน Excel Help เรยีกพืѸนทีѷใดๆทีѷมจํีานวนตัѸงแต ่2 เซลลข์ึѸนไปวา่ Array 

2. การแกะดคูา่ทีѷคํานวณไดจ้ากสตูร Array ใหเ้ริѷมจากคลกิลงไปในเซลลส์ตูรแลว้กดปุ่ ม 
F2 แลว้ตามดว้ยปุ่ ม F9 เมืѷอเห็นคา่ทีѷคํานวณไดแ้ลว้ใหก้ดปุ่ ม Esc เพืѷอกลับเป็นสตูร
ตามเดมิ ทั ѸงนีѸถา้คา่ทีѷแกะไดจ้ากสตูร Array คนืคา่หลายคา่จนเกนิกวา่ทีѷเซลลห์นึѷงจะรับ
ได ้จะพบวา่ Excel ไมย่อมแสดงคา่ใหเ้ห็น 

3. วธิคีน้หาพืѸนทีѷของสตูร Array ทีѷเกดิจากการสรา้ง
ขึѸนหลายเซลลพ์รอ้มกนั ใหเ้ริѷมจากคลกิเลอืก
เซลลใ์ดเซลลห์นึѷงซึѷงใชส้ตูร Array แลว้กดปุ่ ม 
F5 > Special > กาชอ่ง Current array 
 

4. บางคนกดปุ่ ม Ctrl+Shift+Enter แตไ่มไ่ด ้
เครืѷองหมายวงเล็บปีกกา เพราะไมไ่ดก้ดทัѸงสาม
ปุ่ มพรอ้มกนัจรงิ ถา้อยากใหไ้ด ้{ } อยา่งแน่นอน 
ใหใ้ชม้อืซา้ยกดปุ่ ม Ctrl+Shift แชค่า้งไวก้อ่น 
จากนัѸนใชม้อืขวากดปุ่ ม Enter ลงไป 

5. สตูร Array ทีѷเกดิจากการสรา้งขึѸนหลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมส่ามารถ Insert หรอื Delete เฉพาะบางเซลล ์หากตอ้งการ
แกไ้ขหรอืลบทิѸง ตอ้งเลอืกพืѸนทีѷทั Ѹงหมดทีѷใชส้ตูร Array นัѸนกอ่นแลว้จงึแกไ้ขสตูรหรอื
ลบสตูรทิѸง (ดังนัѸนหากสามารถลบสตูร Array เพยีงเซลลเ์ดยีวได ้ยอ่มแสดงวา่เป็นสตูร 
Array ทีѷสรา้งทลีะเซลล)์ 

6. สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมส่ามารถสรา้งลงไปใน
เซลลท์ีѷถกู Merge ไวก้อ่นแลว้ จะถกูเตอืนวา่ 
Array formulas are not valid in merged 
cells (แตเ่ราสามารถ Merge เซลลท์ีѷสรา้งสตูร 
Array ไวก้อ่น) 
 

7. สตูร Array ทีѷเกดิจากการสรา้งขึѸนหลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะใชเ้วลาคํานวณเร็วกวา่การสรา้งสตูรคํานวณเพืѷอหาคําตอบทลีะ
เซลลแ์ยกจากกนั 

8. สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม Ctrl+Shift+Enter ทั Ѹงทีѷสรา้งในเซลลเ์ดยีวหรอื
หลายเซลลพ์รอ้มกนั จะใชเ้วลาคํานวณชา้กวา่สตูรสําเร็จรปูทีѷมอียูใ่น Excel ดังนัѸนจงึ
แนะนําใหใ้ชส้ตูร Array ตอ่เมืѷอไมม่สีตูรสําเร็จรปูอืѷนซึѷงสามารถคํานวณหาคําตอบทีѷ
ตอ้งการไดแ้ลว้เทา่นัѸน 
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9. ใน Excel รุน่ 2003 และรุน่เกา่กอ่นนัѸน สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมย่อมรับการอา้งองิพืѸนทีѷตารางทีѷมขีนาดใหญเ่ต็มความสงูทั Ѹง 
65,536 row ของตาราง เชน่  
{=MIN(IF(A:A<>0,ROW(A:A)))} หรอื  
{=MIN(IF(A1:A65536<>0,ROW(A1:A65536)))}  
แตถ่า้แกเ้ป็น {=MIN(IF(A1:A65535<>0,ROW(A1:A65535)))} จะใชไ้ด ้

10. นอกจากสตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม Ctrl+Shift+Enter แลว้ ใน Excel ยังมี
สตูรสําเร็จรปูอืѷนอกีทีѷทํางานแบบ Array โดยไมต่อ้งกดปุ่ ม Ctrl+Shift+Enter เชน่ สตูร 
SumIF, CountIF, SumIFs, CountIFs, AverageIfs, SumProduct ซึѷงถา้พจิารณาตาม
หลักการแลว้สตูรใดก็ตามซึѷงรับคา่จากเซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไปได ้ยอ่มเป็นสตูรทีѷ
ทํางานแบบ Array จงึยังมสีตูรอกีมากทีѷสามารถทํางานแบบ Array ได ้เชน่ สตูร Sum, 
Max, Min, And, Or, Index, หรอื Offset เป็นตน้ 

11. SumIFs, CountIFs, AverageIfs เป็นสตูรทีѷเกดิขึѸนใน Excel 2007 เป็นตน้มา ดังนัѸน
หากยังจําเป็นตอ้งใช ้Excel 2003 หรอืรุน่เกา่กวา่นีѸอยูอ่กี แนะนําใหห้ลกีเลีѷยงสตูร 
SumIFs, CountIFs, AverageIfs ไปกอ่น โดยหันไปใชส้ตูร Sum-IF-Array, Count-
IF-Array, Average-If-Array ซึѷงสามารถใชง้านใน Excel ไดท้กุรุน่ แตจํ่าเป็นตอ้งสรา้ง
โดยการกดปุ่ ม Ctrl+Shift+Enter 

12. Max, Min, And, Or เมืѷอนํามาใชแ้บบ Array จะไมส่ามารถคนืคา่หลายคา่แบบ Array 
เชน่ ถา้สรา้ง {=Max(RangeA,RangeB)} จะไมไ่ดคํ้าตอบเป็นคา่สงูสดุของแตล่ะ
ตําแหน่งใน RangeA เมืѷอนํามาเทยีบกบัแตล่ะตําแหน่งใน RangeB แตจ่ะไดคํ้าตอบเป็น
คา่สงูสดุเพยีงคา่เดยีวจากคา่ทั Ѹงหมดใน RangeA และ RangeB 

13. สตูร Array บางสตูรไมส่ามารถหาคําตอบมาแสดงใหเ้ห็นในเซลล ์แตถ่า้นําสตูรนัѸนไป
ซอ้นในสตูรอืѷนจะสามารถทํางานรว่มกบัสตูรอืѷนได ้

14. สตูร Array ทีѷคนืคา่คําตอบหลายคา่ ไมค่วรสรา้งสตูรนัѸนลงไปในเซลลเ์ดยีวเพราะจะได ้
คําตอบไมค่รบทัѸงหมดหรอืไดคํ้าตอบ error  

15. ถา้สรา้งสตูร Array ทีѷคนืคา่คําตอบหลายคา่ ลงไปในเซลลเ์ดยีวในแนวเดยีวกบัคําตอบ
จากตารางฐานขอ้มลู จะไดคํ้าตอบจากเซลลใ์นแนวคูข่นานกบัตําแหน่งเซลลท์ีѷสรา้งสตูร
ลงไป ซึѷงถอืเป็นความบังเอญิเทา่นัѸน ถา้ยา้ยสตูรไปนอกแนวคูข่นานจะไดคํ้าตอบ error 
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16. ถา้สรา้งสตูร Array ลงไปในตารางหลายเซลลพ์รอ้มกนั จะพบวา่ในการสรา้งสตูรตอนทีѷ
คลกิเลอืกพืѸนทีѷเซลลท์ีѷเคยตั Ѹงชืѷอ Range Name ไวก้อ่นนัѸน Excel จะไมย่อมนําชืѷอ 
Range Name มาใสใ่หใ้นสตูร เชน่ เดมิตั Ѹงชืѷอเซลล ์B4:B8 วา่ DataRange จากนัѸนเมืѷอ
เลอืกเซลลอ์ืѷนใดเพืѷอจะสรา้งสตูรลงไปพรอ้มกนั พอพมิพ ์= แลว้คลกิเลอืกเซลล ์B4:B8 
จะไมไ่ดช้ืѷอ DataRange มาใสใ่นสตูร แตจ่ะไดตํ้าแหน่งเซลล ์B4:B8 แสดงในสตูร
เหมอืนวา่ไมเ่คยมชีืѷอ DataRange ตั Ѹงไวก้อ่นแตอ่ยา่งใด หากตอ้งการนําชืѷอ Range 
Name มาใสใ่นสตูร ใหก้ดปุ่ ม F3 เพืѷอเลอืกชืѷอทีѷตอ้งการมาใชแ้ทนการคลกิเลอืกเซลล ์

17. ถา้อยากจะเกง่ Excel ใหท้ดลองสรา้งสตูรกบัตารางขนาดเล็กใหผ้า่นกอ่น แลว้ใหล้อง
กดปุ่ ม Enter ตามธรรมดาบา้ง หรอืกดปุ่ ม Ctrl+Shift+Enter บา้ง เพราะบางครั Ѹงจะได ้
คําตอบตา่งไปจากเดมิ 

18. ไมค่วรปลอ่ยใหค้นทีѷไมรู่จั้กวธิสีรา้งสตูร Array ทีѷสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter มาแกไ้ขแฟ้มทีѷมสีตูร Array เพราะเขาจะกดปุ่ ม Enter แทนแลว้อาจ
ทําใหไ้ดคํ้าตอบผดิเพีѸยนไปหรอืไดคํ้าตอบ error ขึѸนมาแทน 

 

หากคณุอา่นบทความนีѸแลว้ยังไมเ่ขา้ใจ แลว้พยายามยอ้นกลับไปอา่นซํѸาแลว้ซํѸาอกี ผมเชืѷอวา่
ถงึอยา่งไรก็จะยังไมเ่ขา้ใจอยูนั่ѷนเอง ถา้อยากจะเขา้ใจสตูร Array ตอ้งเรยีนรูจ้ากการทดลอง 
ลองผดิลองถกูหลายๆครั Ѹง  

พอพบปัญหาใดทีѷคดิวา่ไมส่ามารถใชส้ตูรสําเร็จรปูทีѷ Excel มอียูเ่พืѷอหาคําตอบไดใ้นสตูรเดยีว 
โดยคณุตอ้งใชต้ารางเป็นตัวชว่ยในการคํานวณหาผลลัพธท์ลีะขั Ѹน ซึѷงในทีѷสดุสามารถหาคําตอบ
ทีѷตอ้งการได ้ขอใหค้ดิตอ่ไปวา่ลักษณะเชน่นีѸแสดงวา่การใชส้ตูร Array เพืѷอชว่ยลัดขั Ѹนตอนการ
คํานวณมคีวามเป็นไปได ้แลว้อยา่รอชา้ ใหร้บีทดลองสรา้งสตูร Array ทีѷคดิวา่น่าจะเป็นลงไป 
ถา้สตูรนัѸนสามารถหาคําตอบทีѷตอ้งการไดห้รอืไมไ่ดก้็ตาม ขอใหแ้กะสตูรเพืѷอเรยีนรูว้า่ทําไมถงึ
ทําไดห้รอืทําไมจงึทําไมไ่ด ้

ถา้มัวแตร่รีอ คดิในใจไปเรืѷอยๆวา่จะเป็นไปไดไ้หมเนีѷย ก็ไมม่วีันเกง่สตูร Array 

 

Dynamic Array 
 

ตั Ѹงแต ่Excel 365 รุน่ลา่สดุทีѷ update ตั Ѹงแตต่น้ปี 2021 สตูร Array ทีѷเดมิตอ้งกดปุ่ ม 
Ctrl+Shift+Enter จะทํางานไดโ้ดยกดปุ่ ม Enter ตามปกตไิดเ้ลย และถา้เป็นสตูร Array ทีѷคนื
คา่หลายคา่ จะพบวา่ Excel 365 กระจายผลลัพธอ์อกไปเป็นตารางใหเ้อง (Spilling) โดยไม่
จําเป็นตอ้งเลอืกพืѸนทีѷตารางไวก้อ่นสรา้งสตูรอกีตอ่ไป แตต่อ้งระวังวา่หากไมม่พีืѸนทีѷวา่งเพยีง
พอทีѷจะการกระจายผลออกไปก็จะมคํีาเตอืนวา่ #SPILL! 
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สตูร Array IF เพืѷอใชห้ายอดรวมแยกประเภท 
 

สตูร Array IF เพืѷอใชห้ายอดรวมแยกประเภท ถอืเป็นสตูรทีѷสําคัญเป็นอยา่งยิѷงและเป็นสตูรทีѷใช ้
บอ่ยทีѷสดุสตูรหนึѷงทเีดยีว จนใน Excel 2007 เป็นตน้มาบรษัิทไมโครซอฟทไ์ดเ้พิѷมสตูร 
SumIFs, CountIFs, และ AverageIFs เพืѷอตอบสนองตอ่ความตอ้งการของผูใ้ช ้เพราะใน 
Excel รุน่กอ่นนัѸนมเีพยีงสตูร SumIF และ CountIF ซึѷงไมส่ามารถรับเงืѷอนไขในการคํานวณเกนิ
กวา่ 1 เงืѷอนไข 

แตถ่า้คณุนําแฟ้มทีѷใชส้ตูร SumIFs, CountIFs, และ AverageIFs ไปเปิดดว้ย Excel 2003 
หรอืรุน่เกา่กวา่ จะพบวา่สตูรใหมเ่หลา่นีѸไมทํ่างานเพราะ Excel รุน่ทีѷจะใชส้ตูรใหมไ่ดก้็ตอ้งเป็น 
Excel รุน่ใหมเ่ชน่กนั 

บทความนีѸจะแนะนําแนวทางการสรา้งสตูร Array IF วา่มทีีѷไปทีѷมาอยา่งไร เพืѷอชว่ยใหส้ามารถ
สรา้งสตูรหายอดรวมแยกประเภทไดโ้ดยไมจํ่าเป็นตอ้งอาศัยสตูร SumIFs, CountIFs, และ 
AverageIFs แตอ่ยา่งใด แลว้เมืѷอคณุทราบหลักการทํางานของการใช ้Array IF หรอื Array 
แบบเงืѷอนไข ยังจะชว่ยใหส้ามารถนําไปพัฒนาสรา้งสตูรหาคําตอบประเภทอืѷนๆไดไ้มย่าก 

สตูร Array IF คอือะไร 

สตูร Array IF คอื สตูร IF ทีѷทําหนา้ทีѷตรวจสอบคา่หลายคา่วา่ตรงตามเงืѷอนไขทีѷกําหนดหรอืไม ่
โดยจะไดผ้ลลัพธจ์ากการตรวจสอบเป็น True หรอื False หลายคา่ตามลําดับตําแหน่งของคา่ทีѷ
ใช ้ซึѷงตา่งจากสตูร IF ธรรมดาทีѷมกีารตรวจสอบคา่เพยีงคา่เดยีวและเกดิผลลัพธเ์ป็น True หรอื 
False อยา่งใดอยา่งหนึѷงเพยีงคา่เดยีว 

โดยลําพังของสตูร Array IF จะไมส่ามารถหายอดรวมแยกประเภทได ้แตเ่มืѷอนําผลลัพธ ์True 
หรอื False ทีѷไดนั้Ѹนไปเทยีบกบั Array ของตัวเลขคําตอบทีѷตอ้งการ จะทําใหเ้ราสามารถเลอืก
เก็บตัวเลขเฉพาะตําแหน่งคา่ทีѷตรงกบัตําแหน่งของ True แลว้จงึนําผลทีѷไดไ้ปหายอดรว่มกบั
สตูรอืѷนๆก็จะกลายเป็นสตูร Array เพืѷอหาคา่ตามสตูรนัѸนๆ เชน่ เมืѷอนําผลทีѷไดห้ลังจากการเทยีบ
ตําแหน่ง True/False ไปซอ้นในสตูร Sum ก็จะกลายเป็นสตูร Array Sum IF ซึѷงหายอดรวม
แยกประเภท หรอืถา้ซอ้นในสตูร Average ก็จะกลายเป็นสตูร Array Average IF ซึѷงหาคา่เฉลีѷย
แยกประเภท 

โครงสรา้งของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึѷงโดยทัѷวไปทัѸง 2 สว่นตอ้งมขีนาด
ความสงูความกวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False 

2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

(ในเบืѸองตน้ขอใหจํ้าไวว้า่ขนาด Array ทั Ѹงสองสว่นนีѸตอ้งมขีนาดเทา่กนั ซึѷงทีѷจรงิแลว้ขอเพยีงวา่
มขีนาดความสงูหรอืขนาดความกวา้งดา้นใดดา้นหนึѷงเทา่กนัก็ใชไ้ดแ้ลว้) 
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การใชส้ตูร Array IF แบบเงืѷอนไขเดยีว 

 

โปรดสงัเกตวา่ใน Range ID มรีหัส a001 และ a002 เป็นรายการทีѷบันทกึซํѸา ซึѷงถา้มรีหัสไมซ่ํѸา
แลว้ตอ้งการหายอด Amount ของ a001 จะสามารถหาคําตอบโดยใชส้ตูร Vlookup ไดทั้นท ี
แตเ่มืѷอมรีายการซํѸา ถา้ใชส้ตูร Vlookup ก็จะไดย้อดของ a001 รายการแรกเพยีงรายการเดยีว 
หากตอ้งการหายอดรวม Amount ของ a001 หรอืจะแยกหายอดแตล่ะรายการทีѷซํѸาของ a001 
ก็ตอ้งอาศัยสตูรคํานวณแบบ Array มาชว่ย 

ถา้ไมใ่ชส้ตูร Array IF จะหายอดรวม Amount ของรหัส a001 จากการคํานวณทลีะขั Ѹนได ้
อยา่งไร 

 

1. เพืѷอทําใหต้ารางแสดงเฉพาะพืѸนทีѷซ ึѷงเกีѷยวขอ้งกบัการคํานวณเทา่นัѸน จงึขอลบพืѸนทีѷสว่น
ของ Num และ Name ทิѸงไป แลว้ Insert เพิѷม column C และ E มาใชคํ้านวณทลีะขั Ѹน 

2. ตั Ѹงชืѷอ Check ใหก้บัเซลล ์C3:C7 แลว้สรา้งสตูร =Id=$G$3 จะพบวา่ไดคํ้าตอบเป็น 
TRUE; FALSE; TRUE; FALSE; FALSE ตามลําดับ โดยตําแหน่งทีѷเป็น True คอื
ตําแหน่งของรหัส a001 นัѷนเอง 
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3. เซลล ์E3:E7 สรา้งสตูร =IF(Check,Amount,0) จะพบวา่ถา้ตําแหน่งใดใน Check มคีา่
เทา่กบั True สตูร IF นีѸจะเก็บคา่ Amount มาใชต้ามเดมิ แตถ่า้ไมใ่ชจ่ะใสค่า่ 0 แทน 

4. เซลล ์E8 สรา้งสตูร =SUM(E3:E7) ไดคํ้าตอบเทา่กบั 40 ซึѷงเป็นยอดรวมแยกประเภท
ของรหัส a001 ตามตอ้งการ 

แทนทีѷจะตอ้งสรา้งตารางเพิѷมเตมิเพืѷอคํานวณทลีะขั Ѹน เราสามารถลัดหาคําตอบยอดรวมแยก
ประเภทของรหัส a001 ทีѷตอ้งการโดยพจิารณาแยกพืѸนทีѷตารางเป็น 2 สว่น 

 

1. Id เป็นสว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่
กบัรหัสทีѷตอ้งการ 

2. Amount เป็นสว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

จากนัѸนเราสามารถหาคําตอบยอดรวมแยกประเภทของรหัส a001 ซึѷงบันทกึไวใ้นเซลล ์G3 เป็น
เซลลส์ําหรับใสร่หัสทีѷตอ้งการ แลว้ใชส้ตูรตอ่ไปนีѸหาผลลัพธท์ีѷตอ้งการ 

1. สตูร SUMIF โดยใชส้ตูร =SUMIF(Id,$G$3,Amount) หรอื 

2. สตูร Array SumIF โดยใชส้ตูร { =SUM(IF(Id=$G$3,Amount))} โดยตอ้งกดปุ่ ม 
Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหัวทา้ยสตูร หรอื 

3. สตูร SumArray โดยใชส้ตูร { =SUM((Id=$G$3)*Amount)} โดยตอ้งกดปุ่ ม 
Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหัวทา้ยสตูร หรอื 

4. สตูร SumProduct โดยใชส้ตูร =SUMPRODUCT((Id=$G$3)*Amount) โดยไม่
ตอ้งกดปุ่ ม Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด 
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สตูรทั Ѹงสีѷแบบใชห้ลักการคํานวณแบบเดยีวกนั คอื 

1. Id เป็นสว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่
กบัรหัส a001 ทีѷตอ้งการ จะคนืคา่ออกมาเป็น Array  
{TRUE;FALSE;TRUE;FALSE;FALSE} 

2. Amount เป็นสว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 
{10;20;30;40;50} 

3. เมืѷอนํา Array {TRUE;FALSE;TRUE;FALSE;FALSE} มาเทยีบตําแหน่งกบั Array 
{10;20;30;40;50} จะได ้Array ตัวเลขเฉพาะตัวเลขคําตอบทีѷตอ้งการออกมาเป็น  
{10;FALSE;30;FALSE;FALSE} 

4. จากนัѸนเมืѷอนําผล {10;FALSE;30;FALSE;FALSE} ไปหายอดรวมดว้ยสตูร Sum จงึหา
คําตอบเป็น 40 ตามตอ้งการ 

แมว้า่สตูรทั ѸงสีѷแบบนีѸจะหาผลลัพธท์ีѷตอ้งการไดเ้ชน่เดยีวกนัก็ตาม แตข่อใหพ้จิารณาเลอืกใชใ้ห ้
เหมาะสมกบังาน กลา่วคอื 

1. สตูร SUMIF ใหใ้ชก้บัโจทยท์ีѷงา่ยไปตลอดเพราะสตูรนีѸรับเงืѷอนไขไดเ้พยีงเงืѷอนไข
เดยีว และสตูรนีѸใชเ้วลาคํานวณเร็วทีѷสดุในบรรดาสีѷสตูรทีѷกลา่วถงึอยูน่ีѸ 

2. สตูร Array SumIF สตูรนีѸเป็นสตูรพเิศษ เพราะเราสามารถเปลีѷยนสตูร Sum ดา้นหนา้
ไปเป็นสตูร Average, Count, Max, Min, หรอื Small เพืѷอหายอดอืѷนๆตามสตูรทีѷใช ้
แทนนัѸน และถา้มหีลายเงืѷอนก็สามารถซอ้น IF เขา้ไปไดอ้กี 
 
{ =SUM(IF(Id=$G$3,Amount))} หายอดรวมของ a001 ไดเ้ทา่กบั 40 
{ =AVERAGE(IF(Id=$G$3,Amount))} หาคา่เฉลีѷยของ a001 ไดเ้ทา่กบั 20 
{ =COUNT(IF(Id=$G$3,Amount))} นับยอดของ a001 ไดเ้ทา่กบั 2 
{ =MAX(IF(Id=$G$3,Amount))} หายอดสงูสดุของ a001 ไดเ้ทา่กบั 30 
{ =MIN(IF(Id=$G$3,Amount))} หายอดตํѷาสดุของ a001 ไดเ้ทา่กบั 10 

3. สตูร SumArray เป็นสตูรทีѷผมนยิมใชเ้พราะใชม้านานและพบวา่สามารถหาคําตอบทีѷ
ตอ้งการไดเ้สมอแมจ้ะลงิคข์า้มแฟ้มมาจากแฟ้มทีѷไมไ่ดเ้ปิดก็ยังทํางานได ้และถา้มี
หลายเงืѷอนไข การใชว้งเล็บหลายๆชดุชว่ยตรวจสอบเงืѷอนไขยังงา่ยกวา่ทีѷจะใชส้ตูร IF 
ซอ้นกนัเขา้ไป 

4. สตูร SumProduct เป็นสตูรยอดนยิมของคนทัѷวไปเพราะไมจํ่าเป็นตอ้งกดปุ่ ม 
Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด ซึѷงแทจ้รงิแลว้โครงสรา้งภายในวงเล็บของสตูรนีѸก็
เหมอืนกบัของสตูร SumArray นัѷนเอง 
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เร ืѷองแปลกของ True กบั False 

คณุควรทราบลักษณะสําคัญของคา่ True หรอื False เพิѷมเตมิกอ่นทีѷจะเรยีนรูว้ธิใีชส้ตูร Array 
IF แบบหลายเงืѷอนไข กลา่วคอื Excel ถอืวา่คา่ True มคีา่เทา่กบั 1 และคา่ False มคีา่เทา่กบั 
0 ซึѷงเราจะเห็นคา่เหลา่นีѸไดช้ดั ตอ่เมืѷอนําคา่ True หรอื False มาคาํนวณตอ่  

แตถ่า้นําคา่ True ทีѷไดไ้ปเทยีบตรงๆกบัเลข 1 วา่เทา่กนัหรอืไม ่จะพบวา่ True ไมเ่ทา่กบั 1 
และถา้นําคา่ False ทีѷไดไ้ปเทยีบตรงๆกบัเลข 0 วา่เทา่กนัหรอืไม ่จะพบวา่ False ไมเ่ทา่กบั 0 

 

จากภาพตัวอยา่งนีѸ เซลล ์B2 มคีา่ =TRUE() จากนัѸนเรามาทดสอบคา่ของ B2 กนั จะพบวา่ใน
เซลล ์C2 เมืѷอนํามาเทยีบคา่กนัโดยตรง ซึѷงมสีตูร =B2=1 บอกเราวา่ False แสดงวา่ True 
ไมไ่ดเ้ทา่กบั 1 แตเ่มืѷอนําคา่จาก B2 ไปคํานวณตอ่ในเซลล ์C3:C8 ไมว่า่จะนํา B2 ไป *1, /1, 
+0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่
เทา่กบัเลข 1 ออกมาใหเ้ห็น 

ทํานองเดยีวกนั เซลล ์G2 มคีา่ =FALSE() จากนัѸนเรามาทดสอบคา่ของ G2 กนั จะพบวา่ใน
เซลล ์H2 เมืѷอนํามาเทยีบคา่กนัโดยตรง ซึѷงมสีตูร =G2=0 บอกเราวา่ False แสดงวา่ False 
ไมไ่ดเ้ทา่กบั 0 แตเ่มืѷอนําคา่จาก G2 ไปคํานวณตอ่ในเซลล ์H3:H8 ไมว่า่จะนํา G2 ไป *1, /1, 
+0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่
เทา่กบัเลข 0 ออกมาใหเ้ห็น 

ดังนัѸนถา้เราม ีArray ซึѷงมคีา่ True หรอื False แลว้นําไปบวกหรอืคณูกบั Array อืѷนทีѷมคีา่เป็น
ตัวเลขหรอืมคีา่เป็น True หรอื False ก็ตาม ยอ่มเหมอืนกบันําเลข 1 หรอืเลข 0 ไปบวกหรอืคณู
กบัคา่อืѷนนัѷนเอง โปรดดขูอ้พสิจูนจ์ากรปูตอ่ไปนีѸ 

 

Array ทีѷมเีลข 1 และ 0 จากการบวกหรอืคณูนีѷแหละทีѷชว่ยทําใหเ้ราหายอดรวมแยกประเภท
ตอ่ไปได ้
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การใชส้ตูร Array IF แบบหลายเงืѷอนไข 

กรณี Range ทีѷใชต้รวจสอบเงืѷอนไขมาจากเรืѷองเดยีวกนั ใหใ้ชบ้วก 

 

ใหห้ายอดรวม Amount ของรหัส Id a001 กบั a002 (ทั ѸงนีѸทีѷเรยีกวา่ เป็นเรืѷองเดยีวกนัเพราะ
เงืѷอนไขเป็นเรืѷองของรหัสเชน่กนัทั Ѹงคู)่ โดยบันทกึรหัสทีѷตอ้งการใหใ้ชเ้ป็นรหัสทีѷคน้หาไวท้ีѷ
เซลล ์G3 และ H3 ตามลําดับ ซึѷงสามารถใชส้ตูรหาคําตอบเป็นยอดรวม 110 ไดห้ลายวธิ ีดังนีѸ 

1. ใชส้ตูร {=SUM(IF(Id=G3, Amount, IF(Id=H3,Amount,0) ))} 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร IF(Id=G3, Amount, IF(Id=H3,Amount,0) ) โดยการคลกิลากทับ
สว่นของสตูรนีѸแลว้กดปุ่ ม F9 จะได ้Array {10;20;30;0;50} ซึѷงเปลีѷยนคา่ Amount 
ของรหัสอืѷนทีѷไมเ่ทา่กบั a001 หรอื a002 ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  ((Id=G3)+(Id=H3))  *Amount) } 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร ((Id=G3)+(Id=H3)) โดยการคลกิลากทับสว่นของสตูรนีѸแลว้กดปุ่ ม 
F9 จะได ้Array {1;1;1;0;1} โดยมเีลข 1 ตรงกบัตําแหน่งของรหัสทีѷตอ้งการ  
ถา้แกะทีѷมาของเงืѷอนไข (Id=G3) จะได ้Array ของ 
{TRUE;FALSE;TRUE;FALSE;FALSE} ทีѷนํามาบวกกบั (Id=H3) ซึѷงเป็น Array ของ 
{FALSE;TRUE;FALSE;FALSE;TRUE} ทําใหไ้ด ้Array  
{1;1;1;0;1}  
และเมืѷอนํา {1;1;1;0;1} คณูกบั Array ของ Amount {10;20;30;40;50} 
จะได ้Array {10;20;30;0;50} ซึѷงรวมคา่ทั Ѹงหมดไดเ้ทา่กบั 110 ตามตอ้งการ 
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3. ใชส้ตูร =SUMPRODUCT(  ((Id=G3)+(Id=H3))  *Amount) 
 
โดยมหีลักการคํานวณแบบเดยีวกบัวธิทีีѷสอง แตไ่มต่อ้งอาศัย { } 

เพืѷอชว่ยทําใหม้องเห็นลําดับการคํานวณไดช้ดัเจนขึѸน ขอใหด้ภูาพตอ่ไปนีѸแลว้ดหูลักการ
คํานวณทลีะขั Ѹนจาก column ซา้ยไปขวา 

 

 Column ทีѷ 1 เป็นรหัส Id จะพบวา่มรีหัส a001 กบั a002 อยู ่4 รายการ 

 Column ทีѷ 2 ตรวจสอบรหัส Id a001 จะพบวา่มรีหัส a001 อยู ่2 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 3 ตรวจสอบรหัส Id a002 จะพบวา่มรีหัส a002 อยู ่2 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 0, 1, 0, 0, 1 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 4 เป็นผลรวมเมืѷอนํา Column ทีѷ 2 มารวมกบั Column ทีѷ 3  
จะไดเ้ลข 1, 1, 1, 0, 1 ตามลําดับจากบนมาลา่ง แสดงตําแหน่งของรหัส a001 กบั 
a002 ณ ตําแหน่งทีѷตรงกบัเลข 1 

 Column ทีѷ 5 เป็นตัวเลข Amount ทั Ѹงหมด 

 Column ทีѷ 6 เป็นผลคณูเมืѷอนํา Column ทีѷ 4 มารวมกบั Column ทีѷ 5 
จะไดเ้ลข 10, 20, 30, 0, 50 ตามลําดับจากบนมาลา่ง ซึѷงรวมเทา่กบั 110 
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การใชส้ตูร Array IF แบบหลายเงืѷอนไข 

กรณี Range ทีѷใชต้รวจสอบเงืѷอนไขมาจากตา่งเรืѷองกนั ใหใ้ชค้ณู 

 

ใหห้ายอดรวม Amount ของรหัส Id a001 เฉพาะรายการทีѷม ีName เทา่กบั c (ทั ѸงนีѸทีѷเรยีกวา่ 
เป็นตา่งเรืѷองกนั เพราะเงืѷอนไขรหัสตา่งจากเงืѷอนไขชืѷอ) โดยบันทกึรหัสทีѷตอ้งการใหใ้ชเ้ป็นรหัส
และชืѷอทีѷคน้หาไวท้ีѷเซลล ์G3 และ H3 ตามลําดับ ซึѷงสามารถใชส้ตูรหาคําตอบเป็นยอดรวม 30 
ไดห้ลายวธิ ีดังนีѸ 

1. ใชส้ตูร { =SUM(IF(Id=G3, IF(Name=H3,Amount,0), 0 ))} 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร IF(Id=G3, IF(Name=H3,Amount,0), 0 ) โดยการคลกิลากทับสว่น
ของสตูรนีѸแลว้กดปุ่ ม F9 จะได ้Array {0;0;30;0;0} ซึѷงเปลีѷยนคา่ Amount ของรหัส
อืѷนทีѷไมเ่ทา่กบั a001 และชืѷอไมใ่ช ่c ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  (Id=G3)*(Name=H3)  *Amount) } 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร (Id=G3)*(Name=H3) โดยการคลกิลากทับสว่นของสตูรนีѸแลว้กดปุ่ ม 
F9 จะได ้Array {0;0;1;0;0} โดยมเีลข 1 ตรงกบัตําแหน่งรายการทีѷตอ้งการ  
 
ถา้แกะทีѷมาของเงืѷอนไข (Id=G3) จะได ้Array ของ 
{TRUE;FALSE;TRUE;FALSE;FALSE} นํามาคณูกบั (Name=H3) ซึѷงเป็น Array ของ 
{FALSE;FALSE;TRUE;FALSE;FALSE} ทําใหไ้ด ้Array  
{0;0;1;0;0} 



Page 131 of 147 

 

สดุยอดเคล็ดลับและลัดของ Excel 
© พ.ศ. 2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ

www.ExcelExpertTraining.com 

และเมืѷอนํา {0;0;1;0;0} คณูกบั Array ของ Amount {10;20;30;40;50} 
จะได ้Array {0;0;30;0;0} ซึѷงรวมคา่ทั Ѹงหมดไดเ้ทา่กบั 30 ตามตอ้งการ 

3. ใชส้ตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) 
 
โดยมหีลักการคํานวณแบบเดยีวกบัวธิทีีѷสอง แตไ่มต่อ้งอาศัย { } 

4. ใชส้ตูร =SUMIFS(Amount,Id,G3,Name,H3) เป็นสตูรทีѷเกดิขึѸนใน Excel 2007 
เป็นตน้มา 

เพืѷอชว่ยทําใหม้องเห็นลําดับการคํานวณไดช้ดัเจนขึѸน ขอใหด้ภูาพตอ่ไปนีѸแลว้ดหูลักการ
คํานวณทลีะขั Ѹนจาก column ซา้ยไปขวา 

 

 Column ทีѷ 1 เป็นรหัส Id จะพบวา่มรีหัส a001 อยู ่2 รายการ 

 Column ทีѷ 2 ตรวจสอบรหัส Id a001 จะพบวา่มรีหัส a001 อยู ่2 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 3 เป็นชืѷอ Name จะพบวา่มชีืѷอ c อยู ่1 รายการ 

 Column ทีѷ 4 ตรวจสอบชืѷอ Name c จะพบวา่มชีืѷอ Name c อยู ่1 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 5 เป็นผลคณูเมืѷอนํา Column ทีѷ 2 มาคณูกบั Column ทีѷ 4  
จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง แสดงตําแหน่งของรหัส a001 มชีืѷอ 
Name c ณ ตําแหน่งทีѷตรงกบัเลข 1 

 Column ทีѷ 6 เป็นตัวเลข Amount ทั Ѹงหมด 

 Column ทีѷ 7 เป็นผลคณูเมืѷอนํา Column ทีѷ 5 มาคณูกบั Column ทีѷ 6 
จะไดเ้ลข 0, 0, 30, 0, 0 ตามลําดับจากบนมาลา่ง ซึѷงรวมเทา่กบั 30 
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วธิพีลกิแพลงสตูร SumProduct 

สตูร SumProduct เป็นสตูรทีѷทํางานแบบ Array อยูใ่นตัว มหีนา้ทีѷนํา Range ของตัวเลขแตล่ะ
ตําแหน่งจากตารางทีѷมขีนาดเทา่กนั มาคณูกนัทลีะเซลลต์ามตําแหน่งทีѷตรงกนั จากนัѸนจงึบวก
รวมผลคณูทีѷไดนั้Ѹนเขา้ดว้ยกนั  

ตัวอยา่ง เชน่ เราตอ้งการหามลูคา่ตน้ทนุรวมของสนิคา้ โดยนําตน้ทนุตอ่หน่วยมาคณูกบัจํานวน
หน่วย ซึѷงหากไมรู่จั้กสตูร SumProduct ก็ตอ้งนํา Cost*Quantity ทลีะรายการ เพืѷอใหไ้ด ้
ตัวเลข Total ตาม Column D จากนัѸนจงึสรา้งสตูรในเซลล ์F2 =SUM(D3:D5) จงึจะไดย้อด
รวมตน้ทนุทั Ѹงหมด 

 

ซึѷงแทนทีѷจะตอ้งเสยีพืѸนทีѷคํานวณหา Total ใน Column D เราสามารถใชส้ตูร SumProduct ลัด
หาตน้ทนุรวมไดโ้ดยใชส้ตูรตามนีѸ 

1. =SUMPRODUCT(Cost, Quantity) เป็นการใชส้ตูรตามโครงสรา้งปกต ิโดยใช ้
เครืѷองหมาย comma , คัѷนแตล่ะ Range ในสตูร หรอื 

2. =SUMPRODUCT(Cost*Quantity) เป็นสตูรทีѷนําแตล่ะ Range มาคณูกนัเลย ซึѷง
การสรา้งแบบคณูกนันีѸ จะชว่ยใหเ้ราสามารถคลกิลากทับการคํานวณในวงเล็บแลว้กดปุ่ ม 
F9 เพืѷอเห็นผลการคณูกนัของแตล่ะตําแหน่งไดด้ว้ย 

จากนัѸน ขอยอ้นกลับไปเรืѷองโครงสรา้งภายในสตูร Array IF ตามทีѷอธบิายไวแ้ลว้วา่ โครงสรา้ง
ของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึѷงโดยทัѷวไปทัѸง 2 สว่นตอ้งมขีนาดความสงูความ
กวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False 

2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

ขอนําสตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) มาวเิคราะหแ์ยก
โครงสรา้งขา้งตน้ จะพบวา่ 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False ไดแ้ก ่สว่นของ (Id=G3) และ 
(Name=H3)  ซึѷงนํามาคณูกนัเพืѷอทําใหเ้ปลีѷยน True เป็นเลข 1 และเปลีѷยน False เป็น
เลข 0 
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2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ ไดแ้กส่ว่นของ Amount 

ดังนัѸนหากตอ้งการปรับสตูรใหคํ้านวณนับแทนการหายอดรวมของ Amount โดยใหนั้บวา่มคีา่
ตามเงืѷอนไขทัѸงสิѸนกีѷรายการ ใหใ้ชส้ตูรใดสตูรหนึѷงตอ่ไปนีѸก็ได ้

1. =SUMPRODUCT(  (Id=G3)*(Name=H3) ) โดยสตูร SumProduct จะทํา
หนา้ทีѷรวมเลข 1 ทีѷไดจ้ากการคณูกนัของ Array ภายในวงเล็บวา่มเีลข 1 กีѷตัว นัѷนคอืนับ
จํานวนรายการทีѷมเีงืѷอนไขตามตอ้งการนัѷนเอง 

2. =SUMPRODUCT(  (Id=G3)*1, (Name=H3)*1) 

3. =SUMPRODUCT(  (Id=G3)/1, (Name=H3)/1) 

4. =SUMPRODUCT(  (Id=G3)+0, (Name=H3)+0) 

5. =SUMPRODUCT(  (Id=G3)-0, (Name=H3)-0) 

6. =SUMPRODUCT(  --(Id=G3), --(Name=H3) ) 

สตูร SumProduct แบบทีѷ 2-6 เป็นสตูรทีѷใชเ้ครืѷองหมาย comma , คัѷน จงึจําเป็นตอ้งกระตุน้ให ้
เปลีѷยน True เป็นเลข 1 และเปลีѷยน False เป็นเลข 0 โดยนํา True หรอื False ทีѷไดจ้ากการ
ตรวจสอบเงืѷอนไขไป *1, /1, +0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้กอ่น 

ดังนัѸนจงึขอแนะใหส้รา้งสตูร SumProduct แบบนําเงืѷอนไขมาคํานวณ(คณูหรอืบวก)กนัเองกอ่น 
เพราะนอกจากจะแกะหาผลจากการคณูหรอืบวกกนัจากสว่นของเงืѷอนไขทีѷนํามาคํานวณกนัได ้
แลว้ ยังเป็นสตูรทีѷสั Ѹนกวา่และมขีั Ѹนตอนการคํานวณนอ้ยกวา่สตูร SumProduct ทีѷใชแ้บบ
เครืѷองหมาย comma , คัѷนอยูภ่ายใน 

 

หมายเหต ุ

โดยทัѷวไปหากเงืѷอนไขทีѷใชใ้นสตูร Array IF เป็นการตรวจสอบวา่เทา่กนัหรอืไม ่โดยใช ้
เครืѷองหมาย = ในการเปรยีบเทยีบวา่เป็น True หรอื False เราสามารถทอ่งจําไวเ้ลยดังนีѸ 

 ถา้ Range ทีѷนํามาตรวจสอบเงืѷอนไขเป็น เร ืѷองเดยีวกนั ใหนํ้าผลลัพธจ์ากการ
ตรวจสอบเงืѷอนไขมา บวกกนั และมวีงเล็บเปิดดา้นหนา้ 3 ตัว 

 ถา้ถา้ Range ทีѷนํามาตรวจสอบเงืѷอนไขเป็น ตา่งเรืѷองกนั ใหนํ้าผลลัพธจ์ากการ
ตรวจสอบเงืѷอนไขมา คณูกนั และมวีงเล็บเปิดดา้นหนา้ 2 ตัว 

แตถ่า้เป็นการตรวจสอบเงืѷอนไขประเภทมากกวา่หรอืนอ้ยกวา่หรอืผสมกนั แม ้Range ทีѷนํามา
เป็นเงืѷอนไขจะเป็นเรืѷองเดยีวกนั ก็ไมจํ่าเป็นวา่ตอ้งนําผลลัพธจ์ากการตรวจสอบเงืѷอนไขมาบวก
กนัเสมอไป บางกรณีอาจใชค้ณูกนัก็ได ้ทั ѸงนีѸข ึѸนกบัลักษณะการเปรยีบเทยีบทีѷใชด้ว้ย โดยขอให ้
คดิหาวธิใีดก็ไดท้ีѷจะทําใหเ้กดิเลข 1 ชีѸเฉพาะตําแหน่งรายการทีѷตอ้งการใหไ้ด ้



Page 134 of 147 

 

สดุยอดเคล็ดลับและลัดของ Excel 
© พ.ศ. 2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ

www.ExcelExpertTraining.com 

ของจรงิ ของปลอม ของใชไ้มไ่ดใ้น Excel 
 

ในเรืѷองความซืѷอสตัยส์จุรติ โปรแกรม Excel ถอืวา่ไดห้นึѷงรอ้ยคะแนนเต็ม ไมว่า่คณุจะบันทกึคา่ 
สรา้งสตูร หรอืนํา Excel มาใชแ้บบใด อะไรทีѷคณุทําลงไปใน Excel ก็จะไดร้ับผลตามนัѸน แตถ่า้
คณุเขา้ใจ Excel ไดไ้มด่พีอ ก็อาจจะตโีพยตพีายเมืѷอเห็นวา่ Excel ทรยศ เพราะมันใหคํ้าตอบทีѷ
ผดิพลาดตา่งจากคําตอบทีѷคณุตอ้งการ ทั Ѹงๆทีѷแทจ้รงิแลว้คณุนัѷนแหละทีѷเขา้ใจผดิ 

 

ของจรงิทีѷทาํใหส้ตูร IF กลายเป็นของปลอม 

เนืѸอหาทีѷจะนํามาอธบิายตอ่ไปนีѸจะชีѸเป็นชีѸตายใหก้บัคนทีѷชอบใชส้ตูร IF หรอืสตูรใดก็ตามทีѷ
เกีѷยวขอ้งกบัการตัดสนิใจหรอืใชใ้นการคน้หาขอ้มลูวา่ แฟ้มงานทีѷคณุสรา้งขึѸนนัѸนมคีวาม
น่าเชืѷอถอืหรอืไม ่เพืѷอพสิจูนใ์หเ้ห็นกบัตา ลองดสูตูร IF ตอ่ไปนีѸแลว้คดิวา่จะไดคํ้าตอบออกมา
เป็นคําวา่ เทา่กนั หรอื ไมเ่ทา่กนั 

=IF( 22.3-22.2=0.1, "เทา่กนั", "ไมเ่ทา่กนั") 

เชืѷอหรอืไม!่!! Excel จะใหคํ้าตอบออกมาวา่ 22.3-22.2 นัѸนไมเ่ทา่กบั 0.1 โดยคนืคา่ออกมาเป็น
คําวา่ ไมเ่ทา่กนั ซึѷงถอืเป็นคําตอบทีѷถกูตอ้ง เพราะ 22.3-22.2 ไมไ่ดคํ้านวณออกมาแลว้ใหผ้ล
ลัพธเ์ทา่กบั 0.1 ตามทีѷเราเขา้ใจ 

ขอใหล้องสรา้งสตูร =22.3-22.2 ลงไปในเซลล ์แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่คา่ทีѷ
แทจ้รงิทีѷ Excel คํานวณไดค้อื 0.100000000000001 ซึѷงแน่นอนวา่ไมใ่ช ่0.1 

บางคนมองคา่ 0.100000000000001 แลว้ยอมรับตัวเลขทีѷไดน้ีѸ เพราะเห็นวา่มันตา่งจาก 0.1 ทีѷ
ตอ้งการเพยีงเล็กนอ้ย ถา้ใครคดิเชน่นีѸแสดงวา่เขา้ใจ Excel ผดิ เพราะ Excel จะไมย่อมรับวา่คา่ 
0.1 เทา่กบั0.100000000000001 ไมว่า่คา่ทีѷแตกตา่งกนันัѸนจะนอ้ยมากก็ตาม 

การทีѷ Excel คํานวณไดค้า่ทีѷเพีѸยนตา่งจากทีѷควรนีѸ ไมไ่ดถ้อืวา่เป็นการคํานวณทีѷผดิพลาด และ
ไมไ่ดม้แีคก่รณีนีѸกรณีเดยีว สตูรหรอืการคํานวณใดๆทีѷคณุใชม้โีอกาสคนืคา่เพีѸยนไปจากทีѷ
ตอ้งการไดทั้ ѸงนัѸน 

Excel จะใชร้ปูแบบ (Format Number) แสดงคา่ในเซลลต์ามลักษณะตัวเลขทีѷพมิพ ์นีѷคอื
สาเหตปุระการแรกทีѷอธบิายวา่ ทําไม Excel จงึไมแ่สดงคา่ 0.100000000000001 ในเซลล์
ออกมาใหเ้ห็นครบทกุหลัก เนืѷองจากตัวเลข 22.3-22.2 ทีѷพมิพล์งไปมทีศนยิมเพยีงหนึѷงหลัก 
ดังนัѸน Excel จงึแสดงผลลัพธใ์หเ้ห็นตัวเลขทีѷมทีศนยิมเพยีงหนึѷงหลักตามไปดว้ย 

คา่ทีѷเพีѸยนไปไมไ่ดถ้อืวา่เกดิจากการคํานวณทีѷผดิพลาด แตเ่ป็นเพราะ Excel ใชห้ลักการคํานวณ
แบบเลขฐานสองแลว้แปลงกลับมาเป็นเลขฐานสบิ ซึѷงคา่ 22.3-22.2 คํานวณแบบเลขฐานสอง 
ไดคํ้าตอบเป็นเลขทีѷซํѸาไมรู่จ้บ (Repeating Binary Number) จากนัѸนเมืѷอแปลงกลับมาเป็น
เลขฐานสบิใหพ้วกเราเขา้ใจ จงึตอ้งปรับคา่ใหเ้หลอืเพยีง 15 หลัก (Excel มคีวามละเอยีด
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Precision โดยรับตัวเลขไดส้งูสดุ 15 หลัก) แลว้สง่ผลใหไ้ดผ้ลลัพธแ์ตกตา่งจากทีѷควรบา้ง
เล็กนอ้ย และมไิดเ้กดิขึѸนเฉพาะกรณี 22.3-22.2 เทา่นัѸน เราไมม่ทีางคาดการณ์ไดเ้ลยวา่จะ
เพีѸยนเมืѷอใดและเกดิจากการคํานวณใด 

ดงัน ัҟนกอ่นทีѷคณุจะใชส้ตูรทีѷเก ีѷยวขอ้งกบัการตดัสนิใจหรอืสตูรในการคน้หา
ขอ้มลู เชน่ IF, SumIF, VLookup, หรอื Match จําเป็นตอ้งปรับคา่ใหเ้ทา่กบัคา่ทีѷ
ตอ้งการ เพืѷอใหเ้ป็นไปตามเงืѷอนไขทีѷตอ้งการกอ่นเสมอ โดยใชส้ตูรอืѷนเขา้มาชว่ยปรับ
คา่ จากนัѸนเมืѷอไดค้า่ตามทีѷตอ้งการจรงิๆแลว้คณุจะกําหนดรปูแบบ Format ใดๆใหก้บัคา่
นัѸนก็ตามใจ (การกําหนดรปูแบบไมไ่ดช้ว่ยปรับคา่ทีѷแทจ้รงิแตอ่ยา่งใด และหา้มใช ้Set 
precision as displayed เพราะจะมผีลตอ่ตัวเลขทัѸงแฟ้มโดยไมม่กีารเตอืนผูใ้ช)้ 

สตูรสําคัญซึѷงใชใ้นการปรับคา่ตัวเลขใหเ้ป็นไปตามตอ้งการ (โปรดศกึษารายละเอยีดของสตูร
ไดจ้าก Excel Help) ไดแ้ก ่

1. สตูร =Round(ตวัเลข, จํานวนหลกั) ใชส้ําหรบัการปัดคา่ 
 
=Round(123.45,0) คนืคา่ 123 
=Round(123.45,1) คนืคา่ 123.5  
=Round(123.45,-1) คนืคา่ 120 
=Round(123.45,-2) คนืคา่ 100 
 

2. สตูร =Trunc(ตวัเลข, จํานวนหลกั) ใชส้ําหรบัการตัดคา่ 
 
=Trunc(123.45,0) คนืคา่ 123 
=Trunc(123.45,1) คนืคา่ 123.4 ตา่งจาก Round 
=Trunc(123.45,-1) คนืคา่ 120 
=Trunc(123.45,-2) คนืคา่ 100 
 

3. สตูร =Int(ตวัเลข) ใชส้ําหรับปรับเป็นตัวเลขจํานวนเต็ม(ทีѷนอ้ยกวา่คา่เดมิ) 
 
=Int(1.23) คนืคา่ 1 
=Int(-1.23) คนืคา่ -2 
 

4. สตูร =Mod(เลขต ัҟงต ัҟง, เลขตวัหาร) ใชส้ําหรับหาเศษทีѷเหลอืจากการหาร 
 
=Mod(7,2) คนืคา่ 1 เพราะ 7/2 เทยีบเทา่กบั 3 1/2 
=Mod(7,4) คนืคา่ 3 เพราะ 7/4 เทยีบเทา่กบั 1 3/4 
=Mod(123.45,1) คนืคา่เทา่กบั .45 !!!  
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วนัทีѷจอมปลอม 

 

ในหนา้รายงานของทกุคน ตอ้งมขีอ้มลูเกีѷยวกบัวันเดอืนปีของรายงานนัѸนกํากบัอยูด่ว้ยเสมอ 
ขอใหเ้ปิดแฟ้มของคณุขึѸนมาดซูวิา่ในเซลลท์ีѷมขีอ้มลูแสดงวันเดอืนปี ถา้ไมไ่ดก้ําหนดรปูแบบให ้
ชดิซา้ยหรอืชดิขวา ขอ้มลูวันเดอืนปีของคณุชดิซา้ยของเซลลต์ามรปูขา้งบนนีѸเหมอืนใน 
Column B หรอืชดิขวาของเซลลเ์หมอืนใน Column C 

Column B เป็นชืѷอเดอืนทีѷชดิซา้ยของเซลล ์ไมว่า่คณุจะบันทกึไวเ้ป็นเพยีงเลขทีѷวัน หรอืเฉพาะ
เลขทีѷเดอืน หรอืชืѷอเดอืนเทา่นัѸนตามแบบทีѷเห็นในภาพนีѸ ถา้มันชดิซา้ยเองโดยคณุไมไ่ด ้
กําหนดใหม้ันชดิซา้ย แสดงวา่ขอ้มลูนัѸนมคีา่เป็น Text ซึѷงไมม่ปีระโยชนใ์นการนําขอ้มลูไปใช ้
คํานวณตอ่แมแ้ตน่อ้ย อยา่งเชน่เซลล ์B2 ทีѷมคํีาวา่ Jan ไมไ่ดใ้หร้ายละเอยีดวา่เป็นวันทีѷใดของ
เดอืนมกราคมหรอืเป็นเดอืนมกราคมของปีใด คําวา่ Jan ทีѷชดิซา้ยใหค้วามหมายแตเ่พยีงบอกวา่
เป็นเดอืนมกราคมเทา่นัѸน ซึѷงหลายคนแกปั้ญหาโดยการเพิѷมเซลลบ์ันทกึเลขปีลงไปอกี 

Column C เป็นการบันทกึแบบทีѷถกูตอ้ง สงัเกตวา่ชืѷอเดอืนชดิขวาของเซลล ์และแมใ้นเซลล ์
C2 แสดงคําวา่ Jan ก็ตาม แตเ่มืѷอมองทีѷชอ่ง Formula Bar ดา้นบน จะพบวา่มคีา่ทีѷแทจ้รงิเป็น 
15/1/2010 ซึѷงหากตอ้งการใหแ้สดงชืѷอเดอืนตั Ѹงแตเ่ซลล ์C3 ตอ่ๆกนัไป ใหส้รา้งสตูร =C2+30 
ลงไปในเซลล ์C3 แลว้ Copy สตูรนีѸตอ่ลงไปในแนวตั Ѹง จากนัѸนใหก้ําหนด Format Cells ใน 
Column C เป็น [$-409]mmm หรอื [$-en-US]mmm จะทําใหค้า่ 15/1/2010, 
14/2/2010, 16/3/2010 แสดงเฉพาะชืѷอเดอืน Jan, Feb, Mar ทีѷชดิขวาของเซลล ์ 

สาเหตทุีѷใชค้า่แรกในเซลล ์C2 เป็นวันทีѷ 15 นัѸนเพืѷอชว่ยใหเ้ราสามารถบวกเพิѷมตอ่ไปเซลลล์ะ 
30 วัน เพืѷอทําใหไ้ดเ้ดอืนตอ่ไปเพิѷมทลีะเดอืนไดง้า่ยกวา่ทีѷจะเริѷมเซลลแ์รกเป็นวันทีѷส ิѸนเดอืน ซึѷง
ตอ้งบวกเพิѷมดว้ยจํานวน 31 วัน 30 วัน 28-29 วันแตกตา่งกนัไปในแตล่ะเดอืน 
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วธิใีชว้นัทีѷและเวลา 

1. ในการบันทกึ ใหพ้มิพใ์หค้รบทัѸงวันเดอืนปี อยา่บันทกึเฉพาะวันทีѷหรอืเฉพาะเดอืนหรอืเฉพาะ
ปีเทา่นัѸน โดยจะพมิพส์ว่นของเวลาตอ่ทา้ยดว้ยหรอืไมก่็ได ้เชน่ 14/2/2010 12:00 

2. ใหบ้ันทกึโครงสรา้งของวันทีѷลงไปในเซลลต์ามแบบทีѷกําหนดไวใ้น Regional Setting ของ 
Windows เชน่ ถา้กําหนดไวใ้น Regional Setting เป็น Thai ก็ตอ้งบันทกึวันทีѷตามแบบของ
ประเทศไทยซึѷงใชลํ้าดับตามวันกอ่นเดอืนกอ่นปี แตถ่า้กําหนดใน Regional Setting เป็น 
USA ก็ตอ้งบันทกึตามลําดับเดอืนกอ่นวันกอ่นปี 

3. แมจ้ะใช ้Regional Setting เป็น Thai แตใ่นการบันทกึในสว่นของเลขปีตอ้งใชปี้ค.ศ.ในการ
บันทกึเทา่นัѸน จากนัѸนใหใ้ช ้Format ปรับการแสดงปีค.ศ.ใหเ้ป็นปีพ.ศ.ในภายหลัง เชน่ ให ้
บันทกึ 14/2/2010 (หา้มใชปี้พ.ศ.แทนอยา่งเด็ดขาด) จากนัѸนเมืѷอตอ้งการแสดงเป็น 
14/2/2553 ใหใ้ช ้Format [$-1070000]d/mm/yyyy 

4. ในโครงสรา้งของวันทีѷใหพ้มิพเ์ครืѷองหมาย / ในการแบง่สว่นของ วนั/เดอืน/ปีค.ศ. และ
ในโครงสรา้งของเวลาใหพ้มิพเ์ครืѷองหมาย : ในการแบง่สว่นของ ช ัѷวโมง:นาท:ีวนิาท ี

5. ควรพมิพเ์ลขปีค.ศ.ใหค้รบทัѸง 4 หลักเสมอ แตถ่า้จําเป็นตอ้งพมิพแ์คส่องหลักทา้ย พอกด
ปุ่ ม Enter เพืѷอบันทกึคา่ลงไป Excel จะเปลีѷยนตัวเลขปี 2 หลักทา้ย ดังนีѸ 

5.1. ตั Ѹงแตเ่ลข 00-29 ใหเ้ป็นชว่งปีค.ศ. 2000-2029  

5.2. ตั Ѹงแตเ่ลข 30-99 ใหย้อ้นกลับเป็นชว่งปีค.ศ. 1930-1999 

6. เมืѷอบันทกึวันทีѷแลว้ตอ้งชดิขวาของเซลลเ์สมอ (สาเหตทุีѷชดิขวาเพราะมคีา่เป็นตัวเลข) และ
ขอใหห้ลกีเลีѷยงการใชว้ันทีѷแบบ Text ซึѷงชดิซา้ยของเซลลเ์นืѷองจาก Excel จะไมนํ่า 
Regional Setting มาชว่ยควบคมุในการแบง่สว่นของวันเดอืนปีทีѷใชแ้บบ Text  

7. คา่ของวันทีѷและเวลามชีืѷอเรยีกวา่ Date Serial Number หรอืเรยีกวา่ Serial Number (SN) 
โดย Excel ถอืวา่ 1/1/1900 0:00:00 มคีา่ SN=1 ซึѷงเราสามารถแกะดคูา่ SN ไดโ้ดย
เปลีѷยน Format เป็น General (โดยการกดปุ่ ม Ctrl+Shift+ ~) เชน่ 14/2/2010  12:00:00 
มคีา่ SN เทา่กบั 40223.5 

7.1. ในสว่นของตัวเลข SN สว่นทีѷเป็นจํานวนเต็ม คอื คา่ของวันทีѷ 

7.2. ในสว่นของตัวเลข SN สว่นทีѷเป็นเศษทศนยิม คอื คา่ของเวลา 

8. เวลาของ Excel เริѷมจาก 0:00:00-23:59:59 และใช ้Format h:mm:ss  

9. ระยะเวลา เริѷมจาก 0:00:00 ขึѸนไป โดยไมส่ ิѸนสดุทีѷ 23:59:59 

9.1. ใช ้Format [h]:mm:ss เพืѷอแสดงเลขตั Ѹงแต ่24 ชัѷวโมงขึѸนไปได ้

9.2. ใช ้Format [mm]:ss เพืѷอแสดงเลขตั Ѹงแต ่60 นาทขีึѸนไปได ้
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9.3. ใช ้Format [ss] เพืѷอแสดงเลขตั Ѹงแต ่60 วนิาทขีึѸนไปได ้

10. ในการแสดงเวลาหรอืระยะเวลา ถา้คา่ SN < 1 จะใช ้Format ของเวลาหรอืระยะเวลาก็ได ้
แตถ่า้ SN >=1 ตอ้งเลอืกใช ้Format ของระยะเวลาเทา่นัѸน 

11. ถา้ตอ้งการบันทกึการทํางานขา้มคนื ไมค่วรบันทกึเฉพาะเวลาเขา้ออกงาน แตใ่หบ้ันทกึวัน
เดอืนปีกํากบัเวลาไวด้ว้ย เชน่ 14/2/2010 20:00 เพืѷอทําให ้Excel รับรูค้า่เป็น SN ทีѷมคีรบ
ทัѸงสว่นของวันทีѷและเวลา 

12. Format ในการแสดงวันและเวลา 

12.1. แสดงเลขวันทีѷ ใช ้d หรอื dd  

12.2. แสดงเป็นชืѷอวัน แบบยอ่ใช ้ddd หรอืแบบเต็ม dddd 

12.3. แสดงเป็นเลขเดอืน ใช ้m หรอื mm 

12.4. แสดงเป็นชืѷอเดอืน แบบยอ่ใช ้mmm หรอืแบบเต็ม mmmm 

12.5. แสดงเป็นเลขปี ใช ้yy หรอื yyyy 

12.6. แสดงชัѷวโมง นาท ีวนิาท ีใช ้h:mm:ss หรอื hh:mm:ss 

12.7. รหัสควบคมุ Locale ใช ้[$-409] สําหรับ USA และ [$-1070000] สําหรับไทย 

 

การคาํนวณวนัทีѷและเวลา 

กอ่นทีѷจะนําวันทีѷและเวลามาคํานวณได ้ตอ้งเริѷมจากการตรวจสอบวา่ขอ้มลูเกีѷยวขอ้งกบัวันทีѷและ
เวลาซึѷงถกูบันทกึไวว้า่มโีครงสรา้งทีѷถกูตอ้งตรงกบั Regional Setting หรอืไม ่หากบันทกึไวผ้ดิ 
เชน่ ใน Regional Setting กําหนดไวเ้ป็น USA แตค่นทีѷบันทกึขอ้มลูพมิพว์นัทีѷไวใ้นแบบ
ประเทศไทย เชน่ พมิพ ์4/2/2001 ซึѷงตอ้งการบันทกึแบบไทยใหห้มายถงึวันทีѷ 4 เดอืน 2 ปี 
2001 จะพบวา่เมืѷอนําแฟ้มนัѸนมาเปิดบนเครืѷองทีѷม ีRegional Setting เป็นไทย เลขทีѷของวันจะ
สลับกบัเลขทีѷของเดอืน จะแสดงเป็น 2/4/2001 แทน ทําใหก้ําหนดเวลาทีѷบันทกึไวผ้ดิทั Ѹงหมด 
ถา้ไมเ่กง่สตูรเกีѷยวขอ้งกบัวันทีѷและเวลาก็ตอ้งจัดการพมิพทั์บใหมทั่ Ѹงหมด 

นอกจากนีѸตอ้งตรวจสอบตอ่ไปอกีวา่ คา่ของวันทีѷซ ึѷงบันทกึไวเ้ป็นขอ้มลูทีѷมคีา่เป็นตัวเลข (Date 
Serial Number หรอื SN) หรอืไม ่โดยเริѷมจากยกเลกิการจัดชดิซา้ยชดิขวาของเซลลว์ันทีѷ
ทั Ѹงหมด หากพบวา่ ชดิขวาก็ใชไ้ด ้แตถ่า้พบวา่ชดิซา้ยแสดงวา่มคีา่เป็น Text ซึѷงไมส่ามารถ
นํามาคํานวณตอ่ไดใ้นทันท ีจําเป็นตอ้งอาศัยสตูร Left, Right, Mid แยกตัวเลขแตล่ะสว่นทีѷเป็น
วันเดอืนปีออกจากกนัแลว้ใชส้ตูรวันทีѷและเวลามาชว่ยแกไ้ขใหม้คีา่เป็น SN 

หากคณุอยากจะเกง่สตูรคํานวณเรืѷองวันทีѷและเวลา ตอ้งรูจั้กสตูรหา SN หรอืสตูรทีѷสามารถ
แปลงเลขทีѷของวันเดอืนปีทีѷมนุษยเ์ขา้ใจไปเป็นคา่ SN ทีѷ Excel รูจั้ก เชน่ สตูร Now(), 
Today(), Date(Year,Month,Day), Time(Hour,Minute,Second)  
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จากนัѸนตอ้งสามารถใชส้ตูรแปลงคา่ SN กลับมาเป็นเลขทีѷของวันเดอืนปี เชน่ สตูร Day(SN), 
Month(SN), Year(SN), และ WeekDay(SN) หรอืหาเลขทีѷของเวลา เชน่ Hour(SN), 
Minute(SN), Second(SN) 

 

สตูรแปลงเลขทีѷของวนัเดอืนปีและเวลาทีѷมนษุยเ์ขา้ใจ 
ไปเป็นคา่ Serial Number 

เพืѷอชว่ยใหเ้ขา้ใจสตูรไดง้า่ยขึѸน ขอสมมตวิา่ปจัจบุนั คอื วันทีѷ 14 เดอืนกมุภาพันธ ์ปีค.ศ. 
2010 เวลา 12 นาฬกิา 30 นาท ี45 วนิาท ี

1. =NOW() จะไดว้ันเดอืนปีและเวลาปัจจบุัน เชน่ 14/2/2010 12:30:45 

2. =Today() จะไดเ้ฉพาะวันเดอืนปีปัจจบุัน เชน่ 14/2/2010 

3. =Date(2010,2,14) จะได ้14/2/2010 

4. =Date( Year(Today()), Month(Today())+1, 0) จะไดวั้นเดอืนปีของวันสดุทา้ย
ของเดอืนปัจจบุัน คอื 28/2/2010 

5. =Time(12,30,45) จะไดเ้วลา 12:30:45 

6. =Time(12,30,45)+1 จะไดร้ะยะเวลา 36:30:45 ซึѷงตอ้งใช ้Format [h]:mm:ss ดว้ย 

 

สตูรแปลงคา่ Serial Number  
กลบัมาเป็นเลขทีѷของวนัเดอืนปีและเวลาทีѷมนษุยเ์ขา้ใจ 

สมมตวิา่เซลล ์A1 มสีตูร =NOW() ซึѷงแสดงออกมาเป็น 14/2/2010 12:30:45 (ถา้ตอ้งการ
แสดงคา่ออกมาเป็น SN โดยการเปลีѷยน Format เป็น General จะพบวา่ เซลล ์A1 มคีา่ SN 
เทา่กบั 40223.5213541667 ซึѷงเป็นตัวเลขทีѷ Excel รูจั้กแตเ่ราไมรู่จั้ก) 

1. =Day(A1) จะไดเ้ลขวันทีѷ 14 

2. =Month(A1) จะไดเ้ลขเดอืน 2 

3. =Year(A1) จะไดเ้ลขปี 2010 

4. =WeekDay(A1) จะไดเ้ลขของวันในสปัดาห ์1=Sunday, 2=Tuesday,…7=Saturday 

5. =Hour(A1) จะไดเ้ลขชัѷวโมง 12 

6. =Minute(A1) จะไดเ้ลขนาท ี30 

7. =Second(A1) จะไดเ้ลขวนิาท ี45 
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แฟ้มของฉนัทาํงานไดจ้รงิ แตถ่า้คนอืѷนใชจ้ะเป็นของปลอม 

แฟ้มงานทีѷสรา้งขึѸนบางแฟ้มของผม มมีลูคา่เป็นแสนเป็นลา้นบาท แฟ้มของคณุก็มรีาคามใิช่
นอ้ยอาจจะแพงกวา่แฟ้มของผมเสยีอกี ลองคดิถงึตน้ทนุของการสรา้งงานดซูคิรับ คดิแคค่า่ของ
เวลาทีѷเสยีไปตั Ѹงแตเ่ริѷมสรา้งแฟ้มขึѸนมาใชง้าน กวา่จะแกไ้ขปรับปรงุใหใ้ชง้านไดต้ามตอ้งการ 
ตอ้งเสยีเวลาไปมใิชน่อ้ยเลยใชไ่หม บางแฟ้มใชเ้วลาพัฒนาหลายปี ตอ้งใชทั้ Ѹงประสบการณ์
ทํางานและพืѸนฐานความรูร้อ้ยแปดกวา่จะไดแ้ฟ้มทีѷใชง้านไดต้ามใจนกึ 

แลว้ทราบกนัไหมวา่ แฟ้มทีѷคณุสรา้งมากบัมอืนัѸนน่ะ ตามกฎหมายถอืวา่เป็นของใคร ใครเป็น
เจา้ของตามกฎหมาย คณุเป็นเจา้ของ หรอืบรษัิททีѷเป็นเจา้นายคณุเป็นเจา้ของ 

ตามกฎหมายลขิสทิธิѻคอมพวิเตอร ์“ถา้ผูส้รา้งแฟ้มเป็นลกูจา้ง ลกูจา้งเป็นเจา้ของ โดยผูว้า่จา้งมี
สทิธนํิาไปเผยแพรไ่ด ้เวน้แตจ่ะตกลงกนัเป็นอยา่งอืѷน” กลา่วโดยยอ่ไดแ้บบนีѸ (ตา่งจากกรณี
รับจา้งหรอืขา้ราชการพนักงานรัฐวสิาหกจิ ซึѷงผูว้า่จา้งไดส้ทิธเิป็นเจา้ของ) และลขิสทิธิѻนั Ѹนไม่
ตอ้งเสยีเวลาไปจดทะเบยีนความเป็นเจา้ของกบัใคร แคค่ณุนําแฟ้มไปอวดใหค้นอืѷนเห็นก็ถอืวา่
เริѷมตน้ความเป็นเจา้ของไดแ้ลว้ แตถ่า้คณุไปลงนามในสญัญาจา้งงานใหย้กสทิธใินแฟ้มทีѷสรา้ง
ขึѸนดว้ยคอมพวิเตอรใ์หก้บับรษัิทผูว้า่จา้งไปแลว้ หากคณุลาออกไป คณุจะไมม่สีทิธิѻนําแฟ้มทีѷ
คณุสรา้งเองกบัมอืนัѸนไปใชต้อ่ไดอ้กี เพราะคณุไดย้กแฟ้มงานทีѷถอืวา่เป็นทรัพยส์นิทางปัญญา
ใหเ้ขาไปแลว้ ดังนัѸนในสญัญาจา้งงานทีѷด ีบรษัิทและลกูจา้งควรรักษานํѸาใจซึѷงกนัและกนัโดย
ระบใุนสญัญาจา้งงานไวว้า่ “พนักงานยอมใหบ้รษัิทผูว้า่จา้งมสีทิธิѻเป็นเจา้ของรว่มกบัพนักงาน” 

ถา้คณุเป็นเจา้นายหรอืเป็นเจา้ของบรษัิท อาจเถยีงวา่แฟ้มของพนักงานก็ตอ้งใหบ้รษัิทเป็น
เจา้ของ เพราะบรษัิทไดล้งทนุซืѸอเครืѷองคอมพวิเตอรแ์ละโปรแกรม Excel มาให ้บรษัิทอตุสา่ห์
ลงทนุลงแรงสง่คนไปอบรมพัฒนาความรู ้เงนิเดอืนก็จา่ยไปแลว้ ลกูจา้งจะเอาอะไรอกี 
โปรแกรม Excel มันก็คํานวณใหเ้องอยูแ่ลว้ไมใ่ชห่รอื ไมเ่ห็นจะเขา้ขา่ยกฎหมายลขิสทิธิѻอะไรนีѷ
เลย ... ถา้บรษัิทใดคดิกนัแบบนีѸ แสดงวา่ไมเ่คยทราบวา่แตล่ะแฟ้มทีѷใชง้านกนัทกุวันนัѸน 
พนักงานเขาเหนืѷอยยากแสนเข็นในการคดิแกไ้ขปรับปรงุกนัมาขนาดไหน 

ในดา้นของพนักงานผูส้รา้งแฟ้มขึѸนมา แมจ้ะใสร่หัส Protect Sheet และ Protect Workbook 
เพืѷอป้องกนัไมใ่หค้นอืѷนมาใชแ้ฟ้มไดก้็ตาม คนอืѷนก็ยังสามารถใชโ้ปรแกรมถอดรหัสในแฟ้มได ้
เสยีอกี และโปรแกรมถอดรหัสแฟ้ม Excel นีѸก็หาไดไ้มย่าก มคีนสรา้งแจกฟรใีหห้ามาใชก้นัได ้
ทางอนิเตอรเ์น็ต 

หลายครั Ѹงทีѷเจอลกูศษิยท์ีѷเขา้อบรมกบัผมมาเลา่ใหฟั้งวา่ หัวหนา้ฝากใหผ้มชว่ยดแูฟ้มนีѸใหห้น่อย 
ทําไมบางวันมันก็คํานวณถกูตอ้ง แตบ่างวันมันก็คํานวณผดิเพีѸยนไปเป็นลา้นหลายลา้นก็ม ีเดมิที
แฟ้มนีѸทํางานถกูตอ้งมาตลอด แตเ่มืѷอคนสรา้งแฟ้มลาออกไปแลว้เพืѷอนๆเอาแฟ้มนีѸมาใชต้อ่ พอ
ไปลบชืѷอคนสรา้งเดมิทีѷเขาพมิพไ์วใ้นชที ตั Ѹงแตนั่Ѹนมาแฟ้มนีѸก็คํานวณรวนเรืѷอยมา 

ผมเชืѷอวา่คณุตอ้งมแีฟ้มทีѷเป็นมรดกตกทอดจากเพืѷอนรว่มงานสบืตอ่กนัมาหลายรุน่ แลว้เชืѷอได ้
อกีวา่คณุไมเ่คยเสยีเวลายอ้นกลับไปตรวจสอบความถกูตอ้งของสตูรทีѷมอียูใ่หค้รบทัѸงหมดทกุ
เซลลใ์นตารางหรอกใชไ่หม ลองคดิดซูวิา่ เวลาทีѷเขาลาออกกนัไป มใีครบา้งทีѷลาออกเพราะคดิ
อยากทํางานในบรษัิทเดมิตอ่ไปบา้ง เป็นไปไดไ้หมทีѷเขาอาจสรา้งสตูรไวใ้หทํ้างานถกูตอ้ง
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ตามเดมิไปสกัพักใหค้นใชง้านตายใจ แตพ่อพน้หกเดอืนไปแลว้พอเปิดแฟ้มนัѸนขึѸนมาตัวเลข
ผลลัพธจ์ะคํานวณผดิเพีѸยนไปจากเดมิก็ได ้

 

แนวทางการป้องกนัแฟ้มเพืѷอทําใหค้นอืѷนนําไปใชต้อ่ไมไ่ด ้

1. เมืѷอสรา้งงานเสร็จแลว้ กอ่นจะสง่แฟ้มใหค้นอืѷน ใหทํ้าลายเครืѷองหมาย $ ทีѷใชใ้นสตูร
ทั ѸงหมดทิѸงไป โดยสัѷง Replace เครืѷองหมาย $ แลว้ไมต่อ้งใชเ้ครืѷองหมายอืѷนใดแทน สง่ผล
ใหส้ตูรทีѷไมม่เีครืѷองหมาย $ กํากบัไว ้ไมส่ามารถ copy นําไปใชต้อ่ทีѷเซลลอ์ืѷนไดเ้ลยเพราะ
ตําแหน่งอา้งองิจะเขยืѸอนตา่งไปจากตําแหน่งเดมิ 

2. กําหนดรหัสป้องกนัใหม้ซีบัซอ้นเพืѷอทําใหโ้ปรแกรมถอดรหัสตอ้งใชเ้วลานานมากจนคนทน
รอโปรแกรมถอดรหัสใหเ้สร็จไมไ่หว โดยเลอืกใชร้หัสทีѷยาวทีѷสดุ อาจใชร้หัสเป็นประโยค
ขอ้ความ ผสมตัวเลขตัวอกัษร ใชอ้กัษรตัวใหญผ่สมตัวเล็ก มชีอ่งวา่งดา้นหนา้หรอืตอ่ทา้ย
ดว้ยสญัลักษณ์ เชน่ B1g bRother |$ alw4ys riGHt!? ซึѷงใชแ้บบยอ่ลงมาก็ไดเ้ป็นรหัส 
BBslwys90! 

3. ทําใหด้เูหมอืนเป็นชทีวา่งทีѷไมม่ขีอ้มลูใดๆหรอืกลายเป็นขอ้มลูอืѷน เพืѷอหลอกใหค้นทีѷเปิดดู
ไมเ่ฉลยีวใจ 

3.1. เปลีѷยนส ีFont ใหก้ลนืกบัสขีอง Background 

3.2. นํารปูภาพตารางวา่งๆมาซอ้นทับ หรอื ใชร้ปูภาพทีѷลงิคค์า่จากเซลลอ์ืѷนมาซอ้นทับ โดย
สัѷง Copy แลว้สัѷง Paste แบบ Linked Picture (Excel 2003 กอ่นทีѷจะ Paste ตอ้งกด
ปุ่ ม Shift คา้งไวแ้ลว้คลกิเมนู Edit > Paste Picture Link) 

3.3. กําหนด Format Cells ใหใ้ช ้;;; เพืѷอเลกิการใชร้ปูแบบใดๆในการแสดงตัวเลขและ
ตัวอกัษรใหป้รากฏในชที 

3.4. กําหนด Format Cells > Protection > Hidden เพืѷอทําใหเ้ลกิการแสดงคา่ใหเ้ห็นใน
ชอ่ง Formula Bar และจะไมส่ามารถ Copy สตูรออกไปใชต้อ่ทีѷชทีอืѷนไดเ้ลย ทั ѸงนีѸตอ้ง
ใชร้ว่มกบัการสัѷง Protect Sheet ดว้ยจงึจะเกดิผล 

4. ใชส้ตูร Indirect ทีѷใช ้Text ทีѷบอกตําแหน่งอา้งองิคา่จากเซลลม์าใชแ้ทนทีѷจะใชส้ตูรลงิค์
โดยตรง จะทําใหก้าร Insert หรอื ยา้ยตารางไปทีѷอืѷนไมทํ่าใหส้ตูรปรับตําแหน่งตามไปดว้ย 
เชน่ =Indirect(“A1”) จะยังคงดงึคา่จากเซลลเ์ดมิคอื A1 ไมว่า่เราจะยา้ยเซลล ์A1 ไปทีѷอืѷน
แลว้ก็ตาม 

5. ใหส้รา้งสตูรยาวๆทีѷยากตอ่การแกะ แมเ้จา้ของแฟ้มเองก็ยังแกะไมอ่อก 

6. หากตอ้งการใหส้ตูรเดมิทํางานไดจ้นถงึสิѸนปี 2010 ใหเ้ปลีѷยนสตูรเดมิทีѷใชเ้ป็นสตูร  
=IF( Today()<= 40543, สตูรเดมิ, สตูรอืѷน) โดยตัวเลข 40543 นีѸหมายถงึ Date Serial 
Number ของวันทีѷ 31/12/2010 ซึѷงจะเปลีѷยนเป็นคา่ของวันสดุทา้ยอืѷนใดก็ไดต้ามใจชอบ 



Page 142 of 147 

 

สดุยอดเคล็ดลับและลัดของ Excel 
© พ.ศ. 2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ

www.ExcelExpertTraining.com 

7. ทํารั Ѹวไฟฟ้าทีѷมองไมเ่ห็นป้องกนัไมใ่ห ้Insert แทรกระหวา่งพืѸนทีѷทีѷตอ้งการ โดยสรา้งสตูร 
Array แบบสรา้งพรอ้มกนัทเีดยีวลงไปในแนวรั Ѹว เชน่ ใหเ้ลอืกเซลล ์A1:A10 แลว้พมิพ ์=“” 
จากนัѸนกดปุ่ ม Ctrl+Shift+Enter จะเกดิสตูร Array {=“”} พรอ้มกนั แลว้จะพบวา่จะไม่
สามารถ Insert Row แทรกระหวา่ง Row 1 – 10 ไดต้อ่ไป 

8. ถา้แฟ้มนัѸนมกีารใช ้VBA ประกอบรว่มอยูด่ว้ย ใหส้รา้งสตูรทีѷเป็นสตูร Function VBA เพืѷอ
คํานวณรว่มกบัสตูรสําคัญไวเ้สมอเพืѷอบังคับใหผู้ใ้ชต้อ้ง Enable Macro เพืѷอยอมให ้Macro 
ทํางานทกุครั Ѹงเมืѷอเปิดแฟ้มนัѸนขึѸนมาใชง้าน แตถ่า้ Disable Macro สตูรทีѷเป็น Function 
VBA ก็จะไมทํ่างานแลว้สง่ผลใหส้ตูรอืѷนทีѷเคยคํานวณรว่มกนัไมทํ่างานตามไปดว้ย 

9. ซอ่นชทีแบบ VeryHidden โดยใชคํ้าสัѷง ActiveSheet.Visible = xlVeryHidden ใน VBA 
จะทําใหไ้มส่ามารถใชคํ้าสัѷงใน Excel เพืѷอ Unhide ชทีกลับมาใหเ้ห็นตามเดมิ 

10. ในรหัส VBA ใหใ้ชตํ้าแหน่งอา้งองิทีѷอา้งถงึชืѷอชที ชืѷอแฟ้ม หรอืตําแหน่งเซลลท์ีѷตายตัว ทํา
ใหเ้มืѷอใดทีѷมกีารเปลีѷยนชืѷอชทีหรอืชืѷอแฟ้ม หรอืมกีารยา้ยเซลลไ์ปทีѷอืѷน จะสง่ผลใหร้หัส 
VBA หาตําแหน่งเซลลท์ีѷตอ้งการไมพ่บ 

ทั Ѹง 10 ขอ้นีѸเป็นเพยีงบางวธิทีีѷพบเห็นวา่มกีารใชก้นั เมืѷอใดทีѷคณุนําไปใช ้ขอใหจ้ดจําไวด้ว้ยวา่
ไดใ้ชว้ธิใีดไปบา้ง มฉิะนัѸนแลว้คณุเองนัѷนแหละทีѷจะใชแ้ฟ้มของตัวเองตอ่ไปไมไ่ด ้และหวังวา่จะ
ไมนํ่าไปใชส้รา้งปัญหาใหก้บัผูอ้ืѷน ทําใหเ้กดิเป็นเวรเป็นกรรมตอ้งกลับมาชดใชก้รรมระหวา่งกนั
ตอ่ไปอกี 

 

Excel สวยแตร่ปู จบูไมห่อมก็ได ้จบูหอมก็ได ้

พอเอย่ถงึโปรแกรม Excel จดุเดน่ยอ่มอยูท่ีѷการคํานวณ ซึѷงหลายคนพอเริѷมใช ้Excel บวกเลขก็
สา่ยหนา้ เพราะไมเ่ห็นวา่มันจะคํานวณไดถ้กูตอ้งดังใจ อาจพาลคดิในใจวา่สูใ้ชเ้ครืѷองคดิเลขคดิ
ใหย้ังจะไดคํ้าตอบทีѷถกูตอ้งกวา่ Excel เสยีอกี นีѷเป็นเพราะคนเพิѷงเริѷมใช ้Excel มักเขา้ใจผดิไป
วา่ สิѷงทีѷเห็นในเซลลค์อืสิѷงทีѷได ้เห็นอะไรก็ตอ้งไดอ้ยา่งนัѸน ถา้อยากไดต้ัวเลขทศนยิมกีѷหลัก จะ
ใสเ่ครืѷองหมายคอมมาแทรก ไมเ่ห็นยาก แคค่ลกิเลอืก Format ทีѷตอ้งการ 

การใช ้Format เป็นเรืѷองทีѷหนังสอื Excel ทัѷวไปเขยีนอธบิายไวเ้ป็นบทตน้ๆ โดยหารูไ้มว่า่เรืѷองนีѸ
ตอ้งเขยีนเป็นบททา้ยๆ โดยเฉพาะตอ้งเขยีนไวห้ลังจากบทเรืѷองสตูร Round, Trunc, และ Int 
เพืѷอทําใหผู้ท้ีѷเริѷมใช ้Excel เรยีนรูว้ธิใีชส้ตูรสําคัญเหลา่นีѸ มาใชป้รับตัวเลขในเซลลใ์หม้คีา่เหลอื
เทา่ทีѷตอ้งการกอ่น จากนัѸนจงึคอ่ยใชคํ้าสัѷง Format ปรับคา่ในเซลลใ์หแ้สดงผลลัพธต์ามทีѷ
ตอ้งการเป็นลําดับถัดไป 

การกําหนด Format ใหก้บัเซลลม์ขีั Ѹนตอนไมย่าก คณุอาจเลอืกใชว้ธิคีลกิเลอืกปุ่ ม Format 
Number ทีѷแสดงบนเมนู หรอืใชว้ธิคีลกิขวาลงไปในเซลลแ์ลว้เลอืกเมนู Format Cells > 
Number หรอืถา้ในแฟ้มนัѸนมเีซลลท์ีѷเคยกําหนดรปูแบบไวแ้ลว้ แคส่ัѷง Copy แลว้ไป Paste 
Special เลอืกเฉพาะ Format ก็จะไดร้ปูแบบนําไปใชท้ีѷเซลลอ์ืѷน เนืѷองจาก Format หรอืรปูแบบ
ทีѷเรากําหนดจะตดิอยูก่บัเซลลนั์Ѹนๆ ไมไ่ดต้ดิอยูก่บัตัวแฟ้มหรอืตัวโปรแกรม (ซึѷงใน Excel 2007 
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เป็นตน้มาจะยอมรับรปูแบบสงูสดุถงึ 64,000 แบบเหนอืกวา่รุน่กอ่นๆซึѷงรับรปูแบบไดเ้พยีง 
4,000 แบบตอ่แฟ้มเทา่นัѸน) 

Excel จัดเตรยีม Format มาตรฐานไวใ้หใ้ชก้บัตัวเลขไดม้ากมายหลายแบบ แตถ่า้คณุสามารถ
กําหนดไดเ้องลงไปแบบ Custom โดยพมิพร์ปูแบบลงไปในชอ่ง Type จะสะดวกรวดเร็วกวา่การ
นัѷงไลค่ลกิเพืѷอคน้หาจนพบ Format ทีѷตอ้งการ  

 

หลกัการกําหนด Format Cells > Number 

1. Excel ใชเ้ครืѷองหมาย # และ 0 แทนตําแหน่งของตัวเลข ซึѷงถา้ใชเ้ครืѷองหมาย # แลว้
ตัวเลขมคีา่ไมถ่งึก็จะไมแ่สดงเลขหลักนัѸน แตถ่า้ใช ้0 จะแสดงแทนดว้ยเลข 0 ออกมาให ้
เห็น เชน่ ถา้พมิพต์ัวเลข 1.2 ลงไป ถา้ใช ้Format ##.## จะแสดง 1.2 แตถ่า้ใช ้Format 
00.00 จะแสดง 01.20 ดว้ยเหตนุีѸใน Format มาตรฐานทีѷ Excel เตรยีมไว ้จะพบวา่อยา่ง
นอ้ยตัวเลขหลักหน่วยและหลักทศนยิม จงึกําหนดใหใ้ชเ้ลข 0 ไวเ้สมอ เชน่ #,##0.00 

2. ดา้นหนา้ของ Format ทีѷเป็นเครืѷองหมาย # หรอืเลข 0 เราสามารถกําหนดสขีอง Font ได ้
โดยพมิพช์ืѷอสทีีѷตอ้งการไวใ้นเครืѷองหมาย [ ] เชน่ [Red] หรอืถา้จําชืѷอสไีมไ่ด ้ใหใ้ช ้
[Colorn] แทน โดย n คอืเลขของสทีีѷตอ้งการ เชน่ [Color12] 

3. เครืѷองหมายวงเล็บ [ ] ยังใชใ้นแบบเงืѷอนไขเพืѷอควบคมุใหแ้สดงผลออกมาเฉพาะเมืѷอตรง
กบัเงืѷอนไขทีѷกําหนดไวใ้นเครืѷองหมาย [ ] เชน่ [>=90]00000.00 จะทําใหต้ัวเลขทีѷพมิพล์ง
ไปในเซลลท์ีѷใช ้Format นีѸ เฉพาะเมืѷอมคีา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตัวเลขใน
รปูแบบ 00000.00 
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4. ใน Format สามารถแทรกสญัลักษณ์หรอืตัวอกัษรไวด้า้นหนา้ ดา้นหลัง หรอืระหวา่ง 
Format ทีѷเป็นเครืѷองหมาย # หรอืเลข 0 

4.1. กรณีแทรกสญัลักษณ์ ใหพ้มิพแ์ทรกไดโ้ดยตรง เชน่ (0 . 00) % มเีครืѷองหมายวงเล็บ 
เครืѷองหมายวรรค จดุทศนยิม และ % เป็นสญัลักษณ ์

4.2. กรณีแทรกตัวอกัษร ตอ้งพมิพต์ัวอกัษรไวร้ะหวา่งเครืѷองหมายคําพดู เชน่  
“Total” 0.00 “บาท” 

5. ถา้ตอ้งการปัดตัวเลขใหเ้ป็นหลักพันใหเ้ตมิเครืѷองหมายคอมมาตอ่ทา้ยหนึѷงตัว ถา้ตอ้งการ
ปัดเป็นหลักลา้นใหเ้ตมิคอมมาตอ่ทา้ยสองตัว เชน่ 0.00,, จะแสดงตัวเลข 123456789 ทีѷ
บันทกึลงไปออกมาเป็น 123.46 โดยคา่ทีѷแทจ้รงิยังคงเทา่กบั 123456789 ตามเดมิ 

6. ใหใ้ชเ้ครืѷองหมาย ; ไดส้งูสดุ 3 ตัว เพืѷอควบคมุ Format ใหเ้ปลีѷยนตามคา่บวก คา่ลบ คา่
ศนูย ์และคา่ทีѷเป็นตัวอกัษร ในโครงสรา้งตามนีѸ คา่บวก;คา่ลบ;คา่ศนูย;์คา่ทีѷเป็นตวัอกัษร 

6.1. ถา้ไมใ่สเ่ครืѷองหมาย ; เลย แสดงวา่เป็น Format กลางทีѷใหต้ัวเลขทกุคา่ใช ้Format 
นัѸนรว่มกนั 

6.2. หลังจากเครืѷองหมาย ; ทีѷเตมิตอ่ทา้ยลงไป ถา้ใส ่; ตัวใด ตอ้งตามดว้ย Format ของคา่
นัѸนๆ แตถ่า้เราไมไ่ดก้ําหนด Format ของนัѸนๆไวด้ว้ย จงึไมแ่สดงคา่น ัҟนๆ 

 

ตัวอยา่งตอ่ไปนีѸ สมมตวิา่คา่ทีѷพมิพล์งไปในเซลลค์อื 123, -123, 0, Hello 

 Format ;;; จะไมแ่สดงอะไรใหเ้ห็นเลย 

 Format 0.00 จะแสดง 123.00, -123.00, 0.00, Hello 

 Format 0.00; จะแสดง 123.00, คา่ลบไมแ่สดง, 0.00, Hello 

 Format 0.00;[Red](0.00) จะแสดง 123.00, (123.00) ในสแีดง, 0.00, Hello 

 Format 0.00;; จะแสดงเฉพาะคา่บวก 123.00 กบั Hello เทา่นัѸน คา่ ลบ และ 0 ไม่
แสดง 

 Format 0.00;;; จะแสดงเฉพาะคา่บวก 123.00 เทา่นัѸน 

 Format 0.00;(0.00);; จะแสดงเฉพาะคา่บวก123.00 กบัคา่ลบ (123.00) 

 Format “Yes”;”No”;”Reject”; จะแสดง Yes, No, Reject 

 Format “Total” 0 “Baht”. 00 “Satang”;;; จะแสดง Total 123 Baht. 00 Satang 
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 Format 0.00_);(0.00);; จะแสดง 123.00 ไดแ้นวตรงกบัคา่ลบ (123.00) โดย
เครืѷองหมาย _) ทีѷเตมิตอ่ทา้ย Format คา่บวก หมายถงึ ใหห้า่งจากขอบขวาของเซลล์
เทา่กบัความกวา้งของเครืѷองหมาย ) 

ตัวอยา่ง Format แปลกๆ 

 Format [>=90]”A”;[>=70]”B”;”C” จะเปลีѷยนตัวเลขในเซลลต์ามเงืѷอนไขวา่  
ถา้คา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตัว A แทนตัวเลขนัѸน 
ถา้คา่มากกวา่หรอืเทา่กบั 70 ใหแ้สดงตัว B แทนตัวเลขนัѸน 
หรอืมฉิะนัѸนใหแ้สดงตัว C 

 Format [=1]”Yes”;[=0]”No”;”Reject” จะแสดงคําวา่ Yes, No, Reject แทนตัวเลขทีѷ
มคีา่เทา่กบั 1, 0, หรอืตัวเลขอืѷน ตามลําดับ 

 Format “4”;”4”;”4”;”4” จะเปลีѷยนคา่ใหเ้ป็นเลข 4 แทนไมว่า่คา่ทีѷแทจ้รงิจะเป็นเทา่ใด 

 Format 0000 จะแสดงเลข 123 ออกมาเป็น 0123 (ซึѷงตัวเลขยังคงมสีถานะเป็นตัวเลข
ตามเดมิ ถกูตอ้งกวา่การพมิพ ์‘0123 หรอืใชคํ้าสัѷง Format Cells > Number > Text 
ซึѷงทําใหต้ัวเลขเปลีѷยนสถานะมาเป็น Text ซึѷงดงูา่ยๆวา่จะชดิซา้ยของเซลล)์ 

 หากตอ้งการแทรกสญัลักษณ์แปลกทีѷไมม่บีนแป้นพมิพล์งไปใน Format เชน่ 
เครืѷองหมายบวกลบ ± ใหก้ดปุ่ ม Alt คา้งไวแ้ลว้พมิพต์ัวเลข 0177 ซึѷงสามารถคน้หาตัว
เลขทีѷตอ้งพมิพน์ีѸไดจ้าก โปรแกรม Character Map ซึѷงสัѷงเปิดโปรแกรมนีѸไดง้า่ยๆโดย
พมิพคํ์าวา่ charmap ลงไปในชอ่งของคําสัѷง Start > Run 

 

การใชคํ้าสัѷง Format Cells > Number จะชว่ยปรับการแสดงตัวเลขใหม้ตีัวอกัษรแทรก โดย
คา่ทีѷแทจ้รงิยังคงถอืวา่เป็น Number ทีѷเห็นไดจ้ากการชดิขวาของเซลล ์แตถ่า้เซลลม์คีวาม
กวา้งไมพ่อจะเห็นเป็นเครืѷองหมาย ###### แทน ซึѷงแกไ้ดโ้ดยสัѷง Format Cells > 
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Alignment > กาชอ่ง Shrink to fit เพืѷอทําให ้Excel ปรบัขนาด Font ยอ่ลงใหแ้สดงให ้
เห็นไดใ้นเซลลนั์Ѹนเสมอ 

ประเด็นเรืѷอง Format นีѸขอยํѸาวา่ การใช ้Format เป็นเพยีงการเปลีѷยนสิѷงเห็นเทา่นัѸน มไิดแ้กไ้ข
คา่ใหต้า่งไปจากเดมิแมแ้ตน่อ้ย 

หากตอ้งการนําตัวเลขไปแสดงรว่มกบัตัวอกัษร ยังมอีกีวธิหีนึѷง โดยใชส้ตูร Text เขา้มาชว่ยปรับ
รปูแบบของตัวเลขแลว้นําไปเชืѷอมตอ่กบัตัวอกัษรทีѷตอ้งการโดยใชเ้ครืѷองหมาย & เป็นตัวเชืѷอม  

สมมตวิา่ เซลล ์A1 มคีา่เทา่กบั .15 หากตอ้งการนําเลข .15 ไปแสดงใหเ้ป็นคําวา่ Profit 
15.0% ทําได ้2 วธิ ี

 วธิแีรก ใชคํ้าสัѷง Format Cells > Number > Custom แลว้กําหนด Type เป็น 
“Profit” 0.0% 

 วธิที ีѷสอง สรา้งสตูร =”Profit ”&Text(A1,”0.0%”) 

จะพบวา่ผลจากวธิแีรกไดคํ้าวา่ Profit 15.0% ชดิขวาของเซลลแ์สดงวา่สามารถนําไปคํานวณ
ตอ่ได ้แตว่ธิทีีѷสองแมจ้ะไดคํ้าเดยีวกนัแตจ่ะชดิซา้ยของเซลลซ์ึѷงไมส่ามารถนําไปคํานวณตอ่ จงึ
ขอแนะนําใหใ้ชว้ธิทีีѷสองกบัผลลัพธส์ดุทา้ยทีѷไมต่อ้งนําไปใชคํ้านวณตอ่เทา่นัѸน 

นอกจากนีѸสตูร Text ยังเปรยีบไดก้บัสตูร Round โดยสตูร Text นีѸจะปัดตัวเลขและแสดงตัวเลข
ตามรปูแบบใหด้ว้ย เชน่ =TEXT(123456789,"0.00,,") จะไดคํ้าตอบเป็น 123.46 และมคีา่ 
123.46 ดว้ย 
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วธิใีช ้Add-In 

Add-In เป็นแฟ้มทีѷมนีามสกลุ .xla หรอื .xlam ซึѷงแฟ้มเหลา่นีѸจะทําให ้Excel ทีѷตดิตั Ѹงไวใ้นแต่
ละเครืѷองมสีตูรหรอืคําสัѷงเพิѷมขึѸนมากกวา่เดมิ ซึѷงทกุวันนีѸเราสามารถนําแฟ้ม Add-in ทีѷแจกฟรี
จากอนิเตอรเ์น็ตมาใชก้นัไดทั้นท ี

1. เริѷมจาก Download แฟ้ม Add-in มาเก็บไวใ้นเครืѷองคอมพวิเตอรข์องคณุกอ่น 

2. จากนัѸนเปิดโปรแกรม Excel แลว้สัѷง File > Options > Add-ins แลว้คลกิทีѷปุ่ ม Go 
ดา้นลา่งของหนา้ จะเปิดใหเ้ห็นรายชืѷอ Add-ins Available ทีѷมาพรอ้มกบัโปรกรม Excel 
(Excel 2003 ใหส้ัѷง Tools > Add-Ins) 

3. ใหก้ดปุ่ ม Browse คน้หาแฟ้ม Add-in ทีѷคณุเก็บไวใ้นเครืѷองตามขอ้ 1 ใหพ้บแลว้กดปุ่ ม 
OK 

4. จะพบชืѷอ Add-in ทีѷคณุเลอืกปรากฏเพิѷมในชอ่งรายชืѷอ Add-ins Available  

ขอใหเ้ลอืกกาชืѷอ Add-ins เฉพาะทีѷตอ้งการนํามาใชง้านเทา่นัѸน เพราะการเปิดใช ้Add-in ก็
เหมอืนกบัการเปิดแฟ้มทัѷวไป เพยีงแตเ่มืѷอเปิด Excel จะเปิดแฟ้ม Add-in ทีѷเลอืกไวต้อ่ใหเ้อง 
แตจ่ะไมเ่ห็นตัวแฟ้มแตอ่ยา่งใด ซึѷง Add-in จะทําใหค้ณุมสีตูรเพิѷมเตมิหรอืทําใหม้คํีาสัѷงเพิѷมทีѷ
จะเห็นไดบ้นเมนูก็แลว้แตแ่ฟ้ม Add-in นัѸนสรา้งขึѸนมาเพืѷอจดุประสงคใ์ด 

ขอแนะนําใหใ้ช ้ExcelExpertTrainingAddins.xla ซึѷงเป็น Add-in ทีѷแจกใหใ้ชใ้นหลักสตูร
สดุยอดเคล็ดลับ โดยจะทําใหม้สีตูรตอ่ไปนีѸเพิѷมเตมิ  

 =Fml(cell) ทําหนา้ทีѷแสดงสตูรในเซลล ์

 =Fmt(cell) ทําหนา้ทีѷแสดง Format ในเซลล ์

 =Money(ตัวเลข,”ชืѷอหน่วยเงนิ”,”ชืѷอหน่วยเศษสตางค”์) เชน่ 
=Money(1234.56,”Dollar”,”Cent”) จะอา่นตัวเลขออกมาเป็นคําวา่ One Thousand 
Two Hundred Thirty Four Dollar and Fifty Six Cent 

เนืѷองจากสตูรเหลา่นีѸไมใ่ชส่ตูรทีѷมาตามปกตขิอง Excel ดังนัѸนหากเปิดแฟ้มทีѷใชส้ตูร Fml ขึѸนมา
โดยทีѷยังไมไ่ดเ้รยีกใช ้ExcelExpertTrainingAddins.xla  จะทําใหส้ตูรเหลา่นีѸกลายเป็น Error 
วา่ #NAME! ทั Ѹงหมด ซึѷงแกไ้ขไดโ้ดยทําการตดิตั Ѹง Add-in ExcelExpertTrainingAddins.xla 
กอ่นแลว้จงึตามดว้ยการเปิดแฟ้มทีѷมสีตูรเหลา่นีѸตอ่ แตถ่า้พบวา่สตูรยังคง Error อยู ่ใหค้ลกิทีѷ
เซลลส์ตูรแลว้กดปุ่ ม F2 แลว้กดปุ่ ม Enter เพืѷอกระตุน้ใหส้ตูรเริѷมทํางานตอ่ไปไดต้ามปกต ิ


